This is a publication of Sage Software, Inc.

Version 2012

Copyright © 2012. Sage Software, Inc. All rights reserved.

Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc. or its affiliated entities. All other trademarks are the property of their respective owners.

Business Objects® and the Business Objects logo, BusinessObjects®, and Crystal Reports® are trademarks or registered trademarks of Business Objects Software Ltd. in the United States and in other countries. Business Objects is an SAP company.

Microsoft ®SQL Server®, Windows Vista® and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or in other countries.

The names of all other products and services are property of their respective owners.

Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End User License Agreement ("EULA") or other agreement that is provided with or included in the Sage product. Nothing in this document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and conditions, the information in this document is provided by Sage "AS IS" and Sage disclaims all express, implied or statutory warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove information in this document at any time without notice to you or others.

Sage End User License: http://na.sage.com/sage-na/eula
Contents

Introduction .................................................................................................................. 1

Chapter 1: Setting Up Order Entry .............................................................................. 3
Setting Up Order Entry ................................................................................................. 3
  About Multicurrency Accounting .................................................................................. 6
  About Order Entry Integration with Project and Job Costing ..................................... 7
  About Aging Periods .................................................................................................... 16
  About Numbering Order Entry Documents .................................................................. 17
Processing and Posting .................................................................................................. 18
  About Backorder Quantities ......................................................................................... 18
  About Order Unit of Measure ....................................................................................... 19
  Selecting Transaction Processing Options in Order Entry ............................................ 19
  Setting Up Posting and Day End Processing Options ..................................................... 21
  Order Entry Options for Posting Accounts Receivable Batches .................................... 23
General Ledger Integration ............................................................................................. 24
  General Ledger Accounts Used by Order Entry ............................................................ 24
  General Ledger Integration Options .............................................................................. 28
Inventory Control Integration .......................................................................................... 32
  Allowing Serial and Lot Number Allocation for Quantity Ordered ................................. 33
  Inventory Costing Methods .......................................................................................... 33
Templates ......................................................................................................................... 34
  About Templates .......................................................................................................... 34
  Creating Templates ....................................................................................................... 36
  Managing Templates ..................................................................................................... 37
Transaction History and Statistics ................................................................................... 38
  About Transaction History .......................................................................................... 38
  About Sales History ....................................................................................................... 38
  About Sales Statistics ................................................................................................... 39
  Allowing Editing of Sales Statistics .............................................................................. 40
## Contents

**Credit Checks** ................................................................................................................. 41  
  - About Credit Checks ................................................................................................. 41  
  - Setting Up Customer Credit Check Options ............................................................. 42  

**E-mail Messages** ............................................................................................................. 43  
  - Creating E-mail Messages ......................................................................................... 43  
  - E-mail Message Variables ......................................................................................... 44  

**Miscellaneous Charges** ................................................................................................... 47  
  - About Miscellaneous Charges ................................................................................. 47  
  - Creating Miscellaneous Charges ............................................................................. 49  
  - Managing Miscellaneous Charges ........................................................................... 51  

**Sales Commissions** ......................................................................................................... 52  
  - About Sales Commissions ......................................................................................... 52  
  - Setting Up Salesperson Commissions ...................................................................... 54  

**Ship-Via Codes** ................................................................................................................ 56  
  - Creating Ship-Via Codes ........................................................................................... 56  
  - Managing Ship-Via Codes .......................................................................................... 57  

**Optional Fields** .............................................................................................................. 58  
  - About Optional Fields ............................................................................................... 58  
  - Adding Optional Fields to Transaction Entry Screens ............................................... 60  

**Chapter 2: Entering and Posting Order Entry Transactions** ............................................. 65  
  - About Transaction Processing ................................................................................. 65  
    - Online Posting ........................................................................................................ 65  
    - Day End Processing ................................................................................................ 65  
    - Maintaining Your Audit Trail .................................................................................. 66  
  - About Orders, Shipments, and Invoices ................................................................... 67  
  - About Importing and Exporting Orders and Invoices ............................................. 74  
  - About Exchange Rates ............................................................................................... 75  
  - About Posting Orders, Posting Invoices, and Posting Shipments............................ 77  
  - About Order Completion ........................................................................................... 80  
  - About Price Checks ................................................................................................... 82  
  - Changing Payment Terms .......................................................................................... 83
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Sales Splits</td>
<td>83</td>
</tr>
<tr>
<td>Order Types</td>
<td>84</td>
</tr>
<tr>
<td>Quotes</td>
<td>87</td>
</tr>
<tr>
<td>Entering a Quote</td>
<td>87</td>
</tr>
<tr>
<td>Creating a New Contract for a Quote in Project and Job Costing</td>
<td>89</td>
</tr>
<tr>
<td>Promoting a Quote to an Order</td>
<td>91</td>
</tr>
<tr>
<td>Orders</td>
<td>91</td>
</tr>
<tr>
<td>Entering an Order</td>
<td>92</td>
</tr>
<tr>
<td>Editing an Order</td>
<td>100</td>
</tr>
<tr>
<td>Adding Comments and Instructions to Order Entry Transactions</td>
<td>101</td>
</tr>
<tr>
<td>Canceling Backordered Quantities on an Order</td>
<td>103</td>
</tr>
<tr>
<td>Using the New Contract Wizard</td>
<td>103</td>
</tr>
<tr>
<td>Copying Orders</td>
<td>104</td>
</tr>
<tr>
<td>Prepayments</td>
<td>107</td>
</tr>
<tr>
<td>About Prepayments</td>
<td>107</td>
</tr>
<tr>
<td>Entering a Prepayment</td>
<td>109</td>
</tr>
<tr>
<td>Processing a Credit Card Prepayment</td>
<td>112</td>
</tr>
<tr>
<td>Voiding a Credit Card Prepayment</td>
<td>114</td>
</tr>
<tr>
<td>Shipments and Invoices</td>
<td>115</td>
</tr>
<tr>
<td>About Credits on Invoices</td>
<td>115</td>
</tr>
<tr>
<td>About Customer Payment Schedules</td>
<td>116</td>
</tr>
<tr>
<td>Invoicing Shipments</td>
<td>116</td>
</tr>
<tr>
<td>Shipping Orders and Items</td>
<td>120</td>
</tr>
<tr>
<td>Credit and Debit Notes</td>
<td>127</td>
</tr>
<tr>
<td>About Credit/Debit Notes</td>
<td>127</td>
</tr>
<tr>
<td>Crediting an Existing Invoice</td>
<td>130</td>
</tr>
<tr>
<td>Crediting a Cleared or Missing Invoice</td>
<td>134</td>
</tr>
<tr>
<td>Editing Credit Note Details</td>
<td>138</td>
</tr>
<tr>
<td>Entering and Verifying Credit/Debit Note Totals</td>
<td>140</td>
</tr>
<tr>
<td>Credit Card Transactions</td>
<td>141</td>
</tr>
<tr>
<td>About Pre-authorizing, Capturing, and Forcing Credit Card Payments</td>
<td>141</td>
</tr>
<tr>
<td>Pre-authorizing a Credit Card Payment</td>
<td>144</td>
</tr>
</tbody>
</table>
Capturing a Pre-authorized Credit Card Payment .............................................. 147
Capturing and Invoicing Pre-authorized Credit Card Payments ...................... 150
Voiding a Credit Card Pre-authorization ............................................................ 153

Serial and Lot Numbers ...................................................................................... 154
About Serialized Inventory and Lot Tracking .................................................... 154
Allocating Serial Numbers or Lot Numbers to an Order .............................. 157
Allocating Serial Numbers or Lot Numbers to a Shipment ...................... 161
Allocating Serial Numbers or Lot Numbers to an Invoice ...................... 164
Allocating Serial Numbers or Lot Numbers to a Credit Note .................. 167
Allocating Serial Numbers or Lot Numbers to a Debit Note ..................... 171
Allocating Serial Numbers or Lot Numbers to Items in Copied Orders .... 174

Taxes .................................................................................................................. 176
About Taxes ........................................................................................................ 176
Changing Tax Amounts for Order Entry Documents .................................... 178
Changing Tax Groups and Tax Classes for Order Entry Documents .......... 180
Entering and Distributing Tax Amounts ............................................................ 182
Entering Taxes Manually .................................................................................... 183

Chapter 3: Looking Up Statistics and Information in Order Entry ............... 187
Adding Sales Statistics ...................................................................................... 187
Looking Up Sales Statistics ............................................................................. 187
Looking Up Posted Documents ......................................................................... 188
Looking Up Sales History for Items or Customers ......................................... 190

Chapter 4: Customizing and Printing Order Entry Forms ......................... 193
About Order Entry Customer Forms ................................................................. 193
  Printing before Running Day End Processing ........................................ 193
  Order Confirmations ...................................................................................... 193
  Invoices .......................................................................................................... 194
  Credit Notes and Debit Notes ...................................................................... 194
  Receipts .......................................................................................................... 194
Printing Order Entry Customer Forms ................................................................. 195
Sending Order Entry Forms to Customers by E-mail .............................................. 196
Customizing Order Entry Forms ........................................................................... 197
  Customizable Formats for Printed Order Entry Forms ........................................ 197
  Datapipe Report Parameters for Printed Customer Forms ................................... 198
  Using Non-datapiped Invoice Forms ..................................................................... 199
Credit/Debit Notes .................................................................................................. 200
  Printing a Credit Note or a Debit Note Immediately After Posting ..................... 200
  Printing a Range of Credit Notes or Debit Notes .................................................. 202
Invoices .................................................................................................................... 205
  Printing an Invoice Immediately After Posting .................................................. 205
  Printing a Range of Invoices .................................................................................. 208
Order Confirmations ................................................................................................. 211
  Printing an Order Confirmation Immediately After Posting .............................. 211
  Printing Order Confirmations for a Range of Orders .......................................... 213
Picking Slips ............................................................................................................. 214
  Printing Picking Slips ........................................................................................... 215
Quotes ....................................................................................................................... 216
  Printing a Quote Immediately After Posting ........................................................ 216
  Printing a Range of Quotes ................................................................................... 218
Shipping Labels ....................................................................................................... 219
  Printing Shipping Labels ...................................................................................... 220

Chapter 5: Printing Order Entry Reports ............................................................... 223
About Order Entry Reports ....................................................................................... 223
  Using Optional Fields when Printing Reports ....................................................... 223
  Setup Reports ....................................................................................................... 224
  Sales Analysis and Transaction Reports ............................................................... 224
  Customer Forms ................................................................................................... 224
Selecting a Print Destination .................................................................................... 225
About Print Destinations ......................................................................................... 227
Printing Order Entry Analytical and Setup Reports ............................................... 227
## Printing Salesperson Commission Rates .......................................................... 228

### Chapter 6: Periodic Processing in Order Entry ................................................. 231

#### About Periodic Processing .............................................................................. 231

- Daily Or Weekly Processing Tasks ................................................................. 231
- Period End Tasks ............................................................................................. 231

#### About Day End Processing ............................................................................ 232

- Journal Entries Generated for Posted Order Entry Transactions .................. 235

#### Performing Day End Processing .................................................................... 243

- Creating a Batch of General Ledger Transactions in Order Entry ................. 244
- About Batches Created in Accounts Receivable ............................................. 246
- Posting a Batch of Order Entry Invoices in Accounts Receivable ................. 247

### Appendix A: Order Entry Screen Guides ......................................................... 249

#### Customer Forms Screens .............................................................................. 250

- O/E Credit/Debit Notes Screen ......................................................................... 250
- O/E Invoices Screen .......................................................................................... 254
- O/E Order Confirmations Screen ..................................................................... 256
- O/E Picking Slips Screen ................................................................................. 260
- O/E Quotes Screen ............................................................................................ 265
- O/E Shipping Labels Screen .............................................................................. 268

#### Periodic Processing Screens ......................................................................... 271

- O/E Clear History Screen ............................................................................... 271
- O/E Create Batch Screen ................................................................................ 274

#### Reports Screens ............................................................................................. 275

- Analytical Reports ........................................................................................... 275
- Setup Reports .................................................................................................. 301

#### Setup Screens ................................................................................................ 311

- O/E Options Screen ......................................................................................... 311
- O/E G/L Integration Screen ............................................................................. 327
- O/E Templates Screen ..................................................................................... 334
- O/E Miscellaneous Charges Screen .................................................................. 339
O/E Ship-Via Codes Screen .............................................................. 346
O/E Optional Fields Screen ............................................................ 349
O/E E-mail Messages Screen .......................................................... 357
Statistics and Inquiries Screens ....................................................... 359
O/E Current Orders Inquiry Screen .................................................. 359
O/E Pending Shipments Inquiry Screen .......................................... 363
O/E Sales History Screen ............................................................... 368
O/E Sales Statistics Screen ............................................................. 381
O/E Salesperson Inquiry Screen ..................................................... 386
Transaction Screens .......................................................................... 389
O/E Order Entry Screen ................................................................. 389
O/E Shipment Entry Screen ............................................................. 509
O/E Invoice Entry Screen ............................................................... 562
O/E Credit/Debit Note Entry Screen .................................................. 610
O/E Copy Orders Screen ................................................................. 654
O/E Capture Payments with Invoices Screen .................................... 672

Appendix B: Order Entry Security Authorizations .......................... 679

Appendix C: Data Entry Tools, Tips, and Shortcuts ....................... 683
Data Entry Tools and Shortcuts ........................................................ 683
Order Entry Menu Commands .......................................................... 687
  File Menu ...................................................................................... 687
  Settings Menu .............................................................................. 688
  Help Menu .................................................................................... 688
Working with Detail Entry Tables ...................................................... 689
Keyboard Shortcuts for Detail Tables ................................................. 690
Setting Finder Criteria ...................................................................... 690

Appendix D: Support and Resources ............................................ 693
Finding Help and Documentation ...................................................... 693
  The Sage 300 ERP Learning Center ............................................. 693
Introduction

Order Entry handles all your order entry, invoicing, and order tracking needs, regardless of the size and complexity of your business.

You can use Order Entry to enter orders and sales returns, and to print invoices, quotes, order confirmations, picking slips, credit notes, debit notes, and shipping labels. You can track transaction details and sales information on the screen and on printed reports.

Order Entry is fully integrated with Inventory Control and Accounts Receivable, so you always know your inventory levels and the status of your customer accounts. It also integrates fully with Project and Job Costing, so you can sell merchandise that includes components such as labor, service, or contacting costs.

The *Order Entry User’s Guide* contains the following chapters:

- **Chapter 1: Setting Up Order Entry**
  
  Set up accounts, records, templates, options, and other details for your Order Entry system.

- **Chapter 2: Entering and Posting Order Entry Transactions**
  
  Use Order Entry transaction entry screens to process quotes, orders, shipments, invoices, credit notes, and debit notes.

- **Chapter 3: Looking Up Statistics and Information in Order Entry**
  
  Use Order Entry Statistics and Inquiries screens to look up information about customers and transactions.

- **Chapter 4: Customizing and Printing Order Entry Forms**
  
  Use the report forms that come with Order Entry to print invoices, quotes, credit notes, debit notes, order confirmations, receipts, shipping labels, and picking slips, or select a customized version.

- **Chapter 5: Printing Order Entry Reports**
  
  Use Order Entry Reports screens to print setup reports and analytical reports.
- **Chapter 6: Periodic Processing in Order Entry**
  Use Order Entry Periodic Processing screens to create batches and clear history.

- **Appendix A: Order Entry Screen Guides**
  Learn how to find and use Order Entry screens. Each screen guide includes navigation information, field help, and a list of tasks you can use the screen to perform.

- **Appendix B: Order Entry Security Authorizations**
  If security is turned on for your Sage 300 ERP system, the system administrator must assign these security authorizations to users for Order Entry screens.

- **Appendix C: Data Entry Tools, Tips, and Shortcuts**
  Use these tools and shortcuts to speed up data entry in Sage 300 ERP.

- **Appendix D: Support and Resources**
  Find support and resources to help get Sage 300 ERP up and running quickly.
Chapter 1: Setting Up Order Entry

Set up accounts, records, templates, options, and other details for your Order Entry system.

Setting Up Order Entry

This article lists the steps for setting up a new Order Entry system.

Important! Follow the "Before you start" steps before setting up your Order Entry system.

Before you start:
Before you set up Order Entry, gather information and set up your system, as follows:

1. Gather all your current Order Entry records. These can be manual records or printed listings and reports from other accounting software, such as:
   - A list of the general ledger accounts used in your Order Entry system, including the revenue account to which miscellaneous charges are posted.
   - Lists of the codes and other information you will use to set up ship-via codes, miscellaneous charges, and templates.
   - Outstanding orders, including backorders, standing orders, future orders, and quotes.
   - Historical sales statistics for orders (optional).
   - Samples of Order Entry forms: order confirmations, picking slips, shipping labels, invoices, and credit notes.
   - If you use a multicurrency order entry ledger, a list of the source currencies in which you record transactions, and a list of current exchange rates.

Note: You may be able to enter much of your order entry data by importing it directly from files created by another program.
2. Set up the following records in other Sage 300 ERP programs:
   - **In Common Services**, set up bank, tax, and currency records.
   - **In Accounts Receivable**, set up records for customers, ship-to locations, payment terms, credit checks, and salespersons.
     - **Non-existent customers.** You can enter an order for a customer has no record in Accounts Receivable, but you must add the customer before you post an invoice for that customer in Accounts Receivable.
     - **One-time customers.** If you frequently have one-time cash sales, create a record for one-time customers in Accounts Receivable.
   - **In Inventory Control**, set up records for items, price lists, locations, account sets, and categories.
   - **If you use Payment Processing**, set up processing codes and payment codes for credit card processing.
     - **Processing codes.** Processing codes specify the merchant account, bank, and currency that will be used when processing a credit card transaction. You set up processing codes in **Common Services > Payment Processing > PMT Setup > Processing Codes**.
     - **Payment codes.** To process credit card transactions in Sage Payment Solutions, you must set up at least one payment code in Accounts Receivable that uses the payment type "SPS Credit Card".

3. Add the following Order Entry accounts to your Chart of Accounts:
   - In General Ledger, add the revenue account to which amounts generated by miscellaneous charges are credited (when you post invoices) and debited (when you post credit notes).
   - All other General Ledger accounts to which Order Entry data is posted. These accounts are specified in other Sage 300 ERP programs, as follows:
     - **In Accounts Receivable**, you specify the Receivables Control and Prepayment Liability accounts.
     - **In Inventory Control**, you specify the Sales, Returns, Cost Of Goods Sold, Cost Variance (if using standard or most recent costing), and Damaged Goods accounts for item categories, and the Shipment Clearing and Inventory Control accounts for account sets.
     - **In Tax Services**, you specify the Tax Liability accounts.
For more information about these accounts, see the help for each program.

4. Set up security authorizations. For more information, see "Order Entry Security Authorizations" (page 679).

**To set up your Order Entry system:**

1. Select Order Entry options.

    The options you select on the O/E Options screen determine how your Order Entry system operates and the types of data it stores and displays. You can also use the screen after setup to review your entries and, as needed, change most of them.

    You use the O/E Options screen to perform the following setup tasks:
    - Verify the prefixes and numbers you want Order Entry to assign to orders and invoices, if you want the numbers assigned automatically.
    - Select the options to use when processing orders and invoices.
    - Specify a default order template (optional).
    - Specify the default order unit of measure.
    - Define any optional fields you want to add to transaction entry screens.

    For more information, see "O/E Options Screen" (page 311) and "About Numbering Order Entry Documents" (page 17).

2. Add setup records.

    Before you can process orders, invoices, and credit notes in Order Entry, you need to set up records for ship-via codes, miscellaneous charges, and e-mail messages.

    You can also define templates to speed up and simplify order entry, add optional fields to be used in transactions, and use the O/E Options screen to set up processing and General Ledger integration options for transactions.

    For more information, see "Setup Screens" (page 311).

3. Enter outstanding orders if they exist.

    When you set up Order Entry, you should enter all outstanding orders into the new system so you can track them effectively.
• If you were using a computerized order entry system, you may be able to use Order Entry's import utilities to import records.

• If you are transferring orders from another Sage 300 ERP Order Entry database, you can export records from the other database, use spreadsheet software to change codes, amounts, and other information, and then import the records into the new Order Entry system you are setting up.

**Note:** After importing, you should print the O/E Transaction List report for orders and invoices to verify the imported records. You can also enter outstanding orders directly on the O/E Order Entry screen.

4. Enter sales statistics.

Order Entry maintains sales statistics for the current year and for all previous years for which you store data.

If you set up before fiscal year end, you need to enter sales statistics from previous periods of the current year if you want to view these statistics online or print reports that include them.

You can also enter any sales statistics from previous years that you want to view online, or for which you want to print reports.

After you set up sales statistics, Order Entry automatically updates statistical information each time you run Day End Processing.

5. Design order entry forms. For more information, see "About Order Entry Customer Forms" (page 193) and "Customizable Formats for Printed Order Entry Forms" (page 197).

**About Multicurrency Accounting**

If you use multicurrency accounting, you set up currency information for your Order Entry system in Common Services and Accounts Receivable.

When setting up Order Entry, you need only to verify that the currencies in which you bill your customers have been added to the Currency screens in Common Services.

You need to add currency information in Order Entry only at the following times:

• When setting up a miscellaneous charge or entering a transaction for a customer that is not yet defined in Accounts Receivable. You specify the currency for the charge record or transaction by selecting a tax group that
uses that currency.

- When changing the default exchange rate on a transaction. Order Entry displays the exchange rate that is entered in Common Services for the transaction date, but you can change the exchange rate or rate type.

- When recording a prepayment. You can add prepayments in any currency you have defined for Sage 300 ERP.

Some Order Entry reports can also include source (customer) and functional (company) currency information.

**About Order Entry Integration with Project and Job Costing**

Order Entry provides sales order integration with Project and Job Costing.

You can create an order and specify the job (contract, project, category, and resource, if applicable) to which each order detail applies.

- If an order is job-related, all detail lines on the order must be job-related.

- Orders can list material details—items from inventory used on the job—and they can list miscellaneous charges, which can be labor, subcontracting charges, or charges such as shipping and handling.

**Project Invoicing**

Order Entry lets you handle the complete order-processing cycle in Order Entry, or create the order in Order Entry and manage the billing and invoicing in Project and Job Costing (called Project Invoicing).

- **Invoicing directly from Order Entry**

  Service providers normally invoice directly from Order Entry.

  A series of service calls can apply to a single project, or you can create new projects for each call. Order Entry lets you create new contracts "on the fly" when you create new quotes. The details for each new contract can be copied from an existing template.

- **Using Project Invoicing**

  Companies with more lengthy or complex projects, such as construction companies, normally use project invoicing, and will likely process additional costs through Accounts Payable.
Posting the shipment in Order Entry completes the transactions for O/E. The transaction is sent to Project and Job Costing, which calculates the extended billing amount and the cost portion of the order.

You can then process the billings for the transaction in Project and Job Costing, using the Create Billing Worksheet.

**Note:** If you create an order or shipment for a customer for which no record exists in Accounts Receivable and you select the Project Invoicing option, you will not be able to add order or shipment details unless the default template includes a tax group. (The tax group is not editable if you choose project invoicing, and it will be blank unless it is specified in the template.)

<table>
<thead>
<tr>
<th>Project Type and Accounting Method</th>
<th>Invoicing</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time and Materials project, Billings and Costs or Accrual-Basis accounting method</td>
<td>Can choose to invoice in Order Entry or in Project and Job Costing</td>
<td>If invoicing in Order Entry, the costs and revenue are sent to Project and Job Costing (PJC) from Accounts Receivable when the invoice is posted in A/R. Costs and revenue are recognized during A/R posting. You can process orders, shipments, invoices, debit notes, and credit notes in Order Entry. If invoicing in PJC, the order is completed at shipment posting, and costs are sent to PJC for invoicing, using the Create Billing Worksheet. For Time and Materials projects, the billing type, billing rate, and extended billing amount are also sent to PJC when you post a shipment. You cannot process invoices, debit notes, or credit notes in Order Entry. Costs and revenue are recognized in PJC during revenue recognition.</td>
</tr>
<tr>
<td>Fixed Price project, Billings and Costs or Accrual-Basis accounting method</td>
<td>Invoicing is done by Project and Job Costing</td>
<td>The order is completed at shipment posting, and costs are sent to Project and Job Costing (PJC) for invoicing, using the Create Billing Worksheet. For Time and Materials projects, the billing type, billing rate, and extended billing amount are also sent to PJC when you post a shipment. You cannot process invoices, debit notes, or credit notes in Order Entry. Costs and revenue are recognized in PJC during revenue recognition.</td>
</tr>
<tr>
<td>Time and Materials project, Completed Project accounting method</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed Price project, Project Percent Complete or Completed Project accounting method</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost Plus project, Total Costs Percentage</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Type and Accounting Method</td>
<td>Invoicing</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>Complete, Completed Project, Labor Hours Percentage Complete, Billings and Costs, Category Percentage Complete, or Accrual-basis accounting method</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
One of the most important processing decisions is how you are going to invoice orders (jobs).

- If the invoice needs to be created in Project and Job Costing, Order Entry will complete the order when you post the shipment, and prevent you from invoicing in Order Entry.
- If you delay invoicing in Order Entry, the transaction will be sent to Project and Job Costing as unbilled, and you will have to create the invoice in Project and Job Costing or bill from Accounts Receivable.

If you create the invoice in Order Entry, you can select retainage accounting.

If you create the invoice in Project and Job Costing, you cannot select retainage accounting in Order Entry because you will determine all invoice amounts in Project and Job Costing.

**Quotes and Estimates**

Contracts created from Order Entry quotes start as estimates in Project and Job Costing. Detail lines that you add to an Order Entry quote update contract estimate amounts when you post the quote in Order Entry. (The contract can have an Open status, but the project status must be Estimate.)

When you change the order type to Active and post the order, Order Entry changes the project status to Open for each project to which you posted a detail.

**Order Detail Lines**

Each detail line on a job-related order must be applied to an existing cost category in an open contract and project.
Chapter 1: Setting Up Order Entry

In Project and Job Costing, each category is assigned a cost type with a cost class that can be labor, material, equipment, subcontractor, overhead, or miscellaneous.

- **Item details** assign inventory items to jobs, so the category to which they apply must use a material cost class.

- **Miscellaneous charge details** let you assign costs for all other cost classes—labor, equipment, subcontractor, overhead, and miscellaneous cost.

Setting up the Project and Job Costing side includes:

- Deciding how you are going to invoice customers—in Order Entry or in Project and Job Costing.

- Setting up contracts and projects. You can: Set up template jobs that you can copy for each new order using the New Contract Wizard in Order Entry. For more information, see Using the New Contract Wizard. Set up jobs that are used by groups of orders.

- For each project: Choosing whether the default cost for miscellaneous charges comes from the miscellaneous charge record or from the contract. For accrual-basis or billings and costs projects, choosing whether the billing rate comes from the contract billing rate, from the customer price list, or from a price list specified for the project.

- Adding the cost categories and the employee resources, equipment, subcontractors, overhead, miscellaneous costs, and materials.

Setting up Order Entry includes:

- Adding miscellaneous charges for employee resources, equipment, subcontractors, and miscellaneous costs that you want to include on job-related orders.

- Selecting the **Allow For Jobs** option on job-related miscellaneous charges.

**Miscellaneous Charges**

Miscellaneous charges perform several functions on job-related orders:

- They let you record internal non-material transactions such as equipment, subcontractors, and labor.

- They let you add charges to customer orders for invoicing external charges such as freight (UPS or FedEx).
To create miscellaneous charges for job-related orders, you must select the Allow For Jobs option on the O/E Miscellaneous Charges screen, and then specify:

- An extended cost. For each project in PJC, you can choose to use this cost by default or use the contract cost.
- A miscellaneous charge expense account.
- A miscellaneous charge clearing account.

Miscellaneous charges can be assigned to categories with any cost type except material. You must use item detail lines on orders for material cost types.

**Note:** In Project and Job Costing, you can choose for each project whether to use the amount specified in Order Entry for the miscellaneous charge, or use a default billing rate specified for the contract in PJC.

---

**Taxes**

Although Project and Job Costing allows tax groups to be specified by project, if you are producing the invoice in Order Entry, the tax group specified for the order applies to all contracts and projects listed in the Order Entry document details. If you require different tax groups for different contracts and projects, you must enter these details on separate orders.

Note that this condition does not apply if the document uses project invoicing—the tax group of the project will be used to calculate the tax because the invoice will be generated in Project and Job Costing.

**Note:** If you create an order or shipment for a non-existent customer (a customer for whom no record exists in Accounts Receivable) and you select the **Project Invoicing** option, you will not be able to add order or shipment details unless the default template includes a tax group. (The tax group is not editable if you choose project invoicing, and it will be blank unless it is specified in the template.)

---

**Prepayments**

When you record job-related prepayments, you also distribute the payment amount to the details on the order.

Order Entry lets you automatically prorate payment amounts to individual details or do a "top-down" distribution, starting at the first job-related detail. If you prefer, you can edit the payment distribution amounts yourself.
**Accounts Receivable Integration**

If you are invoicing orders in Order Entry, Day End Processing will send Order Entry invoices to Accounts Receivable, where the costs and revenue are posted together in Accounts Receivable.

When Order Entry creates the invoice, it does not use the Work in Progress account and Billings accounts to post the costs and revenue; instead, it uses the Cost of Sales and Revenue accounts defined in the project or the category.

The Order Entry invoices posted in Accounts Receivable are treated like a billing worksheet in PJC, where the cost transactions are marked as billed and will not appear on the Aged WIP Report.

For more information, see "Journal Entries Generated for Posted Order Entry Transactions " (page 235).

**Purchase Orders Created from Job-Related Sales Orders**

If you are creating purchase orders from orders entered in Order Entry and the details are job-related, Purchase Orders removes the job-related fields when it creates the purchase order. It does this to prevent Receipt Entry from using the Work In Progress account and over stating WIP, which has already been debited with the order.

The entry for the receipt posted by Purchase Orders looks like this:

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Control</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Payables Control</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Double-Counting Item Costs or Miscellaneous Charges**

Processing errors can arise when you bill customers for external charges (services or goods that are provided by a third party and that you receive in Purchase Orders or record in Accounts Payable).

If you are using several accounting programs to process goods or services for a job, you must decide which programs are going to record the costs and assign them to jobs.

For example, if you enter a job-related PO in Purchase Orders; assign items to a specific contract, project, category, and resource (if applicable); and then create a customer order in Order Entry and assign the same items to the same
contract, project, category, and resource, the work in progress account will be overstated (costs recorded twice), and so will Contract Maintenance.

Similarly, if you enter a job-related order in Order Entry that includes a shipping miscellaneous charge, and then process an Accounts Payable invoice for the same charge and treat it as a job-related invoice, you will record charges twice for the job.

If you are invoicing in Project and Job Costing, it might make more sense to omit the miscellaneous charge on the order in Order Entry and record the transaction in Accounts Payable. The shipping charge for the job will then be picked up on the billing worksheet and included on the invoice created in Accounts Receivable.

In any case, you must decide when and how you want to transfer costs to jobs, and then set up the procedures for processing those costs.

**Determining Prices**

How prices are determined depends on the project style, project type, and accounting method.

For the following projects and accounting methods, you set the default source for the price using the Default Billing Rate field on the Project tab in Contract Maintenance:

- Time and Materials projects using the Billings and Costs or Accrual-Basis accounting methods
- Time and Materials projects using the Completed Project accounting method
- Fixed Price projects using the Billings and Costs or Accrual-Basis accounting methods

To set the default source for the price:

- Select Use Customer Price List to use the price list assigned to the customer.
- Select Use Specified Price List to use a price list assigned to the project.
- Select Billing Rate to use the price specified in the contract:
  
  - If the project is a standard project, the billing rate assigned to the item (material) resource (and customer) will be used as the default unit price.
  
  - If the project is a basic project, the billing rate assigned to the material category (and customer) will be used as the default unit price.

If you are entering job-related orders or shipments where both:
Chapter 1: Setting Up Order Entry

- Default Order UOM = Pricing Unit (specified on the O/E Options screen).
- Default Billing Rate = Billing Rate (set for the project in Project and Job Costing).

Order Entry uses the unit of measure from the current price list as the default, and then re-calculates the unit price based on the billing rate specified in PJC Contract Maintenance.

**Note:**
- For Time and Materials projects using the Billings and Costs or Accrual-Basis accounting methods, the project is billed at the category and resource level for standard projects and the category level for basic projects. You can create the invoice in Order Entry or in Project and Job Costing.
- For Time and Materials projects using the Completed Project accounting method, you cannot invoice from Order Entry. Posting the shipment in Order Entry completes the transactions for O/E, and the transaction is sent to Project and Job Costing.
- For Fixed Price projects using the Billings and Costs or Accrual-Basis accounting methods, invoices may be created in Order Entry or billing may be deferred to Project and Job Costing to process using the Create Billing Worksheet.

**For All Other Fixed Price and Cost Plus Projects:**
- Posting the shipment completes the transactions for Order Entry and sends the transaction to Project and Job Costing. Once the project is set to Complete, the PJC Billing Worksheet will process all the transactions and create an invoice for the accumulated costs.
- You can process the billings for the transaction using the Create Billing Worksheet in Project and Job Costing, or you can manually enter invoices in Accounts Receivable.
- The unit price is set to zero and only the costs are processed because:
  - For Fixed Price projects, the price is set to a fixed price amount for the project.
  - For Cost Plus projects, the cost is calculated when you post a shipment.
and perform inventory costing using the costing method assigned to the inventory items in Inventory Control.

**For Fixed Price projects using the Completed Project accounting method**
- Once the project is set to Complete, the PJC Billing Worksheet can process all the transactions and create an invoice for the accumulated costs up to the Fixed Price Amount.

**For Fixed Price projects using the Project Percentage Complete accounting method**
- Billing is determined on a project completion basis using the current estimated costs and the actual costs, not on the purchase of individual items.

**For Cost Plus projects using Billings and Costs or Accrual-Basis accounting method**
- The unit price is set to zero and only the cost portion of the order is processed. The price is determined for billing in PJC using the actual cost of items according to the costing methods assigned in Inventory Control (and calculated by shipping and Day End Processing).

**For Cost Plus projects using Total Cost Percentage Complete and Category Percentage Complete accounting methods**
- The percentage of completion calculation is done during the Create Billing Worksheet process in Project and Job Costing. The amount to be billed is determined on a project or category percentage completion basis using the current estimated costs and the actual costs, not on the purchase of individual items.

**For Cost Plus projects using Labor Hours Percentage Complete accounting methods**
- The customer is billed at the project level. The percentage complete is determined using the current estimated and actual quantity (labor hours) for each category within the project, as well as the cost plus percentage for the category.

**For Cost Plus projects using Completed Project accounting methods**
- Billing occurs when the project status is set to Completed and is calculated using the Create Billing Worksheet in Project and Job Costing.
Chapter 1: Setting Up Order Entry

Cost of Kitting Items in Job-Related Orders

Kitting items are treated differently in Project and Job Costing than they are in Order Entry.

In Order Entry, a kitting item is a collection of separate items, where revenue is recognized at the master level, but costs are recognized for each item in the kit.

In Project and Job Costing, however, a kitting item is treated as a single item for both revenues and costs.

This means that for job-related orders:

- Order entry adds the cost of all kit components to create a single cost for Project and Job Costing, so PJC can recognize one revenue amount and one cost amount.
- If you match transactions from Inventory Control with those from Project and Job Costing, I/C will provide G/L with a string of component cost entries, whereas PJC will provide G/L with a single master cost.

About Aging Periods

On the Documents tab of the O/E Options screen, you can set up default aging periods that determine how outstanding orders are grouped on the O/E Aged Orders report.

Orders are aged into four periods: a current period and three aging periods for billing purposes. You can specify aging periods to correspond with the periods you use to age transactions.

Example: You might set the aging periods to 7, 14, and 21 days to see how many orders are filled within one, two, three, or more weeks of the current period.

When you are ready to print the O/E Aged Orders report, you can change the periods for the report without changing the default settings. Order Entry determines the aging category to which each order belongs by comparing the order date with the Age As Of date you specify on the report.

For more information, see "O/E Options Screen " (page 311) and "O/E Aged Orders Report Screen" (page 275).
About Numbering Order Entry Documents

Each quote, order, shipment, invoice, credit note, and debit note in Order Entry must have a unique number.

- You can specify numbers for quotes, orders, shipments, invoices, credit notes, and debit notes when you enter transactions, or you can use the numbers generated by Order Entry.
- For each transaction type, you define length, prefix, and the next number to use on the Documents tab on the O/E Options screen. For more information, see "O/E Options Screen" (page 311).

Document Number Length

Document numbers can be from 1 to 22 characters long, including an alphanumeric prefix of up to 6 characters.

Example:
You might use any of the following formats to assign numbers to orders, invoices, and credit notes:

- **ORD1457** (3-character prefix, 4-digit number)
- **I-357** (2-character prefix, 3-digit number)
- **CREDIT0009392** (6-character prefix, 7-digit number)

After you specify the next number to use for each transaction type, Order Entry automatically assigns the next available number to each subsequent transaction of each type. You can also assign numbers manually, but if you use automatic numbering, your auditing procedures are simplified because you cannot accidentally skip numbers.

When Order Entry reaches the last available number for a document type (all 9s), it starts again at zero.

Note: On the O/E Options screen, if you want to change the next number to a lower number, you must change the prefix as well. This prevents you from creating two documents with the same document number and prefix.

Entering Document Numbers Manually

If you enter your own document numbers when you add transactions, Order Entry does not update the next number on the O/E Options screen, even if you use the number the program would have assigned.
Chapter 1: Setting Up Order Entry

**Processing and Posting**

Set up Order Entry options for processing and posting transactions, and for running Day End Processing.

**About Backorder Quantities**

Order Entry can automatically calculate a backorder (the difference between the quantity ordered and the quantity shipped) when you enter an item on a transaction entry screen. The resulting figure appears in the Quantity Backordered or Quantity B./O field.

Any amount ordered but not shipped is considered to be a backorder, whether you have stock ready to ship or you have none and are waiting for new stock to arrive.

**Calculating Backorder Quantities**

The **Calculate Backorder Quantities** option (on the Processing tab of the O/E Options screen) determines whether Order Entry calculates and displays the quantity when you add items to an order.

- If you select the option, the calculated quantity appears in the **Quantity Backordered** field on transaction entry screens.

- If you do not select this option, the **Quantity Backordered** field displays zeros, whether or not the quantity ordered is larger than the quantity shipped.

**Note:** Whether or not you calculate backorder quantities, you can edit the number in the **Quantity Backordered** field.

Shipment quantity is based on backorder quantity, so if you do not calculate backorder quantities, you must update backorder quantities manually before you can ship an order.

**Reporting Backordered Quantities**

If you reduce amounts in the Quantity Backordered field without reducing the quantity ordered, or if you cancel an order that has quantities entered in the Quantity Backordered field, the amounts are reported as lost sales on the O/E Sales Statistics report.

If you are unable to ship all items on an order, but do not want to report the unshipped quantities as lost sales, you can edit the item lines to reduce the quantities ordered to match the quantities shipped.
To review backordered quantities, print the O/E Transaction List report.

To review orders that have not been filled, print the O/E Order Action and O/E Aged Orders reports.

**About Order Unit of Measure**

On the O/E Options screen, you can specify whether to use the stocking unit or the pricing unit as the default order unit of measure on Order Entry transaction entry screens. The unit of measure you specify is used by default, but you can select another unit of measure while entering each transaction if necessary.

Stocking units and pricing units are defined for individual items in Inventory Control, and they may be different. For example, you may use "dozen" as the stocking unit for an item, but "each" as the pricing unit.

**Note:** Sage 300 Premium ERP supports multiple pricing units of measure, but you must set one as the default on the I/C Item Pricing screen in Inventory Control.

**Job-Related Orders and Shipments**

If you are entering job-related orders or shipments, and you selected the following options in Order Entry and Project and Job Costing, Order Entry uses the unit of measure from the current price list by default, and then recalculates the unit price based on the billing rate specified in PJC Contract Maintenance.

- On the O/E Options screen, select **Pricing Unit** as the default order unit of measure.
- In Project and Job Costing, select **Billing Rate** as the default billing rate.

**Selecting Transaction Processing Options in Order Entry**

On the O/E Options screen, you can select options that specify how transactions are processed in Order Entry. You can also change any of the selections and information you entered on the O/E Options screen at any time, with a few exceptions and restrictions.

- You cannot change the Multicurrency option. You make the selection for this option on the A/R Options screen, and can change your selection only in Accounts Receivable.
- You can change the type of year (fiscal or calendar) and period by which you accumulate item statistics, but you should do so only at fiscal or calendar
Chapter 1: Setting Up Order Entry

If you change either method partway through a year, the statistics already accumulated will be incorrect or in the wrong period. If you need to change the type of year or period by which Order Entry reports sales history or statistics, you will find it easier to do so after year end. However, if you do change the reporting period during the year, you can edit the statistics for the earlier periods in the year to correct them.

You change costing options in Inventory Control.

- To specify whether inventory is costed when posting Order Entry transactions or during Day End Processing, use the I/C Options screen.
- If you cost items and create subledger transactions during posting, it will take longer to post transactions in Inventory Control, Order Entry, and Purchase Orders.
- If you change from updating costs during Day End Processing to updating costs during posting, you must first run Day End Processing to cost all outstanding posted O/E, I/C, and P/O transactions.

Before you start:

- Make sure no one else is using the Order Entry data and that no other Order Entry screens are open for the company before you save changes. You cannot change settings on the O/E Options screen if other Order Entry screens are open, or other users are working with the Order Entry database.
- Make sure you understand the impact the options have on processing within Order Entry.
- Print the O/E Options report so you have a record of your processing options before you start.
- If you are changing from updating costs during Day End Processing to updating costs during posting, you must run Day End Processing first to cost all outstanding posted transactions.

To change O/E processing options:

1. Open Order Entry > O/E Setup > Options.
2. Click the Processing tab and change options as necessary.
3. Click Save.
After changing O/E processing options

- Print the O/E Options report to check that the settings were changed correctly, and to create a record of options you selected.

Setting Up Posting and Day End Processing Options

You can change Day End Processing options, and batch creation and posting options for transactions created by Order Entry. You set some of these options in Order Entry, and some in Inventory Control.

In Order Entry, you can specify:

- When Order Entry creates G/L batches and whether it should also post them automatically. You select this option on the O/E G/L Integration screen.

- Whether Order Entry posts A/R batches automatically, or whether you will do this manually. You select this option on the O/E Options screen.

In Inventory Control, you can specify:

- Whether costs inventory items when posting transactions or when you run Day End Processing in Inventory Control. You select this option on the I/C Options screen. If you cost inventory items at posting, every shipment, receipt, and transfer will update item costs immediately. This can increase the time it takes to post orders from Order Entry. If you want to speed up order processing, cost inventory when you run Day End Processing. Regardless of when you cost inventory items, Inventory Control updates inventory counts when you post transactions, so you always know your inventory levels.

- When Inventory Control creates subledger and audit information. If speed is a concern, we suggest doing this during Day End Processing. You select this option on the I/C Options screen.

- When Inventory Control creates G/L batches and whether it should also post them automatically. You select this option on the I/C G/L Integration screen.

Note: These options are closely interconnected, and changing one may affect the behavior or availability of others. For example, Day End Processing options affect when Order Entry can post General Ledger and Accounts Receivable batches. For more information, see "About Day End Processing" (page 232) and the Inventory Control help.
**Before you start:**

- If you are changing Day End Processing options, make sure that no Inventory Control or Order Entry screens are open. If any screens are open for these programs, you will not be able to save changes to Day End Processing options.

- Print the O/E G/L Integration report so you have a record of your G/L Integration settings.

- If you are changing from updating costs during Day End Processing to updating costs during posting, you must first run Day End Processing to cost all outstanding posted transactions.

- If you are changing from using the O/E Create Batch screen to creating general ledger transactions during Day End Processing, use the O/E Create Batch screen to process any outstanding transactions first, to avoid accidentally omitting transactions from your general ledger batches.

**To change batch creation and posting options for A/R transactions created by Order Entry:**

1. Open **Order Entry > O/E Setup > Options**.

2. On the Processing tab, select an option on the Post A/R Batches list. If you choose to post A/R batches when you post O/E transactions, and you cost inventory during transaction posting, Order Entry will create and post an A/R batch each time you post an invoice.

3. Click **Save**.

**To change batch creation and posting options for G/L transactions created by Order Entry:**

**Note:** If you currently use the O/E Create Batch screen to create transactions, print a copy of the latest G/L Transactions report, then create any outstanding transactions before changing these options.

1. Open **Order Entry > O/E Setup > Options**.

2. Change options as required.

3. Click **Save**. You cannot save changes if anyone else is using Order Entry data or if other Order Entry screens are open for the company.
To change Day End Processing options in Inventory Control:

1. Open Order Entry > O/E Setup > Options.

2. On the Costing tab, change the appropriate option. For more information, see the Inventory Control help.

3. Click Save. You cannot save changes if anyone else is using Inventory Control data or if other Inventory Control screens are open for the company.

To change batch creation and posting options for G/L transactions created by Inventory Control:

**Note:** Inventory Control generates G/L transactions from order shipments and returns.

1. Open Inventory Control > I/C Setup > G/L Integration.

2. Change the appropriate option. For more information, see the Inventory Control help.

3. Click Save. You cannot save changes if anyone else is using Inventory Control data or if other Inventory Control screens are open for the company.

After changing options

- Print the O/E Options report to check that the settings were changed correctly.
- Print the Order Entry G/L Integration report if you changed integration settings.
- Print the I/C Options report to check that the settings were changed correctly.
- Print the I/C G/L Integration report if you changed integration settings.

Order Entry Options for Posting Accounts Receivable Batches

On the Transactions tab of the O/E Options screen, you can specify when to post Accounts Receivable batches generated from Order Entry transactions: during posting, during Day End Processing, or on request.

**Important!** The option you select here can have a significant impact on system performance during transaction processing, and on the number of A/R batches that Order Entry produces.
Chapter 1: Setting Up Order Entry

### Accounts Receivable Batch Posting Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>During Posting</strong></td>
<td><strong>Warning!</strong> This selection can have a significant impact on the speed of processing inventory transactions and transactions in Order Entry. If you want to speed up order processing, switch to creating transactions when you run Day End Processing. Depending on when you create subledger transactions in Inventory Control, you can select this option to post Accounts Receivable invoice batches created by Order Entry when you post invoices. If you create subledger transactions during posting and you choose to post A/R batches during posting, Order Entry will create and post an A/R batch for each invoice it creates. You specify when to create subledger transactions using the <strong>Create Subledger Transactions And Audit Info. During</strong> option on the Costing tab of the I/C Options screen.</td>
</tr>
<tr>
<td><strong>During Day End Processing</strong></td>
<td>Depending on when you create subledger transactions in Inventory Control, you can select this option to post Accounts Receivable invoice batches created by Order Entry when you run Day End Processing in Inventory Control. You specify when to create subledger transactions using the <strong>Create Subledger Transactions And Audit Info. During</strong> option on the Costing tab of the I/C Options screen. <strong>Tip:</strong> If you are processing a large volume of orders, you should create subledger batches during Day End Processing or use the Create Batch icon to post A/R batches.</td>
</tr>
<tr>
<td><strong>On Request Using Create Batch Icon</strong></td>
<td>Select this option if you want to post Accounts Receivable invoice batches created by Order Entry manually using the O/E Create Batch screen. <strong>Note:</strong> You can also post the Accounts Receivable batches created by Order Entry using the A/R Post Batch screen in Accounts Receivable.</td>
</tr>
</tbody>
</table>

### General Ledger Integration

Select options that specify how Order Entry integrates with General Ledger.

### General Ledger Accounts Used by Order Entry

General Ledger accounts are updated by transactions you post in Order Entry.

The accounts are grouped in this article according to the Sage 300 ERP modules in which they are assigned.
# Inventory Control Account Sets

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Control</td>
<td>An asset account containing the total value of the inventory on hand (at actual cost). The account increases when you receive goods, and decreases when you ship goods. The word &quot;control&quot; in the account name means that the account contains only totals, whereas the information stored by Inventory Control contains details on an item-by-item basis. When you process all accounting entries correctly, the total cost of the inventory in Inventory Control equals the totals in the Inventory Control accounts in the general ledger.</td>
</tr>
<tr>
<td>Payables Clearing</td>
<td>A suspense account to which Inventory Control posts the &quot;other side&quot; of the accounting entries for inventory you receive (and for previous receipts you return to suppliers). Inventory Control normally generates credit entries to this account for inventory you receive; therefore, the account can be thought of as the accrued amount payable for goods received into inventory. Inventory Control debits this account when you enter receipt returns. As you post the related vendor invoices in Accounts Payable, offsetting journal entries (debits) related to the inventory purchased are generated against the Payables Clearing account to clear the balance that is left in this account from posting the inventory receipt.</td>
</tr>
<tr>
<td>Adjustment Write-Off</td>
<td>The account to which you post inventory adjustments and write-offs. Entries to this account are normally expenses (debits); therefore, the account number you specify should be in the expenses or cost of goods sold section of your general ledger.</td>
</tr>
<tr>
<td>Assembly Cost Credit</td>
<td>The account to which you post the variable and fixed costs of assembling items. credits this account with the variable and fixed cost of assembly. You may want to create manual entries in the general ledger to redistribute the assembly cost credit to accounts such as labor costs.</td>
</tr>
<tr>
<td>Non-stock Clearing</td>
<td>The account you credit when you ship non-stock items, and debit when you enter shipment returns for non-stock items. You can use non-stock items to handle specially ordered items that you do not stock in your inventory, and to handle service charges that appear on invoices.</td>
</tr>
<tr>
<td>Transfer Clearing</td>
<td>This account is used for the additional cost amount on the Transfer screen.</td>
</tr>
</tbody>
</table>
Chapter 1: Setting Up Order Entry

### Account Description

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Clearing</td>
<td>Debited instead of Cost of Goods Sold when shipping goods from Order Entry. The Shipment Clearing account is required because the shipment and invoicing functions in Order Entry are separated. Cost of Goods Sold is debited when you invoice the shipment.</td>
</tr>
<tr>
<td>Disassembly Expense</td>
<td>Used if you specify an expense amount when you disassemble items that were previously assembled in Inventory Control.</td>
</tr>
<tr>
<td>Physical Inventory Adjust</td>
<td>The expense account that balances the change in inventory value when you adjust inventory quantities after making a physical inventory count.</td>
</tr>
<tr>
<td>Credit/Debit Note Clearing</td>
<td>Debited instead of the I/C Control account or the Damaged Goods account in Order Entry returns sent to Accounts Receivable. The general ledger transaction credits the clearing account instead of Cost of Goods Sold and the Accounts Receivable Control account. The Credit/Debit Note Clearing account is required because the inventory return and credit note functions in Order Entry are separated, with one side of the transaction going through Accounts Receivable.</td>
</tr>
</tbody>
</table>

### Inventory Control Item Categories

For each category that you add in Inventory Control, you specify general ledger account numbers for the following five accounts.

**Note:** Order Entry uses the Sales, Returns, and Damaged Goods accounts, which are not used by Inventory Control.

<table>
<thead>
<tr>
<th>Item Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>A revenue account that Order Entry credits with the revenue from goods sold.</td>
</tr>
<tr>
<td>Returns</td>
<td>A contra revenue account that Order Entry debits to record the reduction of revenue caused when previously sold goods are returned or credit notes are issued.</td>
</tr>
<tr>
<td>Cost of Goods Sold</td>
<td>An expense account that Inventory Control debits with the cost of goods sold, and credits with the cost of goods returned.</td>
</tr>
</tbody>
</table>
### General Ledger Integration

<table>
<thead>
<tr>
<th>Item Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Variance</td>
<td>An expense account in which Inventory Control records the cost variance between the actual cost and either the standard cost (for items using the standard costing method) or the most recent cost (for items using the most recent costing method) of inventory items sold.</td>
</tr>
<tr>
<td>Damaged Goods</td>
<td>A contra revenue account that is debited instead of Sales Returns whenever goods are returned as damaged in Order Entry.</td>
</tr>
<tr>
<td>Internal Usage</td>
<td>The default expense or asset account that is debited when an item in this category is used internally. You can override this account when you enter transactions.</td>
</tr>
</tbody>
</table>

### Miscellaneous Charges

You specify the following accounts when you add miscellaneous charges to Order Entry.

**Miscellaneous Charges**

<table>
<thead>
<tr>
<th>Charges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Miscellaneous Charge Revenue</td>
<td>The general ledger revenue account to which amounts entered as miscellaneous charges are posted.</td>
</tr>
<tr>
<td>Miscellaneous Charge Expense</td>
<td>For job-related orders, Order Entry credits the expense account and debits the miscellaneous charge clearing account when you ship goods, and then run Day End Processing. (When you post the invoice, it credits the clearing account and debits cost of goods sold.)</td>
</tr>
<tr>
<td>Miscellaneous Charge Clearing</td>
<td>For job-related orders, the miscellaneous charge clearing account is similar to the shipment clearing account.</td>
</tr>
<tr>
<td></td>
<td>Order Entry debits the clearing account and credits the miscellaneous charge expense account when you ship goods, and then run Day End Processing. It then credits the clearing account and debits cost of goods sold when you post the invoice.</td>
</tr>
</tbody>
</table>

### Project and Job Costing Accounts

If you use Project and Job Costing to process job-related orders, the following accounts may appear on item detail lines, depending on whether or not you are using project invoicing.

Order Entry also sends information to Accounts Receivable and Project and Job Costing for the Overhead Allocated and Labor Burden accounts. You specify
those accounts on the Account tab for the category on the I/C Contract Maintenance screen, but you cannot edit those accounts in Order Entry.

**Project And Job Costing Accounts**

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue/Billing (Orders)</td>
<td>If a sales order is job related, and you did not select Project Invoicing, you also specify the Revenue/Billings account for each order detail.</td>
</tr>
<tr>
<td></td>
<td>The default account number comes from Project and Job Costing and is used instead of the Sales Account specified for the item in the item category record.</td>
</tr>
<tr>
<td>WIP (Orders)</td>
<td>If the sales order is job related, and you selected Project Invoicing, you also specify the Work In Progress account for each order detail.</td>
</tr>
<tr>
<td></td>
<td>The account number specified in Project and Job Costing will appear by default, but you can change it. (The level at which the WIP account is specified in Project and Job Costing depends on the project type and accounting method.)</td>
</tr>
<tr>
<td>COGS (Cost of Goods Sold)</td>
<td>If the order is job related, and you did not select <strong>Project Invoicing</strong>, the program displays the default cost of goods sold account from Project and Job Costing for each order detail. You can change the account number.</td>
</tr>
</tbody>
</table>

**General Ledger Integration Options**

On the O/E G/L Integration screen, you can select options that specify how Order Entry integrates with General Ledger.

If you use Sage 300 ERP General Ledger, Order Entry creates batches of transactions right in General Ledger, where you can edit and post them.

If you use another general ledger system, or if your Sage 300 ERP General Ledger system is at another location, Order Entry creates batches you can import into your general ledger (or print, and then enter manually into your general ledger).

**If you do not use Sage 300 ERP General Ledger**

If you do not use Sage 300 ERP General Ledger, or if your Sage 300 ERP General Ledger system is at another location, Order Entry appends its general ledger transactions to a file called oegltran.csv, which can be imported by a Sage 300 ERP General Ledger at another site, or transferred to another general ledger that you use. The file is in Comma Separated Values (CSV) format, and is created in the same directory as your company database.
If you do not use Sage 300 ERP General Ledger in the same database as Order Entry, all general ledger transactions are placed in the same CSV file. Each time Order Entry creates transactions, a message asks whether you want to add transactions to the existing file or replace it.

**Creating G/L Transactions**

On the Integration tab of the O/E G/L Integration screen, you can specify when to create General Ledger transaction batches.

This tab also displays the last day end number for which you created general ledger transactions, as well as the day end number that will be assigned when you next run Day End Processing.

**Note:** If you currently use the O/E Create Batch screen to create General Ledger transactions and you want to change this setting to create batches during Day End Processing, be sure to use the O/E Create Batch screen to process any outstanding transactions first, to avoid accidentally omitting transactions from your General Ledger batches.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>During Posting</td>
<td>Depending on when you create subledger transactions in Inventory Control, you can select this option to create General Ledger transactions during posting.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning!</strong> This selection can have a significant impact on the speed of processing inventory transactions and transactions in Order Entry. If you want to speed up order processing, switch to creating transactions when you run Day End Processing. You specify when to create subledger transactions using the Create Subledger Transactions And Audit Info. During option on the Costing tab of the I/C Options screen.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select this option, you cannot print the O/E G/L Transactions Report, and you cannot consolidate Order Entry transactions that are posted to General Ledger.</td>
</tr>
<tr>
<td>During Day End Processing</td>
<td>Depending on when you create subledger transactions in Inventory Control, you can select this option to create General Ledger transactions when you run Day End Processing in Inventory Control.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select this option, you cannot print the O/E G/L Transactions, and you cannot consolidate Order Entry transactions that are posted to General Ledger. You specify when to create subledger transactions using the Create Subledger Transactions And Audit Info. During option on the Costing tab of the I/C Options screen.</td>
</tr>
</tbody>
</table>

*User's Guide 29*
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Costing tab of the I/C Options screen.</td>
<td></td>
</tr>
</tbody>
</table>
| **On Request Using Create Batch Icon** | Select this option if you want to create General Ledger transactions manually using the O/E Create Batch screen.  
If you prefer to create General Ledger transactions automatically each time you post Order Entry transactions or each time you run Day End processing in Inventory Control, select During Posting or During Day End Processing for the Create G/L Transactions option.  
**Important!** You must select this option if you want to print the O/E G/L Transactions Report, or if you want to consolidate transactions in Order Entry.  
**Note:**  
- If you cost inventory transactions in Inventory Control when you run Day End Processing, you must run Day End Processing before you can create General Ledger transactions using the I/C Create G/L Batch screen.  
- If you cost inventory during posting, you do not have to run Day End Processing before creating the General Ledger batch. |

**Consolidating G/L Batches**

On the Integration tab of the O/E G/L Integration screen, you can specify whether Order Entry consolidates transaction details for the same General Ledger account into a single detail, or whether it posts unconsolidated transaction details to General Ledger.

Consolidation reduces the amount of information in the general ledger batch and results in a shorter list when you print the G/L Transactions Listing report, but also reduces information and prevents drilldown from General Ledger.

If you create batches of G/L transactions during posting or Day End Processing, the program can only consolidate the details within transactions; it cannot consolidate the details from different transactions.

Consolidation has the following effects on General Ledger records and drilldown:

- Removes transaction-specific information from the **Reference** and **Description** fields for each transaction.
- Removes optional field information from transactions.
- Prevents drilldown from General Ledger transactions to the originating entries in Order Entry (unless consolidating by account only).
**Note:** The posting date for consolidated entries is the last date of the fiscal period.

### General Ledger Transaction Consolidation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do Not Consolidate</strong></td>
<td>Select this option to include all details posted in Order Entry in the General Ledger transaction batch.</td>
</tr>
<tr>
<td><strong>Tip:</strong></td>
<td>Select this option if you use optional fields and want to pass optional field information from Order Entry transaction details to General Ledger.</td>
</tr>
<tr>
<td><strong>Consolidate Transaction Details by Account</strong></td>
<td>Select this option to combine all the details in an Order Entry transaction with the same General Ledger account into one detail.</td>
</tr>
<tr>
<td></td>
<td>To be consolidated, details must have the same information in the G/L Detail Description and G/L Detail Reference fields. Details that contain different information in the G/L Detail Description and G/L Detail Reference fields are not consolidated.</td>
</tr>
<tr>
<td><strong>Tip:</strong></td>
<td>Select this option if you do not use optional fields, but still want to associate General Ledger transactions with originating documents (for drilldown or to maintain a manual audit trail).</td>
</tr>
<tr>
<td><strong>Consolidate by Account and Fiscal Period</strong></td>
<td>Select this option to combine all details with the same general General Ledger account number and fiscal period into a single detail.</td>
</tr>
<tr>
<td></td>
<td>If you also select the On Request Using Create Batch Icon option on the O/E G/L Integration screen to create general ledger transactions, you can consolidate transaction details from all transactions for each General Ledger account.</td>
</tr>
<tr>
<td><strong>Consolidate by Account, Fiscal Period, and Source</strong></td>
<td>All the details with the same general ledger account number, fiscal period, and source code are combined into one detail.</td>
</tr>
<tr>
<td></td>
<td>If you also select the On Request Using Create Batch Icon option on the O/E G/L Integration screen to create general ledger transactions, you can consolidate transaction details from all transactions for each General Ledger account.</td>
</tr>
</tbody>
</table>

### Transaction Description, Reference, and Comments

On the Transactions tab of the O/E G/L Integration screen, you can review the information that will appear in the transaction description, detail reference, detail description, and detail comment fields for each unconsolidated General Ledger transaction and transaction detail created from Order Entry transactions.
You can add one or more pieces of information such as order number, customer number, or source code to a field, with multiple pieces of information separated by a separator (such as a hyphen) that you select.

This information appears in the Description, Reference, and Comment columns on the O/E G/L Transactions report, on the G/L Journal Entry screen, and on other reports in General Ledger.

To select and arrange the Order Entry information that will appear in these fields, and to specify a separator (such as a hyphen) that appears between this information, select a detail line and click the Open button to open the O/E G/L Integration Details screen.

For more information, see "O/E G/L Integration Detail Screen " (page 324).

**Note:**
- The combined length of segments and separators must not exceed 60 characters. Fields exceeding this limit will be truncated when you post General Ledger transactions.
- When you consolidate General Ledger transactions, the description for each transaction is changed to "Consol. by O/E on date."

  If you do not consolidate by source code, the source code after consolidation is OE-CO.

  If there is only one of a particular transaction type, the description for the transaction is whatever you specify on the O/E G/L Integration screen.
- If you do not consolidate General Ledger transactions, information for all General Ledger fields is passed to General Ledger.
- If you selected the On Request Using Create Batch Icon option to create General Ledger transactions, the description for each General Ledger transaction is changed to "Consol. by O/E on date" (unless there is only one of a particular transaction type).
- When you create General Ledger transactions, if no data exists in the source transaction field, the field will be blank in the General Ledger transaction.

**Inventory Control Integration**

You set up options related to costing and the allocation and generation of serial numbers and lot numbers in Inventory Control.
Allowing Serial and Lot Number Allocation for Quantity Ordered

You use the Inventory Control option **Use the Qty Ordered Field in OE** to allow allocation of serial numbers or lot numbers to order quantities.

If you select this option, users can allocate serial or lot numbers for quantities ordered on the O/E Order Entry and O/E Shipment Entry screens. (If you want users to allocate serial or lot numbers for quantities shipped, do not select this option.)

For more information about using this screen to allocate and generate serial and lot numbers, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

**Before you start:**

- If security is turned on for your system, you must have Inventory Control Setup Maintenance authorization to change the option for allocating numbers.

- Before making changes on the I/C Options screen, make sure that no other Inventory Control screens are open for your database on your computer or on any other computer on a network. If other I/C screens are open, or if other users are working with I/C data, you cannot change this option.

**To allow allocation of serial and lot numbers from the Quantity Ordered field:**

1. Open **Inventory Control > I/C Setup > Options**.

2. On the Serials tab, select the **Use The Qty Ordered Field In OE For The Allocation Of Serial Numbers** option.

3. On the Lots tab, select the **Use The Qty Ordered Field In OE For The Allocation Of Lot Numbers** option.

4. Click **Save**.

**Inventory Costing Methods**

The unit cost for each inventory item appears in Order Entry screens if you have security authorization to view it.

The O/E Order Entry screen shows the estimated cost of each item in the order. When items are costed during posting or Day End Processing (depending on the costing option specified in Inventory Control), the actual cost is updated on the O/E Shipment Entry and O/E Invoice Entry screens.
Chapter 1: Setting Up Order Entry

**Note:** The O/E Order Entry screen retains the estimated cost and is not updated.

For serial costing and lot costing, if the serial numbers and lot numbers allocated in a transaction have different costs, the average cost of the serials or lots is shown in the Unit Cost field. (For more detailed information, see the Inventory Control help on Serial/Lot Costing Methods.)

For kitting items, the unit cost is displayed as the sum of all of the components’ costs.

The following table lists the various inventory costing methods and the methods used to cost items on orders, shipments and invoices.

<table>
<thead>
<tr>
<th>Item Costing Method</th>
<th>Before Costing</th>
<th>After Costing</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIFO</td>
<td>Moving Average</td>
<td>FIFO</td>
</tr>
<tr>
<td>LIFO</td>
<td>Moving Average</td>
<td>LIFO</td>
</tr>
<tr>
<td>Moving Average</td>
<td>Moving Average</td>
<td>Cost Moving Average</td>
</tr>
<tr>
<td>Most Recent</td>
<td>Cost Most Recent</td>
<td>Detail</td>
</tr>
<tr>
<td>Standard</td>
<td>Standard Cost</td>
<td>Moving Average</td>
</tr>
<tr>
<td>User Specified</td>
<td>User Specified</td>
<td>User Specified</td>
</tr>
<tr>
<td>Serial Costing</td>
<td>Moving Average</td>
<td>Serial Cost</td>
</tr>
<tr>
<td>Lot Costing</td>
<td>Moving Average</td>
<td>Lot Cost</td>
</tr>
</tbody>
</table>

**Templates**

Speed up and simplify order entry by setting up templates that specify default settings for new transactions.

**About Templates**

Templates are sets of default options and settings that you can select when entering new orders and credit notes. You use templates to speed up and simplify data entry.

You specify the following information for each template that you define:
• Order information:
  • Order Type
  • FOB Point
  • On Hold
  • Location
  • Description
  • Reference
  • Comment

• Customer information:
  • Ship-Via Code
  • Customer Type
  • Price List
  • Territory
  • Tax Group
  • Terms

You must specify the order type, customer type, and tax group for each template, but other settings are optional.

**Note:** When you enter an order or a credit note, information from other records can overwrite information from a template. For example, when you specify the customer or a ship-to location, the customer type, location, price list, territory, and tax group from the customer or ship-to location record will replace those from the template.

**Default Templates**

If you want a standard set of customer and order settings to appear for new orders and credit notes, you can designate a template as the default for all orders and credit notes you create.

You specify a default template on the Processing tab of the O/E Options screen.

When you enter a new order or a credit note, you can accept the default template code that appears, or you can select the code for a different template. The default template provides initial settings, but these can be overridden by
settings from the customer record—and from another template, if you choose one.

The following sequence of steps illustrates template use:

1. On the O/E Order Entry screen, beside the **Order Number** field, click the New button or accept the default entry ***New*** to create a new order. The settings from the default template appear.

2. Select the customer number. The information from the customer record replaces the information from the default template.

3. In the **Template Code** field, select a different template to override the customer information. All the information from the new template replaces the current order information

You could specify the customer number, again, to replace the information from the template code with the information from the customer record.

**Credit Note Settings Come From Invoices**

Because most credit notes or returns refer to invoices, they use the invoice information by default.

You can override the invoice information by choosing a different template, or by choosing the default template again. However, if your credit note does not reference an existing invoice, the template works the same as it does for orders.

**Creating Templates**

Order Entry templates are optional. They supply default customer and order information for new orders and new credit notes.

**Note:** You must use the **Order Type** field (on the Order tab) and the **Customer Type** list (on the Customer tab) to specify the order type and customer type for each template. All other information is optional.

**Before you start:**

Create ship-via codes for the delivery methods and carriers you use.

**To create a template:**

1. Open **Order Entry > O/E Setup > Templates**.

2. In the **Template Code** field, enter a code for the new record.
• If the field is clear, enter the new code.

• If you are viewing an existing record, click the New button, and then enter the new code.

**Tip:** If you are viewing an existing record, you can "copy" it to a new record by typing a new code over the displayed code, making any required changes to the other fields on the screen, and then adding the record.

3. Enter an optional description for the new template.

4. On the Order tab, select the order type, and then specify other order settings to use for the template.

5. On the Customer tab, select the customer type, and then specify other customer settings to use for the template.

6. Click **Add** to add the template.

**After creating a template**

Open the O/E Options screen and select one of the templates you have added as the default template code. The information specified in this template will appear when you add a new order, and can be changed as needed for each order.

**Managing Templates**

You can change all the information in a template at any time, except the identifying code.

**Note:** You must use the **Order Type** field (on the Order tab) and the **Customer Type** list (on the Customer tab) to specify the order type and customer type for each template. All other information is optional.

**Before you start:**

- Before deleting a template, check that it is not the default template for entering orders. If it is, use the O/E Options screen to change the default template code (or leave it blank).

**To edit a template:**

1. Open **Order Entry > O/E Setup > Templates**.

2. In the **Template Code** field, enter or select the code for the template you want to change.

3. Change template settings, and then click **Save** to save your changes.
Chapter 1: Setting Up Order Entry

**Note:** Changing a template has no effect on current orders. You will see the changes the next time you select the template for a new order.

**To delete a template:**

1. In the **Template Code** field, enter or select the code for the template you want to delete.
2. Click **Delete**.

**Transaction History and Statistics**

Set up options for entering and maintaining transaction history and statistics.

**About Transaction History**

The **Keep Transaction History** option on the O/E Options screen allows you to save information from posted orders, invoices, and credit notes, so that you can print the information on reports after running Day End Processing.

- If you keep transaction history, you can also drill down from transactions in Accounts Receivable, Inventory Control, and General Ledger to view originating transactions in Order Entry.
- If you do not keep transaction history, you cannot drill down to Order Entry transactions from other Sage 300 ERP programs, and you cannot print the information from posted orders, invoices, and credit notes after running Day End Processing.

To print transaction information in summary or detailed form, use the O/E Transaction List screen.

**About Sales History**

In Order Entry, you can keep sales history for analysis and reporting purposes.

**Keeping Sales History**

To keep sales history, select the **Keep Sales History** option on the Processing tab on the O/E Options screen.

You specify whether to save sales data by fiscal year or calendar year, and select the period type. You can report sales data on the O/E Sales History report, sorted by customer number, item number, or primary salesperson.
**Turning the Options On and Off**

You can turn the options to keep history on or off at any time. If you turn them off after you have used them, Order Entry immediately stops saving information, although it retains those records already collected until you clear (delete) them using the O/E Clear History screen.

If you turn the options on again, there will be a gap in the collected information corresponding to the period when the options were turned off.

**Clearing Historical Data**

Historical data can use a significant amount of storage space on your computer, so you should clear the data when you are finished using it. For example, you might decide to clear data that is more than six months old, or you might keep data for more than a year.

**About Sales Statistics**

In Order Entry, you can keep sales statistics for posted orders, invoices, and credit notes. Sales statistics are created each time you run Day End Processing. You can review these statistics at any time by printing the O/E Sales Statistics report.

**Keeping Sales Statistics**

To keep sales statistics, select the **Keep Sales Statistics** option on the Processing tab on the O/E Options screen.

Order Entry keeps the following statistics:

- Order totals
  - Number of orders
  - Total sales lost
  - Average sales lost
- Invoices
  - Number of invoices
  - Net quantity sold
  - Net sales amount
  - Cost of sales
Chapter 1: Setting Up Order Entry

- Margin percent
- Net invoice amount
- Average amount
- Largest and smallest invoices (with associated customers)

- Credit notes
  - Number of credit notes
  - Average amount
  - Largest and smallest credit notes (with associated customers)

If you keep statistics, you must also decide:

- Whether to allow editing of statistics. To allow editing, select the **Allow Edit of Statistics** option on the O/E Options screen.

  **Tip:** You might want to allow editing of sales statistics if you set up your Order Entry system partway through a fiscal year.

  For more information, see "Allowing Editing of Sales Statistics " (page 40).

- How you will accumulate statistics. You use the following options on the O/E Options screen to do this: Accumulate By. Specify whether you accumulate statistics by fiscal year or calendar year. Period Type. Specify the period type you will use.

  **Turning off Statistics Accumulation**

  If you want to stop accumulating sales statistics, clear the **Keep Sales Statistics** option.

  - If you clear the option, Order Entry will stop saving statistics the next time you run Day End Processing. Any previously saved statistics are saved until you use the O/E Clear History screen to clear them.

  - If you select the option again, there will be a gap in the collected information corresponding to the period when the option was not used.

  **Allowing Editing of Sales Statistics**

  If you select the **Allow Edit Of Statistics** option on the O/E Options screen, Order Entry users can add and edit transaction data for inventory items, and for sales and return quantities and amounts, for the years and periods for which you keep data Order Entry.
Before you start:

- Print the O/E Sales Statistics report to create a record of your current sales statistics. After editing sales statistics, you can print this report again and compare the changes to verify that the information you entered is correct.

- On the I/C Options screen, select the Keep Item Statistics and Allow Edit Of Statistics options.

- Collect transaction data for the current year and for any previous years that you want to add to Order Entry.

To allow editing of sales statistics in Order Entry:

1. Open Order Entry > O/E Setup > Options.
2. Click the Processing tab.
4. Click Save.

After changing O/E processing options

- Print the O/E Sales Statistics report to check the new record information and update your printed records.

- Compare the report you printed before changing or deleting statistics to the report printed after the changes to verify that you made the required changes correctly.

Credit Checks

Manually check customers’ credit before posting a transaction, or set up Order Entry to check customer credit automatically when you post transactions.

About Credit Checks

You can check a customer's credit manually before posting a transaction. You can also set up Order Entry so it automatically checks a customer’s credit when you post a transaction.

Credit Check Options

On the Processing tab of the O/E Options screen, you can specify whether to include pending transactions in Order Entry, Accounts Receivable, and other
programs in credit checks. For more information, see "O/E Options Screen" (page 311).

Checking Credit before Posting Transactions

On some transaction entry screens, you can click the Pre Credit Check button to check the customer's credit status to open the O/E Pre-Transaction Credit Check screen.

You use this screen to check the customer and national account credit limit, outstanding balance, account activity, and aged transactions, and to approve changes to the customer's credit. For more information, see "O/E Pre-Transaction Credit Check Screen" (page 496).

Checking Credit when Posting Transactions

You can set up Order Entry to check a customer's credit limits each time you post a transaction, to see if the new transaction will put the customer over their credit limit.

You select credit checking options in Accounts Receivable for each customer and customer group. For more information, see the Accounts Receivable help.

If you have set up credit checking for a customer and you try to post a transaction that will put the customer over their credit limit, the O/E Pre-Transaction Credit Check screen appears. You can use this screen to override the credit limit (if you have authorization) or to put the order on hold. For more information, see "O/E Pre-Transaction Credit Check Screen" (page 496).

Note:
If the customer is part of a national account, Order Entry also checks national account balances for credit checks, but it does not check pending balances for the national account.

If you set the option in the A/R national account record to check for an aged balance that exceeds a particular amount, Order Entry will also check for an aged overdue balance.

Setting Up Customer Credit Check Options

You can select credit checking options in both Accounts Receivable and Order Entry. For more information, see "About Credit Checks" (page 41).

In Order Entry, you can select options to specify how and when credit checks are performed.

You can set up credit checks to include:
- A specific amount overdue by more than a particular number of days (also specified in the customer record in Accounts Receivable).
- Pending (unposted) transactions in Accounts Receivable.
- Pending transactions in Order Entry.
- Pending transactions in other programs that work with Sage 300 ERP programs.

**Before you start:**
- Before making changes on the O/E Options screen, make sure that no other Order Entry screens are open for your database on your computer or on any other computer on a network. If other Order Entry screens are open, or if other users are working with Order Entry data, you cannot save changes for most of the options on this screen.

**To change customer credit check options in Order Entry:**
1. Open **Order Entry > O/E Setup > Options**.
2. On the Processing tab, select options in the **Credit Checks** group.
3. Click **Save**.

**After changing options**
- Print the O/E Options report to check that the settings were changed correctly. For more information, see "O/E Options Report Screen" (page 306).

---

**E-mail Messages**

Create e-mail messages to send with order confirmations, quotes, invoices, credit notes, and debit notes.

**Creating E-mail Messages**

You can create e-mail messages to send with order confirmations, quotes, invoices, and credit notes.

Each message is identified with a unique message ID of up to 16 characters. You use this message ID to select the message when you select Customer as the delivery method on an Order Entry customer form (an order confirmation, quote, invoice, credit note, or debit note).
Tip: You can add variables to the subject line and body of your e-mail message, which are then replaced with specific information when you send the e-mail message. For more information, see "E-mail Message Variables" (page 44).

To create an e-mail message:
1. Open Order Entry > O/E Setup > E-mail Messages.
2. On the Message Type list, select the type of document for which you are creating a message.
3. In the Message ID field, enter a unique code to identify the new message, using up to 16 characters.
4. In the E-Mail Subject field, enter a subject line for the message. In this field and the message body, you can use variables that will be replaced with information from your database when you send the message. For a list of variables you can use, see E-mail Message Variables.
5. Enter content for the message.
6. Click Add or Save to save the message.

E-mail Message Variables

A variable is a string of characters in an e-mail message that is replaced with a specific term or value when the message is sent.

Example: In an e-mail message to a company where the customer contact is specified as Ron Black, the line "Dear $CUSTOMER_CONTACT" will be replaced with "Dear Ron Black" when the message is sent.

You can use the following common variables in all e-mail messages. Variables that are available only for specific customer forms are listed in separate tables.

Common E-mail Message Variables

<table>
<thead>
<tr>
<th>Value to Insert</th>
<th>E-mail Message Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company contact</td>
<td>$COMPANY_CONTACT</td>
</tr>
<tr>
<td>Company name</td>
<td>$COMPANY_NAME</td>
</tr>
<tr>
<td>Customer contact</td>
<td>$CUSTOMER_CONTACT</td>
</tr>
</tbody>
</table>
### Value to Insert | E-mail Message Variable
---|---
Customer name | $CUSTOMER_NAME
Customer number | $CUSTOMER_NUMBER
Fax number | $COMPANY_FAX
Purchase order number | $PO_NUMBER
Telephone number | $COMPANY_PHONE

#### Order Confirmations

**Order Confirmation E-mail Message Variables**

<table>
<thead>
<tr>
<th>Value to Insert</th>
<th>E-mail Message Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expected ship date</td>
<td>$EXPECTED_SHIP_DATE</td>
</tr>
<tr>
<td>Order amount</td>
<td>$ORDER_AMOUNT</td>
</tr>
<tr>
<td>Order date</td>
<td>$ORDER_DATE</td>
</tr>
<tr>
<td>Order description</td>
<td>$ORDER_DESCRIPTION</td>
</tr>
<tr>
<td>Order number</td>
<td>$ORDER_NUMBER</td>
</tr>
<tr>
<td>Order reference information</td>
<td>$ORDER_REFERENCE</td>
</tr>
<tr>
<td>Ship-via description</td>
<td>$SHIP_VIA_DESCRIPTION</td>
</tr>
<tr>
<td>Ship-via information</td>
<td>$SHIP_VIA</td>
</tr>
</tbody>
</table>

#### Invoices

**Invoice E-mail Message Variables**

<table>
<thead>
<tr>
<th>Value to Insert</th>
<th>E-mail Message Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual ship date</td>
<td>$ACTUAL_SHIP_DATE</td>
</tr>
<tr>
<td>Description</td>
<td>$DESCRIPTION</td>
</tr>
<tr>
<td>Invoice amount</td>
<td>$INVOICE_AMOUNT</td>
</tr>
<tr>
<td>Invoice date</td>
<td>$INVOICE_DATE</td>
</tr>
<tr>
<td>Invoice number</td>
<td>$INVOICE_NUMBER</td>
</tr>
<tr>
<td>Order number</td>
<td>$ORDER_NUMBER</td>
</tr>
</tbody>
</table>
## Chapter 1: Setting Up Order Entry

<table>
<thead>
<tr>
<th>Value to Insert</th>
<th>E-mail Message Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order date</td>
<td>$ORDER_DATE</td>
</tr>
<tr>
<td>Reference information</td>
<td>$REFERENCE</td>
</tr>
<tr>
<td>Ship-via description</td>
<td>$SHIP_VIA_DESCRIPTION</td>
</tr>
<tr>
<td>Ship-via information</td>
<td>$SHIP_VIA</td>
</tr>
</tbody>
</table>

### Credit Notes

**Credit Note E-mail Message Variables**

<table>
<thead>
<tr>
<th>Value to Insert</th>
<th>E-mail Message Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual return date</td>
<td>$ACTUAL_RETURN_DATE</td>
</tr>
<tr>
<td>Credit note amount</td>
<td>$CREDIT_NOTE_AMOUNT</td>
</tr>
<tr>
<td>Credit note date</td>
<td>$CREDIT_NOTE_DATE</td>
</tr>
<tr>
<td>Credit note number</td>
<td>$CREDIT_NOTE_NUMBER</td>
</tr>
<tr>
<td>Description</td>
<td>$DESCRIPTION</td>
</tr>
<tr>
<td>Invoice date</td>
<td>$INVOICE_DATE</td>
</tr>
<tr>
<td>Invoice number</td>
<td>$INVOICE_NUMBER</td>
</tr>
<tr>
<td>Reference information</td>
<td>$REFERENCE</td>
</tr>
</tbody>
</table>

### Quotes

**Quote E-mail Message Variables**

<table>
<thead>
<tr>
<th>Value to Insert</th>
<th>E-mail Message Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expected ship date</td>
<td>$EXPECTED_SHIP_DATE</td>
</tr>
<tr>
<td>Expiration date</td>
<td>$EXPIRATION_DATE</td>
</tr>
<tr>
<td>Order amount</td>
<td>$ORDER_AMOUNT</td>
</tr>
<tr>
<td>Order date</td>
<td>$ORDER_DATE</td>
</tr>
<tr>
<td>Order description</td>
<td>$ORDER_DESCRIPTION</td>
</tr>
<tr>
<td>Order number</td>
<td>$ORDER_NUMBER</td>
</tr>
<tr>
<td>Order reference information</td>
<td>$ORDER_REFERENCE</td>
</tr>
<tr>
<td>Ship-via description</td>
<td>$SHIP_VIA_DESCRIPTION</td>
</tr>
<tr>
<td>Ship-via information</td>
<td>$SHIP_VIA</td>
</tr>
</tbody>
</table>
Miscellaneous Charges

Set up miscellaneous charges for costs other than for items purchased or returned.

About Miscellaneous Charges

Miscellaneous charges are charges added to Order Entry documents for costs other than for items purchased or returned. For example, miscellaneous charges can include postage, shipping, assembly, and restocking charges.

Miscellaneous Charge Invoices

You can enter an invoice that contains only miscellaneous charges.

When you post an invoice that contains only miscellaneous charges, you can specify whether to produce an invoice or post the charge as an order (which you can use later to produce an invoice).

Creating Miscellaneous Charges

Use the O/E Miscellaneous Charges screen to create miscellaneous charge records for your system.

If you use multicurrency accounting, you must specify a currency code for each miscellaneous charge.

Note: If you want to apply the same charges to customers using different currencies, you must create a separate miscellaneous charge record for each currency. However, you can use the same miscellaneous charge code for each of the currencies.

For each miscellaneous charge, you must also specify the tax authorities that levy taxes on the charge, and the applicable tax classes.

Editing Miscellaneous Charge Details

When you add a miscellaneous charge to an Order Entry transaction, Order Entry displays the default description and amount that you specified for the charge on the O/E Miscellaneous Charges screen.

If you edit the description for an individual charge, the new description will appear on order confirmations, picking slips, invoices, and credit notes for that charge. This feature allows you to be very specific in describing miscellaneous charges to your customers.
Tip: When you apply charges to separate invoices (if you partially ship orders and produce partial invoices), all miscellaneous charges on an order will appear on the first partial invoice. If you want to allocate a miscellaneous charge over several invoices, add a portion of the charge as a new detail each time you are ready to produce a partial invoice.

Editing Tax Distribution for Miscellaneous Charges

To verify the tax distribution when adding a miscellaneous charge to an Order Entry transaction, click the **Distribute Taxes** button on the Taxes tab. You can change the tax class and specify whether tax is included in the amount.

When you have finished adding the miscellaneous charge, Order Entry recalculates the order subtotal, and the miscellaneous charge amount is added to the order subtotal.

For more information about sales tax calculation, see "Changing Tax Amounts for Order Entry Documents" (page 178).

Integration with Project and Job Costing

For job-related orders, you can use miscellaneous charges for the following purposes:

- To specify additional charges to customer orders for invoicing external charges such as freight (UPS or FedEx).
- To record internal non-material transactions such as equipment, subcontractors, and labor.

To create miscellaneous charges for job-related orders, you must select the **Allow For Jobs** option on the O/E Miscellaneous Charges screen, and then specify an extended cost, expense account, and clearing account.

Note: If you want to track costing information for a miscellaneous charge, you must set up the charge as a non-stock inventory item in Inventory Control.

For each project in Project and Job Costing, you can specify the following options:

- Whether to use the extended cost for a miscellaneous charge by default or use the contract cost.
- Whether to use the amount specified in Order Entry for the miscellaneous charge or use a default billing rate specified for the contract in PJC.
For more information about integration with Project and Job Costing, see "Journal Entries Generated for Posted Order Entry Transactions" (page 235).

**Creating Miscellaneous Charges**

Create miscellaneous charges to identify the charges used in your Order Entry system. For example, you might create miscellaneous charges for shipping and handling, or for internal non-material transactions such as equipment and subcontractors.

If you use multicurrency accounting, you must specify a currency code for each miscellaneous charge.

**Note:** If you want to apply the same charges to customers using different currencies, you must create a separate miscellaneous charge record for each currency. However, you can use the same miscellaneous charge code for each of the currencies.

For each miscellaneous charge, you must also specify the tax authorities that levy taxes on the charge, and the applicable tax classes.

**Before you start:**

- Add the general ledger revenue accounts to which amounts generated by miscellaneous charges are posted.
- Determine the tax authority and tax class for each miscellaneous charge.

**To create a miscellaneous charge:**

1. Open **Order Entry > O/E Setup > Miscellaneous Charges**.
2. Enter a unique code to describe the new record.

**Example:** For a handling charge, you might use the code "HC".

- If you do not use multicurrency accounting, enter the new code in the **Miscellaneous Charge** field.
  - If the field is clear, enter the new code.
  - If you are viewing an existing record, click the New button, and then enter the new code.
Chapter 1: Setting Up Order Entry

Tip: If you are viewing an existing record, you can "copy" it to a new record by typing a new code over the displayed code, making any required changes to the other fields on the screen, and then adding the record.

- If you use multicurrency accounting:
  - Click the New button.
  - In the Currency field, specify the currency code.
  - In the Miscellaneous Charge field, enter the new code.

3. In the description field to the right of the Miscellaneous Charge field, enter a description for the charge.

4. If the charge has a standard amount, enter it in the Amount field.

5. In the Misc. Charge Revenue field, specify the general ledger revenue account to which amounts entered as miscellaneous charges are posted.

6. If you use Project and Job Costing, and you are using this charge for job-related orders, specify job information.
   a. Select the Allow for Jobs option.
   b. In the Extended Cost field, enter the cost amount for the miscellaneous charge. This amount can also be used in Project and Job Costing to calculate labor and overhead.
   c. In the Expense Account field, select the general ledger expense account to which the expense amounts of miscellaneous charges are posted when you ship goods.
   d. In the Clearing Account field, select the general ledger clearing account to which the expense amounts of miscellaneous charges are posted when you ship goods.

7. If you use Transaction Analysis and Optional Field Creator, click the Zoom button, select the optional fields that apply to this charge, and optionally enter default optional field information. For more information, see "O/E Optional Fields Screen " (page 344).

8. In the Tax Authorities table, select the tax authorities and sales tax classes that apply to the charge.

9. Click Add to add the charge.
After creating a miscellaneous charge

- Print the O/E Miscellaneous Charges report to review information for the new record and update your printed records. For more information, see "O/E Miscellaneous Charges Report Screen" (page 305).

Managing Miscellaneous Charges

You can edit and delete miscellaneous charge records that identify the charges used in your Order Entry system, such as charges for shipping and handling, or for internal non-material transactions such as equipment and subcontractors.

Before you start:

- If you are editing a miscellaneous charge:
  - Add the general ledger revenue accounts to which amounts generated by miscellaneous charges are posted.
  - Determine the tax authority and class for the miscellaneous charge.

- If you are deleting a miscellaneous charge:
  - Print the O/E Transaction List Report for orders (including order details) to check that no orders use the charge you are deleting.
  - Edit the orders if necessary. For more information, see "O/E Transaction List Report Screen" (page 298).

To edit a miscellaneous charge:

1. Open Order Entry > O/E Setup > Miscellaneous Charges.

2. Use the Miscellaneous Charges navigation buttons or Finder to select a miscellaneous charge record. The miscellaneous charge code, description, and currency appear on the screen.

3. If you use multiple miscellaneous charges with identical codes (for example, if you use the code HC for handling charges in multiple currencies), review the description and currency to verify that you have selected the correct miscellaneous charge.

4. Make any other changes you wish to make in the other fields on the screen.

5. Click Save to save the record.
To delete a miscellaneous charge:

1. Open Order Entry > O/E Setup > Miscellaneous Charges.

2. Use the Miscellaneous Charges navigation buttons or Finder to select a miscellaneous charge record. The miscellaneous charge code, description, and currency appear on the screen.

3. If you use multiple miscellaneous charges with identical codes (for example, if you use the code HC for handling charges in multiple currencies), review the description and currency to verify that you have selected the correct miscellaneous charge.

4. Click Delete to delete the record.

After editing a miscellaneous charge

- Print the O/E Miscellaneous Charges report to update your printed records. For more information, see "O/E Miscellaneous Charges Report Screen " (page 305).

Sales Commissions

Select options that determine how Order Entry calculates commissions earned by salespersons.

About Sales Commissions

Order Entry uses transaction data to calculate commissions earned by salespersons.

If you track sales commissions, you can select various options in Accounts Receivable, Order Entry, and Inventory Control to specify how sales commissions are calculated and assigned. For more information, see "Setting Up Salesperson Commissions" (page 54).

Tracking Commissions

On the O/E Options screen, you can select or clear the Track Commissions option at any time.

If you have been tracking commissions and you clear the option, Order Entry immediately stops calculating sales commissions, although it retains those already calculated until you print the A/R Salesperson Commissions Report and use the O/E Clear History screen to clear sales data.
Options for Calculating Commissions

You can calculate commissions on either the sales amount or the margin. You control how commissions are calculated by selecting options in Order Entry and Inventory Control that specify the following settings:

- **Whether to calculate commissions by sales or margin.** You select this option on the Processing tab on the O/E Options screen. If you select sales, commissions are calculated on the invoiced sales amount. If you select margin, commissions are calculated on the margin amount.

- **Whether to use item category rates or salesperson rates.** You specify rates for item categories on the I/C Categories screen in Inventory Control, and you specify rates for salespersons in Accounts Receivable. If the item rate is 0 (zero), Order Entry uses the salesperson rate. If you specified a rate for the item, that rate overrides the salesperson rate.

How Order Entry Calculates Commissions

Order Entry calculates commission amounts on transactions during Day End Processing, and adds them to the commissions already accumulated for salespeople for the current period.

To calculate the commission, Order Entry checks:

- That the salesperson earns commissions.
- That the item is commissionable.
- Whether a commission rate was specified for the item category on the I/C Categories screen in Inventory Control. (If it was, that rate overrides the salesperson rate.)
- Whether commissions are paid on the sales amount or the margin.

Depending on the option you select on the O/E Options screen, Order Entry calculates commissions either on invoiced sales amounts or on margin amounts. If commissions are calculated on margin, cost figures in Inventory Control are used to determine the commission earned.

Reporting Sales Commissions

Order Entry accumulates commission information until you use the O/E Clear History screen to clear sales history.

If you use Order Entry to track commissions, you must follow these steps at the end of each commission period:
1. Run Day End Processing in Inventory Control to update commission information.

2. Print the O/E Salesperson Commissions Report. (You must print this report before you can clear data.)

3. Use the O/E Clear History screen to clear sales data for the commission period.

The length of time between clearing reports is called a commission period.

The O/E Salesperson Commissions Report lists the commission amounts due salespersons for the current commission period. For more information about this report, see "O/E Salesperson Commissions Report Screen" (page 295).

**Setting Up Salesperson Commissions**

If you track sales commissions, you can select various options in Accounts Receivable, Order Entry, and Inventory Control to specify how sales commissions are calculated and assigned.

- In Order Entry, specify whether Order Entry tracks commissions, and whether commissions are calculated on the sales amount or the margin.

- In Accounts Receivable, specify the number of commission rates to use for each salesperson, a commission percentage for each commission rate, and the range of sales amounts to which each rate applies.

- In Inventory Control, allow commissions for item categories and assign commission percentages. (These determine whether Order Entry calculates commissions based on the item category or the rate specified for the salesperson.)

For more information about how sales commissions are calculated and assigned, see "About Sales Commissions" (page 52).

**To set up salesperson commissions:**

1. In Order Entry, turn on commission tracking.
   a. Open **Order Entry > O/E Setup > Options**.
   b. On the Processing tab, select the **Track Commissions** option.
   c. On the **Commission By** list, select **Sales** or **Margin**.
      o If you select **Sales**, Order Entry calculates commissions as a percentage of the sales amount.
If you select Margin, the calculation is based on the margin amount.

d. Click Save.

With the Track Commissions option selected, you can print commission data on the O/E Salesperson Commissions report as data becomes available.

2. In Accounts Receivable, set up commission rates for each salesperson who is paid commissions.

**Note:** You can edit commission rates at any time, but the new rates will affect only future commissions.


b. Select a salesperson.

c. On the Commission tab, select the Paid Commissions option.

d. Select the number of commission rates to use (up to five).

**Example:** You could use two commission rates to specify that a salesperson be paid 2 percent commission on the first $10,000 of sales, and 5 percent on sales over $10,000.

e. If you are setting up multiple rates, specify the commission percentage for each commission rate, and the range of sales amounts to which each rate applies.

f. Click Save.

3. In Inventory Control, allow commissions for each item category that accrues commissions.

**Important!** Item category commission rates override salesperson commission rates. If you want to use the salesperson commission rate you specified on the A/R Salespersons screen for sales of an item, you must set the item’s category commission rate to 0 (zero) percent.

a. Open Inventory Control > I/C Setup > Categories.

b. Select an item category code.

c. On the Options tab, select the Allow Commissions option.
Chapter 1: Setting Up Order Entry

d. Specify a commission rate to use for items in the selected category.
   - If you want to use the salesperson commission rate you specified on the A/R Salespersons screen, enter 0 (zero) in the **Commission Rate** field.
   - If you want to override the salesperson commission rate, enter the rate to use in the **Commission Rate** field.

e. Click **Save**.

**Note:** Each item category in Inventory Control can have a single commission rate. If you want to specify a different rate for an item, you can change its category when you add it to an order.

**After setting up commission rates**
You can print the O/E Salesperson Commissions report or use the O/E Clear History screen to clear commission data.

If you use Order Entry to track commissions, you must follow these steps at the end of each commission period:

1. Run Day End Processing in Inventory Control to update commission information.
2. Print the O/E Salesperson Commissions Report. (You must print this report before you can clear data.)
3. Use the O/E Clear History screen to clear sales data for the commission period.

**Ship-Via Codes**

Set up ship-via codes to identify the shipping methods or carriers you use to deliver goods to customers.

**Creating Ship-Via Codes**
You create ship-via codes to identify the shipping methods or carriers you use to deliver goods to customers (such as courier, air mail, or parcel post).

**Note:** Ship-via codes are optional. If you do not add them to Order Entry and specify them on orders, Order Entry transaction entry screens will display the ship-via description entered with Accounts Receivable ship-to locations (if you specify a ship-to location for the order).
To create a ship-via code:

1. Open Order Entry > O/E Setup > Ship-Via Codes.

2. In the Ship-Via Code field, enter a code for the new record.
   - If the field is clear, enter the new code.
   - If you are viewing an existing record, click the New button, and then enter the new code.

   **Tip:** If you are viewing an existing record, you can "copy" it to a new record by typing a new code over the displayed code, making any required changes to the other fields on the screen, and then adding the record.

   **Example:** For a carrier called Cross-Country Trucking Lines, you might create a "CCT" ship-via code.

3. On the Ship-Via tab, enter information about the shipping method or carrier. You can also enter an optional comment if you wish.

4. On the Contact tab, enter information about the contact person, position, or department that is your primary contact for the shipping method or carrier.

5. Click Add to add the ship-via code.

**After creating ship-via codes**

- Print the O/E Ship-Via Codes report to check the new information and to update your printed records.

**Managing Ship-Via Codes**

You can edit any details for a ship-via code (except the name of the code) at any time.

**Before you start:**

- Before deleting a ship-via code, make sure no current orders use it. If you try to post a document with a code that no longer exists, an error message informs you that you must select a different ship-via before posting the document.
To edit a ship-via code:
1. Open Order Entry > O/E Setup > Ship-Via Codes.
2. In the Ship-Via Code field, enter or select a ship-via code.
3. Make your changes, and then click **Save**.

**Tip:** Editing the description of a ship-via code does not change the description that appears in current documents. To update the description that appears in a document, you must open the document and select the ship-via code again.

After editing ship-via codes

- Print the O/E Ship-Via Codes report to check the new information and to update your printed records.

To delete a ship-via code:
1. Open Order Entry > O/E Setup > Ship-Via Codes.
2. In the Ship-Via Code field, enter or select a ship-via code.
3. Click **Delete** to delete the ship-via code.

After deleting ship-via codes

- Print the O/E Ship-Via Codes report to update your printed records.
- Print the O/E Templates report to check that no Order Entry templates use ship-via codes that you deleted. Edit templates if necessary.
- Print the O/E Transaction List report for orders (including the order information) to check that no orders use ship-via codes that you deleted. Edit the orders if necessary.

Optional Fields

If you use Sage 300 ERP Transaction Analysis and Optional Field Creator, you can add optional fields to records, transactions, and transaction details.

About Optional Fields

**Note:** Optional fields are available if you use Sage Transaction Analysis and Optional Field Creator.
You can customize your Order Entry system by using optional fields to store additional information that you want to keep with miscellaneous charges, orders, shipments, invoices, credit notes, and debit notes.

You can add unlimited optional fields to Sage 300 ERP screens and transaction details. You can also specify whether information is passed to other subledgers or General Ledger.

Validating Data in Optional Fields

You can restrict the information that can be entered into any optional field you add to a transaction entry screen. To do this, you create a list of permitted values when you add the optional field in Common Services, and then use the O/E Optional Fields screen to add the optional field to selected transactions, transaction details, or charges.

When you enter information in the field on a transaction entry screen in Order Entry, Sage 300 ERP validates the information before accepting it. This is useful for any field that has a clearly defined set of valid entries, such as a list of approved freight carriers.

Adding Optional Fields to Transaction Entry Screens

Before adding optional fields for Order Entry, you must first define optional fields for Sage 300 ERP using the Optional Fields screen in Common Services.

After you define these optional fields, you use the O/E Optional Fields setup screen to define optional fields for the following transactions, transaction details, and charges:

- Miscellaneous charges
- Orders and order details
- Shipments and shipment details.
- Invoices and invoice details
- Credit and debit notes, and credit and debit note details

For more information, see "Adding Optional Fields to Transaction Entry Screens" (page 60).

**Note:** If you want to delete an optional field that is used in Order Entry, you must first delete the optional field from the records that use it, or post any transactions that include it.
Chapter 1: Setting Up Order Entry

Passing Information to General Ledger and Other Subledgers

**Important!** You can—and should—restrict the flow of information that is passed to General Ledger when you post transactions that use optional fields. Send values to General Ledger only for optional fields that require financial analysis, and only to accounts where they are required.

If the optional fields you add to Order Entry transactions and transaction details match optional fields in General Ledger transactions, the Order Entry optional field can be passed automatically to General Ledger.

Optional field values are passed to General Ledger if they meet the following criteria:

- The name of the optional field in Order Entry uses the same name as the optional field assigned to the affected account in General Ledger
- The optional field settings in Order Entry specify that optional field information be passed to the type of account used in the transaction

The values then appear in the General Ledger journal entry for the account, as well as in the Optional Fields report.

If you want Order Entry optional field information to appear on invoices transferred to Accounts Receivable, you must use the same optional fields in both programs.

On the O/E Optional Fields setup screen, you can specify groups of accounts for which values for an optional field will be passed to General Ledger. For more information, see "O/E Optional Fields Screen" (page 349).

Adding Optional Fields to Transaction Entry Screens

If you use Transaction Analysis and Optional Field Creator, you can customize Order Entry by adding unlimited optional fields to transaction entry screens and transaction details.

Adding optional fields is a two-step process:

1. Use the Optional Fields screen in Common Services to create optional fields. For more information, see the help for the Optional Fields screen in Common Services.

2. In Order Entry, use the O/E Optional Fields setup screen to add optional fields for different types of transactions and transaction details.
**Note:** If you want information from Inventory Control optional fields to appear with Order Entry transactions, assign the same optional fields to Order Entry transaction details that you assigned to Inventory Control item records.

**Before you start:**

- If security is turned on for your Sage 300 ERP system, you need Setup Maintenance authorization to add or delete optional fields.

- Determine which optional fields you need in Order Entry.

- If the optional fields you need have not been added to Sage 300 ERP, use the Optional Fields screen in Common Services to add them. For more information, see the help for the Optional Fields screen in Common Services.

- Decide which optional field information you want to pass to other ledgers with item records and with General Ledger transactions. Consider carefully the purpose of each optional field you plan to add. For example, only send optional fields to General Ledger that are used for financial analysis, and only to the accounts where they are required.

- Make sure that no one else is using Order Entry, and that no other Order Entry screens are open for the company.

**To add optional fields for transactions, transaction details, and miscellaneous charges:**

1. Open **Order Entry > O/E Setup > Optional Fields**.

2. For each type of document, detail, or charge, add optional fields, as follows:

   a. On the **Optional Fields For** list, select the type of document, detail, or charge that will use the new field.

   **Note:** Optional fields for documents (such as orders) will appear on the Optional Fields tab on the transaction entry screen. Optional fields for details and miscellaneous charges appear as columns in the **Detail** table on the transaction entry screen.

   b. In the first empty row in the table, double-click the cell in the **Optional Field** column. If there is not an empty row, press the Insert key to add one.

      The **Optional Field** Finder appears.

   c. Click the Finder, and then select a optional field.
Chapter 1: Setting Up Order Entry

d. If you want the default value to appear automatically in the optional field on transaction entry screens, select "Yes" in the **Value Set** column (or verify that the option is selected).

e. If you want to set a default value, enter or select it in the **Default Value** column.

- If the default value is validated in Common Services, you must use the Finder (or verify that the option is selected).
- If the default value is not validated, you can use the Finder to select a value, or you can type the default value in the field.

f. If you want the optional field to appear by default on transaction entry screens, select "Yes" in the **Auto Insert** column.

**Note:** If you do not select "Yes," the field is available for the selected type of document, detail, or charge, but must be added manually on the transaction entry screen by users with the appropriate security authorization.

g. If the optional field will be included with General Ledger transactions or with transactions sent to other subledgers, select the accounts and click the **Settings** button.

i. On the O/E Optional Fields Settings screen, select the General Ledger accounts and other subledgers to which Sage 300 ERP sends the information entered in the optional field. For more information, see "O/E Optional Fields Settings Screen " (page 353).

  ii. Click **OK** to close the screen.

3. When you have finished adding optional fields, click **Save** to save your changes.

When you open a transaction entry screen, optional fields for which you selected the **Auto Insert** option appear by default.

**After adding optional fields**

- If you are passing optional field information from Order Entry transaction details to General Ledger, use the Optional Fields screen in General Ledger to add the same optional fields to General Ledger transaction details, if they have not been added yet.
• If you use optional fields that are associated with Inventory Control items, and you want to add those optional fields to transaction details in Order Entry, use the Optional Fields screen in Inventory Control.
Chapter 2: Entering and Posting
Order Entry Transactions

Use Order Entry transaction entry screens to process quotes, orders, shipments, invoices, credit notes, and debit notes.

About Transaction Processing

This topic describes how posting, Day End Processing, and audit trails support transaction processing in Order Entry.

Online Posting

Order Entry uses online transaction processing. This means that it posts each quote, order, shipment, invoice, credit note, and debit note when you enter it. (In contrast, Accounts Receivable uses batch processing. With batch processing, you add transactions to batches, where they are stored until you post the batches.)

When you post Order Entry transactions, the program immediately:

- Updates item quantities in Inventory Control, so you always know your inventory levels.
- Adds any prepayments to an Accounts Receivable receipt batch.

Costing options specified in Inventory Control determine whether the following additional tasks take place in "real time" (during posting) or during Day End Processing:

- Update item costs in Inventory Control.
- Create audit records or general ledger transactions.
- Update sales statistics and customer accounts in Accounts Receivable.

Day End Processing

If Inventory Control uses the options Cost Items During Day End Processing or Create Subledger Transactions And Audit Info During Day End Processing, you must run Day End Processing in Inventory Control to finish updating Order Entry, General Ledger, Inventory Control, and Accounts Receivable, including:
- Order Entry sales statistics, sales commissions, and audit information.
- Costing information, item and sales statistics, and audit information in Inventory Control with the posted transactions.

Day End Processing also creates a batch of summary invoices and credit notes for Accounts Receivable. (For information about creating and posting Accounts Receivable invoices, see "Posting a Batch of Order Entry Invoices in Accounts Receivable" (page 247).)

To keep your audit trail and reports up to date, you should run Day End Processing as part of your daily routine. If necessary, you can run Day End Processing several times a day to keep this information more current.

**Maintaining Your Audit Trail**

**Keeping Transaction History**

If you selected the **Keep Transaction History** option on the O/E Options screen, the program keeps transaction history until you remove it using the O/E Clear History screen. You can then print summary or detail listings of orders, invoices, and credit notes; reprint invoices and credit notes; and view transactions in the original transaction entry screens and in the Salesperson Inquiry screen.

If you do not keep transaction history, Order Entry automatically deletes completed transactions when you run Day End Processing. Order Entry treats the following transactions as completed:

- Orders with a Completed status.
- Invoices and credit notes that you have printed.

**Note:** If you do not keep history, you cannot print transaction lists for completed orders or for printed invoices and credit notes after you run Day End Processing.

**Printing Posting Journals**

You can print posting journals for invoices and credit notes after running Day End Processing.

You can keep posting journals until you remove the information using the Clear History screen. However, you cannot remove the information for a particular day-end sequence until you have printed the posting journals.

For more information, see "About Day End Processing " (page 232).
Creating Transactions for General Ledger

You use the O/E Create Batch screen to create General Ledger batches if you do not automatically create G/L transactions when you post transactions or when you run Day End Processing.

You specify how to create G/L transactions using the Create G/L Transactions option on the O/E G/L Integration screen. For more information, see "O/E G/L Integration Screen" (page 327).

About Orders, Shipments, and Invoices

Order processing in Order Entry supports and enhances your workflow in several important ways:

- Individual Order Entry, Shipment Entry, and Invoice Entry screens have separate authorizations, allowing tight control of the order processing, shipping, and invoicing functions. If security is turned on for your system, managers can separate the processing of orders, shipments, and invoices by supervisor or administrative unit.

- If security is not turned on, or if you have sufficient authorization, you are not restricted to using separate screens for these functions.

You can enter quotes, orders, shipments, and backorders on the Order Entry screen, and then automatically create invoices for the shipped quantities.

You can enter shipments and print invoices from the Order Entry screen or the Shipment Entry screen—without entering orders first.

You can add prepayments to an Accounts Receivable batch using the Order Entry, Shipment Entry, and Invoice Entry screens.

- Because the entry screens and the information used in orders, shipments, and invoices are similar (with a few exceptions), the workflow is efficient. Information you enter on an order is reused on the shipment, and shipment information is passed to the invoice.

  - When you select an order for shipment on the Shipment Entry screen, the details from the order are copied to the shipment document you are entering.

  When you select a shipment for invoicing on the Invoice Entry screen, the details from the shipment are copied to the invoice you are entering.

  - Payment details appear on invoices, so if you specify a multiple payment schedule, you confirm all the payment details (such as the due dates) when you invoice the customer.
Chapter 2: Entering and Posting Order Entry Transactions

- If you use Payment Processing, you can process and void credit card prepayments from the Order Entry, Shipment Entry, and Invoice Entry screens. However, you can pre-authorize credit card transactions (and void pre-authorized credit card transactions) only from the Order Entry screen.

Shipments and invoices contain only the shipped items and miscellaneous charges for the orders that you are shipping or invoicing.

**Processing Orders and Quotes**

You use the Order Entry screen to enter orders and quotes. To save time, you can also use the Copy Orders screen to copy the details of existing orders for a selected customer to a new order.

You can also enter quotes, orders, shipments, and backorders on the Order Entry screen, and then automatically create invoices for the shipped quantities.

To process a shipment while entering an order, you enter the shipped quantities directly on the order.

To create an invoice for the shipped goods automatically when you post the order, you select the **Create Invoice** option on the Order Entry screen.

For step-by-step instructions on entering orders, see "Entering an Order " (page 92).

You can also enter prepayments with orders. For step-by-step instructions, see "Entering a Prepayment " (page 109).

If you use Payment Processing, you can pre-authorize or process a credit card prepayment for an order. For more information and step-by-step instructions, see "Pre-authorizing a Credit Card Payment" (page 144) and "Capturing a Pre-authorized Credit Card Payment" (page 147).

**Processing Shipments**

To process a shipment after entering the order, use the Shipment Entry screen.

You can enter any number of shipments for a single order until the order is fully shipped.

You can also process a single shipment for multiple orders. However, details that are fully shipped are not available for future shipments.
You can edit a shipment document until the order is fully shipped. You can delete details, and you can edit most of the detail information for a shipment, except the item numbers and the quantities committed to the order. You can also enter a negative quantity on a shipment transaction. However, you cannot enter new detail lines for a posted shipment.

To create an invoice automatically when you post a shipment, you select the **Create Invoice** option on the Shipment Entry screen.

For step-by-step instructions on creating shipments, see "Shipping Orders and Items" (page 120).

**Allowing Negative Inventory Levels**

Unless the **Allow Negative Inventory Levels** option is selected in Inventory Control, the program ships only quantities that are on hand in Inventory Control.

If negative inventory is allowed, the program warns you when you enter shipped quantities that will result in negative inventory levels.

For more information about this option, see the Inventory Control help.

**Processing Credit Card Payments for Shipments**

If you use Payment Processing, you can process a credit card prepayment for a shipment, and you can capture a pre-authorized credit card payment for an order.

**Note:** If you use Payment Processing, you must capture or void all outstanding credit card pre-authorizations for any orders that are included in the shipment before you can post the shipment.

For more information, see "Capturing a Pre-authorized Credit Card Payment" (page 147) and "Voiding a Credit Card Pre-authorization" (page 153).

**Processing Invoices**

You can create invoices automatically when you ship goods using the Order Entry screen or the Shipment Entry screen.

If you don't create an invoice when you ship goods, you use the Invoice Entry screen to process invoices for shipped items and miscellaneous charges.

You can process a single invoice for one shipment or for multiple shipments, but only until the shipment is fully invoiced. (Details that are fully invoiced are not available for future invoices.)
If you use Payment Processing, you can process a credit card prepayment for an invoice.

You can print the invoice when you post the shipment.

For step-by-step instructions on creating invoices, see "Invoicing Shipments" (page 116).

**Creating Partial Invoices**

You create a partial invoice when you ship and invoice only part of an order. You can post as many invoices from a single order as you require, until all the quantities are shipped.

When you post a partial invoice:

- All the miscellaneous charges currently entered for the order and not marked Completed are invoiced.
- The program deducts the quantities shipped from the quantities on order. The next time you recall the order, the quantities on order will be the reduced amounts, showing the quantities outstanding.

To check the original quantity ordered for the item, select the item line and review the amount in the **Original Order** field.

**Entering Credits on Invoices**

You can enter credit amounts on invoice detail lines for returned items or to reverse miscellaneous charges, providing the order is incomplete.

For more information, see "About Credits on Invoices" (page 115).

**Overriding Customer Credit Limits**

**Important!**

When you try to post an invoice that will put a customer account over its credit limit, Order Entry displays a warning message and the following customer information:

- Credit limit
- Outstanding Accounts Receivable balance
- Order amount
- Last invoice amount and date
- Last payment amount and date
If you use security, you or your supervisor must enter a user ID and password to approve credit before you can post the invoice.

If you are not authorized to override the credit limit, or if you want to put the order on hold for later invoicing, select On Hold. If an order is on hold, you can post the order but you cannot ship goods and produce an invoice until you clear the on-hold status.

**Job-Related Orders, Shipments, and Invoices**

If you use Project and Job Costing (PJC), you can create and process job-related orders that allocate inventory items, labor costs, and miscellaneous charges to particular contracts, projects, and categories that are tracked in PJC.

**Quotes and New Contracts**

You can create a new contract in PJC when you enter a quote in Order Entry.

New contracts can be based on existing contracts, so you can create template contracts that contain standard items and costs.

Amounts entered on quote detail lines appear as original estimates in the Contract Maintenance screen in PJC.

When you change the order from Quote to Active, Order Entry updates the PJC contract line-by-line to change the status of each referenced project from Estimate to Open.

**Service Orders for Existing Contracts**

You can process orders and invoices in Order Entry for existing long-term contracts, and let PJC track the costs and revenues.

For example, you could have a year-long service contract, but invoice the client for each service call. For each service call, you could activate a standing order with standard call details, change it as required, and then issue the invoice.

**Project Invoicing**

The Project Invoicing option determines whether you invoice job-related orders in Order Entry or from Project and Job Costing.

*If you select Project Invoicing:*
• Project and Job Costing handles all billing for the order.

• Order Entry debits the Work in Progress account when you ship the order and passes all billing information to Project and Job Costing.

• You can post a negative shipment. Although you cannot post a credit note for project-invoiced jobs, negative shipments provide credit note functionality.

*If you do not select Project Invoicing:*

• Order Entry creates invoices for Accounts Receivable, where the cost of sales and revenues are posted together. Typically, service companies invoice from Order Entry, and close the jobs when they post the invoices.

### Project Invoicing in Order Entry

<table>
<thead>
<tr>
<th>Project Type / Accounting Method</th>
<th>Project Invoicing</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Time And Materials projects with Billings And Costs or Accrual-Basis accounting method.</td>
<td>• Project Invoicing is optional. You can invoice in Order Entry or in PJC.</td>
<td>• If invoicing in Order Entry, all costs (allocated and expensed) and revenue are sent to PJC from Accounts Receivable when the invoice is posted in Accounts Receivable. Revenue is also recognized during posting in Accounts Receivable.</td>
</tr>
<tr>
<td>• Fixed Price projects with Billings And Costs or Accrual-Basis accounting method.</td>
<td></td>
<td>• If invoicing in PJC, Order Entry sends costs to PJC with allocated and expensed tax amounts, and sends revenue net of tax amounts. Revenue is recognized in PJC.</td>
</tr>
<tr>
<td>• Cost Plus projects with Total Costs Percentage Complete,</td>
<td>• Project Invoicing is mandatory. PJC handles all billing.</td>
<td>• The order is completed at shipment posting and sent to PJC for invoicing.</td>
</tr>
<tr>
<td>• Fixed Price projects with Project Percent Complete or Completed Project accounting method.</td>
<td></td>
<td>• Only costs (including allocated and expensed tax) are sent to PJC.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For Time And Materials projects, the billing type, billing rate, and extended</td>
</tr>
<tr>
<td>Project Type / Accounting Method</td>
<td>Project Invoicing</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Completed Project, Labor Hours Percentage Complete, Billings And Costs, Category Percentage Complete, or Accrual-Basis accounting method.</td>
<td></td>
<td>billing amount are also sent to PJC.</td>
</tr>
</tbody>
</table>

**Item Details**

You cannot mix job-related and non-job-related order details on the same order.

For job-related orders, you must specify the quantity purchased, as well as the contract, project, and category to which each item applies. The contract, project, category and resource (for standard projects) must exist in PJC.

For orders that use project invoicing, the program displays the **Billing Type**, **Billing Rate**, and **Extended Billing Amount** fields for Time And Materials projects and for Fixed Price projects that use the Billings and Costs or Accrual-Basis accounting method.

For all other project types and accounting methods:

- You use the **Unit Price** and **Extended Price** fields for item details.
- Order Entry sends the extended cost and the extended price to PJC.
- Depending on the **Default Billing Rate** setting for the project in PJC, Order Entry may use the project’s billing rate as the unit price.
- When you post a shipment in Order Entry, PJC calculates overhead and labor, and sends the amounts and accounts to Order Entry. (This behavior is the same as for Accounts Receivable.)
- The Order Entry and Shipment Entry screens check the project settings in PJC to determine the unit price to bill the customer.

**Miscellaneous Charges**

Miscellaneous charges perform two functions on job-related orders:

- They allow you to invoice external charges, such as freight.
- They record internal, non-material transactions, such as equipment use, subcontractors, or labor.
You must select the **Allow For Jobs** option on the Miscellaneous Charges setup screen to use a miscellaneous charge on a job-related order.

To calculate labor and overhead for a miscellaneous charge, the detail must have an extended cost, and the **Labor Type** and **Overhead Type** for the specified category must be a percentage method.

If the **Labor Type** and **Overhead Type** is set to **None** or is a flat rate, labor and overhead are not calculated.

**Multicurrency**

If you are invoicing in Order Entry, Order Entry sends functional cost amounts and functional and source revenue amounts to Accounts Receivable.

If you selected **Project Invoicing**, Order Entry sends both functional and source cost amounts and source revenue amounts to PJC. (Order Entry calculates the source cost by using the document currency and date for exchange.)

**Taxes**

Project and Job Costing allows tax groups to be specified by project on an invoice. When Project and Job Costing creates an invoice, it uses each project’s tax group to calculate tax. Therefore, you can enter details for contracts and projects that use different tax groups on the same document, provided Project and Job Costing handles the invoicing. (This is the case if you select **Project Invoicing** for a document.)

However, if you will produce the invoice in Order Entry, you must use separate orders for contracts and projects that use different tax groups. This is because the tax group specified for an Order Entry invoice applies to all the document details.

**Note:** If you create an order or shipment for a "non-existent" customer (a customer for which no record exists in Accounts Receivable) and select **Project Invoicing**, you will not be able to add order or shipment details unless the default template includes a tax group. (The tax group is not editable if you select **Project Invoicing**, and it will be blank unless it is specified in the template.)

**About Importing and Exporting Orders and Invoices**

Use the **Import** and **Export** commands on the File menu in the O/E Order Entry and O/E Invoice Entry screens to import and export orders.
You cannot import invoices. However, Order Entry will create and post invoices for imported orders that contain shipped quantities or miscellaneous charges.

**Kit components, serial numbers and lot numbers.**

You cannot import or export serial numbers or lot numbers for kit components.

**Tip:** You can use a macro to automate the entry of serial numbers and lot numbers for kit components.

For more information about importing and exporting, see the help for System Manager.

**About Exchange Rates**

If you use multicurrency accounting, exchange rate information appears on the Rates tab of transaction entry screens when you enter documents for customers who do not use your company's functional currency.

By default, Order Entry uses the document date as the default rate date for each document. If you change the rate date, Order Entry checks the rate tables and updates the rate. (For more information about how Sage 300 ERP selects exchange rates, see the System Manager help.)

**About the Rates Tab**

On transaction entry screens, you use the Rates tab to view and edit rate information for currency conversion.

The Rates tab can show the following groups of exchange rate information:

- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:
Chapter 2: Entering and Posting Order Entry Transactions

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.
- If you are shipping goods, change rate information for converting the shipped amount from customer's currency.
- If you are invoicing shipped goods, change rate information for the invoice.
- If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

**Defining Rate Types**

Rate types specify how source currency amounts are converted to their equivalent amounts in your company's functional currency. Examples of rate types might be "Daily spot rate," "Monthly average rate," "Contract rate," and "Forward rate."

*Example:* You might define the rate type "Forward rate" to describe the rate at which a bank is willing to exchange one currency for another at a specified future date.

If you use multicurrency accounting, you use the Currency Rate Types screen in Common Services to define rate types for the exchange rates you use.

**Changing Exchange Rates**

You can change rates manually on the Rates tab, or you can change the tax totals on the Taxes tab and then derive the new rate on the Rates tab.

When changing exchange rates, remember the following points:

- You cannot change the rate after an order has been invoiced.
- When you change the rate for the tax reporting currency on the Rates tab:
  - If you calculate taxes automatically, Order Entry updates the tax reporting amounts on the Taxes tab automatically.
About Transaction Processing

- If you do not calculate taxes automatically, Order Entry updates these amounts when you click the **Calc. Taxes** button.

- If you clear the Calculate Tax option and change the tax reporting amount on the Taxes tab, you must redistribute the new tax amount to the detail lines, and then enter the new tax reporting exchange rate on the Rates tab. (To calculate the new exchange rate, click the Derive Rate button.) If you do this, you cannot post the document unless the tax reporting exchange rate is correct for the tax reporting amount on the Taxes tab. Also, the tax reporting amounts for the document details must match the total tax reporting amount on the Taxes tab.

**About Posting Orders, Posting Invoices, and Posting Shipments**

After entering all required details, you can post Order Entry transactions (orders, shipments, and invoices).

**Posting Orders**

After you have finished entering all the details for an order, you can post the order.

**Customer Credit Limits**

You can set up Order Entry to automatically check a customer’s credit limits each time you post a transaction, to see if the new transaction will put the customer over their credit limit.

**Note:** You select credit checking options in Accounts Receivable for each customer and customer group. For more information, see the Accounts Receivable help.

If you have set up credit checking for a customer and you try to post a transaction that will put the customer over their credit limit, the O/E Credit Check screen appears, and displays information related to the customer’s credit, including:

- Credit limit
- Outstanding Accounts Receivable balance
- Order amount
- Last invoice amount and date
- Last payment amount and date

On the O/E Credit Check screen, you can proceed in the following ways:
Chapter 2: Entering and Posting Order Entry Transactions

- If you have Credit Approval authorization, you can override the credit limit and post the transaction by entering your user ID and password. This is only necessary if security is turned on for your system.

- If you do not have Credit Approval authorization, or if you want to put the order on hold for later invoicing, select On Hold. If the order is on hold, you can post the order, but you cannot produce an invoice for it until you clear its on-hold status.

**Posting an Order to a Non-existent Customer**

If the **Allow Non-existent Customers** option is selected on the Processing tab of the O/E Options screen, you can post orders and invoices to non-existent customers.

**Creating an Invoice**

If you have shipped anything from an order, you have the option to create an invoice when you post the order.

If you post an order without creating an invoice:

- The quantity ordered and the quantity backordered are updated for each item. (The quantity ordered but unshipped appears as the Backordered quantity if you select the Calculate Backorder Quantities option.)

- The quantity on sales order (in Inventory Control) is increased for each item on the order.

- You can print an order confirmation and picking slips, as described in the next section. (You can print the order confirmation immediately after posting the order.)

If you post an order and create an invoice:

- The quantity on hand (in Inventory Control) is reduced for each item that is shipped from the order.

- The status of a line item is changed to Completed in the Order Entry screen if the ordered quantity has been:
  - Fully shipped and invoiced, or
  - Partially shipped and invoiced, and you have set the backorder quantity to zero. The amount shown on order becomes a lost sale.

- The quantity ordered, the quantity backordered, and the quantity shipped to date are updated for the order (if you display it on the Order Entry screen or
print it on the Order List). Order Entry calculates the backordered quantity only if you select the Calculate Backorder Quantities option.

- You can print an invoice immediately after posting the order.

**Other Effects of Posting**

Depending on when you cost inventory in I/C, posting an order may also:

- Update item costs in Inventory Control.
- Update sales statistics.
- Create audit records or general ledger transactions.

**Note:** If you cost inventory at day end, you must run Day End Processing in Inventory Control to do the above tasks.

**Posting Invoices**

After you have finished entering all the details for an invoice, you can post the invoice.

Take note of the following information about fields:

- **Invoice Date.** The invoice date is the date that will appear on the invoice and will be used for document aging. The invoice date also appears on invoice transactions in Accounts Receivable.

- **Posting Date.** This is the transaction date used by Day End Processing in Inventory Control when it creates journal entries for the general ledger. The posting date determines the fiscal year and period to which transactions are posted in the general ledger.

- **Fiscal Year and Period.** This is a display-only field on data entry screens. It shows the fiscal year and period is the period to which the invoice transactions will be posted in Accounts Receivable—no matter what date appears as the Invoice Date (and on the invoice).

The Invoice Date and the Posting Date do not have to match each other. By default, the fiscal period will match the Invoice Date. However, if you are late invoicing an order, you might want to post the transaction to a previous fiscal period.

**Day End Processing**

If you cost inventory during Day End Processing, you must use the Day End Processing screen in Inventory Control to update Order Entry sales statistics,
sales commissions, and audit information, and to create batches of Accounts Receivable invoices and credit notes. (You can post A/R batches during day end processing, or later, using the Create Batch icon in Order Entry.)

**Posting Shipments**

After you have finished entering all the details for a shipment, you can post the shipment.

Take note of the following information about fields:

- **Shipment Date.** The shipment date is the date on which you ship the order. You enter it in the Shipment Date field on the Shipment tab. The shipment date is used to calculate the average days between shipments on the Item Status report in Inventory Control.

- **Posting Date.** The posting date is the transaction date used by Day End Processing in Inventory Control when it creates journal entries for the general ledger. The posting date determines the fiscal year and period to which transactions are posted in the G/L.

**Posting Updates Quantities**

When you post a shipment in Order Entry, the quantities on sales order and on hand in Inventory Control are immediately reduced for the items on the shipment.

Depending on the costing options that you choose in the Inventory Control program, posting may also update inventory costing information.

**Note:** Posting does not immediately update accounting or statistical information.

**About Order Completion**

As you process orders and shipments, Order Entry displays the completion status of each order and each detail on the Order Entry and the Shipment Entry screens.

You can ship a whole order at once, or in parts. An order is completed when all its details are fully shipped.

If the items in a detail are fully shipped, during posting the program:

- Sets the Completed field for the order detail to Yes on the Order Entry screen.
• Sets the **Completes Order** field for the shipment detail to **Yes** on the Shipment Entry screen.

A shipment is considered completed when you post an invoice for the shipment. The program sets the shipment's **Complete Status** to **Complete**.

**Note:** There are no partially invoiced shipments in Order Entry. The invoice is considered the final change to a shipment.

When you run Day End Processing, the program assigns the session date as the completion date for completed orders.

### Unshipped and Partially Shipped Orders

#### Completing Orders by Canceling Backordered Quantities

If you want to complete an item detail line and the item is partially shipped or you have not shipped any of the units ordered for the item detail, you must set the backordered quantity to zero before you post the order or shipment.

You can change the backordered quantity in the Order Entry screen or in the Shipment Entry screen.

When you cancel the unshipped units by zeroing the backordered quantity, the program:

• Sets the Completed field for the order detail to Yes on the Order Entry screen.

• Sets the **Completes Order** field for the shipment detail to **Yes** on the Shipment Entry screen.

The unshipped quantity will be listed as lost sales on the Sales Statistics screen and on the Sales Statistics report after the order is processed by posting or by Day End Processing.

**Note:** If the order consists of just one line and no items have been shipped, you should simply delete the order. You do not need to change the backordered amount or Completed status.

#### Calculating Taxes for Partially Shipped Orders

If you partially ship an order for which taxes have been entered manually, Order Entry displays a message asking whether you want the program to recalculate taxes for you.
You must decide whether to recalculate taxes for the invoice and the order as follows:

- **Choose No** if you want to post the shipment without recalculating taxes for the shipment and the order. The invoice will be posted with the full tax amounts specified on the order.
- **Choose Yes** if you want the program to recalculate taxes for the invoice (for the items shipped) and for the order (for the items remaining on order).
- **Choose Cancel** if you want to cancel posting and return to the Shipment Entry screen to enter recalculated taxes manually.

**Adding new details to completed orders**

You can add new detail lines to any completed orders that have not been cleared. If you add new lines, the order is no longer complete, and Order Entry resets the order status.

**Clearing Completed Orders**

Completed orders are cleared from the system using one of two methods:

- **If you did not select the Keep Transaction History option**, Day End Processing automatically removes all orders that have been completed since you last performed day-end processing.
- **If you selected the Keep Transaction History option**, you use the Clear History screen to clear all orders with a completion date through the date you specify. For example, you can specify that all transactions through September 30, 2011, should be cleared.

Until deletion, you can use the completed data to answer customer inquiries, copy it to issue repeat orders, or use it for other purposes.

**About Price Checks**

In Inventory Control, price limits can be specified for items, price lists, and Sage 300 ERP user IDs. (For more information, see the Inventory Control help.)

These price limits are checked when you enter a unit price for a detail. If the price is outside the allowed limits, you need to do one of the following:

- Change the price so it is within the allowed limits.
- Delete the detail.
About Transaction Processing

- Approve the price (if you are authorized) or have an approver do so. For more information, see "O/E Price Approval Screen" (page 499).

**Note:** Price approval is available only in Sage 300 Premium ERP.

**Changing Payment Terms**

Payment terms can be as simple as a due date and a discount date and rate, or they can include payment schedules to allow for several installment payments.

All payment terms are defined in Accounts Receivable and assigned to A/R customer records, but you can change the terms on the Customer tab of the O/E Order Entry screen, O/E Shipment Entry screen, or O/E Invoice Entry screen before you post the invoice.

For detailed information about using terms codes, see the Accounts Receivable help.

**To change payment terms for an order, shipment, or invoice:**

1. Open **Order Entry > O/E Transactions**.
2. Select **Order Entry**, **Shipment Entry**, or **Invoice Entry**.
3. Enter the number of the transaction whose terms you want to change (you can manually enter a number, or you can select a number using the Finder). You cannot change the terms for a completed order, an invoiced shipment, or a posted invoice.
4. On the **Customer** tab, change the terms code or other payment terms as necessary.
5. Click **Post**.

**Managing Sales Splits**

Use the Sales Split tab to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by
default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

**To manage sales splits:**

1. Open **Order Entry > O/E Transactions**.
2. Select a transaction entry screen, such as **Order Entry**.
3. On the **Sales Split** tab, specify salespersons and commissions for a transaction:
   - **To add a salesperson** - add a new line, select a salesperson code, and then specify a commission amount for the salesperson in the **Percentage** column.
   - **To assign the transaction to another salesperson** - select a currently assigned salesperson, click the **Salesperson Code** Finder, and then select the salesperson to use.
   - **To delete a salesperson** - select the salesperson, and then press **Delete**.
4. Ensure that the amounts in the **Percentage** column add up to 100.
5. Enter remaining information and post the document.

**Order Types**

The type of order you are entering determines how the order is processed.
## Order Types

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Active     | An active order is an order that you expect to fill in a normal period of time. An active order may also contain items on backorder, or may be on hold. If the order is not on hold, you can post and print an invoice for shipped goods. | • **Inactive customers.** If a customer account or customer account set is inactive, you cannot enter an order for the customer. If a customer account becomes inactive after you enter an order, you will not be able to post updates to the order or post an invoice for the order until the account is made active again.  
• **On-hold orders.** You cannot ship any items for an on-hold order until you clear the **On Hold** option and post the order. Posting an order that is on hold has no effect on Inventory Control records. However, if you place an order on hold after it has been posted, it has the following effects:  
  • If an item is serialized, the **Allocated to OE Order** option is cleared for the item and serial number on the I/C Serial Numbers screen.  
  • If an item is lotted, the number in the **Quantity Reserved for Order** field is reduced for the item and lot number on the I/C Lot Numbers screen.  

Placing an order on hold automatically clears any serial numbers or lot numbers that have been allocated to the order quantity.  

If you are entering a new order and the customer's account has been placed on hold in Accounts Receivable, a message warns you that the order will be placed on hold in Order Entry. You can enter the order and post it, but you cannot ship items or create an invoice for the order until the customer's on-hold status is cleared in Accounts Receivable.  

To view orders currently on hold, you can print the Order Action report. |
| Future     | A future order is an order to be filled on a future date you specify. When you run | • **Day End Processing** automatically activates future orders on the order date (or the first time you run Day End processing after the order date). Alternatively, you can change the status |
### Chapter 2: Entering and Posting Order Entry Transactions

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day End Processing</td>
<td>Day End Processing on that date, the order is automatically activated and posted.</td>
<td>of a future order to Active before the order date. Day End Processing also posts the activated future orders so that sales statistics are updated. If you usually run Day End Processing at the end of the work day, future orders set to be activated on a certain day will not become active until the end of the day. To be sure a future order is ready to be processed on the day you planned, select an order date that is one day earlier than the date on which you want to use the order.</td>
</tr>
</tbody>
</table>
| Standing | A standing order is an order that is filled regularly for the same customer, or for different customers. | • **Currency for standing orders.** If you have a multicurrency system, you create standing orders in the currency of the tax group that applies to the customer. You can issue orders for other customers from the standing order only if the other customers use the same tax group and currency.  
  
  • **Placing active orders from standing orders.** To create an active order from a standing order, you must open the standing order and change the order type to Active or Future.  
  
  You can make any changes you require to the standing order, including changing the customer number, ship-to location, or template code if they use the same tax group.  
  
  You can enter a new order number if you assign numbers manually, or you can have the number automatically assigned by the program when you post the order.  
  
  When you create an active order from a standing order, the original standing order is retained in the system, unchanged and with the original order number, regardless of how many orders you create from it.  
  
  The order you create from the standing order displays the terms code and other information |
Quotes

Enter and post customer quotes in Order Entry.

Entering a Quote

You can use the O/E Order Entry screen to enter new quotes for customers.

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quote</td>
<td>A quote is an order with an expiration date. When you run Day End Processing on that date, the quote is removed from the system. If a quote is accepted by the customer before the expiration date, you can change the order type to Active to change the quote to an order. Quotes do not affect quantities on sales orders until you make them active.</td>
<td>maintained in Accounts Receivable for the customer number. If you use multicurrency accounting, you can assign a standing order only to a customer with the same currency as the standing order.</td>
</tr>
</tbody>
</table>

- **Reusing quotes.** To reuse a quote that you have previously converted to an order, add a new order for the customer using the From Multiple Quotes option.

- **Changing quotes to orders.** When you enter a quote, you enter the date on which the quote expires. Order Entry displays a default expiration date based on the number of days you specified on the O/E Options screen.

  To change the quote to an order, open the quote and change the order type to Active. Edit the order information as required, check tax statuses and order totals, and then post the order.

  If you do not change a quote to an order before the expiration date, Order Entry automatically removes the quote when you run Day End Processing.

  - If you selected the Clear Expired Quotes option and specified a number of days on the O/E Options screen, Order Entry deletes the expired quote from the system the next time you run Day End Processing after the specified delay.

  - If you do not select the Clear Expired Quotes option, expired quotes are not deleted.
Chapter 2: Entering and Posting Order Entry Transactions

**Note:** A quote does not affect quantities on sales orders until you set its order type to **Active**.

To enter a quote:

1. Open **Order Entry > O/E Transactions > Order Entry**.

   **Note:** If the O/E Order Entry screen is already open on an existing order, you can create a new order by clicking the New button to the right of the **Order No.** field.

2. Enter the order number to use for the quote, or accept *** NEW *** to have Order Entry assign the next available number when you post the quote.

   Order Entry assigns order numbers according to settings you specify on the Documents tab of the O/E Options screen. For more information, see "O/E Options Screen" (page 311).

3. Enter the customer number in one of the following ways:

   - Enter the number, and then press Tab.
   - Use the Finder to select the number.

   You can also create a new customer, look up customer information, and edit bill-to information for the customer.

   Using the buttons to the right of the **Customer No.** field, you can:

   - **Create a new customer.** Click the New button to create a new customer on the A/R Customers screen. When you finish, the new customer number appears in the **Customer No.** field.

   - **Check the customer's credit.** Click the Pre Credit Check button to check the customer's credit status before entering a transaction.

   - **Edit the customer's billing address.** Click the Zoom button to view and edit the customer's billing address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

   - **Look up information about the customer.** Click the Inquiry button to open the A/R Customer Inquiry screen to look up information about the customer.
4. On the Order Type list, select Quote. The Expiration Date field appears and displays the default expiration date based on the default number of days specified on the O/E Options screen.

5. Enter the expiration date.

**Note:**
- If you selected the Clear Expired Quotes option and specified a number of days on the O/E Options screen, Order Entry deletes the expired quote from the system the next time you run Day End Processing after the specified delay.
- If you do not select the Clear Expired Quotes option on the O/E Options screen, expired quotes are not deleted.
- If you do not change the quote to an order before the expiration date, Order Entry automatically removes the quote when you run Day End Processing.

6. Enter remaining information for the quote, including items and charges to be included. For more information about entering information and details, see "Entering an Order" (page 92). For more information about specific fields and controls on the O/E Order Entry screen, see "O/E Order Entry Screen" (page 389).

7. Click Post.

**After entering a quote**
- You can promote a quote to an active, standing, or future order. For more information, see "Promoting a Quote to an Order" (page 91).
- If you do not promote the quote to an order before the expiration date you entered, Order Entry automatically removes the quote the next time you run Day End Processing after that date.

**Creating a New Contract for a Quote in Project and Job Costing**

When entering a job-related quote in Order Entry, you can use the New Contract wizard to create a new contract by copying an existing one from Project and Job Costing.

The New Contract wizard copies the settings, projects, categories, and resources from the existing contract to the new contract.
You can choose whether to use original or current estimates, actual revenues and costs, or no amounts from the existing contract as the default estimate for the new contract.

You can also choose whether to use the same optional fields as the existing contract or use the default optional fields.

**To create a contract using the New Contract Wizard:**

1. On the O/E Order Entry screen, start a new order.
2. From the **Order Type** list, select **Quote**.
3. Select the **Job Related** option.
4. Click the **Contracts** button at the bottom of the O/E Order Entry screen.
5. On the Copy From tab:
   a. In the **New Contract Customer Number** field, enter the A/R customer number.
   b. If you want to assign this customer to all the projects in the new contract, select **Default New Contract Customer to Projects**.
   c. If you want to copy the settings, projects, categories, and resources from an existing contract to the new contract:
      i. In the **Existing Contract Number** field, specify the code for the contract whose settings you want to copy.
      ii. Specify the source for the new contract's default estimate. You can use the original estimate, the current estimate, actuals, or none of the amounts from the existing contract as the default estimate.
6. On the **Contract Number** tab, create a new contract number.
   Select a structure code, and then enter a number for each segment required for the contract number structure.
7. On the **Contract Style** tab, choose whether to create a basic contract or a standard contract.
8. On the **Optional Fields** tab, choose whether to copy the optional fields from the template contract, use the PJC default optional fields, or use no optional fields for this contract.
9. Click the **Finish** button to create the contract.
Promoting a Quote to an Order

You can use the O/E Order Entry screen to promote a quote to an active, standing, or future order.

For more information about order types, see "Order Types " (page 84).

**Note:** A quote does not affect quantities on sales orders until you set its order type to **Active**.

**To promote a quote to an order:**

1. Open **Order Entry > O/E Transactions > Order Entry**.
2. In the **Order No.** field, enter or select the quote number.
3. On the **Order Type** list, select **Active**.
4. Edit other fields on the quote as needed to update general information and details for the order.
   - For more information about entering information and details, see "Entering an Order " (page 92).
   - For more information about specific fields and controls on the O/E Order Entry screen, see "O/E Order Entry Screen" (page 389).
5. Click **Post**.

**After posting an order**

On the O/E Confirmation screen, select the documents that you want to print for the order:

- Order confirmation
- Shipment picking slip (if you are shipping goods)
- Invoice (if you are shipping goods and selected the option to create an invoice)
- Prepayment receipt (if you entered a prepayment for the order)

**Orders**

Use the O/E Order Entry screen to enter, edit, and post sales orders.
Chapter 2: Entering and Posting Order Entry Transactions

**Entering an Order**

You use the O/E Order Entry screen to enter new sales orders, and optionally to ship and invoice those orders.

You can also use the O/E Copy Orders screen to create a new order by copying the details from an existing order or a range of orders. For more information, see "O/E Copy Orders Screen" (page 654).

**Note:** For detailed information about fields and controls on the O/E Order Entry screen, see "Fields and Controls" in "O/E Order Entry Screen" (page 389).

**Before you start:**

Make sure you have complete information for the order, the items included, any miscellaneous charges, and currency exchange information if necessary.

- **Order information.** Make sure you have the following information for the order:
  - Customer number and customer type
  - Order number (if you assign document numbers manually)
  - Billing address (if it differs from the address in the customer record)
  - Order date and type
  - Location code
  - Price list
  - Tax group
  - Payment terms

- **Item information.** Make sure you have the following information for each item on the order:
  - Item number (you can also use the Finder to look this up on the detail line in the Detail table)
  - Price list
  - Unit of measure
  - Quantity
  - Unit price
• Location
• Item category

• **Miscellaneous charges.** If the order includes miscellaneous charges, make sure you have the following information for each charge:
  
  • Charge type
  • Dollar amount of the charge

• **Currency exchange information.** If the order involves multiple currencies, make sure you have the following information to use for each invoice and payment:
  
  • Exchange rate
  • Rate type
  • Rate date

**To enter a new order:**

1. Open **Order Entry > O/E Transactions > Order Entry**.

   **Note:** If the O/E Order Entry screen is already open on an existing order, you can create a new order by clicking the New button to the right of the **Order No.** field.

2. Enter the order number or accept ***NEW*** to have Order Entry assign the next available order number when you post the order.

   Order Entry assigns order numbers according to settings you specify on the Documents tab of the O/E Options screen. For more information, see "O/E Options Screen" (page 311).

3. Enter the customer number in one of the following ways:

   • Enter the number, and then press Tab.
   • Use the Finder icon to select the number.

You can also create a new customer, look up customer information, and edit bill-to information for the customer. Using the buttons to the right of the **Customer No.** field, you can:

   • **Create a new customer.** Click the New button to create a new customer on the A/R Customers screen. When you finish, the new customer number appears in the **Customer No.** field.
• **Check the customer's credit.** Click the Pre Credit Check button to check the customer's credit status before entering a transaction.

• **Edit the customer's billing address.** Click the Zoom button to view and edit the customer's billing address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

• **Look up information about the customer.** Click the Inquiry button to open the A/R Customer Inquiry screen to look up information about the customer.

4. On the Order tab, enter general information for the order.

   **Note:** For detailed information about the fields and controls on the screen, see "Fields and Controls" in "O/E Order Entry Screen" (page 389).

   a. If you use templates to assign default information to orders, select a template code.

   b. Enter a purchase order number, if the customer has one.

   c. Accept the default order date or enter the date to use.

   d. Enter the code for the inventory location from which you expect to ship items to fill the order.

   e. Select the order type. For more information, see "Order Types" (page 84).

   f. If you want to create a new order from multiple quotes, or to reuse quotes from which you have already produced an order:

      i. Click the Zoom button to the right of the From Multiple Quotes option.

      ii. In the Create Order From Quotes screen that opens, either enter quote numbers in the Quote Number column or select quotes using the Finder.

      iii. When you have selected all the quotes you need, click Order to add the details to the order.

      iv. Click Close.

   g. If the order is job related (that is, if it relates to a project that you are managing using Project and Job Costing):
i. Select **Job Related**. When you select this option, additional columns appear in the Detail table so you can enter job-related information for each detail line.

ii. If you want Project and Job Costing to handle all invoicing for the order, select **Project Invoicing**.

iii. If retainage applies to the order, select the **Retainage** option. (You specify how to process the retainage amount on the **Retainage** tab.)

h. Enter the location to which the order will be shipped.

i. Enter the date you expect to ship the order.

j. If you want Order Entry to calculate tax automatically for the order, select **Calc. Tax**.

k. If you want to place the order on hold, select **On Hold**, and then enter the reason you are placing it on hold. This option is selected automatically if the customer for which you are creating the order is on hold.

l. If you are editing an order for which you have already shipped goods and you want to create an invoice, select **Create Invoice** to create an invoice when you post the order.

m. Enter a description and reference information for the order, if applicable.

5. On the Detail table, add items and miscellaneous charges for the order.

Add a new detail line by pressing **Insert**.

You can move through the columns in the table by pressing **Tab**.

**Tip:**
- To open a separate detail entry screen to view and change information for a selected detail, click **Items/Taxes**.
- Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed. Inventory quantities are displayed in the unit of measure defined for the item.

If the item entered is serialized and/or lotted, you use the O/E Serial/Lot Numbers Allocation screen or the O/E Serial/Lot Numbers Generation screen.
to allocate or generate serial or lot numbers. For more information, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

For more information about table fields, see "Fields and Controls" in "O/E Order Entry Screen" (page 389).

6. On the Customer tab, review and edit customer information such as tax code, price list, and payment terms.

On the Customer tab, you can specify:

- Shipping method
- Tracking number if sending by courier or registered mail
- Optional FOB (free-on-board) location
- Optional territory code
- Customer type (this specifies whether the customer is eligible for discounts or special pricing)
- Price list to use to select prices for item details
- Tax group
- Customer account set
- Payment terms that will be used for invoices from this transaction
- Due date and discount terms

7. On the Taxes tab, select the method you will use to calculate taxes, and review and change tax information.

On the Taxes tab, you can:

- Specify whether taxes are calculated manually or automatically.
- Select automatic tax calculation for tax reporting (if you report taxes in a different currency), or enter the tax reporting amounts manually.
- Review the tax information that applies to the transaction.
- Change the customer tax class for the document.

Tip: To change the tax status of an item, click the Items/Taxes button on the Order tab.

- Enter the tax base and tax amount, if you are entering taxes manually.
Orders

- Enter or edit the customer's tax exemption number.
- Automatically prorate tax amounts for individual details on the document.

For information about entering and distributing tax amounts manually, see "Entering and Distributing Tax Amounts" (page 182).

8. If you use optional fields, enter information in the fields that appear on the Optional Fields tab.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

9. On the Sales Split tab, assign or credit a salesperson for the order.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The
Chapter 2: Entering and Posting Order Entry Transactions

amounts in the Percentage column must total 100 (or 0 if you do not assign salespeople to the transaction).

10. If you use multicurrency accounting, review and edit currency exchange rates on the Rates tab if necessary.

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

If you are shipping goods, you can also change the rate information for converting the shipped amount from customer's currency.

The Rates tab can show the following groups of exchange rate information:

- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer’s currency to your company’s functional currency.
- If you are shipping goods, change rate information for converting the shipped amount from customer’s currency.
- If you are invoicing shipped goods, change rate information for the invoice.
- If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.
Orders

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

11. On the Totals tab, review and edit discounts, totals, and other final document details.

On the Totals tab, you can:

- Verify totals and discounts before posting an order.
- Check the total estimated weight of items ordered.
- Specify whether any discounts apply to miscellaneous charges.
- Specify the number of labels you want to print for an order.
- Automatically create an invoice for the shipped items when you post the order.
- Enter a comment for the order.

**Tip:** If you are shipping any goods, select the **Create Invoice** option on the Totals tab to create an invoice for the shipped quantities when you post the order. (This option appears after you enter a quantity shipped for one or more items.)

12. If you use Payment Processing and you want to pre-authorize a credit card payment for the order, click **Pre-authorize**.

The O/E Pre-authorization screen appears. For more information about using this screen, see "Pre-authorizing a Credit Card Payment" (page 144).

13. If you want to enter a prepayment for the order, click **Prepayment**. For more information, see "Entering a Prepayment " (page 109).

**Note:** If you use Payment Processing, you can process a credit card payment on the O/E Prepayments screen.

14. If you are adding a job-related quote and you want to create a new contract in Project and Job Costing, click **Contracts** to open the New Contract Wizard.
Chapter 2: Entering and Posting Order Entry Transactions

The New Contract Wizard copies the settings, projects, categories, and resources from the existing contract to the new contract, and allows you to specify various settings for the new contract.

**Note:** When you post the quote, all details that you entered for the quote will update the contract estimates in Project and Job Costing.

15. Click **Post**.

   The order is posted, and the O/E Confirmation screen appears.

**After posting an order**

On the O/E Confirmation screen, select the documents that you want to print for the order:

- Order confirmation
- Shipment picking slip (if you are shipping goods)
- Invoice (if you are shipping goods and selected the option to create an invoice)
- Prepayment receipt (if you entered a prepayment for the order)

**Editing an Order**

Before posting an active, future, or standing order, you can change it, cancel parts of it, or cancel the whole order.

After you post an order, you can change any part of the order except the order number, customer number, and any completed detail lines.

- You can add new detail lines to an order at any time—even if the order is completely shipped and invoiced.
- You can delete detail lines, provided no items on the order have been shipped.
- You can change the outstanding amounts of any detail lines that are partially shipped.
- If you use multicurrency accounting, you can change the tax group to another tax group that uses the customer's currency.

If you use Payment Processing and have pre-authorized a credit card payment, you can also capture (process payment for) the pre-authorization
Orders

before posting it. For more information, see "Capturing a Pre-authorized Credit Card Payment" (page 147).

To edit an existing sales order:

1. Open Order Entry > O/E Transactions > Order Entry.
2. Enter the number of the order you want to edit (you can manually enter a number, or you can select a number using the Finder Q).
3. Make changes as needed. You can revise all information entered for the order except the order number, the customer number, and the Job Related option.

For example, you can:

- Add lines
- Delete lines (unless you have shipped any quantities of any items)
- Change item quantities
- Change prices
- Add comments or instructions
4. Click Post.

Note: If you increase the quantity backordered on a shipment for a fully shipped order, Order Entry sets the order status to Incomplete.

Adding Comments and Instructions to Order Entry Transactions

On Order Entry transaction entry screens, you can add comments for customers and instructions for your staff.

- Comments appear on printed quotes, order confirmations, invoices, credit notes, and debit notes. You can add comments for each document, and for individual details included in a document.
- Instructions appear only on picking slips. You add instructions for individual details included in a document.

To add comments to a transaction:

1. Open Order Entry > O/E Transactions.
2. Select a transaction entry screen, such as Order Entry.
3. Select a transaction, and then click the Totals tab.
Chapter 2: Entering and Posting Order Entry Transactions

4. In the **Comment** field, enter comments.

5. Enter remaining information for the document, and then click **Post**.

Comments you entered appear in the **Comments** section on printed documents (such as quotes, order confirmations, and invoices).

**To add comments or instructions to a detail:**

**Directly in the Detail Line**

1. Select a detail line, and then open the O/E Detail Comments/Instructions screen in one of the following ways: Click the Comments/Instr. column header. Click in the Comments/Instr. field, and then press Ctrl+Shift+F9.

2. In the **Type** field, specify the type of information you are entering (Comment or Instruction).

3. Enter comments or instructions. You can enter up to 80 characters per line. To start a new line, press Tab or Enter.

4. Click **Close**.

Comments you entered appear in the **Description** column on printed documents, directly below the description for each item or miscellaneous charge.

Instructions you entered appear in the **Description** column on printed picking slips.

**On the O/E Items/Taxes screen (which displays all fields for the detail line in a single screen)**

1. Select a detail line.

2. Click **Item/Tax**.

3. Click the Zoom button to the right of the **Comments/Instructions** option.

4. In the **Type** field, specify the type of information you are entering (Comment or Instruction).

5. Enter comments or instructions. You can enter up to 80 characters per line. To start a new line, press Tab or Enter.

6. Click **Close**.
Comments you entered appear in the **Description** column on printed documents, directly below the description for each item or miscellaneous charge.

Instructions you entered appear in the **Description** column on printed picking slips.

**Canceling Backordered Quantities on an Order**

Before posting an active, future, or standing order, you can change it, cancel parts of it, or cancel the whole order.

After you post an order, you can change any part of the order except the order number, customer number, and any completed detail lines.

- You can add new detail lines to an order at any time—even if the order is completely shipped and invoiced.
- You can delete detail lines, provided no items on the order have been shipped.
- You can change the outstanding amounts of any detail lines that are partially shipped.
- If you use multicurrency accounting, you can change the tax group to another tax group that uses the customer's currency.

**To cancel backordered quantities:**

1. Open **Order Entry > O/E Transactions > Order Entry**.
2. Enter the number of the order you want to edit (you can manually enter a number, or you can select a number using the Finder Q).
3. Select the detail line that you want to cancel, and then enter 0 (zero) in the Quantity Backordered field. When you post the order, Order Entry records the line amount (in the Quantity Ordered field) as lost sales.
4. Click **Post**.

**Note:** If you increase the quantity backordered on a shipment for a fully shipped order, Order Entry sets the order status to **Incomplete**.

**Using the New Contract Wizard**

If you are creating a job-related quote in Order Entry, you can use the New Contract wizard to create a new contract in Project and Job Costing by copying an existing one.
Chapter 2: Entering and Posting Order Entry Transactions

The wizard copies the settings, projects, categories, and resources from the existing contract to the new contract. The wizard also lets you choose to use original or current estimates, actual revenues and costs, or no amounts from the existing contract as the default estimate for the new contract. You can also choose whether to use the same optional fields as the existing contract or the program default optional fields.

**Note:** When you add job-related detail lines to a quote, the detail lines must be applied to projects with an Estimate status. Quote amounts appear as estimates in the new contract.

**To use the New Contract Wizard:**

1. Open **Order Entry > O/E Transactions > Order Entry**.
2. On the O/E Order Entry screen, start a new order and select the following:
   In the Order Type field, select Quote. Select the Job-Related option.
3. Click **Contracts**.
4. Enter a new contract number (you can use the **Contract Number** tab to help you do this), and specify the number of the contract that you are copying to create this new contract.
5. On the **Contract Style** tab, choose whether you want to create a basic contract or a standard contract.
6. On the **Optional Fields** tab, choose whether you want to copy the optional fields from the template contract, use the PJC default optional fields, or use no optional fields for this contract.
7. Click **Finish** to create the contract.

**Copying Orders**

Use the O/E Copy Orders screen to select an existing order, or a range of orders, from which to copy information and details to create a new order.

Details from the source orders appear as defaults for the new order, including item numbers, quantities ordered, pricing, and other information.

You can select the details you want to use in the new order, and you can change the price list, location, ship date, quantity ordered, unit of measure, and unit price for any detail line.
To create a new order from one or more existing orders:

1. Open Order Entry > O/E Transactions > Copy Orders.

   **Note:** You can also open this screen directly from the O/E Order Entry screen, by copying a posted order that is open in that screen. If you do this, information for the order being copied is automatically entered in the O/E Copy Orders screen.

2. Enter information about the source order(s).

   a. In the **From Customer Number** field, enter the number of the customer whose order details you want to copy.

   b. In the **From Order Number** and **To Order Number** fields, specify the range of existing orders from which to copy information.

   c. Select an order type.

   d. If the source orders are job related, select **Job Related**.

      **Note:**
      - You can copy details from an active job-related order to a new order, but not to a new quote.
      - You can copy details from a job-related quote to a new quote.

   e. If the source orders use project invoicing, select **Project Invoicing**.

3. Enter information about the customer for which you are creating the order.

   a. In the **To Customer Number** field, enter the number of the customer for which you are creating the new order.

   b. If the customers are different and have different tax groups, specify the tax group for the new order, or verify the default selection.

   c. If the customers use different currencies, specify the price list to use for the details in the new order.

      **Note:**
      - You can change prices for the new details after creating the order.
      - If the original order uses a currency with more decimal places than the new order, the program will display an error message if the order contains miscellaneous charges.

4. Click the Go
Chapter 2: Entering and Posting Order Entry Transactions

button.

Details from the order or orders you selected appear in the Copy Orders Detail table.

5. On the Copy Orders tab, enter information about the new order you are creating.

   a. In the **Order Number** field, enter a number for the new order you will create, or leave the default value ***NEW*** in the field if you want Sage 300 ERP to assign a new order number.

   b. Enter the date for the order. For a future order, enter the date that the order becomes active.

   c. If you want to place the new order on hold, select **On Hold**.

   **Note:** If the customer account is on hold in Accounts Receivable, the order is automatically placed on hold. You can enter the order and post it, but you cannot ship items or produce an invoice for the order until you clear the customer’s on-hold status.

   d. Select the type of order you want to create: Active, Future, Standing, or Quote. For more information about order types, see "Order Types" (page 84).

   e. Enter a description for the order.

   f. Enter optional reference information for the order.

   **Note:** The reference information you enter here appears in Accounts Receivable as the reference for the invoice. It may also appear in the General Ledger batch, depending on your system settings. For more information, see Accounts Receivable and General Ledger help.

   g. If you use retainage accounting and are copying job-related orders, you can select this option to indicate that retainage applies to the order you are creating.

   **Note:** The **Retainage** option is not available if you are copying orders that use project invoicing (where invoicing is handled through Project and Job Costing).

106 Sage 300 ERP Order Entry
6. If the Optional Fields tab appears, enter information about the new order you are creating. For more information, see "About Optional Fields" (page 58).

7. In the Copy Orders Detail table, select detail lines to include in the new order, and edit information for each detail line as necessary. For more information about editing details, see "O/E Copy Orders Screen" (page 654).

Note: If you need to assign serial or lot numbers to detail items, see "Allocating Serial Numbers or Lot Numbers to Items in Copied Orders " (page 174).

8. Click Create to create the new order.

After copying an order or orders
Use the O/E Order Entry screen to review, edit, and post the order.

Prepayments

Enter prepayments for active orders, future orders, and shipments.

About Prepayments

You can enter as many prepayments as you wish to active orders, future orders, and shipments. You can also enter one prepayment for each invoice you produce. The prepayment information is printed on the transaction lists and the posting journals.

If you use Payment Processing, you can process a credit card prepayment for an order, shipment, or invoice. You can also pre-authorize a credit card payment for an order, and then capture the payment when you ship the order. For more information, see "Entering a Prepayment " (page 109).

You can see the total prepayment amount on the Totals tab, and you can print prepayment details on the order, shipment, and invoice transaction lists and on the Invoice Posting Journal.

Once you enter and post a prepayment, you cannot change it in Order Entry. If you need to change the amount of the prepayment (or other information), you must adjust the receipt in Accounts Receivable.

Selecting the Accounts Receivable Batch

When you enter a prepayment, you can select an existing Accounts Receivable receipt batch, or you can create a new receipt batch in which to include the
prepayment. If you select an existing batch, Order Entry checks the batch status. If the batch is not available (for example, if it has been deleted or posted), Order Entry displays a message to notify you of the problem.

If you create a new batch, Accounts Receivable assigns the batch number. You enter the description, date, and bank code.

**Choosing the Deposit Number**

When you create a new receipt batch, you assign a deposit number to the batch, as follows:

- **New deposit number.** Click the New button beside the Deposit Number field to let the program assign the next deposit number.

- **Existing deposit number.** Use the Finder to select an existing deposit number (for example, to consolidate a number of receipt batches into one bank deposit).

If you leave the field blank, the program assigns the next deposit number when you add the first receipt to the batch.

**Note:** After adding the first receipt to the batch, you can no longer edit the deposit number.

**Prepayments on Invoices**

If you enter a prepayment for an invoice, the amount of the prepayment is displayed in the Totals tab before you post the invoice. The amount of the prepayment is included in the credit limit check for the customer, and it immediately reduces the amount due on the invoice you print from Order Entry. Note, however, that the amount is not added to the order prepayment amount kept with the order.

If you use Payment Processing, you can process a credit card prepayment for an invoice. For more information, see "Processing a Credit Card Prepayment " (page 112).

**Prepayments on Orders and Shipments**

If you are not invoicing the order or shipment, the prepayment total for the document is displayed on the Totals tab. The prepayment total is included in the credit limit check for the customer, but it does not reduce the amount of the next invoice you create. You can see the total prepayments to date on the Totals tab.
Prepayments on orders and shipments are matched to invoices in Accounts Receivable using the order number.

If you use Payment Processing, you can use Order Entry screens to pre-authorize, capture, and process credit card payments as follows:

- Use Order Entry to pre-authorize or process a credit card prepayment, or to capture a pre-authorized prepayment for an order.
- Use Shipment Entry to capture a pre-authorized credit card payment, or to process a new credit card prepayment for a shipment.
- Use Invoice Entry to process a credit card prepayment for an invoice.

For more information, see "Processing a Credit Card Prepayment" (page 112) and "Pre-authorizing a Credit Card Payment" (page 144).

**Prepayments on Job-Related Orders and Invoices**

If you are entering a prepayment for a job-related order, shipment, or invoice, you must also distribute the prepayment to individual order/invoice detail lines.

Click the Jobs button on the O/E Prepayments screen to display the Prepayment Details screen for job-related orders, shipments, and invoices. You can manually distribute the payment amount to job details, or you can let the program prorate payment amounts to details or allocate the payment starting with the first detail (top-down method).

**Multicurrency Prepayments**

If you use multicurrency accounting, you also specify the currency of the prepayment. If you select an existing batch, the batch currency must match the prepayment currency.

If you select another batch with a different currency after saving a prepayment, the program clears the receipt amount. You must re-enter the information.

**Entering a Prepayment**

You can enter one or more prepayments for an active order, a future order, or a shipment. You can also enter one prepayment for each invoice you produce.

You can review prepayment information in the Prepayments fields on the Totals tab of a document. You can also print prepayment details on the order, shipment, and invoice transaction lists, and on the invoice posting journal.
• An invoice prepayment immediately reduces the amount of the invoice.
• Prepayments entered for orders and shipments appear on the Totals tab of the invoice, but they do not reduce the amount of the invoice.

**Note:** Prepayments entered for orders are matched to invoices in Accounts Receivable by order number.

• If you use Payment Processing, you can process a credit card prepayment using the O/E Order Entry, O/E Shipment Entry, or O/E Invoice Entry screen. You can also pre-authorize a credit card payment for an order, and then capture the payment when you ship the order.

After you enter and post a prepayment, you cannot change it in Order Entry. If you need to change the amount of the prepayment (or other information), you must adjust the receipt in Accounts Receivable.

**Before you start:**
• Find out which Accounts Receivable receipt batch to use for the prepayment.
• Find out which deposit number to use for the prepayment. You can look up the bank code and deposit number when you enter the receipt.

Once a default deposit number has been assigned to the receipt batch, you cannot use a different one in Order Entry.

**To enter a prepayment:**
1. Open **Order Entry > O/E Transactions**.
2. Open **Order Entry, Shipment Entry, or Invoice Entry**, and then create or select a transaction.
3. Click the **Prepayment** button.
4. On the O/E Prepayments screen, create or select a receipt batch for the prepayment you are entering.
   a. In the **Batch Number** field, select an existing receipt batch for the prepayment you are entering, or click the New button to create a new batch.
   b. If you are creating a new batch, enter the batch date.
   c. If you use multicurrency accounting, select the bank code and currency.
d. Select a deposit number, or click the New button to create a new deposit.

**Tip:** If you want to consolidate multiple receipt batches into a single bank deposit, select an existing deposit number.

5. Enter payment details. If you use Payment Processing and want to process a credit card prepayment, you must also enter a processing code.

a. In the **Payment Code** field, select a payment code.

**Note:** If you want to use Sage Payment Solutions to process a credit card prepayment, select a payment code that uses the payment type SPS Credit Card.

**Tip:** Click the Finder to see a list of payment codes and associated payment types.

b. If you are processing a credit card prepayment, select a processing code that will be used to process the credit card transaction.

**Note:** The bank and currency for the processing code you select must match the bank and currency for the current transaction.

c. In the **Check/Receipt No.** field, enter the check number if payment is by check.
   
   - If the payment is not by check, you can enter a reference number.
   
   - If you leave the field blank, Order Entry assigns a number that consists of the batch number and the entry number.

d. Enter the receipt date.

e. In the **Receipt Amount** field, enter the amount of the prepayment.

f. If you use multicurrency accounting, enter bank rate information. For more information about these fields, see "O/E Prepayments Screen" (page 489).

g. If the document for which you are adding a prepayment is job related, click the **Jobs** button to open the O/E Project and Job Costing Apply Details screen and distribute payment amounts to job details. For more information, see "O/E Project and Job Costing Apply Details Screen" (page 445).
6. Click **Add** to add the prepayment.

   If you use Payment Processing and you selected a payment code that uses the payment type SPS Credit Card, the **Charge** button becomes available.

7. If you want to process a credit card payment, click **Charge** and use PMT Process Credit Card screen to process the credit card payment.

8. Close the O/E Prepayments screen.

**After entering a prepayment**

If you processed a credit card payment for a transaction that has not been posted, and the transaction has not been settled in Sage Payment Solutions, you can void the payment. For more information, see "Voiding a Credit Card Prepayment " (page 114).

**Processing a Credit Card Prepayment**

If you use Payment Processing, you can use the O/E Prepayments screen to process a credit card prepayment.

**Before you start:**

- Sage Exchange must be installed and running on the workstation you are using to process the prepayment. For more information, see Payment Processing Help.

- You must have a working Internet connection.

**To process a credit card prepayment:**

1. Open **Order Entry > O/E Transactions**.

2. Open **Order Entry, Shipment Entry**, or **Invoice Entry**.

3. Click the Prepayment button, and then enter and add a prepayment. For more information, see Entering a Prepayment. You must select a payment code that uses the payment type SPS Credit Card, and you must select a processing code for the transaction. After you add the prepayment, the Charge button becomes available.

4. Click **Charge**.

   The PMT Process Credit Card screen appears. If a default credit card exists in the customer record that uses the processing code selected for the current transaction, that credit card is selected by default.
5. Specify a credit card.
   - To select a saved credit card, use the Finder

   - To enter details for a new card and save the card in the customer record, click the New button, and then add the card details on the A/R Credit Card Information screen.

   - To enter details for a new credit card that will not be saved in the customer record, select Enter a Card for One-Time Use. (You enter card details on the Sage Payment Solutions browser form after you click the Process Pre-authorization button.)

6. Enter or review billing details. These may be different from the information in the Sage 300 ERP customer record. For example, the customer may be using a company credit card, or may be authorized to use a card on behalf of the primary cardholder.

   Tip: When entering billing details, you can select the Same as Customer Address option to fill in billing details with name and address information from the customer record.

7. Review totals.

   Note: For some transactions, you can edit the amount in the Taxes field in order to comply with Level 2 processing requirements. When you edit this amount, the amount in the Subtotal field is calculated automatically by subtracting the taxes you entered from the transaction total.

8. Click Process Payment.

   The Sage Payment Solutions browser form appears.

9. Review or enter credit card details.
   - If you use a card reader device and did not select a saved credit card for this transaction, you can click Swipe Card to swipe a credit card.
   - If you want to review these details, click the Next button on the browser form.

10. Click Submit.

    Sage Payment Solutions processes the payment. The browser form closes, and transaction details and a status message appear on the PMT Process Credit Card screen.
11. On the PMT Process Credit Card screen, review transaction details and status.

12. Click Close to close the PMT Process Credit Card screen.

13. Post or save the document.

**Voiding a Credit Card Prepayment**

If you want to void a credit card prepayment in Order Entry, you must do so before posting the order, shipment, or invoice. After you post, the prepayment is cleared and posted to Accounts Receivable, and can be voided only in Accounts Receivable.

If a credit card payment has not been settled in Sage Payment Solutions, you can void the transaction in Sage 300 ERP or by signing in to Sage Virtual Terminal.

If a transaction has been settled in Sage Payment Solutions, it cannot be voided. If you want to refund a settled transaction, you must use the Refund Entry screen in Accounts Receivable.

**Before you start:**

- A credit card payment must have been processed, but not settled by Sage Payment Solutions. Transactions are typically settled within 24 to 48 hours.

- Sage Exchange must be installed and running on the workstation you are using to void the payment.

- You must have a working Internet connection.

**To void a credit card prepayment:**

1. On the O/E Order Entry, O/E Shipment Entry, or O/E Invoice Entry screen, select a document for which a credit card prepayment has been processed. You can void a prepayment in Order Entry only if the document has not been posted. If the document has been posted, you must void the prepayment in A/R Receipt Entry.

2. Click Prepation.

   The O/E Prepayments screen appears.
3. Click **Void**.

Sage 300 ERP checks Sage Payment Solutions to determine whether the transaction has been settled.

- If the transaction has been settled in Sage Payment Solutions, an error message informs you that the transaction cannot be voided. If you want to refund the transaction, you must use the Refund Entry screen in Accounts Receivable.
- If the transaction has not been settled, the PMT Process Credit Card screen appears. The credit card that was used for the payment is selected.

4. Click **Void Sale**.

Sage Payment Solutions voids the payment.

### Shipments and Invoices

Create shipments and invoices for orders in Order Entry.

**About Credits on Invoices**

You can enter credit amounts on invoice detail lines for returned items or to reverse miscellaneous charges, providing the order is incomplete.

**Credit For a Returned Item**

To enter a credit for a returned item, enter a negative quantity in the *Qty. Invoiced* field before posting an invoice.

Order Entry calculates the extended price of the item as a negative amount.

Credit amounts entered on invoices are included with other invoice data on the Invoice List. They do not appear on the Credit Note List.

**Note:** When you post the invoice, the quantities on hand in Inventory Control are adjusted.

**Costs Of Returned Items**

The costs of the returned items are adjusted when you run Day End Processing in Inventory Control.

Although you can enter a detail line with a negative quantity shipped, Order Entry does not allow you to post an order or invoice with a negative total.
About Customer Payment Schedules

Payment terms can be as simple as a due date and a discount date and rate, or they can include payment schedules to allow for several installment payments.

Payment schedules appear on the Customer tab of the Invoice Entry screen when you use a terms code that has been set up to use a multiple payment schedule.

All payment terms are defined in Accounts Receivable, but you can change the terms for an order or an invoice on the Customer tab of the Invoice Entry screen.

Invoicing Shipments

You can use the O/E Order Entry screen or the O/E Shipment Entry screen to invoice goods as you ship them, or use the O/E Invoice Entry screen to invoice goods at any time.

When you are creating orders or shipments (on the O/E Order Entry screen or the O/E Shipment Entry screen), you can create invoices automatically.

You can also create invoices on the O/E Invoice Entry screen, which gives you more control over invoice creation. For example, you can:

- Edit more details, including customer information, tax information, prices, discounts, sales splits, optional field information, and currency exchange rates.
- Select one or more shipments to invoice.

**Note:**

- All shipments in a single invoice must be either job-related or non-job-related.
- You cannot invoice job-related shipments that use the Project Invoicing option in Order Entry. These shipments are invoiced in Project and Job Costing.

Before you start:

- If you use Payment Processing, you must use the O/E Order Entry screen or the O/E Shipment Entry screen to capture or void any pre-authorized credit card prepayments for an order or shipment before creating an invoice. (You cannot post a shipment if it has any outstanding credit card pre-
To invoice goods when shipping:

1. Open Order Entry > O/E Transactions.
2. Open Order Entry or Shipment Entry.
3. Enter an amount in the Qty. Shipped field for at least one detail line.
4. On either the main screen or the Totals tab, select the Create Invoice option.
5. On the Totals tab, review invoice information.
   a. Enter an invoice number if you do not want one to be assigned automatically.
   b. Change the invoice date if you want to use a date other than the current date.
6. Click Post.

   **Note:** To print the invoice, verify that the Invoice option is selected on the O/E Confirmation screen that appears after posting. You can also print order confirmations, shipment picking slips, and prepayment receipts.

To invoice one or more shipments using the O/E Invoice Entry screen:

1. Open Order Entry > O/E Transactions > Invoice Entry.
2. In the Invoice No. field, enter an invoice number, or leave *** NEW *** if you want Order Entry to assign a new number when you post the invoice.
3. In the Customer No. field, enter a customer number.

   If you need to create a new customer, edit customer information, or find more information about the customer, use the buttons to the right of the Customer No. field.

   Using the buttons to the right of the Customer No. field, you can:

   - **Create a new customer.** Click the New button to create a new customer on the A/R Customers screen. When you finish, the new customer number appears in the Customer No. field.
   - **Check the customer's credit.** Click the Pre Credit Check button to check the customer’s credit status before entering a transaction.
Chapter 2: Entering and Posting Order Entry Transactions

- **Edit the customer's billing address.** Click the Zoom button to view and edit the customer's billing address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

- **Look up information about the customer.** Click the Inquiry button to open the A/R Customer Inquiry screen to look up information about the customer.

4. Select one or more shipments from which to create the invoice.

   - If you are invoicing a single shipment, enter the number in the **Shipment Number** field.

     **Tip:** To view shipment details, click the **Shipment Number Drilldown** button.

   - If you are invoicing multiple shipments, select the **From Multiple Shipments** option, and then click the Zoom button to select shipments on the O/E Create Invoice from Shipments screen. For more information, see "O/E Create Invoice from Shipments Screen" (page 609).

     Information from the shipments you select appears on the O/E Invoice Entry screen, where you can review and edit it as necessary.

5. On the Invoice tab, review and edit general information for the invoice.

   a. Enter the invoice date and posting date (if different).

      **Note:** The posting date is the date you use for posting the transaction in General Ledger, and determines the year and period to which the transaction is posted.

   b. In the **Location** field, verify that the inventory location from which you shipped the items is selected.

   c. Review ship-to information for the invoiced shipment or shipments, and edit if necessary.

   d. Verify that the correct options are selected for tax, project and job costing, project invoicing, and retainage. For more information about these options, see "O/E Invoice Entry Screen" (page 562).

   e. Enter a description and reference information for the invoice.
6. Review invoice details and edit if necessary. You can edit each invoice detail in the table, or click the **Item/Tax** button to edit the detail on the O/E Items/Taxes screen.

   For each detail, you can edit the following information:
   - Quantity invoiced
   - Unit price
   - Extended price
   - Discount percentage or discount amount
   - Ship-via method and tracking number
   - Customer item number
   - Comments and instructions

   **Note:** If you need to change tax information for a detail, use the O/E Items/Taxes screen.

7. On the other tabs on the O/E Invoice Entry screen, review and edit information as needed.
   a. If you use optional fields, enter information on the Optional Fields tab.
   b. On the Customer tab, review payment terms and adjust any discounts or scheduled payments associated with the terms code.
   c. If you are invoicing several shipments, use the Sales Split tab to verify that the sale is allocated correctly. If the shipments used various sales splits, you must change the allocation manually.
   d. On the Rates tab, verify that exchange rate information is correct.
   e. On the Taxes tab, check the tax class and the tax registration number for the customer. If you are entering taxes manually, you can adjust the tax base and tax amount, if necessary.

      If the tax currency differs from the customer currency, you can enter a reporting tax amount or let the program calculate it automatically.
   f. On the Totals tab, check the totals for the invoice.

8. Post the invoice.
Chapter 2: Entering and Posting Order Entry Transactions

**Note:** To print the invoice, verify that the **Invoice** option is selected on the O/E Confirmation screen that appears after posting. You can also print order confirmations, shipment picking slips, and prepayment receipts.

**Important!**
When you try to post an invoice that will put a customer account over its credit limit, Order Entry displays a warning message and the following customer information:

- Credit limit
- Outstanding Accounts Receivable balance
- Order amount
- Last invoice amount and date
- Last payment amount and date

If you use security, you or your supervisor must enter a user ID and password to approve credit before you can post the invoice.

If you are not authorized to override the credit limit, or if you want to put the order on hold for later invoicing, select **On Hold**. If an order is on hold, you can post the order but you cannot ship goods and produce an invoice until you clear the on-hold status.

**Shipping Orders and Items**

You can enter shipped quantities on the O/E Order Entry screen or on the O/E Shipment Entry screen.

In other words, you can:

- Use the O/E Order Entry screen to create orders and ship them in one step—even generating the invoice at the same time.
- Skip the Order Entry phase entirely and use the O/E Shipment Entry screen to enter shipments directly—and optionally generate the invoice at the same time.

**Note:** If you use Payment Processing and you selected the **Require Capture of Pre-authorized Payments at Shipment** option on the PMT Options screen, you must process or void all pre-authorized credit card transactions before you can ship the orders for which the pre-authorizations exist.
To enter shipped quantities on the O/E Order Entry screen:

1. Open Order Entry > O/E Transactions > Order Entry.
2. Select an existing order or create a new one.

   a. If you are entering shipped quantities for an existing order, enter the order number, or select it using the Finder.

   b. If you are creating a new order, press the Tab key in the Order No. field to accept *** NEW *** as the order number, and then enter the customer number.
3. On the Order tab, enter general order information.

   For complete instructions on entering a new order, see "Entering an Order" (page 92).

   To enter general order information:

   • On the Order Type list, select Active.

   • If your company uses templates to fill in default field entries, select a template.

   • If the customer has a purchase order number, enter the number.

   • Select the warehouse location from where you are shipping goods. The default location can come from the customer record or order template. You can change it for the transaction, and for each detail line.

   • If the customer wants goods shipped to a particular location, use the Ship-To Location Finder to select it. You can click the Zoom button to edit the ship-to location, or click the New button to add one to Accounts Receivable.

   • If the transaction is job related, select the Job Related option. For more information on job-related options, see "O/E Order Entry Screen" (page 389).

   • If you want Order Entry to calculate tax automatically for the transaction, select the Calc. Tax option.

   • Enter a description and reference information if applicable.

4. To ship all outstanding items on the order, click the Ship All button.
To ship items for some detail lines on the O/E Order Entry screen:

1. Open Order Entry > O/E Transactions > Order Entry.
2. Enter the order number, or select it using the Order No.Finder Q.
3. Select a line for which you want to enter shipped quantities.

   The number of items available at the selected location and for all locations appears in the inventory quantities area below the Detail table.

   **Tip:** If you want to view all fields for the selected detail on the O/E Items/Taxes screen, rather than in the Detail table, press F9 or click the Item/Tax button.

4. In the Qty. Shipped field, enter the number of items that you want to ship.
5. If you use backorder quantities, tab to the Qty. B/O field and update it as required.
6. If you want to add a prepayment to the order, click the Prepayment button. If you use Payment Processing, you can also process a credit card prepayment for the order.
7. On the Totals tab, check the totals for the order. If you want to automatically create an invoice for shipped quantities, select the Create Invoice option on the Totals tab.
8. Post the document.

To ship items for one or more orders on the O/E Shipment Entry screen:

1. Open Order Entry > O/E Transactions > Shipment Entry.
2. In the Shipment Number field, press the Tab key to accept *** NEW *** as the shipment number.

   Order Entry will assign a shipment number when you post the shipment. If you do not want Order Entry to assign the number automatically, you can type the new number yourself, and then press the Tab key.
3. Enter the customer number or select it using the Customer No.Finder Q.

   **Tip:** You can skip this field and use the Order NumberFinder Q to select by order number, PO number, salesperson, customer number, etc.

   If you enter a customer number, you can also:
• Click the Pre Credit Check button beside the **Customer No.** field to check the customer's credit status and determine whether you should continue with the shipment.

• Click the Zoom button beside the **Customer No.** field to view or edit customer address and contact information.

On the Customer tab, you can change customer information such as tax code, price list, and payment terms.

4. Select the order(s) for which you are creating the shipment.

• If you are shipping goods for a single order, type the order number or select it using the Finder.

• If you are shipping goods from multiple orders, select the **From Multiple Orders** option, and then click the Zoom button to select the orders on the O/E Create Shipment from Orders screen. For more information, see "O/E Create Shipment from Orders Screen" (page 561).

**Note:** If you use Payment Processing, you must capture or void all outstanding credit card pre-authorizations for any orders that are included in the shipment before you can post the shipment.

• If you want to ship items without creating an order first, see the next procedure in this topic, "To ship items on the O/E Shipment Entry screen without creating an order first."

5. If you want to automatically create an invoice for the shipped quantities, select the **Create Invoice** option on the Shipment tab or the Totals tab. (If you want to create the invoice later, use the O/E Invoice Entry screen.)

6. Enter the shipped quantities. If you want to ship all quantities on the order, click the Ship All button. If you want to create a partial shipment (that is, to ship only some of the details): Enter the quantity to ship in the **Qty. Shipped** field for each detail line you are shipping. If necessary, tab to the **Qty. B/O** field.

7. As needed, enter prepayments, add optional field information, assign one or more salespeople, change currency exchange rates, and check totals.

**Note:** For more information about performing these tasks on the O/E Shipment Entry screen, see "O/E Shipment Entry Screen" (page 509).
• To enter a prepayment for the shipment, click the **Prepayment** button. For more information, see "Entering a Prepayment " (page 109).

• On the Optional Fields tab, add optional field information.

• On the Sales Split tab, assign or credit a salesperson. If you are shipping multiple orders, you should always check the allocation on this panel.

• On the Rates panel, review and change currency exchange rates as needed.

• On the Totals tab, check the totals for the shipment.

8. Post the document.

**To ship items on the O/E Shipment Entry screen without creating an order first:**

1. Open **Order Entry > O/E Transactions > Shipment Entry**.

2. In the **Shipment Number** field, press the Tab key to accept *** NEW *** as the shipment number.

   Order Entry will assign a shipment number when you post the shipment. If you do not want Order Entry to assign the number automatically, you can type the new number yourself, and then press the Tab key.

3. In the **Customer No.** field, type the customer number or select it from the Finder.

   **Tip:** You can skip this field and use the **Order Number**Finder to select by order number, PO number, salesperson, customer number, etc.

   If you enter a customer number, you can also:

   • Click the Pre Credit Check button beside the **Customer No.** field to check the customer’s credit status and determine whether you should continue with the shipment.

   • Click the Zoom button beside the **Customer No.** field to view or edit customer address and contact information.

   On the Customer tab, you can change customer information such as tax code, price list, and payment terms.

4. If you want to ship goods without creating an order first, leave the **Order Number** field blank.
5. On the Shipment tab, enter general shipment information.
   - Check the shipment date.
   - If your company uses templates to fill in default field entries, select a template.
   - If the customer has a purchase order number, enter the number.
   - Select the warehouse location from where you are shipping goods. The default location can come from the customer record or order template. You can change it for the transaction, and for each detail line.
   - If the customer wants goods shipped to a particular location, use the Ship-To Location Finder to select it. You can click the Zoom button to edit the ship-to location, or click the New button to add one to Accounts Receivable.
   - If the transaction is job related, select the **Job Related** option. For more information on job-related options, see "O/E Order Entry Screen" (page 389).
   - If you want Order Entry to calculate tax automatically for the transaction, select the **Calc. Tax** option.
   - Enter a description and reference information if applicable.

6. Click or tab into the Detail table, and then enter shipment details.

**Tips:**
- To start a new line, press the Insert key.
- If you want to view all fields for the selected detail on the O/E Items/Taxes screen, rather than in the Detail table, press F9 or click the **Item/Tax** button.

**To enter a shipment detail line:**

a. Double-click the **Type** field to specify whether you are entering an item or a miscellaneous charge.

b. Double-click the Item No./Misc. Charge field and enter an item number, or select it using the Finder. If you are using a scanner, click in the Item Number field before scanning the bar code.
c. Check the **Price List** and **Location** fields. You can change the default price list (determined by the customer account) and location (from the shipment header fields).

d. Tab to the Qty. Shipped field and enter the number of items that you are shipping. Order Entry displays a matching order quantity in the Qty. On Order (Order UOM) field, and updates available item quantities displayed in the inventory quantity area below the Detail table. You cannot enter a backordered amount.

e. Tab through the remaining fields for the detail line, entering any other required information.

7. As needed, enter prepayments, add optional field information, assign one or more salespeople, change currency exchange rates, and check totals.

**Note:** For more information about performing these tasks on the O/E Shipment Entry screen, see "O/E Shipment Entry Screen " (page 509).

- To enter a prepayment for the shipment, click the **Prepayment** button. For more information, see "Entering a Prepayment " (page 109).

- On the Optional Fields tab, add optional field information.

- On the Sales Split tab, assign or credit a salesperson. If you are shipping multiple orders, you should always check the allocation on this panel.

- On the Rates panel, review and change currency exchange rates as needed.

- On the Totals tab, check the totals for the shipment.

8. Post the document.

**After posting the order or shipment**

On the O/E Confirmation screen that appears after posting, you can print the following documents:

- Shipment picking slip
- Invoice (if you selected the **Create Invoice** option)
- Prepayment receipt (if you entered a prepayment for the shipment)

You can also print these forms separately at any time. For more information, see "Printing Order Entry Customer Forms " (page 195).
Credit and Debit Notes

Enter, import, export, and post credit and debit notes to credit or debit customer accounts.

About Credit/Debit Notes

Use the O/E Credit/Debit Note Entry screen to enter credit notes and debit notes for existing invoices, as well as for invoices that have been cleared or are not yet entered in your system.

You enter credit notes or debit notes to:

- Credit a customer’s account for returned merchandise, damaged items, or price reductions
- Correct an error on an invoice (debit or credit)
- Post a debit or a credit for a miscellaneous charge

You can credit an entire invoice or part of an invoice.

**Important!** All Order Entry credit notes and debit notes affect sales amounts. If you do not want to affect any Order Entry or Inventory Control amounts or statistics, enter the credit note in Accounts Receivable.

**Note:** You cannot post a credit note for documents that use the Project Invoicing option. To effect credit note functionality for job-related invoices, you can enter negative shipments for job-related documents.

Choosing Credit Types for Credit Notes

When you enter a credit note, you must select one of the following credit types for each invoice detail you are crediting:

- **Items Returned to Inventory**
  
  If you select the Items Returned to Inventory credit type, you enter the number of units returned to inventory in the Quantity field. The program calculates the extended amount (quantity returned multiplied by price).

  If you selected an existing invoice number, the program displays the cost of the sold item. If the invoice number was blank or non-existent, the program displays a unit cost based on the item's costing method.

  The costing method can be one of the following:
**Most Recent Cost**

**Standard Cost**
- Average cost—for **Average**, **LIFO**, and **FIFO** costing methods

You can edit any item fields that are not dimmed – for example, the price or the extended amount.

Quantities on hand in Inventory Control are adjusted when you post the credit note.

**Damaged Items**

If you select the **Damaged Items** credit type, you enter the number of units damaged in the **Quantity** field. The program then calculates and displays the extended price for this quantity.

Damaged items do not affect inventory levels, but they do affect item sales.

You can edit any item fields that are not dimmed.

**Price Adjustment** (increases or decreases)

If you select the **Price Adjustment** credit type, you enter the price adjustment in the **Price/Adjustment** field, as follows:

- Enter a decrease as a positive number.
- Enter an increase as a negative number.

**Note:** You can enter a detail line with a negative amount, but you cannot post a credit note or a debit note with a negative total amount.

When you enter the adjustment, the program calculates and displays the extended price adjustment in the **Extended Amount** field. The program multiplies the adjustment by the quantity to determine the adjustment for the detail line.

Price adjustments affect the item sales amount.

**Entering Credit Notes Against Non-Existent Invoices**

If you are entering a credit note against a non-existent invoice:

- The average cost will be displayed for items using average costing, FIFO, and LIFO.
- The most recent cost will be displayed for items using most recent cost.
- The standard cost will be displayed for items using standard costing.
You can edit the cost before posting the return.

**Crediting Part of an Invoice**

If you do not want to credit an entire invoice, or if you need to change the numbers or amounts for invoice details, use the Detail table.

You can delete lines for details you do not want to credit, and insert lines for items or miscellaneous charges you want to credit for the invoice.

**When You Post a Credit Note or a Debit Note**

During posting, Order Entry assigns the credit note or debit note number using the prefix and next number specified on the O/E Options screen. In addition:

- **Items returned to inventory.** When you post a credit note for items returned to inventory, the quantities on hand in Inventory Control are immediately increased for the items on the credit note.

- **Day End Processing.** If you keep sales statistics, the quantity sold, sales amount, invoice amount, and item cost of sales are updated when you run Day End Processing in Inventory Control. If you keep sales history, the number of returns and the returned amount are updated. When you post a credit note for a returned item to which serial numbers were assigned, the serial numbers are reported on the Serial Numbers List in Inventory Control.

- **Damaged items.** If you post a credit note for damaged items, there is no effect on the quantity on hand or on costs. Damaged items update sales statistics and history after Day End Processing, just as items returned to inventory do.

- **Price adjustments.** If you post a credit note or a debit note as a price adjustment, there is no effect on the quantity on hand or on costs. The item sales and invoice amounts are updated when you run Day End Processing, but the number of returns and the returned amounts are not.

- **Sales commissions.** If your salespeople earn commissions, credit notes posted against invoices reduce the commission earned accordingly. The recalculation of commissions is done during Day End Processing.

**Importing Debit Notes and Credit Notes**

You use the **Import** command on the File menu in the Credit/Debit Note Entry screen to import debit notes and credit notes.
Chapter 2: Entering and Posting Order Entry Transactions

You can import the same debit note or credit note any number of times. The original credit information is retained until you delete it from the program in which you created the import file.

**Kit components, Serial numbers and Lot numbers**

You cannot import serial numbers or lot numbers for kit components.

**Tip:** You can use a macro to automate the entry of serial numbers and lot numbers for kit components.

**Multicurrency Ledgers**

You cannot import multicurrency debit notes or credit notes into a single-currency Order Entry system. If necessary, edit the import file to remove the multicurrency field before importing.

For more information about importing, see the help for System Manager.

**Crediting an Existing Invoice**

When you issue a credit note for an existing invoice that has not been cleared from your system, Order Entry displays all the invoice details when you enter the invoice number.

If there are any errors in the invoice details, Order Entry omits those detail lines, and displays messages explaining the errors. (For example, if an item was deleted after invoicing, the item cannot be displayed on the credit note. Order Entry will display an error message indicating that the item has been deleted.)

Order Entry assigns the credit type **Items Returned To Inventory** as the default credit type for all the invoice details.

You can credit all the detail lines as displayed, you can delete details you do not want to credit, and you can edit specific details that you do want to credit.

**Important!** If you do not want to affect any Order Entry or Inventory Control statistics, you should enter the credit note in Accounts Receivable.

**Before you start:**

- Determine the invoice numbers to be credited. You can:
• Enter the number of an existing invoice.

• Enter the number of an invoice that does not exist in Order Entry (such as the number of a deleted invoice).

• Leave the invoice number blank.

• Determine whether or not items will be returned to inventory for resale. You can return goods to inventory, mark goods as damaged, or enter price adjustments (to create credit notes or debit notes).

All credit notes affect sales amounts. If you do not want to affect any Order Entry or Inventory Control amounts or statistics, enter the credit note in Accounts Receivable.

• Verify the numbers you want Order Entry to assign to credit notes. (You use the O/E Options screen to set up prefixes and number sequences.)

• Run Day End Processing in Inventory Control after posting the invoice, so that the appropriate costing information will appear when you return goods to inventory.

To credit an invoice:

1. Open Order Entry > O/E Transactions > Credit/Debit Note Entry.

2. Press the Tab key to accept *** NEW *** as the credit note number in the Document No. field.

   Note: If you do not want Order Entry to assign the number automatically, you can type the new number yourself, and then press the Tab key.

The default document type is Credit Note.

3. In the Customer Number field, enter the customer number, or use theFinder to select it.

   • To check or edit the bill-to address and contact information, click the Zoom button beside the Customer Number field.

   • To change other customer information, such as the tax group or price list, you use the Customer tab.

4. In the Invoice Number field, type the number of the invoice you want to credit.
Chapter 2: Entering and Posting Order Entry Transactions

**Note:** If the invoice still exists in Accounts Receivable, you must use the correct invoice number to properly credit the invoice.

5. Verify that the displayed invoice information is correct.
   - You can change the entries in any fields other than the **Order Number** and **Invoice Date** field, and the **Job Related** option.
   - You can click the Drilldown button beside the **Invoice Number** field to view the invoice.
   - You can drill down from the invoice to the shipment and the original order.

6. Check the **Actual Return Date** and **Credit Note Date**, and edit them if necessary.

7. If all items on the invoice have been returned to inventory, check the quantities for the item details, and check the Totals tab.
   a. Check item quantities to make sure that the number of items returned match the number on the invoice.
   b. Check the Totals tab before posting the return.

8. If this is a partial return or a price adjustment, or if items are damaged, or if you need to add detail lines for the credit note, edit the credit note details.
   a. To start entering credit note details, tab into the Detail table, or click the table.

   Tips for working with Item Numbers
   - You can click the **Item Number** column heading to look up item numbers.
   - If you are using a scanner, click the **Item Number** field before scanning the bar code.
   - To add a detail line, press the Insert key, and then on the new line:
     i. Double-click the **Type** field to specify whether you are entering an item or a miscellaneous charge.
     ii. Double-click the **Item No./Misc. Charge** field, and then enter an item number or a miscellaneous charge code. (If this is a job-
related credit note, you must enter the contract and job information before you can select the item.)

iii. Use the Tab key to navigate through the columns in the Detail table. For information on detail fields, see "O/E Credit/Debit Note Entry Screen" (page 610).

**Note:** If you want to use the O/E Items/Taxes screen to add items (instead of adding them in the table), click the **Item/Tax** button or press the F9 key. Some fields that appear on the O/E Items/Taxes screen may not appear in the table.

The default price list is determined by the customer account, but you can change it.

The default location for a detail line is the location specified for the document.

c. If you are crediting an Item detail, double-click the **Credit Type** field, and then select a credit type.

You can select the following credit types:

- **Items Returned to Inventory.** Enter the number of units returned to inventory in the **Quantity** field. You can edit other fields if they are not set to read-only. When you enter the number of units, the program displays the extended price for this quantity.

- **Damaged Items.** Enter the number of units damaged in the **Quantity** field. Damaged items credit the customer and affect item sales, but do not affect inventory levels. You can edit other fields if they are not dimmed. When you enter the number of units, the program displays the extended price for this quantity.

- **Price Adjustment.** If you select this type, enter the price adjustment in the **Price/Adjustment** field.
  
  - Price adjustments affect the item sales amount but not inventory levels.
  
  - Enter a price decrease as a credit note, and a price increase as a debit note. Enter just the differences in price.
Chapter 2: Entering and Posting Order Entry Transactions

- When you enter the adjustment, the program displays the extended price adjustment in the **Extended Amount** field. (You can also just enter the extended amount directly.)

- If you do not want to affect any Order Entry or Inventory Control statistics, you should enter the credit note in Accounts Receivable.

9. After you finish editing detail lines, check the information on the remaining tabs on the screen.

   - To assign or credit a salesperson for the credit note, click the **Sales Split** tab.
   - To add optional field information to the credit note, click the **Optional Fields** tab.
   - To edit exchange rates (in a multicurrency system), click the **Rates** tab.
   - To check the totals for the credit note, or to add an extended comment, click the **Totals** tab.

10. Post the credit note.

    If you want to print the credit note, click **Yes** on the Confirmation form that appears after posting. You can also use the O/E Credit/Debit Note screen to print the credit note later.

**Crediting a Cleared or Missing Invoice**

You can post a return or credit note to an invoice number that has already been cleared from your Order Entry system, or to an invoice that you have not yet entered in your Order Entry system.

If you enter a credit note against an invoice that has not yet been entered or has been cleared from your system, Order Entry displays item costs based on each item’s costing method, as follows:

- The average cost for items that use the moving average, FIFO, and LIFO costing methods.

- The most recent cost for items that use most recent cost.

- The standard cost for items that use standard costing.

You can edit item costs before posting the credit note.

If you want to credit an invoice that was deleted from Order Entry but still exists in Accounts Receivable, you must enter the original invoice number to ensure that the credit is properly posted in Accounts Receivable.
Important! If you do not want to affect any Order Entry or Inventory Control statistics, you should enter the credit note in Accounts Receivable.

To credit an invoice that no longer exists in Order Entry:

1. Open Order Entry > O/E Transactions > Credit/Debit Note Entry.
2. Press the Tab key to accept *** NEW *** as the credit note number in the Document No. field.

   **Note:** If you do not want Order Entry to assign the number automatically, you can type the new number yourself, and then press the Tab key.

   The default document type is Credit Note.

3. In the Customer Number field, enter the customer number, or use the Finder ▶ to select it.
   - To check or edit the bill-to address and contact information, click the Zoom ▲ button beside the Customer Number field.
   - To change other customer information, such as the tax group or price list, you use the Customer tab.

4. In the Invoice Number field, enter the number of the invoice you want to credit. If you do not know the number, leave this field blank.

   **Note:** If the invoice still exists in Accounts Receivable, you must use the correct invoice number to properly credit the invoice.

5. On the Credit Note tab, enter general information for the credit note.
   a. If the customer had a PO number, enter it in the PO Number field.
   b. If your company uses templates to fill in default field entries, select a template code.

      **Note:** When you enter an invoice number that does not currently exist in Order Entry, the program uses entries from the default template.

   c. In the Actual Return Date field, enter the date of the return.
   d. In the Credit Note Date field, enter the date of the credit note.
   e. In the Posting Date field, enter the date for the year and period to which you are posting the credit note.
Chapter 2: Entering and Posting Order Entry Transactions

f. In the **Location** field, specify the warehouse location where you are returning goods.

g. If the original invoice was job-related, select the **Job Related** option.

   For information on job-related options, see "O/E Credit/Debit Note Entry Screen" (page 610).

h. If you want Order Entry to calculate taxes for the credit note, select the **Calculate Tax** option.

i. Enter a short description and/or reference for the credit note. You can also add comments to each item detail line, and you can add a long comment for the credit note on the Totals tab.

6. In the Detail table on the Credit Note tab, enter details for the credit note.

   a. To start entering credit note details, tab into the Detail table, or click the table.

   **Tips for working with Item Numbers**

   - You can click the **Item Number** column heading to look up item numbers.

   - If you are using a scanner, click the **Item Number** field before scanning the bar code.

   b. To add a detail line, press the Insert key, and then on the new line:

      i. Double-click the **Type** field to specify whether you are entering an item or a miscellaneous charge.

      ii. Double-click the **Item No./Misc. Charge** field, and then enter an item number or a miscellaneous charge code. (If this is a job-related credit note, you must enter the contract and job information before you can select the item.)

      iii. Use the Tab key to navigate through the columns in the Detail table. For information on detail fields, see "O/E Credit/Debit Note Entry Screen" (page 610).

**Note:** If you want to use the O/E Items/Taxes screen to add items (instead of adding them in the table), click the **Item/Tax** button or press the F9 key. Some fields that appear on the O/E Items/Taxes screen may not appear in the table.
The default price list is determined by the customer account, but you can change it.

The default location for a detail line is the location specified for the document.

c. If you are crediting an Item detail, double-click the **Credit Type** field, and then select a credit type.

You can select the following credit types:

- **Items Returned to Inventory.** Enter the number of units returned to inventory in the **Quantity** field. You can edit other fields if they are not set to read-only. When you enter the number of units, the program displays the extended price for this quantity.

- **Damaged Items.** Enter the number of units damaged in the **Quantity** field. Damaged items credit the customer and affect item sales, but do not affect inventory levels. You can edit other fields if they are not dimmed. When you enter the number of units, the program displays the extended price for this quantity.

- **Price Adjustment.** If you select this type, enter the price adjustment in the **Price/Adjustment** field.

  - Price adjustments affect the item sales amount but not inventory levels.
  - Enter a price decrease as a credit note, and a price increase as a debit note. Enter just the differences in price.
  - When you enter the adjustment, the program displays the extended price adjustment in the **Extended Amount** field. (You can also just enter the extended amount directly.)
  - If you do not want to affect any Order Entry or Inventory Control statistics, you should enter the credit note in Accounts Receivable.

7. After you finish editing detail lines, check the information on the remaining tabs on the screen.

  - To assign or credit a salesperson for the credit note, click the **Sales Split** tab.

  - To add optional field information to the credit note, click the **Optional Fields** tab.

  - To edit exchange rates (in a multicurrency system), click the **Rates** tab.
• To check the totals for the credit note, or to add an extended comment, click the **Totals** tab.

8. Post the credit note.

   If you want to print the credit note, click **Yes** on the Confirmation form that appears after posting. You can also use the O/E Credit/Debit Note screen to print the credit note later.

**Editing Credit Note Details**

If you enter a credit note against an invoice that has not been cleared from your system, Order Entry displays all the invoice details when you enter the invoice number. You can edit these details before you post the credit note.

If you enter a credit note against an invoice that has not yet been entered or has been cleared from your system, Order Entry displays item costs based on each item's costing method.

Item costs are displayed as follows:

• The average cost for items that use the moving average, FIFO, and LIFO costing methods.

• The most recent cost for items that use most recent cost.

• The standard cost for items that use standard costing.

You can edit item costs before posting the credit note.

---

**Important!** If you do not want to affect any Order Entry or Inventory Control statistics, you should enter the credit note in Accounts Receivable.

---

**To edit credit note details:**

1. With the credit note displayed in the O/E Credit/Debit Note Entry screen, tab to the details table.

2. If you are crediting an existing invoice, delete any lines that you are not going to credit.

   Select the detail, and then press the **Delete** key. If you are prompted to confirm the deletion, click **Yes**.

---

**Note:** If you are crediting an invoice that does not exist in Order Entry, the first line is selected.
3. For each line to be credited:
   a. In the **Credit Type** column, select the reason you are crediting the detail. To specify the credit type, double-click in the Credit Type column for that detail, and then select one of the following types from the list:

   - **Items Returned to Inventory**—for items that are being returned to inventory.
   - **Damaged Items**—for items that are damaged (and not being returned to inventory).
   - **Price Adjustment**—for price adjustment on items. If the invoice number does not exist in Order Entry, the program displays item unit costs based on each item's costing method.

   b. Use the O/E Items/Taxes screen to check and edit tax information for the detail, as necessary. Select the line on the details table, and then click the **Item/Tax** button to open the O/E Items/Taxes screen.

c. For information on editing tax information, see "Changing Tax Groups and Tax Classes for Order Entry Documents " (page 180).

4. Add detail lines for item details or miscellaneous charges, if needed.

**To edit the exchange rate for a credit note:**

1. Click the Rates tab.

2. Edit the **Rate Type** code if you want to change the method to convert source-currency amounts to their functional-currency equivalents.

3. Enter the **Rate Date** (to select the credit note exchange rate from the currency rate table in Common Services).

4. If you need to change the exchange rate, enter it in the **Rate** field.

**Note:** The Rates tab appears only in a multicurrency ledger, if the customer does not use the functional currency. You enter exchange rate information in the Credit/Debit Note Entry screen only if you do not want to use the current exchange rate for the credit note, or if no rate is entered for the credit note date.

**Tip:** If the exchange rate of the return or credit note differs from the rate of the invoice, you will realize an exchange gain or loss on the transaction.

When you are satisfied with your changes, follow the steps in "Entering and Verifying Credit/Debit Note Totals " (page 140).
**Entering and Verifying Credit/Debit Note Totals**

Before you post a credit note or a debit note, you should verify the document totals, and specify whether the credit note or debit note includes the invoice discount (if one applied). You can also enter a comment for the debit note or credit note.

**To verify discounts and document totals:**

1. Click the Totals tab on the O/E Credit/Debit Note Entry screen.

2. If a discount was applied on the original invoice to the items and miscellaneous charges that you are now crediting or debiting, check the discount that appears on the Totals tab, and edit the discount percentage or amount, if necessary.

   This discount is in addition to any discounts that were applied to items. It is prorated to all the items and miscellaneous charges (if you are discounting them) on the current document. It is subtracted from the credit note or debit note amount.

   If the document discount applied to miscellaneous charges on the original invoice, select the **Discount Miscellaneous Charges** option. You should take a corresponding discount on the miscellaneous charges you are crediting or debiting. Any miscellaneous-charge discount amount is included in the credit/debit note subtotal.

   If you are crediting or debiting an invoice that does not exist in your Order Entry system, or if you need to apply a different discount, enter the discount as a percentage or a fixed amount.

   **Note:**
   If you override the amount calculated from a percentage, an asterisk appears beside the amount. The discount amount will not change unless you re-enter the discount percentage.

   However, if you add details to the credit note or debit note, the discount percentage is recalculated for each detail (except miscellaneous charges, if you are not discounting them).

3. Check the remaining document totals and subtotals.

   - Estimated weight for all items on the credit note (using the unit weights from Inventory Control item records).

   - Number of detail lines on the credit note.
- Subtotal of all shipped items and miscellaneous charges on the credit note.

- Credit note amount, which is calculated as:
  - Credit note subtotal (shipped items + misc. charges)
  - - Discount
  - + Tax (if it is not included in item prices)

If item prices include tax, the amount of the included tax is displayed on the right side of the screen. It does not affect the calculation of the credit note amount.

If you need to change tax information for the customer, you use the Taxes tab. See Changing Tax Amounts for Order Entry Documents for more information.

4. Enter a comment for the current document, as needed.

5. When you are satisfied with the document totals and other information, click Post.

6. If you want to print the credit note or debit note, click Yes on the Confirmation form that appears after posting. You can also use the O/E Credit/Debit Note screen to print the credit note later.

**Credit Card Transactions**

If you use Payment Processing, you can pre-authorize and process credit card payments for transactions in Accounts Receivable and Order Entry.

**About Pre-authorizing, Capturing, and Forcing Credit Card Payments**

If you use Payment Processing, you pre-authorize a credit card payment when you want to verify that sufficient credit exists on a customer's credit card before processing a sale.

When you create a pre-authorization, the cardholder’s credit limit is reduced by the amount of the pre-authorization until the pre-authorization is captured or expires.

After pre-authorizing a payment, you can capture (process) the payment or void the pre-authorization. In Order Entry, you can also use the O/E Capture Payments With Invoices screen to capture and invoice pre-authorized payments for multiple Order Entry documents.
If a pre-authorization has expired recently, you may be able to force a payment for the pre-authorized amount.

**Pre-authorizing Payments**

On the O/E Order Entry screen, you can click the **Pre-authorize** button to pre-authorize a credit card payment.

The amount of a pre-authorization does not need to match the amount captured in the final sale. The captured amount may be more (as when a restaurant customer adds a tip) or less (as when a service station customer swipes a credit card, and then purchases fuel that costs less than the amount pre-authorized for a fill-up).

**Important!**

If it is likely that more than seven days will pass before an order is shipped, you should not pre-authorize a credit card payment for the order. If you do, the pre-authorization may expire, in which case your merchant service provider will charge a fee. (Credit card pre-authorization in Sage Payment Solutions expires after approximately seven days.)

Rather than pre-authorize a credit card payment, you can process an initial prepayment when the order is created, and then process the balance when the order is shipped.

For more information, see "Pre-authorizing a Credit Card Payment" (page 144).

**Capturing Pre-authorized Payments**

You capture a pre-authorized credit card payment when you are ready to process payment for goods that you have shipped, or for goods or services that a customer has received.

You can capture a pre-authorization only once. After you capture it, the pre-authorization is released in full, regardless of whether the amount captured matches the amount that was pre-authorized.

On some Order Entry transaction screens, you can click the **Capture** button to capture (process) a pre-authorized credit card payment. This button appears on the O/E Order Entry and O/E Shipment Entry screens, and may also appear on the O/E Invoice Entry screen (depending on the options you selected on the PMT Options screen).
In Order Entry, you can also use the O/E Capture Payments With Invoices screen to capture and invoice pre-authorized payments for multiple Order Entry documents.

For information about Payment Processing options, see the Payment Processing help.

For more information about capturing pre-authorized payments, see the following topics:

- "Capturing a Pre-authorized Credit Card Payment" (page 147)
- "Capturing and Invoicing Pre-authorized Credit Card Payments" (page 150)

**Forcing Payment for Expired Pre-authorizations**

If a pre-authorization has expired, you may be able to force a payment for the pre-authorized amount.

**Note:** Forced transactions may be subject to higher fees than regular transactions, depending on the terms of your agreement with your merchant service provider.

You can force a payment if the pre-authorization has expired recently (typically within 30 days), and if you used a saved credit card for the pre-authorization (that is, you did not select the **Enter A Card For One-Time Use** option when processing the pre-authorization).

If you attempt to use the PMT Process Credit Card screen to capture an expired pre-authorization that cannot be forced, a message informs you that you must create a new pre-authorization or prepayment.

If you are using the O/E Capture Payments With Invoices screen to capture and invoice multiple pre-authorized payments, Sage 300 ERP attempts to force all expired pre-authorizations. If an expired pre-authorization cannot be forced, a message informs you that the payment could not be processed.

**Voiding Existing Pre-authorizations**

On the O/E Order Entry screen, you can click the **Void Pre-auth** button to open the O/E Pre-authorization screen, and then click **Void** to void an existing pre-authorization.

Merchant service providers charge a fee for voiding a credit card pre-authorization. However, this fee is lower than the fee that is charged if you do not void or capture a pre-authorization and allow it to expire. For this reason, we recommend that you void any pre-authorization that will not be captured.
For more information, see "Voiding a Credit Card Pre-authorization" (page 153).

**Pre-authorizing a Credit Card Payment**

If you use Payment Processing, you can click **Pre-authorize** on the O/E Order Entry screen to pre-authorize a credit card payment for an order.

You pre-authorize a credit card payment when you want to verify that sufficient credit exists on a customer's credit card before processing a sale. When you create a pre-authorization, the cardholder’s credit limit is reduced by the amount of the pre-authorization until the pre-authorization is captured or expires.

The amount of a pre-authorization does not need to match the amount captured in the final sale. The captured amount may be more (as when a restaurant customer adds a tip) or less (as when a service station customer swipes a credit card, and then purchases fuel that costs less than the amount pre-authorized for a fill-up).

If you use multicurrency accounting, you can pre-authorize a credit card payment only if the customer currency matches the currency specified for an existing processing code. For example, if you want to pre-authorize a credit card payment for a USD customer, USD must be specified as the currency for an existing processing code.

Merchant service providers charge a fee for voiding a credit card pre-authorization. However, this fee is lower than the fee that is charged if you do not void or capture a pre-authorization and allow it to expire. For this reason, we recommend that you void any pre-authorization that will not be captured.

If a pre-authorization has expired, you may be able to force a payment for the pre-authorized amount. You can force a payment only if the pre-authorization has expired recently (typically within 30 days), and if you used a saved credit card for the pre-authorization (that is, you did not select the **Enter A Card For One-Time Use** option when processing the pre-authorization).

**Note:** Forced transactions may be subject to higher fees than regular transactions.

If it is likely that more than seven days will pass before an order is shipped, you should not pre-authorize a credit card payment for the order. If you do, the pre-authorization may expire, in which case your merchant service provider will charge a fee. (Credit card pre-authorization in Sage Payment Solutions expires after approximately seven days.) Rather than pre-authorize
a credit card payment, you can process an initial prepayment when the order is created, and then process the balance when the order is shipped.

For more information, see "About Pre-authorizing, Capturing, and Forcing Credit Card Payments" (page 141)

**Before you start:**

- Sage Exchange must be installed and running on the workstation you are using to pre-authorize the payment.
- You must have a working Internet connection.

**To pre-authorize a credit card payment:**

1. Open **Order Entry > O/E Transactions > Order Entry**.
2. Create or select an order for which you want to pre-authorize a credit card payment.
3. Click **Pre-authorize**.

   The O/E Pre-authorization screen appears. The **Pre-authorization Amount** field displays the order total (including taxes).
4. Review the information on the screen.
   a. Verify that the **Payment Code** field displays the correct payment code, or select a payment code that uses the payment type SPS Credit Card.

   **Tip:** Click the Finder Q to see a list of payment codes and associated payment types.

   b. Verify that the **Processing Code** field displays the correct processing code, or select a processing code.

   The bank code associated with the processing code appears in the **Bank Code** field.

   **Note:** The processing code you select must use the same bank and currency as the current transaction.
5. Click **Pre-authorize**.

   The PMT Process Credit Card screen appears.
6. Specify a credit card.
   - To select a saved credit card, use the Finder.
   - To enter details for a new card and save the card in the customer record, click the New button, and then add the card details on the A/R Credit Card Information screen.
   - To enter details for a new credit card that will not be saved in the customer record, select Enter a Card for One-Time Use. (You enter card details on the Sage Payment Solutions browser form after you click the Process Pre-authorization button.)

7. Enter or review billing details. These may be different from the information in the customer record. For example, the customer may be using a company credit card, or may be authorized to use a card on behalf of the primary cardholder.

   **Tip:** When entering billing details, you can select the Same as Customer Address option to fill in billing details with name and address information from the customer record.

8. Review totals.

   **Note:** For some transactions, you can edit the amount in the Taxes field in order to comply with Level 2 processing requirements. When you edit this amount, the amount in the Subtotal field is calculated automatically by subtracting the taxes you entered from the transaction total.

9. Click Process Pre-authorization.

   The Sage Payment Solutions browser form appears.

10. Review or enter credit card details.
   - If you use a card reader device and did not select a saved credit card for this transaction, you can click Swipe Card to swipe a credit card.
   - If you want to review these details, click the Next button on the browser form.

11. Click Submit.

    Sage Payment Solutions processes the pre-authorization. A message displays information about the transaction.
12. On the PMT Process Credit Card screen, review pre-authorization details and status.

13. Click Close to return to the O/E Pre-authorization screen.

**After pre-authorizing a credit card payment**

- After posting the order, you can capture the pre-authorization either when the order is shipped (using the O/E Shipment Entry screen) or when the order is invoiced (using the O/E Invoice Entry screen).

**Note:** The options available for capturing individual pre-authorizations depend on the settings you specify on the PMT Options screen. For more information, see Payment Processing Help.

- You can use the O/E Capture Payments With Invoices screen to capture and invoice pre-authorized payments for multiple Order Entry documents. For more information, see "Capturing and Invoicing Pre-authorized Credit Card Payments" (page 150).

- If you want to void the pre-authorization, you can click the Void Pre-auth button on the O/E Order Entry screen.

**Capturing a Pre-authorized Credit Card Payment**

If you use Payment Processing, you can use the O/E Prepayment screen to capture (process payment for) a credit card prepayment that was previously authorized. You capture a pre-authorized credit card payment when you are ready to process payment for goods that you have shipped, or for goods or services that a customer has received.

You can capture a pre-authorization only once. After you capture it, the pre-authorization is released in full, regardless of whether the amount captured matches the amount that was pre-authorized.

On the O/E Shipment Entry screen, when you open a document with a pre-authorization, the Create Invoice option is selected by default. You must create an invoice when capturing a pre-authorized credit card payment from this screen.

Depending on the settings you specified on the PMT Options screen, you may be required to capture a pre-authorized payment on the O/E Shipment Entry screen before shipping an order, or you may be able to post the shipment, and then capture the payment later when creating the invoice.

If a pre-authorization has expired, you may be able to force a payment for the pre-authorized amount.
Chapter 2: Entering and Posting Order Entry Transactions

**Note:** Forced transactions may be subject to higher fees than regular transactions.

For more information about forcing payment, see "About Pre-authorizing, Capturing, and Forcing Credit Card Payments" (page 141).

**Note:** You can use the O/E Capture Payments With Invoices screen to capture and invoice of pre-authorized payments for multiple Order Entry documents. For more information, see "Capturing and Invoicing Pre-authorized Credit Card Payments" (page 150).

**Tip:** On the O/E Order Entry screen, you can use the Order NumberFinder Q to view pre-authorization status. If a credit card payment has been pre-authorized but not processed for the order, the Order Has Pre-authorization column for the order displays "Yes."

**Before you start:**

- A credit card pre-authorization must exist for the document. For instructions on creating a credit card pre-authorization, see "Pre-authorizing a Credit Card Payment" (page 144).
- Sage Exchange must be installed and running on the workstation you are using to capture the pre-authorized payment.
- You must have a working Internet connection.

**To capture a pre-authorized credit card prepayment:**

1. Open **Order Entry > O/E Transactions**.
2. Select **Order Entry, Shipment Entry, or Invoice Entry**.
   
   **Note:** You can capture pre-authorized payments from the O/E Invoice Entry screen only if the Require Capture of Pre-authorized Payments at Shipment option is cleared on the PMT Options screen.

3. Select a document or order number for which a credit card payment has been pre-authorized.

   **Note:** On the O/E Shipment Entry screen, the Create Invoice option is selected by default. You must create an invoice when capturing a pre-authorized credit card payment from this screen.
4. For each item that you are shipping, enter the quantity shipped in the Quantity Shipped field.

5. Click Capture.

   The O/E Prepayments screen appears. The Payment Code, Processing Code, and Pre-authorization Amount fields display the information that was entered for the pre-authorization.

   **Note:** The Receipt Amount field displays the invoice amount, rather than the pre-authorized amount.

6. Select a batch for the prepayment, or create a new batch.

7. In the Receipt Amount field, enter the amount to capture for the pre-authorization.

   **Note:** When you capture a pre-authorized credit card payment, the amount captured can be different than the amount that was pre-authorized. For example, if a customer at a restaurant adds a tip, the amount captured will be greater than the amount that was pre-authorized.

8. Click Add.

   The Charge button becomes available.

9. Click Charge.

   The PMT Process Credit Card screen appears.

10. Review totals.

   **Note:** For some transactions, you can edit the amount in the Taxes field in order to comply with Level 2 processing requirements. When you edit this amount, the amount in the Subtotal field is calculated automatically by subtracting the taxes you entered from the transaction total.

11. Click Process Payment.

    Sage Payment Solutions processes the payment.

12. Click Close to close the PMT Process Credit Card screen, and then the O/E Prepayments screen.

13. Post the document.
Capturing and Invoicing Pre-authorized Credit Card Payments

You capture a pre-authorized credit card payment when you are ready to process payment for goods that you have shipped, or for goods or services that a customer has received.

In Order Entry, you can use the O/E Capture Payments With Invoices screen to capture and invoice pre-authorized credit card payments for multiple orders or shipments in a batch. For more information about this screen, see "O/E Capture Payments with Invoices Screen" (page 672).

**Note:** You can also use O/E transaction entry screens to capture individual pre-authorized payments by document. For more information, see "Capturing a Pre-authorized Credit Card Payment" (page 147).

Before you start:

- A credit card pre-authorization must exist for one or more Order Entry documents. For instructions on creating a credit card pre-authorization, see "Pre-authorizing a Credit Card Payment" (page 144).
- Sage Exchange must be installed and running on the workstation you are using to capture the pre-authorized payments.
- You must have a working Internet connection.

**To capture and invoice pre-authorized credit card payments:**

1. Open **Order Entry > O/E Transactions > Capture Payments with Invoices**.

2. In the **A/R Receipt Batch Date** field, specify the date for the receipt batch (or batches) that will be created when you capture pre-authorized payments.

   **Note:** If you process payments that use multiple processing codes, a separate Accounts Receivable receipt batch is created for each processing code.

3. If you want to filter documents by processing code or document number, specify criteria.

   a. In the **From/To Processing Code** fields, specify a range of processing codes to view, or accept the default entries to view pre-authorized payments for all processing codes. (A processing code specifies the bank, currency, and merchant account that will be used to
process a credit card transaction.)

b. In the From/To document number fields, specify a range of shipment numbers and/or order numbers to view, or accept the default entries to view pre-authorized payments for all documents.

**Note:** If you specify ranges of both shipment numbers and order numbers, only pre-authorized payments that match all criteria you specify will appear in the table.

c. Click the Go button.

Documents that match the criteria you specified appear in the table.

4. If you do not want to capture and invoice pre-authorized payments for all documents that appear in the table, set the value in the Apply column to "No" for those documents, and then select documents for which to process payments.

   - To set the value in the Apply column, select a row, and then double-click the Apply column or press the spacebar.
   
   - If you want to set this value to "No" for all documents, click the Apply None button.
   
   - If you want to set this value to "Yes" for all documents again, click the Apply All button.

5. If you want to print invoices and/or receipts after you capture payments and create invoices, select the Print Invoices After Capture and/or Print Receipts After Capture options.

   - If you select Print Invoices After Capture, the O/E Invoices report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last invoice in the new batch are specified in the From Invoice and To Invoice fields, and the Include Invoices Already Printed option is cleared.

   - If you select Print Receipts After Capture, the A/R Receipts report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last Accounts Receivable batches created while capturing payments are specified in the From and To batch number fields.
6. Click **Capture and Invoice**.

- Sage Payment Solutions processes pre-authorized payments for all documents that display "Yes" in the **Apply** column.

- Order Entry creates an invoice for each pre-authorized payment that was successfully processed.

- Accounts Receivable creates a receipt batch with the batch date you specified. If you use multiple processing codes, a separate receipt batch is created for each processing code.

- When processing is complete, a message displays summary information about payments that were successfully processed. If any errors occur while processing payments and creating invoices, a message displays detailed information about each error.

**Tip:** If any payments were not processed, or if any invoices were not created, print this message to create a record of errors that you need to resolve.

- If you select **Print Invoices After Capture**, the O/E Invoices report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last invoice in the new batch are specified in the **From Invoice** and **To Invoice** fields, and the **Include Invoices Already Printed** option is cleared.

- If you select **Print Receipts After Capture**, the A/R Receipts report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last Accounts Receivable batches created while capturing payments are specified in the **From** and **To** batch number fields.

**After capturing and invoicing credit card payments**

If any payments could not be processed, resolve errors related to those payments.

When you pre-authorize a credit card payment, credit card information is validated in Sage Payment Solutions, and the cardholder’s credit limit is reduced by the amount of the pre-authorization until the pre-authorization is captured or expires. For these reasons, it is rare for errors to occur while capturing a payment. However, the following issues may cause a capture to fail:
- **The pre-authorization has expired and cannot be forced.** Pre-authorizations usually expire after seven days, and you may be able to "force" payment for an expired pre-authorization up to 30 days after expiry. If more than 30 days have passed since the pre-authorization expired, you may be unable to process payment.

- **The pre-authorization has expired and credit card information was not saved.** If credit card information was not saved when the pre-authorization was created, you cannot force payment after the pre-authorization expires.

- **The pre-authorization has been voided.** If you or another user voided the transaction in Sage 300 ERP or in Sage Virtual Terminal, you cannot capture payment.

- **The receipt amount is zero.** You cannot capture a pre-authorized payment if the receipt amount is zero.

- **Another user modified the order or shipment during payment processing.** If another user changes the order or shipment information during processing, the transaction may fail.

- **The Internet connection was lost or interrupted.** If a capture fails due to issues with your Internet connection, you should be able to process the transaction again successfully when the connection is restored.

- **Merchant information has been changed.** If you or another user changed the merchant information or processing codes for your Payment Processing system, capture may fail for pre-authorizations created using the original merchant information or processing codes.

### Voiding a Credit Card Pre-authorization

If you use Payment Processing, you can use the O/E Pre-authorization screen to void a pre-authorized credit card payment for an order if the payment has not yet been processed.

Merchant service providers charge a fee for voiding a credit card pre-authorization. However, this fee is lower than the fee that is charged if you do not void or capture a pre-authorization and allow it to expire. For this reason, we recommend that you void any pre-authorization that will not be captured.

For more information, see "About Pre-authorizing, Capturing, and Forcing Credit Card Payments " (page 141).
Chapter 2: Entering and Posting Order Entry Transactions

**Tip:** On the O/E Order Entry screen, you can use the **Order Number Finder** to view pre-authorization status. If a credit card payment has been pre-authorized but not processed for the order, the **Order Has Pre-authorization** column for the order displays "Yes."

**Before you start:**
- A credit card pre-authorization must exist for an order.
- Sage Exchange must be installed and running on the workstation you are using to pre-authorize the payment.
- You must have a working Internet connection.

**To void a credit card pre-authorization:**
1. Open **Order Entry > O/E Transactions > Order Entry**.
2. Select a document for which a credit card payment has been pre-authorized.
3. Click **Void Pre-auth**.
   - The O/E Pre-authorization screen appears.
4. Click **Void**.
   - The PMT Process Credit Card screen appears.
5. Click **Void Pre-authorization**.
   - Sage Payment Solutions voids the pre-authorization.

**Serial and Lot Numbers**

If you use Serialized Inventory and Lot Tracking, assign serial numbers and lot numbers to items that you sell or return to inventory.

**About Serialized Inventory and Lot Tracking**

If you have a license to use Serialized Inventory and Lot Tracking, you can allocate serial numbers or lot numbers to items when you enter transactions.

You use serial and lot numbers to track items—from their receipt into inventory to their sale and shipment to customers. You can also use serial and lot numbers to track returned items (from the customer back to the vendor).
Serial and Lot Numbers

Serial Numbers
Serial numbers are used to track individual items. Each serial number must be unique to one specific item.

Example: An electronics retailer can use serial numbers to record sales of items that have warranties.

Lot Numbers
Lot numbers are used to track groups of items. Unlike serial numbers, a lot number can be allocated to multiple items.

Example: A food distribution company can use lot numbers to record purchases and sales of unique batches of product.

Managing Serialized and Lotted Inventory
Serial numbers and lot numbers are managed by item and location in Inventory Control. Also, settings in Inventory Control determine how you process serialized and lotted items in Order Entry.

Note: To change these settings, you must have Inventory Control Setup Maintenance security authorization. (For more information, see the Inventory Control help.)

In Inventory Control, you can specify:

• If an item is serialized or lotted (or both). For serialized or lotted items, you must assign serial or lot numbers when you sell the item or return it to inventory.

• If you must allocate serial numbers and lot numbers to all quantities in shipments, invoices, credit notes, and debit notes, or if you can allocate fewer serial numbers or lot quantities than the quantities in entries. Regardless of this setting, you can always post an order, even if the order quantity does not equal the quantity of allocated serial numbers or lot numbers.

• Whether you allocate serial numbers and lot numbers for the quantity ordered or the quantity shipped (the default is quantity shipped).

If the option **Use the Qty Ordered field in OE for the Allocation of Serial Numbers** is selected in Inventory Control:
When you allocate a serial number to an order quantity, the program selects the **Allocated To OE Order** setting for the item and serial number in Inventory Control (on the I/C Serial Numbers screen).

When you ship an order, the program clears the **Allocated To OE Order** setting for the item and serial number, and sets the serial number’s status to Not Available.

If the option **Use the Qty Ordered field in OE for the Allocation of Lot Numbers** is selected in Inventory Control:

- When you allocate order quantities to lots, the program updates the **Quantity Reserved For Order** for the item and lot number (on the I/C Lot Numbers screen).
- When you ship the order, the program decreases the **Quantity Reserved For Order** by the quantity shipped.

If you allocate serial numbers or lot numbers for the quantity ordered, Inventory Control reserves the numbers until you ship the items.

**Note:** You can allocate serial and lot numbers for the quantity ordered only to active orders (not to future orders, standing orders, or quotes).

### Generating and Allocating Serial Numbers and Lot Numbers in Order Entry

You generate serial numbers and lot numbers for an inventory location when you receive serialized or lotted items (in Inventory Control or in Purchase Orders), and, if necessary, when you return the items to Inventory Control (in Order Entry).

You allocate serial numbers and lot numbers from an inventory location when you sell or ship serialized or lotted items (in Inventory Control or in Order Entry), and, if necessary, when you return them to the vendor (in Purchase Orders).

When you enter quantities for a serialized or lotted item in an Order Entry transaction, the program prompts you to allocate or generate serial numbers and lot numbers, as follows:

- **O/E Serial/Lot Numbers Allocation screen.** This screen appears when you:
  - Enter a quantity on the O/E Order Entry, O/E Shipment Entry, or O/E Invoice Entry screen, and then press the Tab key or click the column
Serial and Lot Numbers

header.

- Enter a quantity for a debit note on the O/E Credit/Debit Note Entry screen.

- **O/E Serial/Lot Numbers Generation screen.** This screen appears when you enter a quantity for a credit note on the O/E Credit/Debit Note Entry screen.

For more information about the allocation and generation screens, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

For information about allocating lot numbers and serial numbers in Order Entry, see "Serial and Lot Numbers" (page 154).

**Transaction Records in Inventory Control**

Transaction records are generated for I/C Serial Numbers and I/C Lot Numbers when you post serialized or lotted items for:

- O/E shipments
- O/E shipment adjustments
- O/E invoice adjustments
- O/E credit notes (for type **Items Returned To Inventory**)
- O/E debit notes (for type **Items Removed From Inventory**)

For I/C Serial Numbers, the transaction cost is shown for each transaction record.

For I/C Lot Numbers, the quantity and transaction cost are shown for each transaction record.

For more information, see the Inventory Control help.

**Allocating Serial Numbers or Lot Numbers to an Order**

During transaction entry, you can allocate serial numbers or lot numbers to items and to components of kitting items.

**Note:** You specify (in Inventory Control) whether you will allocate serial numbers and lot numbers from the **Quantity Ordered** field or the **Quantity Shipped** field. For more information, see "About Serialized Inventory and Lot Tracking" (page 154).
To allocate serial numbers or lot numbers to items:

1. Open Order Entry > O/E Transactions > Order Entry.
2. Enter information for the order.
3. Allocate serial numbers and lot numbers to non-kitting items.
   a. In the Qty. Ordered field, enter a quantity for the item, and then press Tab.
   
   **Note:**
   If Inventory Control uses the option to allocate serial numbers and/or lot numbers using the quantity ordered, the Serial/Lot Numbers Allocation screen appears. You must allocate serial numbers and/or lot numbers before you can ship them using the Qty. Shipped field.
   
   If you allocate serial and/or lot numbers using the Qty. Ordered field, and you do not intend to ship any items at this time, skip step b.

   b. In the Qty. Shipped field, enter a quantity for the item, and then press Tab.

   **Note:** If Inventory Control does not use the option to allocate serial numbers and/or lot numbers using the quantity ordered, the Serial/Lot Numbers Allocation screen appears.

   The Serial/Lot Numbers Allocation screen includes a Serials tab if the item is serialized and/or a Lots tab if the item is lotted.

   c. Allocate serial numbers and lot numbers as required.

   The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

   **Ways to allocate serial numbers**
   - In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.
   - On the Serials tab, click **Auto-Alloc.** to allocate all required serial numbers.

   **Note:**
   - By default, serial numbers are allocated starting with the first
Serial and Lot Numbers

available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.

- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

**Ways to allocate lot numbers**

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.

- On the Lots tab, click **Auto-Alloc.** to allocate all required lot numbers.

**Note:**

- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.

- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.


d. When the quantity of serial numbers and/or lot numbers remaining is zero, click **Close** to return to the O/E Order Entry screen.

4. Allocate serial numbers and lot numbers to kitting items.

   a. On the Details table, select a detail for a kitting item that includes serialized or lotted components.

   b. Enter the quantity ordered and the quantity shipped for the kitting item, and then click **Components**.

      The O/E Kitting Components screen appears, listing the items that make up the kit.

      The Serialized/Lotted column displays Yes for items that are serialized or lotted.

   c. For each serialized or lotted component item:

      i. In the **Qty. Ordered** field, enter a quantity for the item, and then press **Tab**.
Chapter 2: Entering and Posting Order Entry Transactions

If your system is set up to use the Qty. Ordered field to allocate serial/lot numbers, the Serial/Lot Numbers Allocation screen appears. Otherwise, proceed to the following step.

ii. In the Qty. Shipped field, enter a quantity for the item, and then press Tab.

If your system does not use the option to allocate serial numbers and/or lot numbers using the quantity ordered, the Serial/Lot Numbers Allocation screen appears.

iii. Allocate serial numbers and lot numbers as required.

The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

Ways to allocate serial numbers

- In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.

- On the Serials tab, click Auto-Alloc. to allocate all required serial numbers.

**Note:**

- By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the Auto-Allocate From option, and then enter a number in the field.

- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

Ways to allocate lot numbers

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.

- On the Lots tab, click Auto-Alloc. to allocate all required lot numbers.
Serial and Lot Numbers

Note:
- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

To indicate that serial numbers or lot numbers have been shipped:

If you allocate serial numbers to the quantity ordered (instead of the quantity shipped), when you ship items, you indicate that serial numbers or lot numbers have been shipped. To do this:

1. On the Details table, select a detail for a serialized or lotted item, then click the **Qty. Shipped** column header.

   The Serial/Lot Numbers Allocation screen appears.

2. On the Serials tab, change the Shipped status for serial numbers:
   - To change the Shipped status to Yes for an individual serial number, double-click in the **Shipped** column on a detail line.
   - To change the Shipped status to Yes for all the serial numbers in the list, click **Ship All**.

3. On the Lots tab, enter the quantity shipped for lot numbers:
   - To indicate the quantity shipped for an individual lot number, enter an amount in the **Quantity Shipped** column on a detail line.
   - To ship all the lot quantities listed on all lines, click **Ship All**.

Allocating Serial Numbers or Lot Numbers to a Shipment

During transaction entry, you can allocate serial numbers or lot numbers to items and to components of kitting items.

d. Click **Close** to return to the O/E Kitting Components screen.
e. Click **Close** to return to the O/E Order Entry screen.
Chapter 2: Entering and Posting Order Entry Transactions

**Note:** You can specify (in Inventory Control) whether you will allocate serial numbers and lot numbers from the **Quantity Ordered** field or the **Quantity Shipped** field. For more information, see "About Serialized Inventory and Lot Tracking" (page 154).

To allocate serial numbers or lot numbers to items:

1. Open **Order Entry > O/E Transactions > Shipment Entry**.
2. Enter information for the shipment.
3. Do one of the following:
   - If you entered an order number and you are shipping all of the items on backorder, click **Ship All**.
   - If you did not enter an order number or you are not shipping all of the items on backorder, specify an inventory location for each serialized or lotted item detail. (Because serial numbers and lot numbers are maintained by location, you must specify a location before you enter a quantity.)
4. Allocate serial numbers and lot numbers to non-kitting items.
   - On the Details table, select a detail for a serialized or lotted item, and then click the **Qty. Shipped** column header.
     The Serial/Lot Numbers Allocation screen appears. This screen includes a Serials tab if the item is serialized and/or a Lots tab if the item is lotted.
   - Allocate serial numbers and lot numbers as required.
     The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

**Ways to allocate serial numbers**

- In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.
- On the Serials tab, click **Auto-Alloc.** to allocate all required serial numbers.
Serial and Lot Numbers

### Note:
- By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

### Ways to allocate lot numbers
- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.
- On the Lots tab, click **Auto-Alloc.** to allocate all required lot numbers.

#### Note:
- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

**c.** When the quantity of serial numbers and/or lot numbers remaining is zero, click **Close** to return to the O/E Shipment Entry screen.

### 5. Allocate serial numbers and lot numbers to kitting items.

#### a. On the Details table, select a detail for a kitting item that includes serialized or lotted components.

#### b. Click **Components.**

#### c. On the O/E Kitting Components screen that appears, select a serialized or lotted item, and then click the **Qty. Shipped** column header.

The Serial/Lot Numbers Allocation screen appears.

#### d. Allocate serial numbers and lot numbers as required.

The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.
Chapter 2: Entering and Posting Order Entry Transactions

Ways to allocate serial numbers

- In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.

- On the Serials tab, click **Auto-Alloc.** to allocate all required serial numbers.

**Note:**
- By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.

- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

Ways to allocate lot numbers

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.

- On the Lots tab, click **Auto-Alloc.** to allocate all required lot numbers.

**Note:**
- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.

- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

e. Click **Close** to return to the O/E Kitting Components screen.

f. Click **Close** to return to the O/E Shipment Entry screen.

**Allocating Serial Numbers or Lot Numbers to an Invoice**

During transaction entry, you can allocate serial numbers or lot numbers to items and to components of kitting items.
Serial and Lot Numbers

**Note:** You can allocate serial numbers and lot numbers only if you are invoicing for a quantity that is different from the quantity shipped.

To allocate serial numbers or lot numbers to items:

1. Open **Order Entry > O/E Transactions > Invoice Entry**.
2. Enter information for the invoice.
3. Allocate serial numbers and lot numbers to non-kitting items.
   a. On the Details table, select a detail for a serialized or lotted item, and then click the **Qty. invoiced** column header.
      
      The Serial/Lot Numbers Allocation screen appears. This screen includes a Serials tab if the item is serialized and/or a Lots tab if the item is lotted.
      
      b. Allocate serial numbers and lot numbers as required.

      The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

      **Ways to allocate serial numbers**

      - In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.
      - On the Serials tab, click **Auto-Alloc.** to allocate all required serial numbers.

      **Note:**

      - By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
      - If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

      **Ways to allocate lot numbers**

      - In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.
Chapter 2: Entering and Posting Order Entry Transactions

- On the Lots tab, click **Auto-Alloc.** to allocate all required lot numbers.

**Note:**
- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

c. When the quantity of serial numbers and/or lot numbers remaining is zero, click **Close** to return to the O/E Invoice Entry screen.

4. Allocate serial numbers and lot numbers to kitting items.

   a. On the Details table, select a detail for a kitting item that includes serialized or lotted components.

   b. Click **Components.**

   c. On the O/E Kitting Components screen that appears, select a serialized or lotted item, and then click the **Qty. Invoiced** column header.

   The Serial/Lot Numbers Allocation screen appears.

   d. Allocate serial numbers and lot numbers as required.

   The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

   **Ways to allocate serial numbers**

   - In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.

   - On the Serials tab, click **Auto-Alloc.** to allocate all required serial numbers.

   **Note:**

   - By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and
then enter a number in the field.

- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

Ways to allocate lot numbers

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.
- On the Lots tab, click **Auto-Allocl**. to allocate all required lot numbers.

**Note:**

- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

e. Click **Close** to return to the O/E Kitting Components screen.

f. Click **Close** to return to the O/E Invoice Entry screen.

**Allocating Serial Numbers or Lot Numbers to a Credit Note**

During transaction entry, you can allocate serial numbers or lot numbers to items and to components of kitting items.

**To allocate serial numbers or lot numbers to items:**

1. Open **Order Entry > O/E Transactions > Credit/Debit Note Entry**.
2. On the **Document Type** list, select **Credit Note**.
3. Select the invoice number, if necessary.

Order Entry automatically fills in other fields with information from the invoice.
**Note:** If you select an invoice number, you cannot allocate serial numbers or lot numbers to details that existed on the invoice. However, you can allocate serial and lot numbers to new details that you add. You can also delete serial and lot numbers from existing details.

4. For the detail that includes the item being returned, enter item information and the location to which you are returning the item, and then select **Items Returned To Inventory** as the credit type.

**Note:** You cannot allocate serial numbers or lot numbers if you select **Damaged Items** or **Price Adjustment** as the credit type.

5. Allocate serial numbers and lot numbers to non-kitting items.

   a. Enter a quantity in the **Quantity** column if necessary, and then click the Zoom button in the **Quantity** column heading.

      The Serial/Lot Numbers Allocation screen appears. This screen includes a Serials tab if the item is serialized and/or a Lots tab if the item is lotted. For serialized items, you can select serial numbers that are allocated to items that have been shipped, or you can generate new serial numbers.

   b. Allocate serial numbers and lot numbers as required.

      **Note:** The quantity of serial numbers or lot numbers you require appears in the Serial Number or Lot Number list. The quantity remaining to be allocated is reduced as you allocate numbers.

      **Ways to allocate serial numbers**

      - In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.

      - On the Serials tab, click **Auto-Alloc.** to generate all required serial numbers.

      **Note:**

      - By default, serial numbers are generated starting with the first available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

Ways to allocate lot numbers

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.
- On the Lots tab, click **Auto-Alloc.** to generate all required serial numbers.

**Note:**
- By default, lot numbers are generated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

6. Allocate serial numbers and lot numbers to kitting items.

   a. On the Details table, select a detail for a kitting item that includes serialized or lotted components.

   b. Enter the quantity ordered and the quantity shipped for the kitting item, and then click **Components**.

      The O/E Kitting Components screen appears, listing the items that make up the kit.

      The Serialized/Lotted column displays Yes for items that are serialized or lotted.

   c. For each serialized or lotted component item:

      i. In the **Qty. Ordered** field, enter a quantity for the item, and then press Tab.

      If your system is set up to use the **Qty. Ordered** field to allocate serial/lot numbers, the Serial/Lot Numbers Allocation screen appears. Otherwise, proceed to the following step.
ii. In the Qty. **Shipped** field, enter a quantity for the item, and then press **Tab**.

iii. Allocate serial numbers and lot numbers as required.

   The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

**Ways to allocate serial numbers**

- In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.

- On the Serials tab, click **Auto-Alloc.** to allocate all required serial numbers.

**Note:**

- By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.

- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

**Ways to allocate lot numbers**

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.

- On the Lots tab, click **Auto-Alloc.** to allocate all required lot numbers.

**Note:**

- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
Serial and Lot Numbers

- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

d. Click Close to return to the O/E Kitting Components screen.

e. Click Close to return to the O/E Credit/Debit Note Entry screen.

7. Enter any additional information required for the credit note, and then post the transaction.

Allocating Serial Numbers or Lot Numbers to a Debit Note

During transaction entry, you can allocate serial numbers or lot numbers to items and to components of kitting items.

To allocate serial numbers or lot numbers to items:

1. Open Order Entry > O/E Transactions > Credit/Debit Note Entry.

2. On the Document Type list, select Debit Note.

3. Select the invoice number, if necessary.

Order Entry automatically fills in other fields with information from the invoice.

Note: If you select an invoice number, you cannot allocate serial numbers or lot numbers to details that existed on the invoice. However, you can allocate serial and lot numbers to new details that you add. You can also delete serial and lot numbers from existing details.

4. For the detail that includes the item being removed from inventory, enter item information and the location from which you are removing the item, and then select Items Removed From Inventory as the debit type.

Note: You cannot allocate serial numbers or lot numbers if you select Damaged Items or Price Adjustment as the credit type.

5. Allocate serial numbers and lot numbers to non-kitting items.

a. Enter a quantity in the Quantity column if necessary, and then click the Zoom button in the Quantity column heading.

The Serial/Lot Numbers Allocation screen appears. This screen includes a Serials tab if the item is serialized and/or a Lots tab if the item is lotted.
b. Allocate serial numbers and lot numbers as required.

The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

**Ways to allocate serial numbers**

- In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.
- On the Serials tab, click **Auto-Alloc.** to allocate all required serial numbers.

**Note:**
- By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

**Ways to allocate lot numbers**

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.
- On the Lots tab, click **Auto-Alloc.** to allocate all required lot numbers.

**Note:**
- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

6. Allocate serial numbers and lot numbers to kitting items.

   a. Select the kitting item in the Detail table, and then click the **Components** button.
The O/E Kitting Components screen appears, listing the items that make up the kit.

The Serialized/Lotted column displays Yes for items that are serialized or lotted.

b. For each serialized or lotted component item:
   i. In the Qty. Ordered field, enter a quantity for the item, and then press Tab.

   If your system is set up to use the Qty. Ordered field to allocate serial/lot numbers, the Serial/Lot Numbers Allocation screen appears. Otherwise, proceed to the following step.

   ii. In the Qty. Shipped field, enter a quantity for the item, and then press Tab.

   iii. Allocate serial numbers and lot numbers as required.

   The quantity of serial numbers or lot numbers you require appears in the lower left part of the screen. The quantity remaining to be allocated is reduced as you allocate numbers.

Ways to allocate serial numbers

- In the Serial Number list, allocate serial numbers one at a time by manually entering them or by using the Finder.

- On the Serials tab, click Auto-Alloc. to allocate all required serial numbers.

Note:

- By default, serial numbers are allocated starting with the first available serial number, but you can specify a different starting number. To do this, select the Auto-Allocate From option, and then enter a number in the field.

- If there are fewer serial numbers available than are required, all available serial numbers will be allocated, and a message will notify you that not all required serial numbers were allocated.

Ways to allocate lot numbers

- In the Lot Number list, allocate lot numbers one at a time by manually entering them or by using the Finder.
On the Lots tab, click **Auto-Alloc.** to allocate all required lot numbers.

**Note:**
- By default, lot numbers are allocated starting with the first available lot number, but you can specify a different starting number. To do this, select the **Auto-Allocate From** option, and then enter a number in the field.
- If there are fewer lot numbers available than are required, all available lot numbers will be allocated, and a message will notify you that not all required lot numbers were allocated.

c. Click **Close** to return to the O/E Kitting Components screen.
d. Click **Close** to return to the O/E Credit/Debit Note Entry screen.
e. Enter any additional information required for the document, and then post the transaction.

### Allocating Serial Numbers or Lot Numbers to Items in Copied Orders

When using the O/E Copy Orders screen to copy orders, you can allocate serial numbers or lot numbers to items included in the new order.

**Note:** The procedure you follow depends on whether the items are kitting items or not.

**To allocate serial numbers and lot numbers for items that are kitting items:**

1. Open **Order Entry > O/E Transactions > Copy Orders.**
2. Enter information about the source order(s) and the new order you are creating. For more information, see "Copying Orders" (page 104).
3. Click the Go >> button.
   
   Details you can copy to the new order appear in the Copy Orders Detail table.
4. Select the detail line for a kitting item, and then click the **Kit Component** button.

   The O/E Kitting Components screen appears, listing the items that make up the kit. The Serialized/Lotted column displays **Yes** for each serialized or lotted item.
5. Allocate numbers for each serialized or lotted item.
   a. On the detail line, select or tab to the **Qty. Ordered** field.
   b. Press the Tab key to leave the field.
      The O/E Serial/Lot Numbers Allocation screen appears.
   c. Allocate serial numbers and/or lot numbers for the item. For more information, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

6. When you have finished allocating serial numbers and/or lot numbers, close the O/E Serial/Lot Numbers Allocation screen and the O/E Kitting Components screen, and then finish editing information and details for the new order.

7. Click **Create** to create the order.

**To assign serial numbers and lot numbers for items that are not kitting items:**

1. Open **Order Entry > O/E Transactions > Copy Orders**.

2. Enter information about the source order(s) and the new order you are creating. For more information, see "Copying Orders " (page 104).

3. Click the Go >> button.

   Details you can copy to the new order appear in the Copy Orders Detail table.

4. On the detail line for an item, select or tab to the **Qty. Ordered** field.

5. Press the Tab key to leave the field.

   The O/E Serial/Lot Numbers Allocation screen appears.

6. Allocate serial numbers and/or lot numbers for the item. For more information, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

7. When you have finished allocating serial numbers and/or lot numbers, close the O/E Serial/Lot Numbers Allocation screen, and then finish editing information and details for the new order.

8. Click **Create** to create the order.
Chapter 2: Entering and Posting Order Entry Transactions

Taxes

Change tax amounts, tax groups, and tax classes for Order Entry documents.

About Taxes

Order Entry can calculate taxes for documents automatically, or you can manually enter and distribute tax amounts to document details.

- Calculating Tax Amounts Automatically
- Entering and Distributing Tax Amounts
- Changing Tax Amounts
- Tax Groups and Tax Classes
- Tax Groups and Order Entry Templates
- Tax Groups and Project and Job Costing

Calculating Tax Amounts Automatically on Documents

Order Entry calculates sales tax using the rates defined for the customer tax class and item tax classes for each authority that can levy taxes on the customer.

You specify the tax rates for tax authorities and tax classes in Tax Services.

Order Entry calculates sales taxes automatically if:

- The Calculate Tax option on the Taxes tab is selected. (The option is selected by default.)
- The customer is subject to tax.

You enter the tax classes and tax registration numbers for each customer in Accounts Receivable. However, you can change the customer tax class for individual documents on transaction entry screens.

- The document contains taxable items or taxable miscellaneous charges.

Item tax classes are set up in Inventory Control, but you can change the tax classes for a detail while editing the detail line. You can also specify whether tax is included in or excluded from the price of an item.
**Entering and Distributing Tax Amounts**

You can use the Taxes tab on the Order Entry screen to manually enter and distribute tax amounts and tax reporting amounts (if reporting tax in another currency).

For instructions, see "Entering and Distributing Tax Amounts" (page 182) and "Entering Taxes Manually" (page 183).

**Changing Tax Amounts**

You can change the tax amounts on Order Entry orders, shipments, invoices, credit notes, and debit notes by changing the following settings:

- The tax group and tax classes for the customer.
  
  The customer tax group determines the tax jurisdiction (taxing authorities) for the document.
  
  The customer tax classes determine whether the customer is subject to tax within a jurisdiction.

- The tax class, taxable status, or tax amount for any of the detail lines.
  
  Default item tax classes are assigned to items in Inventory Control.

- The actual tax amounts for the entire document or for individual details.

For instructions on changing tax groups and tax classes, see "Changing Tax Groups and Tax Classes for Order Entry Documents" (page 180).

For instructions on changing tax amounts directly, see "Changing Tax Amounts for Order Entry Documents" (page 178).

**Tax Groups and Tax Classes**

Tax groups and tax classes are defined in Tax Services.

A customer tax group determines the tax authorities (jurisdictions) to which a customer is subject. Customers are assigned to tax groups in Accounts Receivable, and they are assigned a tax class for each authority in their tax group. In a multicurrency system, the tax group on a document must use the same currency as the account set specified in the customer record.

Inventory items are assigned default item tax classes in Inventory Control.

For instructions on changing tax groups and tax classes, see "Changing Tax Groups and Tax Classes for Order Entry Documents" (page 180).
**Chapter 2: Entering and Posting Order Entry Transactions**

**Tax Groups and Order Entry Templates**

If you use Order Entry templates, the tax group you select for a template is used for an order or shipment only if you have not yet added the customer record. The tax group specified in the customer record always overrides the tax group specified in the template.

If you use multicurrency accounting, when you use a template to create an order or shipment for a customer that has not yet been added to Accounts Receivable, the tax group sets the currency and the reporting currency for the order or shipment.

For more information, see "O/E Templates Screen" (page 334).

**Tax Groups and Project and Job Costing**

Project and Job Costing allows tax groups to be specified by project on an invoice. When Project and Job Costing creates an invoice, it uses each project's tax group to calculate tax. Therefore, you can enter details for contracts and projects that use different tax groups on the same document, provided Project and Job Costing handles the invoicing. (This is the case if you select **Project Invoicing** for a document.)

However, if you will produce the invoice in Order Entry, you must use separate orders for contracts and projects that use different tax groups. This is because the tax group specified for an Order Entry invoice applies to all the document details.

**Note:** If you create an order or shipment for a "non-existent" customer (a customer for which no record exists in Accounts Receivable) and select **Project Invoicing**, you will not be able to add order or shipment details unless the default template includes a tax group. (The tax group is not editable if you select **Project Invoicing**, and it will be blank unless it is specified in the template.)

**Changing Tax Amounts for Order Entry Documents**

You can change the tax amounts on Order Entry orders, shipments, invoices, credit notes, and debit notes by changing the following settings:

- The tax group and tax classes for the customer.

  The customer tax group determines the tax jurisdiction (taxing authorities) for the document.
The customer tax classes determine whether the customer is subject to tax within a jurisdiction.

- The tax class, taxable status, or tax amount for any of the detail lines.
  Default item tax classes are assigned to items in Inventory Control.
- The actual tax amounts for the entire document or for individual details.

You can also specify whether Order Entry calculates taxes automatically.

Order Entry calculates sales taxes automatically if:

- The Calculate Tax option on the Taxes tab is selected. (The option is selected by default.)
- The customer is subject to tax.

You enter the tax classes and tax registration numbers for each customer in Accounts Receivable. However, you can change the customer tax class for individual documents on transaction entry screens.

- The document contains taxable items or taxable miscellaneous charges.

  Item tax classes are set up in Inventory Control, but you can change the tax classes for a detail while editing the detail line. You can also specify whether tax is included in or excluded from the price of an item.

This topic describes how to change the actual tax amounts on a document. For more detailed information on how to change the tax group or tax classes, see "Changing Tax Groups and Tax Classes for Order Entry Documents" (page 180).

**To change the total tax amount for a document:**

1. Display the document whose tax information you want to change.
   a. Open **Order Entry > O/E Transactions**.
   b. Open **Order Entry, Shipment Entry, Invoice Entry**, or **Credit/Debit Note Entry**.
   c. Type the number of the document that you want to edit, or select it using the Finder Q.

2. Click the **Taxes** tab.

3. Change any customer tax classes, as necessary, and then click the **Calc. Taxes** button to see the results of the change.
To change a customer tax class, click in the **Customer Tax Class** field for the tax authority, and then use the Finder to select the correct tax class.

4. To enter taxes manually: Clear the Calculate Tax option. You cannot edit taxes or see the Dist. Taxes button if the Calculate Tax option is selected. Enter new tax amounts. You can also change the tax base, if necessary. Click the Dist. Taxes button to distribute the new tax totals automatically to all the detail lines on the document.

**To change tax information for single items:**

1. Display the document whose tax information you want to change.
   
a. Open **Order Entry > O/E Transactions**.

b. Open **Order Entry, Shipment Entry, Invoice Entry**, or **Credit/Debit Note Entry**.

c. Type the number of the document that you want to edit, or select it using the Finder.

2. If you are going to adjust tax amounts for details manually, clear the Calc. Taxes option. Tax amounts are not recalculated automatically unless you select the Calc. Tax option. If you want to recalculate taxes, you must select the Calculate Tax option or use the Calc. Taxes button on the Taxes tab.

3. On the Detail table, select the detail for which you want to edit tax information, and then click the **Item/Tax** button or press F9.

4. For each tax authority, as required: In the tax table at the bottom of the screen, change the Tax Class or the Tax Included field. You can change this setting only if the tax authority (in Tax Services) allows tax to be included in the price. To change tax amounts manually, enter the new tax base and tax amount for the detail line. When you are finished, click Close. The tax amounts are not recalculated until you close this window and move to another document tab.

5. To check tax amounts for the entire document, click the **Taxes** tab or the **Totals** tab.

**Changing Tax Groups and Tax Classes for Order Entry Documents**

You can change the tax amounts on Order Entry orders, shipments, invoices, credit notes, and debit notes by changing the following settings:
• The tax group and tax classes for the customer.

  The customer tax group determines the tax jurisdiction (taxing authorities) for the document.

  The customer tax classes determine whether the customer is subject to tax within a jurisdiction.

• The tax class, taxable status, or tax amount for any of the detail lines.

  Default item tax classes are assigned to items in Inventory Control.

• The actual tax amounts for the entire document or for individual details.

This topic describes how to change the tax jurisdiction and taxable status of an Order Entry document. For information on changing tax amounts directly, see "Changing Tax Amounts for Order Entry Documents " (page 178).

**Note:** You cannot change information for a completed order, for an invoiced shipment, or for a posted invoice.

**To change the customer tax group or the tax classes for an Order Entry document:**

1. Display the document whose tax information you want to change.
   
   a. Open **Order Entry > O/E Transactions**.
   
   b. Open **Order Entry, Shipment Entry, Invoice Entry**, or **Credit/Debit Note Entry**.
   
   c. Type the number of the document that you want to edit, or select it using the Finder Q.

2. To change the tax authorities (jurisdiction) for the document, change the customer tax group, as follows:
   
   a. Click the **Customer** tab.
   
   b. In the **Tax Group** field, type the new tax group code, or select it using the Finder Q.

3. To change whether the customer is taxable, change the customer tax class, as follows:
   
   a. Click the **Taxes** tab.
   
   b. In the **Customer Tax Class** field for each tax authority, enter the
correct customer tax class for this document.

c. Enter a tax registration number, if necessary.

4. To change the tax class or the Tax Included status for an item or miscellaneous charge:
   a. Click the first tab for the document. (Depending on the type of document, this is the Order, Shipment, or Invoice tab.)
   b. On the Detail table, select the detail for which you want to edit tax information, and then click the Item/Tax button, or press F9.
   c. For each tax authority, as required:
      i. On the tax table at the bottom of the screen, for each tax authority, change the Tax Class.
      ii. Change the Tax Included setting, if necessary.

   Note: You can change this setting only if the tax authority (in Tax Services) allows tax to be included in the price.

d. Click Save, and then close the O/E Items/Taxes screen.

5. When you have finished editing the document, post it.

**Entering and Distributing Tax Amounts**

You can manually enter item tax amounts for each detail on an Order Entry document, or you can enter total tax amounts for the document, and distribute tax amounts to document details.

**To enter item tax amounts manually:**

1. Open a transaction entry screen, such as O/E Order Entry.
2. Clear the Calc. Tax option.
3. Select a detail line for which you want to edit tax amounts, and then click the Item/Tax button.
4. On the tax table at the bottom of the screen, for each tax authority, change the sales tax class, tax base, and tax amount, as required.
To enter document taxes manually, and distribute tax amounts to details:

1. Open a transaction entry screen, such as O/E Order Entry.
2. On the Taxes tab, clear the Calculate Tax option.
3. Change the customer tax class, tax base, tax amount, and tax reporting amount (if reporting tax in another currency), as required.
4. Click the Dist. Taxes button to distribute the amounts on the Taxes tab to the individual document detail lines.

**Note:** If you entered tax amounts for individual detail lines, do not redistribute the total. You will overwrite the entries that you made for document details.

To manually enter tax reporting amounts (if reporting tax in another currency):

1. Open a transaction entry screen, such as O/E Order Entry.
2. On the Taxes tab, clear the Calculate Tax Reporting option.
3. For each tax authority, enter the correct tax reporting amount.
4. On the Rates tab, click the Derive Rate button.

Order Entry automatically prorates and allocates to document details the total tax amount you entered.

**Entering Taxes Manually**

For each transaction you enter, and for each detail line included in the transaction, you can enter taxes manually or Order Entry can calculate taxes automatically.

**Note:** If an order is job related and you select the Project Invoicing option, you cannot enter taxes manually. The Calculate Tax option is automatically selected, and you cannot change it.

When you enter taxes manually, you must enter the following information for each authority within the tax group:

- The total tax amount
- The tax amount for each detail included in the transaction
You can enter the total tax amount for each authority and then enter the tax for individual details, or you can enter the taxes for each detail first and then enter the total amounts.

**Important!** The total tax amounts must equal the sum of the detail taxes entered for each authority.

**To enter taxes manually for a transaction:**

1. Open **Order Entry > O/E Transactions**.
2. Open **Order Entry, Shipment Entry, or Invoice Entry**.
3. Clear the **Calculate Tax** option if it is selected.
4. Enter order information and item details.

   For more information about entering information and details, see "Entering an Order " (page 92).

   For more information about specific fields and controls on the O/E Order Entry screen, see "O/E Order Entry Screen" (page 389).

5. On the Taxes tab, enter the tax base and total tax amounts for each tax authority.

   **Note:** You can review tax amounts for document details on the O/E Items/Taxes screen. For more information, see "O/E Items/Taxes Screen" (page 460).

6. If you want to prorate the total tax amount to document details, click **Dist. Taxes**.

   **Note:** If you click **Calc. Taxes**, Order Entry calculates tax amounts and replaces any tax amounts you have entered manually.

   Order Entry automatically prorates and allocates to document details the total tax amount you entered.

   You can also enter tax amounts manually for each detail line, as described in the next procedure.

7. Review remaining transaction information and details, and then post the transaction.

   **Tip:** To allocate the total tax amounts automatically to individual items, click the **Dist. Tax** button on the Taxes tab.
To enter taxes manually for a detail line:

1. Open **Order Entry > O/E Transactions**.
2. Open **Order Entry, Shipment Entry**, or **Invoice Entry**.
3. On the Detail table, select the detail line for which you want to adjust taxes, and then click the **Item/Tax** button.
   
The O/E Items/Taxes screen appears.
4. On the tax table at the bottom of the screen, in the **Tax Base** and **Tax Amount** columns, enter the tax base and tax amount you have calculated for the detail line.

   **Important!** After entering the tax base and tax amount for all detail lines, ensure that the sum of the taxes for the details equals the total tax amount you entered in the **Tax Amount** column on the Taxes tab of the O/E Order Entry screen.

5. Review remaining information and details, and then post the document.

**After distributing tax amounts manually**

You can allocate taxes manually to partial shipments.

If you partially ship and invoice an order for which taxes have been entered manually, a message asks whether you want the program to recalculate taxes.

- If you want Order Entry to recalculate taxes for the invoice (for the items shipped) and for the order (for the items remaining on order), click **Yes**.
- If you want to post the invoice without recalculating taxes for the invoice and the order, click **No**. The invoice will be posted with the full tax amounts specified on the order.
- If you want to cancel posting and return to the transaction entry screen to enter recalculated taxes manually, click **Cancel**.
Chapter 3: Looking Up Statistics and Information in Order Entry

Use Order Entry Statistics and Inquiries screens to look up information about customers and transactions.

**Adding Sales Statistics**

If you selected the **Allow Edit of Sales Statistics** option on the O/E Options screen, you can use the O/E Sales Statistics screen to add and edit sales statistics.

**Before you start:**

- You must select the **Allow Edit of Sales Statistics** option on the O/E Options screen before you can use this screen to add and edit statistics.

**To add sales statistics:**

1. Open **Order Entry > O/E Statistics and Inquiries > Sales Statistics**.
   
   For more information about this screen, see "O/E Sales Statistics Screen" (page 381).

2. Select a year for which to view sales statistics.

3. If you use multicurrency accounting, select a currency.

4. Enter total sales and statistics for invoices, credit notes, and debit notes.

   **Note:** If you use multicurrency accounting, amounts appear in both the customer’s currency and your company’s functional currency.

5. When you are finished adding statistics for the period, click **Save**.

**Looking Up Sales Statistics**

If you selected the **Keep Sales Statistics** option on the O/E Options screen, you can view sales statistics for the years and periods for which you keep statistical data.
**To look up sales statistics:**

1. Open **Order Entry > O/E Statistics and Inquiries > Sales Statistics**.
   
   For more information about this screen, see "O/E Sales Statistics Screen" (page 381).

2. Select a year and period for which to view sales statistics.

3. If you use multicurrency accounting, select a currency.

4. To print a report of the selected statistics:
   
   - Click **File > Print**.
   
   - Review the settings on the O/E Sales Statistics Report screen, edit settings as necessary, and then print the report.
   
   For more information, see "O/E Sales Statistics Report Screen" (page 294).

   - Click **Close** to return to the O/E Sales Statistics inquiry screen.

**Looking Up Posted Documents**

In Order Entry, you can use several inquiry and reporting features to review posted orders, shipments, invoices, credit notes, and debit notes in summary or in detailed form.

You can use the following screens and features to look up posted documents:

- **Transaction entry screens.** On transaction entry screens such as Order Entry, Shipment Entry, and Invoice Entry, you can open and review posted documents.

- **Buttons.** On many screens, you can click Drilldown or **Details** buttons to open source documents in transaction entry or inquiry screens.

- **Statistics and Inquiry screens.** Use these screens to look up current orders, pending shipments, sales history, sales statistics, or salesperson information. For more information, see "Statistics and Inquiries Screens" (page 359).

**To look up posted documents on transaction screens:**

1. Open **Order Entry > O/E Transactions**.

2. Select a transaction entry screen, such as **Order Entry**.
3. If you want to view the document on the transaction entry screen, enter the document number or use the Finder to search for documents.

4. If you want to drill down to a source document, use Finders, buttons, or read-only fields to find the source transaction.
   - Use the Finder to search for orders, shipments, or invoices.
   - After selecting a source document in a field, click the Drilldown, Zoom, or Inquiry button beside the field to open the source document in other transaction entry and inquiry screens.
   - In some table columns, you can double-click a detail line or click the Drilldown button in the column header to open source documents.
   - Depending on the type of document you are viewing, read-only fields display information about related documents. For example, the O/E Order Entry screen displays Last Shipment Number and Last Invoice Number fields for the current order.

To look up current orders by customer using the O/E Current Orders Inquiry screen:

1. Open Order Entry > O/E Statistics and Inquiries > Current Orders Inquiry.

2. Enter the number of the customer whose orders you want to review.

3. Specify order types, date ranges, and order statuses to include. For more information about using this screen, see "O/E Current Orders Inquiry Screen" (page 359).

4. Click the Go button.
   Orders that match the criteria you specified appear in the table.

5. To view details for an order that appears in the results, select a detail line and click the Details button.
   The order appears in the O/E Order Entry screen.

To look up pending shipments by customer, item, and/or location using the O/E Pending Shipments Inquiry screen:

1. Open Order Entry > O/E Statistics and Inquiries > Pending Shipments Inquiry.

2. Specify shipment dates, customer numbers, item numbers, and/or locations to include, and specify order statuses to include. For more information about
using this screen, see "O/E Pending Shipments Inquiry Screen " (page 363).

3. Click the Go button.

Pending shipments that match the criteria you specified appear in the table.

4. To view details for a document that appears in the results, click Details to open the O/E Pending Shipments Inquiry Details screen. For more information, see "O/E Pending Shipments Inquiry Details Screen " (page 366).

**To look up invoices and credit notes by salesperson using the O/E Salesperson Inquiry screen:**

1. Open Order Entry > O/E Statistics and Inquiries > Salesperson Inquiry.

2. Select a salesperson.

3. Specify the customer number, document type, range of years and periods, and (if you use multicurrency accounting) currency to include. For more information about using this screen, see "O/E Salesperson Inquiry Screen " (page 386).

4. Click the Go button.

Documents that match the criteria you specified appear in the table.

5. To view or print a document that appears in the results, select the detail line for the document and click the Details button.

**Looking Up Sales History for Items or Customers**

If you keep sales history in Order Entry, you can view sales history and drill down to transactions for the fiscal years and periods for which you have kept history.

You can use the O/E Sales History screen to display all items ordered by a customer, or to display all customers who ordered an item. The screen displays all sales and returns of items for the fiscal years and periods for which you keep history.
To look up sales history for an item or a customer:

1. Open Order Entry > O/E Statistics and Inquiries > Sales History.

2. Specify a range of years and periods for which to view sales history.

3. Specify a customer or item for which you want to view sales history.
   - To view all the customers who ordered or returned a particular item, select Item Number, and then enter an item number.
   - To view all the items ordered or returned by a particular customer, select Customer Number, and then enter a customer number.

4. If you use multicurrency accounting, specify whether to display amounts in your functional currency or in the customer's currency.

5. Click the Go button to view results.

If you are viewing sales history for a customer, the program lists all the items used on invoices or returns for the customer for the selected range of years and periods.

If you are viewing sales history for an item, the program lists all the customers to which you sold the item for the selected range of years and periods.

After looking up sales history for an item or a customer

- To view additional information about the selected customer or item, click the Details button to open the O/E Sales History Detail screen. For more information, see "O/E Sales History Detail Screen" (page 374)

- To print a report, click File > Print.
Chapter 4: Customizing and Printing Order Entry Forms

Use the report forms that come with Order Entry to print invoices, quotes, credit notes, debit notes, order confirmations, receipts, shipping labels, and picking slips, or select a customized version.

About Order Entry Customer Forms

Order Entry includes the following forms:

- "O/E Order Confirmations Screen" (page 256)
- "O/E Invoices Screen" (page 254)
- "O/E Picking Slips Screen" (page 260)
- "O/E Credit/Debit Notes Screen" (page 250)
- "O/E Shipping Labels Screen" (page 268)
- "O/E Quotes Screen" (page 265)

You can print order confirmations, receipts, invoices, credit notes, and debit notes immediately after posting an Order Entry document, or you can print a range of these documents at any time.

Printing before Running Day End Processing

**Important!** If Order Entry does not use the option to keep transaction history, information for printed invoices, debit notes, and credit notes is deleted when you run Day End Processing in Inventory Control. You should always print these documents before running Day End Processing, because you will not be able to reprint these documents later.

Order Confirmations

You can print order confirmations immediately after posting an order, or at any time using the O/E Order Confirmations screen.

- To print order confirmations after posting an order, select the **Order Confirmation** option in the message that appears after you post the order.
Chapter 4: Customizing and Printing Order Entry Forms

For more information, see "Printing an Order Confirmation Immediately After Posting" (page 211).

- To print order confirmations for a range of posted orders before they are cleared from Order Entry, print the O/E Order Confirmations report. For more information, see "Printing Order Confirmations for a Range of Orders" (page 213).

**Invoices**

You can print invoices immediately after posting an invoice, or at any time using the O/E Invoices screen.

- To print an invoice after posting, select **Yes** to print the invoice after posting. For more information, see "Printing an Invoice Immediately After Posting" (page 205).

- To print a range of invoices, open the O/E Invoice Entry screen and fill in the range of invoices you want to print before they are cleared from Order Entry. For more information, see "Printing a Range of Invoices" (page 208).

**Credit Notes and Debit Notes**

You can print credit notes and debit notes immediately after posting, or at any time using the O/E Credit/Debit Notes screen.

For more information, see "Printing a Range of Credit Notes or Debit Notes" (page 202).

**Receipts**

You can print receipts immediately after posting a document, or at any time using the A/R Receipts screen in Accounts Receivable.

- Print a receipt immediately after posting an order or an invoice that includes a prepayment.

- Print one or more receipts using the A/R Receipts report in Accounts Receivable. For more information, see the Accounts Receivable help.

**Note:**

- For information about customizing Order Entry forms, see "Customizable Formats for Printed Order Entry Forms" (page 197).
After posting orders and invoices that include prepayments, you can also print receipts. Order Entry adds receipts to Accounts Receivable receipt batches. You can use the A/R Receipts screen to print prepayment confirmations.

**Printing Order Entry Customer Forms**

Order Entry includes customer forms that you can print "as is" or adapt to print on forms that you already use for quotes, order confirmations, picking slips, shipping labels, invoices, and credit and debit notes.

You can open Order Entry customer forms using the icons in the Forms folder on the desktop, or you can print these forms immediately after posting the corresponding transaction.

**Note:** You can also print Accounts Receivable receipts when entering prepayments with orders, shipments, and invoices.

For more information about these forms, see "About Order Entry Customer Forms" (page 193).

**Before you start:**

- Find out which report format to use for the form you are printing. For example, you might use different label formats depending on the destination or shipper.

  You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

**To print a customer form:**

1. Open **Order Entry > O/E Forms**.

2. Double-click the form you want to print.

3. Specify print options for the form.

   For information about the options available on the screen you are working with, press the F1 key.
4. If you want to review a document before printing, or to print a test copy to verify that information is aligned correctly on a preprinted form, click Align.

5. Click Print.

Order Entry prints the form to your usual print destination, and sets the document status to "Printed."

**Tip:**
If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**Sending Order Entry Forms to Customers by E-mail**

When you print Order Entry quotes, order confirmations, invoices, debit notes, and credit notes, you can send these forms to customers using the delivery method specified in the customer records, or you can print them to your usual print destination.

Customer delivery methods include Mail, E-mail, or Contact’s E-mail.

If you select Customer as the delivery method, Order Entry e-mails the forms immediately to customers that use an e-mail delivery method.

For customers that use Mail as the delivery method, the forms are sent to your usual print destination for regular mail delivery.

If you select Customer as the delivery method, Order Entry e-mails the forms to customers that use E-mail or Contact’s E-mail as the delivery method, along with an e-mail message that you select at the time of printing.

**To send Order Entry forms to customers by e-mail:**

1. In Accounts Receivable, for customers to whom you want to e-mail forms, make sure that E-mail or Contact’s E-mail is selected as the delivery option.
method, and that the e-mail addresses are up to date in the customer records. (For more information, see the Accounts Receivable help.)

2. Make sure that e-mail messages exist for the forms that you are sending by e-mail, or create them. For more information, see "Creating E-mail Messages" (page 43)

3. Open Order Entry > O/E Forms, and then select Quotes, Order Confirmations, Invoices, or Credit/Debit Notes.

4. When selecting options for printing the form:
   a. In the Delivery Method field, select Customer.
   b. In the Message ID field that appears, select the ID for the e-mail message you want to send with the current form.

5. Click Print.

When you print using the Customer delivery method, Sage 300 ERP creates a PDF or RTF version of the report, opens your default e-mail software, and attaches the report file to a new e-mail message.

Customizing Order Entry Forms

Order Entry includes customizable report formats for quotes, order confirmations, picking slips, shipping labels, invoices, and credit notes.

You may be able to print these reports "as is," or you can use Crystal Reports or Crystal Info to change the layout to suit your needs (or to create your own forms).

Customizable Formats for Printed Order Entry Forms

Order Entry includes customizable report formats for quotes, order confirmations, picking slips, shipping labels, invoices, and credit notes.

You may be able to print these reports "as is," or you can use Crystal Reports or Crystal Info to change the layout to suit your needs (or to create your own forms).

Note: For information about customizing Sage 300 ERP reports, see Customizing Printed Forms in the User Documentation section on the Sage 300 ERP Customer Portal.
### Customizable Order Entry Report Formats

<table>
<thead>
<tr>
<th>Sage 300 ERP Form</th>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Notes</td>
<td>OECRN01.RPT</td>
<td>A credit note for laser printers.</td>
</tr>
<tr>
<td>Credit Notes</td>
<td>OECRN02.RPT</td>
<td>A credit note for pre-printed forms.</td>
</tr>
<tr>
<td>Invoices</td>
<td>OEINV01.RPT</td>
<td>A &quot;datapiped&quot; invoice for laser printer (plain paper version).</td>
</tr>
<tr>
<td>Invoices</td>
<td>OEINV02.RPT</td>
<td>A &quot;datapiped&quot; invoice for pre-printed forms.</td>
</tr>
<tr>
<td>Invoices</td>
<td>OEINV03.RPT</td>
<td>An invoice for Internet inquiries (iConnect Sales Orders).</td>
</tr>
<tr>
<td>Invoices</td>
<td>OEINV04.RPT</td>
<td>A &quot;non-datapipe&quot; invoice for laser printer (plain paper version).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> To use this non-datapipe form, edit the OEINV01 section of OERP.INI.</td>
</tr>
<tr>
<td>Invoices</td>
<td>OEINV05.RPT</td>
<td>A &quot;non-datapipe&quot; invoice for pre-printed forms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> To use this non-datapipe form, edit the OEINV02 section of OERP.INI.</td>
</tr>
<tr>
<td>Order Confirmations</td>
<td>OECONF01.RPT</td>
<td>An order confirmation for laser printers.</td>
</tr>
<tr>
<td>Order Confirmations</td>
<td>OECONF02.RPT</td>
<td>An order confirmation for pre-printed forms.</td>
</tr>
<tr>
<td>Order Confirmations</td>
<td>OECONF03.RPT</td>
<td>An order confirmation for Internet orders (used by iConnect Sales Orders Order Entry).</td>
</tr>
<tr>
<td>Picking Slips</td>
<td>OEPICK01.RPT</td>
<td>A picking slip for laser printers.</td>
</tr>
<tr>
<td>Picking Slips</td>
<td>OEPICK02.RPT</td>
<td>A picking slip for pre-printed forms.</td>
</tr>
<tr>
<td>Quotes</td>
<td>OEQUOT01.RPT</td>
<td>A quote for laser printers.</td>
</tr>
<tr>
<td>Quotes</td>
<td>OEQUOT02.RPT</td>
<td>A quote for pre-printed forms.</td>
</tr>
</tbody>
</table>

### Datapipe Report Parameters for Printed Customer Forms

Order Entry includes both "datapipe" and "non-datapipe" invoice forms. You may be able to print these forms "as is," or you can use Crystal Reports or Crystal Info to change the layout to suit your needs (or to create your own forms).
A "datapipe" is a dynamic link library (DLL) program that performs database queries for reports or forms.

Because datapipes are compiled and optimized for specific reports, they can provide significant performance advantages over reports that use standard database access techniques (ODBC access).

The disadvantage of datapipes is that they provide access to a fixed group of fields. You cannot customize a datapiped report as much as you can customize non-datapiped one.

For information about customizing Sage 300 ERP reports, see *Customizing Printed Forms* in the User Documentation section on the Sage 300 ERP Customer Portal.

To include information in a "datapiped" report, set the corresponding parameter to 1.

If the information is not required on the report, set the parameter to 0.

### **OERPT.INI Parameters**

<table>
<thead>
<tr>
<th>#</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>PRM_PRN_TERMS</td>
<td>Print Invoice Terms</td>
</tr>
<tr>
<td>9</td>
<td>PRM_PRN_COMMENTS</td>
<td>Print Comments/Instructions</td>
</tr>
<tr>
<td>10</td>
<td>PRM_PRN_SERIALNUM</td>
<td>Print Serial Numbers</td>
</tr>
<tr>
<td>11</td>
<td>PRM_PRN_PREPAYMENT</td>
<td>Print Invoice Prepayment</td>
</tr>
<tr>
<td>12</td>
<td>PRM_PRN_ITEMINFO</td>
<td>Print Item/Location Info</td>
</tr>
<tr>
<td>13</td>
<td>PRM_PRN_CUSTINFO</td>
<td>Customer Info</td>
</tr>
<tr>
<td>14</td>
<td>PRM_PRN_SALESINFO</td>
<td>Salesperson Info</td>
</tr>
</tbody>
</table>

### Using Non-datapiped Invoice Forms

Order Entry includes both "datapiped" and "non-datapiped" invoice forms. You may be able to print these forms "as is," or you can use Crystal Reports or Crystal Info to change the layout to suit your needs (or to create your own forms).

**To use non-datapiped invoice forms:**

1. In your Sage 300 ERP program folder, locate the OERPT.INI file and open it in text editing software.
2. In the OEINV01 and OEINV02 sections:
   At the beginning of the type = DATAPIPE line, type an apostrophe.
   At the beginning of the datapipe path = ..\ line, type an apostrophe.

3. Save and close the file.

4. Restart Sage 300 ERP.

**Credit/Debit Notes**

Use the O/E Credit/Debit Notes report screen to print sales returns and other credit notes and debit notes posted to customer accounts in Order Entry.

**Printing a Credit Note or a Debit Note Immediately After Posting**

You can print a credit note or a debit note invoice immediately after posting it.

For more information about the O/E Credit/Debit Notes screen, see "O/E Credit/Debit Notes Screen " (page 250).

**Before you start:**

- Decide which report format to use for the document you are printing.

  The following formats for debit notes and credit notes are available with Order Entry:

  - **OECRN01.RPT.** A credit/debit note for laser printer (plain paper version).
  
  - **OECRN02.RPT.** A credit/debit note for preprinted forms.

You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

- If you are planning to send these forms by e-mail:
  
  - Make sure that E-mail or **Contact's E-mail** is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.
- Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages " (page 43).

- For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail " (page 196).

Note:
- If the Keep Transaction History option is not selected on the O/E Options screen, Sage 300 ERP deletes information for printed credit notes and debit notes when you run Day End Processing in Inventory Control, preventing you from reprinting any invoices after you run Day End Processing.

- Regardless of whether you keep history, however, you must print credit notes and debit notes before they can be cleared by Day End Processing or using the Clear History form.

- You can reprint credit notes and debit notes as many times as necessary before clearing them.

To print an invoice immediately after posting it:

1. On the O/E Credit/Debit Note Entry screen, create or select a credit note or debit note, and then click Post.

2. When prompted to print the credit note or debit note, click Yes.

   The O/E Credit/Debit Notes screen appears, displaying the document number you posted.

3. In the Use Credit Note (or Use Debit Note) field, select a template or a custom form to use.

   You can select one of the following formats, or a custom format:

   - OEcrn01.rpt. A credit/debit note for laser printer (plain paper version)
   - OEcrn02.rpt. A credit/debit note for preprinted forms.

4. Select a delivery method.

   You can select one of the following methods:

   - Select Print Destination to print the invoices to your usual print destination.
Chapter 4: Customizing and Printing Order Entry Forms

- Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable.

  If you select **Customer** as the delivery method, select the ID for the message you want to send with e-mailed documents.

  To view or edit the message for the selected ID, or to add a new e-mail message, click the Zoom button for the **Message ID** field.

5. Select options for printing the credit note or debit note.

You specify the following options, as needed:

- **Print Serial/Lot Numbers.** If you use Serialized Inventory and Lot Tracking, select this option if you want the printed document to show serial numbers or lot numbers assigned to serialized or lotted items.

- **Use Custom Form.** Select this option to use a custom form that does not use the report selection criteria set by this print form.

  **Important!** Select this option only if you are using a customized report form that requires it.

- **Print Kit Component Items.** Select this option if you want the printed document to show all components in kit assemblies.

- **Print Bills of Material Component Items.** Select this option if you want the printed document to show all components in assemblies that are manufactured from bills of material.

- **Retainage.** Select this option if you want the printed document to show retainage amounts.

  **Note:** The **Retainage** option appears only if you use Project and Job Costing and have selected the **Retainage Accounting** option in Accounts Receivable.

6. If you want to review the debit note or credit note before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click Align.

7. When you are ready to print, click **Print**.

**Printing a Range of Credit Notes or Debit Notes**

You can print a single credit note or debit note immediately after posting, or you can print a range of credit and debit notes using the O/E Credit/Debit
Notes screen.

For more information about the O/E Credit/Debit Notes screen, see "O/E Credit/Debit Notes Screen" (page 250).

**Before you start:**

- Decide which report format to use for the document you are printing.
  
  The following credit/debit note formats are available with Order Entry:
  - **OECRN01.RPT.** A credit/debit note for laser printer (plain paper version).
  - **OECRN02.RPT.** A credit/debit note for preprinted forms.

  You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

- If you are planning to send these forms by e-mail:
  
  - Make sure that E-mail or Contact's E-mail is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.
  
  - Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages" (page 43).

  - For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail" (page 196).

**Note:**

- If the Keep Transaction History option is not selected on the O/E Options screen, Sage 300 ERP deletes information for printed credit notes and debit notes when you run Day End Processing in Inventory Control, preventing you from reprinting any invoices after you run Day End Processing.

- Regardless of whether you keep history, however, you must print credit notes and debit notes before they can be cleared by Day End Processing or using the Clear History form.

- You can reprint credit notes and debit notes as many times as necessary before clearing them.
To print a range of credit notes or debit notes:

1. Open Order Entry > O/E Forms > Credit/Debit Notes.

2. From the Document Type list, select Credit Note or Debit Note.

3. In the Use Credit Note (or Use Debit Note) field, select a template or a custom form to use.

   You can select one of the following formats, or a custom format:
   
   - **OECRN01.RPT.** A credit/debit note for laser printer (plain paper version).
   
   - **OECRN02.RPT.** A credit/debit note for preprinted forms.

4. In the From Credit/Debit Note No. and To Credit/Debit Note No. fields, accept the default entries to print all the credit notes or debit notes, or specify a range to print.

5. Select a delivery method.

   You can select one of the following methods:
   
   - Select **Print Destination** to print the document to your usual print destination.
   
   - Select **Customer** to use the delivery method specified in the customer record in the Accounts Receivable program.

      If you choose Customer as the delivery method, select the ID for the e-mail message you want to send to customers that use an e-mail delivery method.


7. Specify information to show on printed documents.

   - If you use Serialized Inventory and Lot Tracking and you want printed invoices to show serial numbers or lot numbers assigned to serialized or lotted items, select **Serial/Lot Numbers**.

   - If you are using a customized credit/debit note report form that uses different selection criteria than the standard criteria for this report, select **Custom Form**. (Do not select this option unless the custom form you selected requires it.)

   - To show all components in kit assemblies, select **Kit Component Items**.
- To show all components in assemblies that are manufactured from bills of material, select **Bill of Materials Component Items**.
- To show retainage amounts, select **Retainage**.

**Note:** The Retainage option appears only if you use Project and Job Costing and Accounts Receivable uses retainage accounting.

8. If you want to print a test copy to verify that information is aligned correctly on a preprinted form, click Align.

9. Click **Print** to print credit notes or debit notes.

### Invoices

Use the O/E Invoices screen to print detailed invoices for items shipped and miscellaneous charges processed in Order Entry.

**Printing an Invoice Immediately After Posting**

You can print an invoice immediately after posting it.

For more information about the O/E Invoices screen, see "O/E Invoices Screen" (page 254).

**Before you start:**

- Decide which report format to use for the invoices you are printing.

The following invoice formats are included with Sage 300 ERP:

- **OEINV01.RPT.** A "datapiped" invoice for laser printer (plain paper version).
- **OEINV02.RPT.** A "datapiped" invoice for preprinted forms.
- **OEINV03.RPT.** An invoice for Internet inquiries (iConnect Sales Orders).
- **OEINV04.RPT.** A "non-datapiped" invoice for laser printer (plain paper version).
- **OEINV05.RPT.** A "non-datapiped" invoice for preprinted forms.

You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).
Chapter 4: Customizing and Printing Order Entry Forms

- Check the print destination. For information, see "About Print Destinations" (page 227).
- If you are planning to send these forms by e-mail:
  - Make sure that **E-mail** or **Contact's E-mail** is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.
  - Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages " (page 43).
  - For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail " (page 196).

**Note:**
If the **Keep Transaction History** option is not selected on the O/E Options screen, Sage 300 ERP deletes information for printed invoices when you run Day End Processing in Inventory Control, preventing you from reprinting any invoices after you run Day End Processing.

Regardless of whether you keep history, however, you must print invoices before they can be cleared by Day End Processing or using the Clear History form.

**To print an invoice immediately after posting it:**

1. On the O/E Invoice Entry screen, create or select an invoice, and then click **Post**.

   **Note:** You can also post and then print an invoice from the O/E Order Entry screen or the O/E Shipment Entry screen if you select the **Create Invoice** option before posting the order or the shipment.

2. On the Confirmation screen that appears, make sure **Invoice** is selected (if you are posting an order or a shipment), and then click **Yes**.

   The O/E Invoices screen appears, displaying the invoice number you posted.

3. In the **Use Invoice** field, type the name of the invoice form to use, or click **Browse**, and then select the form from the list that appears.

4. Select a delivery method.
You can select one of the following methods:

- Select **Print Destination** to print the invoices to your usual print destination.

- Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable

  If you select **Customer** as the delivery method, select the ID for the message you want to send with e-mailed documents.

  To view or edit the message for the selected ID, or to add a new e-mail message, click the Zoom \(\text{Zoom}\) button for the **Message ID** field.

5. Select options for printing the invoice.

You specify the following options, as needed:

- **Print Serial/Lot Numbers.** If you use Serialized Inventory and Lot Tracking, select this option if you want the invoice to show serial numbers or lot numbers assigned to serialized or lotted items.

- **Require Shipping Labels.** Select this option if you want to print a shipping label. (When you print shipping labels, you can print labels for invoices that were marked as requiring them.)

  You can print shipping labels only if you entered a number on the Totals tab for the invoice.

- **Include Backordered Items.** Select this option to show backordered items on these invoices.

- **Use Custom Form.** Select this option to use a custom form that does not use the report selection criteria set by this print form.

  **Important!** Select this option only if you are using a customized invoice form that requires it.

- **Print Kit Component Items.** Select this option if you want the printed invoice to show all components in kit assemblies.

- **Print Bills of Material Component Items.** Select this option if you want the invoice to show all components in assemblies that are manufactured from bills of material.

- **Retainage.** Select this option if you want the printed invoice to show retainage amounts.
Chapter 4: Customizing and Printing Order Entry Forms

Note: The Retainage option appears only if you use Project and Job Costing and have selected the Retainage Accounting option in Accounts Receivable.

6. If you want to review the invoices before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click Align.

7. When you are ready to print the invoice, click Print.

Printing a Range of Invoices

You can print a range of invoices after they are posted and before they are cleared from Order Entry.

For more information about the O/E Invoices screen, see "O/E Invoices Screen" (page 254).

Before you start:

- Decide which report format to use for the form you are printing.

  The following invoice formats are included with Sage 300 ERP:

  - OEINV01.RPT. A "datapiped" invoice for laser printer (plain paper version).
  - OEINV02.RPT. A "datapiped" invoice for preprinted forms.
  - OEINV03.RPT. An invoice for Internet inquiries (iConnect Sales Orders).
  - OEINV04.RPT. A "non-datapipe" invoice for laser printer (plain paper version).
  - OEINV05.RPT. A "non-datapipe" invoice for preprinted forms.

  You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

- If you are planning to send these forms by e-mail:

  - Make sure that E-mail or Contact's E-mail is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.
• Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages " (page 43).

• For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail " (page 196).

**Note:**
If the Keep Transaction History option is not selected on the O/E Options screen, Sage 300 ERP deletes information for printed invoices when you run Day End Processing in Inventory Control, preventing you from reprinting any invoices after you run Day End Processing.

Regardless of whether you keep history, however, you must print invoices before they can be cleared by Day End Processing or using the Clear History form.

**To print a range of invoices:**

1. Open Order Entry > O/E Forms > Invoices.

2. In the Use Invoice field, type the name of the invoice format to use, or click Browse, and then select the format from the list that appears.

   The following invoice formats are included with Sage 300 ERP:
   
   - **OEINV01.RPT.** A "datapiped" invoice for laser printer (plain paper version).
   - **OEINV02.RPT.** A "datapiped" invoice for preprinted forms.
   - **OEINV03.RPT.** An invoice for Internet inquiries (iConnect Sales Orders).
   - **OEINV04.RPT.** A "non-datapiped" invoice for laser printer (plain paper version).
   - **OEINV05.RPT.** A "non-datapiped" invoice for preprinted forms.

3. Use the From Invoice and To Invoice fields to specify a range of invoices, or accept the default entries to print all invoices.

4. Select a delivery method for the invoices.

   You can select one of the following methods:
   
   - Select Print Destination to print the invoices to your usual print destination.
• Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable

If you select **Customer** as the delivery method, select the ID for the message you want to send with e-mailed documents.

To view or edit the message for the selected ID, or to add a new e-mail message, click the Zoom button for the **Message ID** field.

5. Specify whether to reprint invoices already printed.

6. Select optional information for the printed invoices.

You specify the following options, as needed:

• **Print Serial/Lot Numbers.** If you use Serialized Inventory and Lot Tracking, select this option if you want printed invoices to show serial numbers or lot numbers assigned to serialized or lotted items.

• **Require Shipping Labels.** Select this option to print shipping labels for marked invoices only. (When you print shipping labels, you can print labels for the invoices that were marked as requiring them.)

You can print shipping labels only if you entered a number on the Totals tab for each invoice.

• **Include Backordered Items.** Select this option to show backordered items on these invoices.

• **Use Custom Form.** Select this option only if you are using a customized invoice form that does not use the report selection criteria set by this print form.

• **Print Kit Component Items.** Select this option if you want printed invoices to show all components in kit assemblies.

• **Print Bills of Material Component Items.** Select this option if you want printed invoices to show all components in assemblies that are manufactured from bills of material.

• **Retainage.** Select this option if you want printed invoices to show retainage amounts.

**Note:** The **Retainage** option appears only if you use Project and Job Costing and have selected the **Retainage Accounting** option in Accounts Receivable.
7. If you want to review invoices before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click **Align**.

8. Click **Print** to print invoices.

**Order Confirmations**

Before completing and invoicing an order, you can print and send an order confirmation that acknowledges receipt of the order and confirms the contents.

You can print confirmations for all orders, for a range of order numbers, or for a single order.

**Printing an Order Confirmation Immediately After Posting**

You can print an order confirmation immediately after posting an order, or you can print confirmations for a range of orders using the O/E Order Confirmations screen. For more information, see "O/E Order Confirmations Screen" (page 256).

**Note:** If you are shipping goods (and, optionally, producing an invoice) you can also print a picking slip and an invoice.

**Before you start:**

- Decide which report format to use for the order confirmation.

  Order Entry includes three formats that you may be able to use when printing order confirmations:

  - **OECONF01.RPT** A complete order confirmation (including lines and borders) that you can print on plain paper using a laser or ink-jet printer.
  - **OECONF02.RPT** An order confirmation for preprinted forms.
  - **OECONF03.RPT** An order confirmation used for Internet orders entered through iConnect Sales Orders.

  You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

- If you are planning to send these forms by e-mail:
- Make sure that **E-mail** or **Contact's E-mail** is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.

- Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages " (page 43).

- For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail " (page 196).

**To print an order confirmation after posting an order:**

1. Use the O/E Order Entry form to create a new order, and then click **Post**.
   - The Confirmation screen appears.

2. Click **Yes**.
   - The O/E Order Confirmations screen appears, displaying the order number you posted.

3. In the **Use Confirmation** field, select the format to use for printing the order confirmation.

4. Specify the delivery method to use for sending the confirmation to the customer.
   - You can select one of the following methods:
     - Select **Print Destination** to print the invoices to your usual print destination.
     - Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable

     If you select **Customer** as the delivery method, select the ID for the message you want to send with e-mailed documents.

     To view or edit the message for the selected ID, or to add a new e-mail message, click the Zoom 🔍 button for the **Message ID** field.

5. Review the options on the screen, and change selections as required.
   - For more information, see the list of fields and controls in "O/E Order Confirmations Screen" (page 256).
6. If you want to review the order confirmation before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click Align.

7. Click Print.

Printing Order Confirmations for a Range of Orders

You can print order confirmations for a range of orders at any time after they are posted and before they are cleared from Order Entry.

**Note:** Order confirmations list items and quantities that have not yet been invoiced.

**Before you start:**

- Decide which report format to use for the order confirmations you are printing.

  Order Entry includes three formats that you may be able to use when printing order confirmations:

  - **OECONF01.RPT** A complete order confirmation (including lines and borders) that you can print on plain paper using a laser or ink-jet printer.
  - **OECONF02.RPT** An order confirmation for preprinted forms.
  - **OECONF03.RPT** An order confirmation used for Internet orders entered through iConnect Sales Orders.

  You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

- If you are planning to send these forms by e-mail:

  - Make sure that **E-mail** or **Contact's E-mail** is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.
  
  - Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages " (page 43).
• For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail" (page 196).

To print order confirmations for a range of orders:

1. Open Order Entry > O/E Forms > Order Confirmations.

2. In the Use Confirmation field, select the report format to use for printing the order confirmations.

3. Use the From Order Number and To Order Number fields to specify a range of orders, or accept the default entries to print confirmations of all orders.

4. Specify the delivery method to use for sending confirmations to the customer.

   You can select one of the following methods:

   • Select Print Destination to print the invoices to your usual print destination.

   • Select Customer to use the delivery method specified in each customer record in Accounts Receivable.

      If you select Customer as the delivery method, select the ID for the message you want to send with e-mailed documents.

      To view or edit the message for the selected ID, or to add a new e-mail message, click the Zoom button for the Message ID field.

5. Review the remaining options, changing selections as required.

   For more information, see the list of fields and controls in "O/E Order Confirmations Screen" (page 256).

6. If you want to review the order confirmation before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click Align.

7. Click Print.

Picking Slips

Use the O/E Picking Slips screen to print picking slips that warehouse or shipping staff can use to locate items and check the availability of inventory.
Printing Picking Slips

Use the O/E Picking Slips screen to print picking slips that warehouse or shipping staff can use to locate items and check the availability of inventory.

Before you start:

- Decide which format to use to print the picking slips.

Order Entry provides the following picking slip formats for use with orders:

- **OEPICKORDER1.** A picking slip for laser printers (plain paper version).
- **OEPICKORDER2.** A picking slip for preprinted forms.

It also provides the following picking slip formats for shipments:

- **OEPICKSHIPMENT1.** A picking slip for laser printers (plain paper version).
- **OEPICKSHIPMENT2.** A picking slip for preprinted forms.

For more information about formats and printing options for picking slips, see "O/E Picking Slips Screen" (page 260).

You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

To print picking slips:

1. Open **Order Entry > O/E Forms > Picking Slips**.

2. In the **Select By** field, specify whether to print picking slips for order numbers or for shipment numbers.

3. In the **Use** field, select the report format for the type of picking slip you want to print. The report file last used appears by default.

4. In the **Sort By** field, specify whether to list item details by picking sequence, item number, or order or shipment line number.

5. Use the **From/To Order/Ship Number** fields to specify the range of orders or shipments for which to print picking slips.

6. In the **Print By** field, specify whether to print picking slips for the location
specified in the document header or for the locations specified for the item details.

If you print by header locations, the program will print one picking slip for each order or shipment when the location specified in the header is within the range that you specify.

If you print by detail locations, the program will print a separate picking slip for each location listed in the item details of each order or shipment, provided that the location falls within the location range that you specify next.

7. Specify the range of locations for which you want to print picking slips.

8. Select additional printing options, as required.

9. If you want to print a test label to verify that information is aligned correctly, click **Align**.

   **Note**: Clicking **Align** does not set document status to "Printed." To set document status to "Printed," you must click **Print**.

10. Click **Print**.

### Quotes

Use the O/E Quotes screen to print one or more sales quotes.

#### Printing a Quote Immediately After Posting

You can print a sales quote immediately after posting it, or you can use the O/E Quotes screen to print a range of quotes. For more information, see "O/E Quotes Screen" (page 265).

For more information on the O/E Quotes screen, see "O/E Quotes Screen" (page 265)

**Before you start:**

- Decide which report format to use for the quote you are printing.

  Order Entry includes two formats for printing quotes that you may be able to use "as is" or customize:
• **OEQUOT01.RPT** A quote for laser printers (plain paper version).

• **OEQUOT02.RPT** A quote for preprinted forms.

You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

• Check the print destination. For information, see "About Print Destinations" (page 227).

• If you are planning to send these forms by e-mail:
  
  • Make sure that E-mail or Contact's E-mail is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.

  • Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages " (page 43).

  • For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail " (page 196).

**To print a quote immediately after posting it:**

1. Use the O/E Order Entry form to enter a quote, and then click **Post**.
   
The Confirmation screen appears.

2. Click **Yes**.
   
The O/E Quotes screen appears, displaying the number of the quote you posted.

3. In the **Use Quote** field, select the format to use for printing the quote.

4. Specify the delivery method to use for sending the quote to the customer.

   You can select one of the following methods:

   • Select **Print Destination** to print the invoices to your usual print destination.

   • Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable
If you select Customer as the delivery method, select the ID for the message you want to send with e-mailed documents.

To view or edit the message for the selected ID, or to add a new e-mail message, click the Zoom button for the Message ID field.

5. Review the options on the screen, and change selections as required.

6. If you want to review the quote before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click Align.

7. Click Print.

**Printing a Range of Quotes**

You can print a range of quotes at any time after they are posted and before they are cleared from Order Entry.

For more information on the O/E Quotes screen, see "O/E Quotes Screen " (page 265)

**Note:** Quotes list items and quantities that have not yet been invoiced.

**Before you start:**

- Decide which report format to use for the quotes you are printing.
  
  Order Entry includes two formats for printing quotes that you may be able to use "as is" or customize:
  
  - **OEQUOT01.RPT** A quote for laser printers (plain paper version).
  
  - **OEQUOT02.RPT** A quote for preprinted forms.
  
  You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

- If you are planning to send these forms by e-mail:
  
  - Make sure that E-mail or Contact's E-mail is selected as the delivery method in the Accounts Receivable customer record, and that the e-mail addresses are up to date.
• Make sure that e-mail messages exist for these forms in Order Entry, or create messages as needed. For more information, see "Creating E-mail Messages" (page 43).

• For more information about sending documents to customers by e-mail, see "Sending Order Entry Forms to Customers by E-mail" (page 196).

**To print a range of quotes:**

1. Open **Order Entry > O/E Forms > Quotes**.

2. In the **Use Quote** field, select the report format to use for printing the quotes.

3. Use the **From Order Number** and **To Order Number** fields to specify a range of quotes, or accept the default entries to print all quotes.

4. Specify the delivery method to use for sending quotes to customers.

   You can select one of the following methods:

   • Select **Print Destination** to print the invoices to your usual print destination.

   • Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable

      If you select **Customer** as the delivery method, select the ID for the message you want to send with e-mailed documents.

      To view or edit the message for the selected ID, or to add a new e-mail message, click the Zoom button for the **Message ID** field.

5. Review the remaining options, changing selections as required.

6. If you want to print a test copy of the quote to verify that information is aligned correctly on a preprinted form, click **Align**.

7. Click **Print**.

**Shipping Labels**

Use the O/E Shipping Labels screen to print shipping labels that you can attach to shipments you send from the warehouse or shipping department.
**Printing Shipping Labels**

Use the O/E Shipping Labels screen to print shipping labels that you can attach to shipments you send from the warehouse or shipping department.

**Before you start:**

- Decide which report format to use for the form you are printing. For example, you might use different label formats depending on the destination or shipper.

Order Entry includes two shipping label templates that you may be able to use:

- **OELABEL.RPT.** 1½" x 4" sheet labels for a laser printer (14 labels on a page).

- **OELABELD.RPT.** 1½" x 3¾" tractor feed labels.

For more information about label formats and printing options, see "O/E Shipping Labels Screen" (page 268).

You can also use Crystal Reports to customize a format for your requirements. For more information, see "Customizable Formats for Printed Order Entry Forms" (page 197).

- Check the print destination. For information, see "About Print Destinations" (page 227).

**To print shipping labels:**

1. Open **Order Entry > O/E Forms > Shipping Labels.**
2. In the **Use Label** field, select the type of label you want to print.
3. In the Select field, specify whether to print labels for a range of order numbers, shipment numbers, or invoice numbers.
4. Use the **From** and **To** fields to specify the range of orders, shipments, or invoices to include.
5. If you want to reprint previously printed labels, select **Include Labels Already Printed.**
6. If you want to print labels only for orders, shipments, or invoices that have been marked as requiring labels, select **Print Only Labels Marked As Required.**
**Tip:** To mark transactions as requiring labels, you select the **Require Shipping Labels** option when printing order confirmations, picking slips, and invoices.

7. If you want to print a test label to verify that information is aligned correctly, click **Align**.

8. Click **Print** to print the labels.
Chapter 5: Printing Order Entry Reports

Use Order Entry Reports screens to print setup reports and analytical reports.

About Order Entry Reports

You can print a variety of reports to help you manage your sales orders. If you use multicurrency accounting, some of these reports can include source and functional-currency information.

Order Entry prints reports to your usual print destination. When you print to any destination, Order Entry updates the report status to "Printed." For more information about print destinations, see "About Print Destinations" (page 227).

You can print Order Entry reports on 8½" x 11" paper or A4-sized paper. (The Posting Journal can also be printed on 8½"x14" paper.)

Tip: Printed reports can serve as a source of backup information in the event that data is lost or damaged.

For instructions on printing reports, see "Printing Order Entry Analytical and Setup Reports" (page 227).

Using Optional Fields when Printing Reports

Optional fields let you analyze your Order Entry data in ways that are relevant to your business. The following reports let you select records by optional fields:

- Posting Journals Report
- Miscellaneous Charges Report
- Transaction List Report

When you use optional fields as selection criteria, Order Entry prints records that have optional fields and values in the ranges you specify.

For more information about using optional fields in Order Entry, see "About Optional Fields" (page 58).
Setup Reports

Setup reports show the information entered to define records you create when setting up or updating your Order Entry system.

- "O/E Options Report Screen" (page 306)
- "O/E G/L Integration Report Screen" (page 304)
- "O/E Optional Fields Report Screen" (page 301)
- "O/E Miscellaneous Charges Report Screen" (page 305)
- "O/E Ship-Via Codes Report Screen" (page 308)
- "O/E E-mail Messages Report Screen" (page 303)
- "O/E Templates Report Screen" (page 310)

When you add, delete, or change any of these records, you should print and file the corresponding reports to keep your printed records up to date.

Sales Analysis and Transaction Reports

Order Entry provides reports you can use to analyze sales orders. There are also reports about the Order Entry transactions you post (invoices and credit notes), and the journal entries created for the general ledger from these transactions.

- "O/E Transaction List Report Screen" (page 298)
- "O/E G/L Transactions Report Screen" (page 278)
- "O/E Sales History Report Screen" (page 288)
- "O/E Order Action Report Screen" (page 282)
- "O/E Invoice Action Report Screen" (page 280)
- "O/E Sales Statistics Report Screen" (page 294)
- "O/E Aged Orders Report Screen" (page 275)
- "O/E Salesperson Commissions Report Screen" (page 295)
- "O/E Posting Journals Report Screen" (page 285)

Customer Forms

Order Entry also provides you with the standard customer forms you need to process sales orders and invoice customers.
Selecting a Print Destination

You can print Sage 300 ERP reports to a printer, to the screen, to a file, or as an attachment to an e-mail message.

**Note:** You must be assigned to a security group that has authorization to change the print destination, or the only destination available will be a physical printer.

**To set the Sage 300 ERP print destination to Printer:**

**Note:** These instructions assume that you have set up printers in Microsoft Windows.

1. On the Sage 300 ERP Desktop menu, click **File > Print Destination**.
2. Select **Printer**, and then click **OK**.

When you next print from Sage 300 ERP, the report will be sent to the Windows default printer.

**Tip:** If you want to confirm the destination printer, page size, and orientation each time you print a report, on the Desktop, click **View > Preferences**, and then select **Confirm on print**.

**To print to the screen (display reports on your monitor):**

1. On the Sage 300 ERP Desktop menu, click **File > Print Destination**.
2. Click **Preview**.

**Note:** For Web-based clients, the Preview screen appears first when you click the **Print** button.

**Tip:** You can print a report displayed in the Preview window by clicking the **Print Report** button.

**To print to a file:**

1. On the Sage 300 ERP Desktop menu, click **File > Print Destination**.
2. Click **File**.

When you next print from Sage 300 ERP, you are prompted for an export format.
and a destination.

- If you select **Disk file** as the destination, browse to the location where you want to save the file, accept the file name or type the name you want to use, and then click **Save**.

- If you select **Application** as the destination, Sage 300 ERP opens the associated application, and displays the report in that application. You can then save the file to a location using the file name you want.

- If you select **Microsoft Mail** as the destination, Sage 300 ERP opens your e-mail client so that you can send the report as an attachment to recipients you specify.

**Note:** You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

**To print reports as attachments to e-mail messages:**

1. On the Sage 300 ERP Desktop menu, click **File > Print Destination**.

2. Select **E-mail** to create a file that can be attached to an e-mail.

3. Select either **Adobe Acrobat (PDF)** or **Rich Text Format (RTF)** as the file format for the e-mail attachment.

   - You can open PDF files with Adobe Acrobat Reader (available as a free download from the Adobe Software website).
   - You can open RTF files with most Windows and Linux word processing programs.

4. Click **OK**.

When you print using an e-mail destination Sage 300 ERP creates a PDF or RTF version of the report, opens your default e-mail program, and attaches the report file to a new e-mail message.

In Microsoft Windows, the default e-mail program is set in Internet Options, in the Control Panel.
About Print Destinations

There are several ways to print reports in Sage 300 ERP, depending on your needs. Before you print, you can select a print destination to:

- Print directly from the program to the printer, to obtain permanent copies of the information.
- Print the information on your screen, for quick review.
- Print to a file so that you can print the report later, import it into another program, or transfer it to other electronic media.
- Print to e-mail to send a report to an electronic mail recipient.

**Note:** To change the print destination for forms and reports, you must have Change Print Destination security authorization for Administrative Services.

You select print destinations from the **File** menu on the Sage 300 ERP desktop. For more information, see "Selecting a Print Destination" (page 225).

**Important!** When you print to any destination, the report’s status is updated to **Printed**.

**Tips:**
If you use **Preview** as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

Printing Order Entry Analytical and Setup Reports

Order Entry includes analytical reports that provide order status information, statistics, and transaction information. It also includes setup reports that provide basic setup record information.

For more information about the reports available in Order Entry, see "About Order Entry Reports " (page 223).
To print a report:

1. Open Order Entry > O/E Reports.

2. Double-click the report you want to print.

3. On the report screen, specify print options for the report.
   
   For information about the options available on the screen you are working with, press the F1 key.

4. Click Print.

Order Entry prints the report to your usual print destination, and sets the report status to Printed.

Tip:
If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.

- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

Printing Salesperson Commission Rates

The A/R Salesperson Commissions report lists commissions earned in the current commission period, for each salesperson for whom you track commissions.

You can print a detail or summary version of the report.

Before you start:

- You must select the Track Commissions option on the O/E Options screen before you run Day End Processing.

- For each salesperson whose commissions you want to track, the Paid Commissions option must be selected in the salesperson record (in Accounts Receivable).

For more information, see "About Sales Commissions " (page 52).
To print salesperson commission rates:

   
   (You can also open the report screen by clicking File > Print in the A/R Salespersons screen.)

2. In the Report Type field, select Salesperson Profile.

3. Specify the range of salespeople that you want to appear on the report.

4. Select the Include Commission Rates option.

5. Click Print.

After printing the report, you can clear the salesperson commission data to start a new commission period.
Chapter 6: Periodic Processing in Order Entry

Use Order Entry Periodic Processing screens to create batches and clear history.

About Periodic Processing

This topic introduces tasks you might perform as part of your daily, weekly, bi-weekly, or monthly procedures.

Daily Or Weekly Processing Tasks

If you have high order volumes, you can use the following screens at the end of each day to complete order processing:

- **I/C Day End Processing screen.** Day End Processing performs several tasks depending on the processing options that you select in Inventory Control, Order Entry, and Accounts Receivable. For more information, see "About Day End Processing " (page 232).

  **Important!** The time required to complete Day End Processing varies according to your computer and the number of transactions you entered since the last time you ran Day End Processing. For information about improving performance, see "About Day End Processing " (page 232).

- **O/E Create Batch screen.** You can use this screen to perform the following tasks:

  - Create the General Ledger batch.
  - Optionally, post the General Ledger Batch (if you select the Create G/L Transactions By Creating and Posting a New Batch option on the O/E G/L Integration screen).
  - Post A/R batches in Accounts Receivable.

  For more information, see "O/E Create Batch Screen " (page 274).

Period End Tasks

At each period end, you should:
Use the O/E Order Entry screen to create any new sales orders you wish to process in the period.

Use the O/E Shipment Entry, O/E Invoice Entry, and O/E Credit/Debit Note Entry screens to post other transactions that apply to the period.

Print the O/E Order Action, O/E Invoice Action, and O/E Aged Orders reports to identify orders that require action.

Print the O/E G/L Transactions report, and then use the O/E Create Batch screen to create and process general ledger transactions (if you do not use the option to create general ledger transactions during Day End Processing).

Use the O/E Clear History screen to clear paid transactions, posting journals, and statistics that you no longer need.

### About Day End Processing

You perform Day End Processing in Inventory Control, using the I/C Day End Processing screen. To keep your audit trail and reports up to date, you should run Day End Processing as part of your daily routine.

Day End Processing processes all transactions posted since the last time you ran Day End Processing, and performs several tasks, depending on the processing options that you select in Inventory Control, Order Entry, and Accounts Receivable:

- Activates and posts future orders that have reached their order date, and updates the quantities on sales order. When Day End Processing is complete, you can print order confirmations and picking slips, enter quantities shipped, and issue invoices for these orders.

  **Tip:** If you usually run Day End Processing at the end of the work day, future orders set to be activated on a certain day become active only at the end of the day. To be sure a future order is ready to be processed on the correct date, assign a date earlier than the desired date for the order.

- Removes quotes with expiration dates up to and including the session date for Day End Processing, and deletes expired quotes from the system if you selected the Clear Expired Quotes option and specified a number of days on the O/E Options screen.

- Optionally, costs items and creates subledger transactions in Inventory
About Periodic Processing

Control. Depending on whether you cost inventory during posting or during Day End Processing, you can set options to cost items and create subledger transactions in Inventory Control, on the I/C Options screen.

Costing inventory during posting ensures that item costs are updated immediately. However, because costing calculations require more system resources, they can slow down processing. To avoid delays, you can select the Cost Items During Day End Processing option on the I/C Options screen.

- Calculates the unit cost for each item on an invoice, using the item’s costing method. (For more information, see the Inventory Control help.) The unit costs calculated are the default unit costs for credit notes entered against the invoices.

- Updates costing information for LIFO- and FIFO-costed items in Inventory Control.

- Updates Inventory Control with the costs of items returned as negative shipments on invoices.

- Updates statistics and history in both Order Entry and Inventory Control.

- Updates sales commissions if you selected the Track Commissions option on the O/E Options screen, and if you entered salesperson commission rates in Accounts Receivable (or if you allow commissions for item categories in Inventory Control).

- Creates a batch of Accounts Receivable summary invoices and credit notes from posted Order Entry transactions using the next available Accounts Receivable batch number. For more information, see "About Batches Created in Accounts Receivable " (page 246).

- Creates the invoice and credit note posting journals in Order Entry for the new day-end sequence number. These journals are the detailed records of the general ledger entries that will be created when the Accounts Receivable batches are posted.

Improving the Performance of Day End Processing

**Important!** The time required to complete Day End Processing varies according to your computer and the number of transactions you entered since the last time you ran Day End Processing. We recommend that you run Day End Processing overnight, or when you do not need to use your computer for other tasks.

If performance is important, you can select the following options:
• On the I/C Options screen, select the **Cost Items During Day End Processing** option, rather than cost inventory during posting.

• On the O/E G/L Integration screen, select the **Create G/L Transactions Using Create Batch Icon** option.

• On the O/E Options screen, select the **Post A/R Batches On Request Using Create Batch Icon** option.

**Inventory Control Costing Options**

The costing options you select in Inventory Control determine whether the following additional tasks take place during posting or during Day End Processing:

• Updating item costs in Inventory Control

• Creating audit records or general ledger transactions

• Updating sales statistics and customer accounts in Accounts Receivable

This flexibility allows you to decide between processing speed and keeping your inventory data up to date.

• If you select the Cost Items During Day End Processing or Create Subledger Transactions And Audit Info During Day End Processing options on the I/C Options screen, you must run Day End Processing in Inventory Control to finish updating Order Entry, General Ledger, Inventory Control, and Accounts Receivable.

• If you cost inventory items during Day End Processing, the program will also create subledger transactions then. (You will not be able to select the Cost Items During Posting option.)

• If you cost items during posting, you can also specify when to create subledger transactions and audit information—during posting or when you run Day End Processing.

• If you want to speed up order processing, you should create subledger transactions and cost inventory when you run Day End Processing.

**Posting to Locked Fiscal Periods**

If a fiscal period is locked for General Ledger but not for Order Entry, you can create batches for General Ledger as follows:

• During posting.

• During Day End Processing.
• Using the G/L Batch screen (depending on the options you select on the O/E G/L Integration screen).

**Note:**
If you try to post transactions to a locked period in General Ledger, transactions will be added to an error batch. To prevent this from happening, create and post General Ledger batches for outstanding Order Entry transactions before locking the period for General Ledger.

Similarly, you can create transactions for Accounts Receivable from Order Entry transactions, but you cannot post them to a period that is locked for Accounts Receivable.

### Journal Entries Generated for Posted Order Entry Transactions

Sage 300 ERP generates journal entries for your general ledger when you:

- Post, in Accounts Receivable, invoice and receipt batches created in Order Entry
- Process billings in Project and Job Costing
- Process shipments posted in Order Entry.

Except for shipment transactions, these journal entries appear on the Accounts Receivable G/L Transactions report. Shipment transactions appear on the Order Entry G/L Transactions report.

### Shipments

On the Order Entry G/L Transactions report, shipments are assigned source code OE-SH.

Item quantities are removed from Inventory Control for posted shipments (either during Day End Processing or when you use the Create G/L Batch screen) as follows:

#### Journal Entries for Shipments

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Clearing</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Inventory Control</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Invoices

On the Accounts Receivable G/L Transactions report, invoices are assigned source code OE-IN.

When you post an invoice, Sage 300 ERP generates the following entries:

**Journal Entries for Invoices**

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receivables Control</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods Sold (Item)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Shipment Clearing</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tax Liability</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Sales</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Costing methods.** If an item’s costing method is the standard method or the most recent cost method, the item's cost variance account is debited or credited with the difference between the standard or most recent cost and the weighted average cost of the items shipped.

**Decreasing quantities shipped.** If you decrease the quantity shipped on an invoice, Order Entry creates an entry to adjust Inventory Control (either when you run Day End Processing or when you use the Create G/L Entries screen) as follows:

**Journal Entries for Invoices**

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Control</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Shipment Clearing</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

The source code that appears on the G/L Transactions report for this entry is OE-IN.

**Detail Lines in Accounts Receivable Invoices**

The detail lines that Order Entry creates in Accounts Receivable invoices vary depending on whether you use optional fields for detail lines or you use Sage 300 ERP Project and Job Costing.

**Without optional fields or Project and Job Costing.** If you do not use optional fields in Order Entry invoice details and in Accounts Receivable invoice details, and you are not posting job-related transactions, Order Entry
creates Accounts Receivable invoices with separate detail lines for sales, cost of goods sold, and shipment clearing entries.

All Accounts Receivable invoice details are consolidated by general ledger account, so if you use only one sales account, one cost of goods sold account, and one clearing account, you will see only three lines on an invoice.

**Accounts Receivable Invoice Details (No Optional Fields; Not Job Related)**

<table>
<thead>
<tr>
<th>Description</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>Acct 4111</td>
<td>750.00</td>
</tr>
<tr>
<td>Cost of Goods Sold</td>
<td>Acct 5200</td>
<td>-500.00</td>
</tr>
<tr>
<td>Shipment Clearing</td>
<td>Acct 5900</td>
<td>500.00</td>
</tr>
</tbody>
</table>

**With optional fields or Project and Job Costing.** If you use optional fields in Order Entry invoice details and in Accounts Receivable invoice details, or if you are posting job-related transactions, Order Entry creates a single Accounts Receivable invoice detail line for each Order Entry invoice detail line.

Each Accounts Receivable invoice detail includes the entries for the revenue, inventory (shipment clearing), and cost of goods sold accounts. There will be as many invoice detail lines as there were on the original Order Entry invoice. Accounts Receivable invoice details are not consolidated.

**Accounts Receivable Invoice Details (Job Related or Optional Fields)**

<table>
<thead>
<tr>
<th>Description</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales item 1</td>
<td>Acct 4111</td>
<td>250.00</td>
</tr>
<tr>
<td>Sales item 2</td>
<td>Acct 4111</td>
<td>250.00</td>
</tr>
<tr>
<td>Sales item 3</td>
<td>Acct 4111</td>
<td>250.00</td>
</tr>
</tbody>
</table>

Each of the unconsolidated Accounts Receivable invoice lines will produce a journal entry with sales account, cost of goods sold account, and clearing account details when posted in Accounts Receivable.

**Prepayments**

On the G/L Transactions report, prepayments are assigned source code AR-PI.

Prepayments are added directly to Accounts Receivable receipt batches when you post an order, shipment, or invoice that has a prepayment. Prepayments debit the general ledger prepayment liability account and credit the customer's receivables control account.
Credit Notes

Credit notes are assigned source code OE-CN on the Accounts Receivable G/L Transactions report.

Credit note transactions debit and credit general ledger accounts as shown in the following tables.

If an item's costing method is the standard method or the most recent cost method, then the item's cost variance account is debited or credited with the difference between the standard or most recent cost and the weighted average cost of the items shipped.

Items Returned to Inventory

The following example records a credit note transaction for items returned to inventory. The first transaction is posted directly to General Ledger from Order Entry; the second one goes through Accounts Receivable.

| Journal Entries for Transactions Posted Directly to G/L from Order Entry |
|-----------------------------|-----------------|-----------------|
| G/L Account | Debit | Credit |
| Inventory Control | X | |
| Credit/Debit Note Clearing | | X |

| Journal Entries for Transactions Posted Through Accounts Receivable |
|-----------------------------|-----------------|-----------------|
| G/L Account | Debit | Credit |
| Sales Returns | X | |
| Credit/Debit Note Clearing | | X |
| Tax Liability | X | |
| Receivables Control | | X |
| Cost of Goods Sold | | X |

Damaged items

The Damaged Goods account is debited rather than the Sales Returns account.

| Journal Entries for Damaged Goods |
|-----------------------------|-----------------|-----------------|
| G/L Account | Debit | Credit |
| Damaged Goods | X | |
| Credit/Debit Note Clearing | | X* |
### About Periodic Processing

#### G/L Account

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Liability</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Receivables Control</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Cost of Goods Sold</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

*The Credit/Debit Note Clearing and the COGS entries will always be zero for damaged goods.*

This transaction will appear differently in the Accounts Receivable invoice depending on whether or not the transaction is job-related or uses optional fields.

- If the transaction is job-related or uses optional fields, the invoice will list a single detail line for the damaged goods account.
- If the transaction is not job-related and does not use optional fields, the invoice will list three lines—one for damaged goods, one for cost of goods sold, and one for Credit/Debit Note clearing—but only the damaged goods line will have an amount.

### Price adjustments

#### Journal Entries for Price Adjustment

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Tax Liability</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Receivables Control</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

### Shipping and Invoicing Kitting Items

If you have Project and Job Costing or if you use optional fields with invoice details, Accounts Receivable invoices show only one detail line for each kitting item listed on an invoice, instead of showing one line for each component of each kitting item. Order Entry handles the accounting for kitting items with the following general ledger entries.

When you ship kitting items, Order Entry creates general ledger entries for each of the components in the kitting item:
Chapter 6: Periodic Processing in Order Entry

---

**Journal Entries for Components in the Kitting Item**

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Clearing, component 1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Inventory Control</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Shipment Clearing, component 2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Inventory Control</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

When you invoice a kitting item, Order Entry creates the following general ledger entries to back out the components for the master item from the shipment clearing account:

**Journal Entries to Back Out Components for Master Item from Shipment Clearing Account**

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Clearing, master item</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Shipment Clearing, component 1</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Shipment Clearing, component 2</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

The source code that appears on the G/L Transactions report for the shipment entry is OE-SH. The source code that appears on the G/L Transactions report for the invoice entry is OE-IN.

**Note:** If you do not use optional fields in Order Entry invoice details and in Accounts Receivable invoice details, and if you do not use Project and Job Costing, Order Entry creates shipment clearing lines on the Accounts Receivable invoice for each component, and does not create the general ledger entries shown above during invoicing.

---

**Shipping and Invoicing Job-Related Transactions**

When entering job-related transactions, you can create invoices in Order Entry, or you can select the **Project Invoicing** option if you want to create invoices in Project and Job Costing.

---

**Creating Invoices in Order Entry**

The following example shows the shipping and invoicing transactions for an order with one item and one miscellaneous charge. The miscellaneous charge is considered internal, because it's a handling charge and one of your employees is packaging the shipment. You can enter both the revenue and
cost for the miscellaneous charge or only the revenue. Usually, you enter the cost because you want to associate both the cost and revenue with the job, and have labor and overhead calculated on the cost.

### Journal Entry for Shipping and Invoicing in Order Entry

<table>
<thead>
<tr>
<th>Type</th>
<th>Item No./Misc. Charge</th>
<th>Qty</th>
<th>Unit Cost</th>
<th>Billing Cost Type</th>
<th>Ext. Billing Amt.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>A1-103/0</td>
<td>1</td>
<td>50.00</td>
<td>Billable</td>
<td>100.00</td>
</tr>
<tr>
<td>Misc.</td>
<td>HC</td>
<td></td>
<td>15.00</td>
<td></td>
<td>30.00</td>
</tr>
</tbody>
</table>

### Journal Entry for Shipment Posting

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Clearing</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>Misc. Charges Clearing</td>
<td>15.00</td>
<td></td>
</tr>
<tr>
<td>Inventory Control</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>Shipping Expense</td>
<td>15.00</td>
<td></td>
</tr>
</tbody>
</table>

### Journal Entry for Invoice Posting

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receivables Control</td>
<td>146.90</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods Sold</td>
<td>71.50</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td>130.00</td>
<td></td>
</tr>
<tr>
<td>Overhead Allocated</td>
<td>3.25</td>
<td></td>
</tr>
<tr>
<td>Labor Burden</td>
<td>3.25</td>
<td></td>
</tr>
<tr>
<td>GST (Fed sales tax)</td>
<td>9.10</td>
<td></td>
</tr>
<tr>
<td>PST (Prov/State sales tax)</td>
<td>7.80</td>
<td></td>
</tr>
<tr>
<td>Shipment Clearing</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>Misc. Charges Clearing</td>
<td>15.00</td>
<td></td>
</tr>
</tbody>
</table>

### Creating Invoices in Project and Job Costing

The following example shows an item being shipped from Order Entry and invoiced through Project and Job Costing. It also shows the entries for an additional shipping cost (FedEx) coming through Accounts Payable instead of through Order Entry.
The shipping cost is recorded in Accounts Payable, picked up by PJC when you run the Billing Worksheet, and, finally, included on the invoice created in Accounts Receivable.

**Journal Entry for Item Shipped from Order Entry**

<table>
<thead>
<tr>
<th>Type</th>
<th>Item No.</th>
<th>Qty.</th>
<th>Unit Cost</th>
<th>Billing Cost Type</th>
<th>Ext. Billing Amt.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>A1-103/0</td>
<td>1</td>
<td>50.0</td>
<td>Billable</td>
<td>100.00</td>
</tr>
</tbody>
</table>

**Shipment Posting Journal Entry**

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work In Progress</td>
<td>55.00</td>
<td></td>
</tr>
<tr>
<td>Inventory Control</td>
<td></td>
<td>50.00</td>
</tr>
<tr>
<td>Overhead Burden</td>
<td></td>
<td>2.50</td>
</tr>
<tr>
<td>Labor Burden</td>
<td></td>
<td>2.50</td>
</tr>
</tbody>
</table>

**Accounts Payable Invoice Entry for FedEx Charge**

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work In Progress</td>
<td>16.50</td>
<td></td>
</tr>
<tr>
<td>Work In Progress (Prov/State sales tax)</td>
<td>.90</td>
<td></td>
</tr>
<tr>
<td>GST (Canadian Fed sales tax)</td>
<td>1.05</td>
<td></td>
</tr>
<tr>
<td>A/P Invoice Posting</td>
<td></td>
<td>16.95</td>
</tr>
<tr>
<td>Overhead Allocated</td>
<td></td>
<td>.75</td>
</tr>
<tr>
<td>Labor Burden</td>
<td></td>
<td>.75</td>
</tr>
</tbody>
</table>

**Accounts Receivable Invoice Created From Billing Worksheet**

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receivables Control</td>
<td>146.90</td>
<td></td>
</tr>
<tr>
<td>Billings</td>
<td></td>
<td>130.00</td>
</tr>
<tr>
<td>GST (Canadian Fed sales tax)</td>
<td></td>
<td>9.10</td>
</tr>
<tr>
<td>PST (Prov/State sales tax)</td>
<td></td>
<td>7.80</td>
</tr>
</tbody>
</table>
Performing Day End Processing

Perform Day End Processing as part of your daily routine, to keep your Inventory Control audit trail and reports up to date. You can perform Day End Processing as many times a day as you want.

Day End Processing performs several tasks, depending on the processing options you select in Inventory Control, Order Entry, and Accounts Receivable. For more information, see "About Day End Processing" (page 232).

Before you start:

- **Post all the transactions that you want to be processed.** Any transactions you post while Day End Processing is running will not be processed if processing has already been completed for the transaction type.

  To ensure that all the day's transactions are processed, post them before performing Day End Processing. Inventory Control processes receipts first, followed by adjustments, transfers, assemblies, and shipments.

- **Back up your Order Entry data.** For information about backing up data, see the System Manager help.

- **Allow enough time to perform Day End Processing.** The time it takes to complete Day End Processing varies according to your computer hardware and software, and according to the number of transactions you entered since the last time you performed Day End Processing.

  **Tip:** We recommend that you perform Day End Processing when you do not need to use your computer for other tasks. You might find it best to run it overnight.
To perform Day End Processing:

1. Open Inventory Control > I/C Periodic Processing > Day End Processing.

2. Click Process.

A message appears when processing is complete.

After performing Day End Processing

- Print the I/C Item Valuation report and compare it to the previously printed report.
- Print the I/C Posting Journals report for the Adjustments journal to check the actual posted adjustments.
- Print the O/E Posting Journals report for a record of the general ledger entries created for Order Entry transactions in Accounts Receivable.
- If it is the end of a commission period, print the O/E Salesperson Commission report, and then use the O/E Clear History screen to clear salesperson commission statistics.
- Print any other reports to update your records as needed.
- Modify options on the O/E Options screen as needed.

Creating a Batch of General Ledger Transactions in Order Entry

You use the O/E Create Batch screen to create General Ledger batches if you do not automatically create G/L transactions when you post transactions or when you run Day End Processing.

You specify how to create G/L transactions using the Create G/L Transactions option on the O/E G/L Integration screen. For more information, see "O/E G/L Integration Screen" (page 327).

If a fiscal period is locked for General Ledger but not for Order Entry, you can create batches for General Ledger as follows:

- During posting.
- During Day End Processing.
- Using the G/L Batch screen (depending on the options you select on the O/E G/L Integration screen).

Note: If you try to post transactions to a locked period in General Ledger,
transactions will be added to an error batch. To prevent this from happening, create and post General Ledger batches for outstanding Order Entry transactions before locking the period for General Ledger.

Similarly, you can create transactions for Accounts Receivable from Order Entry transactions, but you cannot post them to a period that is locked for Accounts Receivable.

**Before you start:**

- On the O/E G/L Integration screen, select options for creating and posting General Ledger batches.
- Run Day End Processing to complete processing and update Order Entry and Inventory Control data.
- Print the O/E G/L Transactions report and file it with your audit trail reports.

**To create a batch of General Ledger transactions:**

1. Open **Order Entry** > **Periodic Processing** > **Create Batch**.
   
   The O/E Create Batch screen appears. The **Create G/L Batch Through Day End Number** option is selected by default.

2. Specify the range of day-end numbers for which to create General Ledger transactions. (You create the transactions for all outstanding day-end numbers up to and including the number you specify.)

3. If you also want to post invoice transactions created by Order Entry in Accounts Receivable, select Post A/R Batches.

4. Click **Process**.

**After creating a G/L batch**

If your system does not post General Ledger batches automatically, post the General Ledger batches you have created.

- If you use Sage 300 ERP General Ledger, post the batch you created.

   Order Entry automatically posts the batch in General Ledger if you selected **Create G/L Transactions by Creating and Posting a New Batch** on the O/E G/L Integration screen.
Chapter 6: Periodic Processing in Order Entry

- If you use a different general ledger, do one of the following:
  - Import the CSV batch file into your general ledger, and then delete the file.
  - Using the G/L Transactions report, transfer the entries to your general ledger manually, and then delete the CSV batch file.

**About Batches Created in Accounts Receivable**

On the O/E Options screen, you can specify how and when Order Entry posts Accounts Receivable batches. For more information, see "Order Entry Options for Posting Accounts Receivable Batches" (page 23).

When you create an Accounts Receivable batch from posted Order Entry transactions, the Accounts Receivable batch contains summary details only.

In Accounts Receivable, you use the A/R Invoice Batch Listing screen to print the batch. Default batch information is as follows:

- The batch date is the Posting or Day End Processing date (depending on the options you selected)
- The batch description is O/E Invoices/Credit Notes
- The batch type is Imported
- The batch status is Ready To Post
- The detail type is Summary

If you selected the **Allow Edit Of Imported Batches** option on the A/R Options screen, you can open and edit batch information (other than customer number, document type, and document number) before you post it.

**Note:** You can also post an invoice batch in Accounts Receivable. When you post the invoice batch, Accounts Receivable makes sure there are no duplicate invoice or credit note numbers. If duplicate numbers exist, they are placed in an error batch.

**Adding Customers Before Posting Batches**

In Order Entry, you can add transactions for non-existent customers (customers for which no customer record exists in Accounts Receivable). However, you cannot post batches that contain these transactions in Accounts Receivable until you add the customer records.
Performing Day End Processing

Note: When adding records for customers for which you have already posted Order Entry transactions, make sure you use the same customer number that you used on the Order Entry transactions.

Posting a Batch of Order Entry Invoices in Accounts Receivable

You can use the O/E Create Batch screen to post Accounts Receivable invoice batches created by Order Entry.

Note: You can use this screen to post Accounts Receivable batches only if you do not automatically post batches when you post invoice transactions or when you run Day End Processing.

 Depending on the options you select on the O/E Options screen for posting Accounts Receivable transactions, you can post Accounts Receivable batches in the following ways:

- Automatically each time you post an Order Entry invoice.
- Using the O/E Create Batch screen.
- In Inventory Control, when you run Day End Processing.
- In Accounts Receivable, using the A/R Invoice Batch List screen or the A/R Post Batches screen.

You specify how to create G/L transactions using the Create G/L Transactions option on the O/E G/L Integration screen. For more information, see "O/E G/L Integration Screen" (page 327).

On the O/E Create Batch screen, you can select the Create G/L Batch Through Day End Number option and specify a range of day-end numbers to create a batch of General Ledger transactions from posted shipments, invoices, and credit notes (and optionally post them automatically in General Ledger). For more information, see "O/E Create Batch Screen" (page 274).

Before you start:

- Run Day End Processing to complete processing and update Order Entry and Inventory Control data.
To post a batch of invoices created by Order Entry in Accounts Receivable:

1. Open **Order Entry > Periodic Processing > Create Batch**.
   
   The O/E Create Batch screen appears. The **Create G/L Batch Through Day End Number** option is selected by default.

2. Specify the range of day-end numbers for which to create General Ledger transactions. (You create the transactions for all outstanding day end numbers up to and including the number you specify.)

3. Select **Post A/R Batches** to post invoice transactions created by Order Entry in Accounts Receivable.

4. Click **Process**.

**After posting a batch of invoices**

If your system does not post General Ledger batches automatically, post the General Ledger batches you have created.

- If you use Sage 300 ERP General Ledger, post the batch you created.
   
   Order Entry automatically posts the batch in General Ledger if you selected **Create G/L Transactions by Creating and Posting a New Batch** on the O/E G/L Integration screen.

- If you use a different general ledger, do one of the following:
  
   - Import the CSV batch file into your general ledger, and then delete the file.
   
   - Using the G/L Transactions report, transfer the entries to your general ledger manually, and then delete the CSV batch file.

---

*Sage 300 ERP Order Entry*
Appendix A: Order Entry Screen Guides

Learn how to find and use Sage 300 ERP screens. Each screen guide includes navigation information, field help, and a list of tasks you can use the screen to perform.
Customer Forms Screens

Use the report forms that come with Order Entry to print invoices, quotes, credit notes, debit notes, order confirmations, receipts, shipping labels, and picking slips, or select a customized version.

O/E Credit/Debit Notes Screen

To open this screen:
Open Order Entry > O/E Forms > Credit/Debit Notes.

Related tasks:
- "Printing a Range of Credit Notes or Debit Notes " (page 202)
- "Printing a Credit Note or a Debit Note Immediately After Posting " (page 200)

Overview

Use the O/E Credit/Debit Notes report screen to print sales returns and other credit notes and debit notes posted to customer accounts in Order Entry.

Credit/Debit Note Formats

Order Entry includes two credit/debit note report formats that you may be able to use:

- OECRN01.RPT. A credit/debit note for laser printer (plain paper version).
- OECRN02.RPT. A credit/debit note for preprinted forms.

You can use the sample formats or change them to suit your company's requirements.

Note: You can use Crystal Reports or Crystal Info to include other information in credit notes and debit notes, change the layout to suit your needs, or create your own forms.

Credit/Debit Note Printing Options

When printing credit notes and debit notes, you can:
• Print test copies of credit notes and debit notes to check the alignment of your forms in your printer.

• Print all credit notes or debit notes in a range, or only documents that were not previously printed.

• Reprint credit notes and debit notes as many times as necessary.

**Important!**
When pricing by weight, and when the order unit of measure is not the pricing unit of measure, the printed unit price may not match the unit price on the transaction entry screens.

The information that appears in the Unit Price column on credit notes and debit notes is calculated by dividing the extended price by the quantity shipped or returned, whether pricing by quantity or by weight.

**Note:**
• If you want to review information before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click **Align**.

Clicking **Align** does not set document status to "Printed." To set document status to "Printed," you must click **Print**.

• If Order Entry does not use the **Keep Transaction History** option (on the O/E Options screen), Sage 300 ERP deletes information for printed credit notes and debit notes when you run Day End Processing in Inventory Control, preventing you from reprinting these documents after you run Day End Processing.

**Fields and Controls**

**Buttons**

**Close**
Click **Close** to close the screen.

**Print**
Click **Print** to print credit notes or debit notes and set document status to "Printed."

**Align**
Click **Align** to print a test copy to verify that the information is aligned
correctly on a preprinted form.

**Note:** Clicking **Align** does *not* set document status to "Printed." To set document status to "Printed," you must click **Print.**

**Delivery Method**
Specify how to send documents to your customers:

- Select **Print Destination** to print to your usual print destination.
- Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable.

  If you select **Customer** as the delivery method, select the ID for the e-mail message you send with e-mailed documents for customers that use an e-mail delivery method.

**Document Type**
Specify whether to print credit notes or debit notes.

**From/To Credit/Debit Note No.**
Select a credit note or debit note, or specify a range of credit notes or debit notes to print.

**Include Credit/Debit Notes Already Printed**
Select this option if you want to reprint credit notes or debit notes that were printed previously.

**Message ID**
If you selected Customer as the delivery method, select the ID for the message you want to send with e-mailed credit notes and debit notes to customers that use an e-mail delivery method.

  To view or edit the message for the selected ID, or to add a new e-mail message for invoices, click the Zoom button for this field.

**Print Bills of Materials Component Items**
Select this option if you want printed credit notes or debit notes to show all components in assemblies that are manufactured from bills of material.

**Print Kit Component Items**
Select this option if you want printed credit notes or debit notes to show all components in kit assemblies.
Print Serial/Lot Numbers
If you use Serialized Inventory and Lot Tracking, select this option to include serial numbers or lot numbers with serialized or lotted items on the credit notes or debit notes.

Retainage
Select this option if you want printed credit notes or debit notes to show retainage amounts.

Note: This option appears only if you use Project and Job Costing and Accounts Receivable uses retainage accounting.

Use Credit Note/Debit Note
Select a report format for printing the credit notes or debit notes. The following sample formats are included with Sage 300 ERP:

- **OE<n>RN01.RPT.** A credit/debit note for laser printer (plain paper version).
- **OE<n>RN02.RPT.** A credit/debit note for preprinted forms.

Use Custom Form
Select this option to use a customized report format that does not use the selection criteria usually used by this report.

Important! Do not select this option unless you are using a customized credit note or debit note form that requires it.
**O/E Invoices Screen**

**To open this screen:**
Open *Order Entry > O/E Forms > Invoices*.

**Related tasks:**
- "Printing a Range of Invoices " (page 208)
- "Printing an Invoice Immediately After Posting " (page 205)

**Overview**

Use the O/E Invoices screen to print detailed invoices for items shipped and miscellaneous charges processed in Order Entry.

**Formats for Printed Invoices**

Order Entry includes formats for printed invoices that you may be able to use "as is" or customize.

The following invoice formats are included with Sage 300 ERP:

- **OEINV01.RPT.** A "datapiped" invoice for laser printer (plain paper version).
- **OEINV02.RPT.** A "datapiped" invoice for preprinted forms.
- **OEINV03.RPT.** An invoice for Internet inquiries (iConnect Sales Orders).
- **OEINV04.RPT.** A "non-datapiped" invoice for laser printer (plain paper version).
- **OEINV05.RPT.** A "non-datapiped" invoice for preprinted forms.

You can also use Crystal Reports or Crystal Info to include other information on invoices, change the layout to suit your needs, or create your own forms. For more information, see Customizable Formats for Printed Order Entry Forms.

---

**Important!**

When pricing by weight, and when the order unit of measure is not the pricing unit of measure, the printed unit price may not match the unit price on the transaction entry screens.

The information that appears in the Unit Price column on an invoice is calculated by dividing the extended price by the quantity ordered, whether pricing by quantity or by weight.
Note:
If the **Keep Transaction History** option is not selected on the O/E Options screen, Sage 300 ERP deletes information for printed invoices when you run Day End Processing in Inventory Control, preventing you from reprinting any invoices after you run Day End Processing.

Regardless of whether you keep history, however, you must print invoices before they can be cleared by Day End Processing or using the Clear History form.
O/E Order Confirmations Screen

To open this screen:
Open **Order Entry > O/E Forms > Order Confirmations**.

Related tasks:
- "Printing an Order Confirmation Immediately After Posting" (page 211)
- "Printing Order Confirmations for a Range of Orders" (page 213)

Overview

Before completing and invoicing an order, you can print and send an order confirmation that acknowledges receipt of the order and confirms the contents.

You can print confirmations for all orders, for a range of order numbers, or for a single order.

For the selected orders, you can:
- Print only the order confirmations that have not been printed yet, or also print new copies of those that were printed previously.
- Print serial numbers and lot numbers for serialized and lotted items, if you use Serialized Inventory and Lot Tracking.
- Indicate whether shipping labels are required for the order.

Formats for Printed Order Confirmations

Order Entry includes three formats that you may be able to use when printing order confirmations:

- **OECONF01.RPT** A complete order confirmation (including lines and borders) that you can print on plain paper using a laser or ink-jet printer.
- **OECONF02.RPT** An order confirmation for preprinted forms.
- **OECONF03.RPT** An order confirmation used for Internet orders entered through iConnect Sales Orders.

These report formats list all the items and miscellaneous charges on an order, plus any comments that were entered for the order or the items included in it.
Note: You can use Crystal Reports or Crystal Info to include other information in quotes, change the report layout to suit your needs, or create your own forms.

Order Confirmation Printing Options

You can print a single order confirmation immediately after posting the order, or you can use the O/E Order Confirmations screen to print one or more confirmations.

Note: If you want to review information before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click Align.

Clicking Align does not set document status to "Printed." To set document status to "Printed," you must click Print.

Important!
When pricing by weight, and when the order unit of measure is not the pricing unit of measure, the printed unit price may not match the unit price on the transaction entry screens.

The information that appears in the Unit Price column on an order confirmation is calculated by dividing the extended price by the quantity ordered, whether pricing by quantity or by weight.

Fields and Controls

Buttons

Close
Click Close to close the screen.

Print
Click Print to print order confirmations and set document status to "Printed."

Align
Click Align to review order confirmations before printing, or to print a test copy to verify that the information is aligned correctly on a preprinted form.
Note: Clicking Align does not set document status to "Printed." To set document status to "Printed," you must click Print.

**Delivery Method**
Specify how to send documents to your customers:
- Select Print Destination to print to your usual print destination.
- Select Customer to use the delivery method specified in each customer record in Accounts Receivable.
  
  If you select Customer as the delivery method, select the ID for the e-mail message you send with e-mailed documents for customers that use an e-mail delivery method.

**From/To Order Number**
Specify a range of order numbers for which to print order confirmations.

**Include Confirmations Already Printed**
Select this option if you want to print new copies of order confirmations that have been printed previously.

**Message ID**
If you selected Customer as the delivery method, select the ID for the message you want to send with e-mailed confirmations to customers that use an e-mail delivery method.

To view or edit the message for the selected ID, or to add a new e-mail message for order confirmations, click the Zoom button for this field.

**Print Bills of Material Component Items**
Select this option if you want printed order confirmations to show all components in assemblies that are manufactured from bills of material.

**Print Kit Component Items**
Select this option if you want printed order confirmations to show all components in kit assemblies.

**Print On Hold Orders**
Select this option field to print confirmation for orders that are on hold.

**Print Serial/Lot Numbers**
If you use Serialized Inventory and Lot Tracking, select this option if you
want printed order confirmations to show serial numbers or lot numbers assigned to serialized or lotted items.

**Require Shipping Labels**
Select this option to mark shipping labels as required for all orders in the range you specify in the From and To Order Number fields.

When you print shipping labels, you can print labels for the order confirmations that were marked as requiring them.

**Note:** You can print shipping labels only if you entered the number of labels on the Totals tab for each order.

**Use Confirmation**
Select a report format to use for printing order confirmations.

**Use Custom Form**
Select this option to use a custom format that does not use the usual selection criteria set by this screen.

**Important!** Do not select this option unless you are using a customized format that requires it.
O/E Picking Slips Screen

To open this screen:
Open Order Entry > O/E Forms > Picking Slips.

Related tasks:
- "Printing Order Entry Customer Forms " (page 195)
- "Printing Picking Slips " (page 215)

Overview

Use the O/E Picking Slips screen to print picking slips that warehouse or shipping staff can use to locate items and check the availability of inventory.

Picking slips show the number of items that are currently on order (usually the original amount minus any quantity shipped). If your order or shipment details include goods from multiple locations, you can print multiple picking slips per order or shipment.

Note: You can also print picking slips immediately after posting a shipment by selecting Picking Slips on the O/E Confirmation screen.

Formats for Printed Picking Slips

Order Entry includes report formats for picking slips that you may be able to use "as is" or customize for orders and shipments.

Order Entry provides the following picking slip formats for use with orders:

- **OEPICKORDER1.** A picking slip for laser printers (plain paper version).
- **OEPICKORDER2.** A picking slip for preprinted forms.

It also provides the following picking slip formats for shipments:

- **OEPICKSHIPMENT1.** A picking slip for laser printers (plain paper version).
- **OEPICKSHIPMENT2.** A picking slip for preprinted forms.

These formats list all the items and miscellaneous charges on an order, together with any instructions that were entered either with detail lines or for the order.
Note: You can use Crystal Reports or Crystal Info to include other information in picking slips, change the layout to suit your needs, or create your own forms.

Picking Slip Printing Options

When printing picking slips, you can:

- Sort items by picking sequence, item number, or order line number.
- Select a range of orders or shipments for which to print picking slips.
- Select a range of locations for which to print picking slips.
- Print all picking slips in a range, or print only picking slips that have not been printed before.
- If you use Serialized Inventory and Lot Tracking, print serial numbers and lot numbers for serialized and lotted items.

Note:
- If you want to review information before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click Align.

Clicking Align does not set document status to "Printed." To set document status to "Printed," you must click Print.

- If you select the Require Shipping Labels option. To mark the transactions, you must click Print.
- You can print shipping labels only if you entered the number of labels on the Totals tab for each order.
- If you use the O/E Order Entry screen to ship goods for an order, and then print the picking slip after posting, the print status of the shipment is set to Picking Slip Printed, but the print status of the order is not changed.

Fields and Controls

Buttons

Close

Click Close to close the screen.
Print
Click Print to print picking slips and set document status to "Printed."

If you selected the Required for Selected Orders option or the Required for Selected Shipments option, picking slips are marked as required when you click Print.

Align
Click Align to review picking slips before printing, or to print a test copy to verify that the information is aligned correctly on a preprinted form.

Note: Clicking Align does not set document status to "Printed." To set document status to "Printed," you must click Print.

From Order/Shipmen Number
Specify a range of orders or shipments for which to print picking slips, and specify whether to print picking slips for the location specified for the document or for the locations specified for the item details.

- Select Default Location to print a picking slip for each order or shipment that uses a location within the range you specify.
- Select Detail Location to print a picking slip for each location listed in the item details of each order or shipment that falls within the range you specify.

From/To Location
Specify the range of locations for which to print picking slips.

Include Picking Slips Already Printed
Select this option if you want to print new copies of picking slips that have been printed previously.

Print Bills of Materials Component Items
Select this option if you want printed picking slips to show all components in assemblies that are manufactured from bills of material.

Print By
Specify whether to print picking slips for the location specified in the document header or for the locations specified for the item details.
If you print by header locations, the program will print one picking slip for each order or shipment when the location specified in the header is within the From/To Location range.

If you print by detail locations, the program will print a separate picking slip for each location listed in the item details of each order or shipment, provided that the location falls within the From Location/To Location range that you specify next.

**Print Kit Component Items**
Select this option if you want printed picking slips to show all components in kit assemblies.

**Print Serial/Lot Numbers**
If you use Serialized Inventory and Lot Tracking, select this option if you want printed picking slips to show serial numbers or lot numbers assigned to serialized or lotted items.

**Require Shipping Labels**
Select this option to mark shipping labels as required for all orders or shipments in the range you specify in the Order Number or Shipment Number field.

When you print shipping labels, you can print labels for the transactions that were marked as requiring them.

**Note:**
- Transactions are marked as requiring shipping labels when you click **Print**. Clicking **Align** does not mark shipping labels as required.
- You can print shipping labels only if you entered a number on the Totals tab for each order.

**Select By**
Select the transaction type for which you are printing picking slips (order or shipment).

**Sort By**
Specify whether to sort picking slips by picking sequence, item number, or order/shipment line number.

**Use Slip**
Select a report form to use for printing picking slips.

Order Entry provides the following picking slip formats for use with orders:
- **OEPICKORDER1.** A picking slip for laser printers (plain paper version).
- **OEPICKORDER2.** A picking slip for preprinted forms.

It also provides the following picking slip formats for shipments:

- **OEPICKSHIPMENT1.** A picking slip for laser printers (plain paper version).
- **OEPICKSHIPMENT2.** A picking slip for preprinted forms.
**O/E Quotes Screen**

**To open this screen:**
Open **Order Entry > O/E Forms > Quotes**.

**Related tasks:**
- "Entering a Quote" (page 87)
- "Printing Order Entry Customer Forms" (page 195)
- "Printing a Quote Immediately After Posting" (page 216)
- "Printing a Range of Quotes" (page 218)

**Overview**

Use the O/E Quotes screen to print one or more sales quotes.

**Tip:** To create a quote for a customer, you use the Order Entry screen, selecting **Quote** as the order type and entering details as you would for an order. You can print the quote for the customer immediately after posting it.

**Formats for Printing Quotes**

Order Entry includes two formats for printing quotes that you may be able to use "as is" or customize:

- **OQUOT01.RPT** A quote for laser printers (plain paper version).
- **OQUOT02.RPT** A quote for preprinted forms.

These formats list all the items and miscellaneous charges on a quote, plus any comments that were entered for the quote and for specific items and charges included in the quote.

**Note:** You can use Crystal Reports or Crystal Info to include other information in quotes, change the report layout to suit your needs, or create your own forms.

**Important!**
When pricing by weight, and when the order unit of measure is not the pricing unit of measure, the printed unit price for a quote may not match the unit price on the transaction entry screens.
The information that appears in the Unit Price column on an invoice is calculated by dividing the extended price by the quantity shipped or returned, whether pricing by quantity or by weight.

**Quote Printing Options**

You can print a single quote immediately after posting the quote, or you can use the Quotes screen to print one or more quotes.

**Note:**
If you want to review information before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click **Align**.

Clicking **Align** does *not* set document status to "Printed." To set document status to "Printed," you must click **Print**.

**Fields and Controls**

**Buttons**

- **Close**
  
  Click **Close** to close the screen.

- **Print**
  
  Click **Print** to print quotes and set document status to "Printed."

- **Align**
  
  Click **Align** to review quotes before printing, or to print a test copy to verify that the information is aligned correctly on a preprinted form.

  **Note:** Clicking **Align** does *not* set document status to "Printed." To set document status to "Printed," you must click **Print**.

**Delivery Method**

Specify how to send documents to your customers:

- Select **Print Destination** to print to your usual print destination.

- Select **Customer** to use the delivery method specified in each customer record in Accounts Receivable.
If you select **Customer** as the delivery method, select the ID for the e-mail message you send with e-mailed documents for customers that use an e-mail delivery method.

**From/To Order Number**
Select an order or specify a range of order numbers for which to print quotes.

**Include Quotes Already Printed**
Select this option if you want to print new copies of quotes that were printed previously.

**Print Bills of Material Component Items**
Select this option if you want printed quotes to show all components in assemblies that are manufactured from bills of material.

**Print Kit Component Items**
Select this option if you want printed quotes to show all components in kit assemblies.

**Use Custom Form**
Select this option to use a custom form that does not use the report selection criteria set by this print form.

**Important!** Do not select this option unless you are using a customized quote form that requires it.

**Use Quote**
Select a report format to use to print the quotes. The following formats are included with Order Entry:

- **OEQUOT01.RPT.** A quote for laser printers (plain paper version).
- **OEQUOT02.RPT.** A quote for preprinted forms.
O/E Shipping Labels Screen

To open this screen:
Open Order Entry > O/E Forms > Shipping Labels.

Related tasks:
- "Printing Shipping Labels " (page 220)

Overview

Use the O/E Shipping Labels screen to print shipping labels that you can attach to shipments you send from the warehouse or shipping department.

Tip: Print labels when assembling orders for shipping.

Shipping Label Templates

Order Entry includes two shipping label templates that you may be able to use:

- **OELABEL.RPT.** 1½" x 4" sheet labels for a laser printer (14 labels on a page).
- **OELABELD.RPT.** 1½" x 3¼" tractor feed labels.

You can change the shipping labels to suit your needs or create your own labels using the Crystal Reports designer. You should set up and test these forms before you begin entering transactions.

Shipping Label Printing Options

You can print labels:

- For all orders, shipments, or invoices
- For a range of transactions
- Only for transactions for which you have not already printed a label
- Only for transactions you marked as requiring shipping labels when you printed order confirmations, picking slips, and invoices

The number of labels printed for each order, shipment, or invoice is the number specified for the document on the Totals tab of the O/E Order Entry, Shipment Entry, or Invoice Entry screen.
Appendix A: Order Entry Screen Guides

Note:
If you want to review information before printing, or to print a test copy and verify that information is aligned correctly on a preprinted form, click **Align**. Clicking **Align** does not set document status to "Printed." To set document status to "Printed," you must click **Print**.

Fields and Controls

Buttons

Close
Click **Close** to close the screen.

Print
Click **Print** to print shipping labels and set document status to "Printed."

**Note:** Clicking **Align** does not set document status to "Printed." To set document status to "Printed," you must click **Print**.

Align
Click **Align** to print a test copy to verify that the information is aligned correctly on the labels.

**Note:** Clicking **Align** does not set document status to "Printed." To set document status to "Printed," you must click **Print**.

From/To
Select a range of order numbers, shipment numbers, or invoice numbers for which to print labels, or accept the default entries to print all labels.

Include Labels Already Printed
Select this option if you want to reprint previously printed labels.

Print Only Labels Marked as Required
Select this option if you want to print labels only for orders, shipments, or invoices that have been marked as requiring labels. (You select the **Require Shipping Labels** option when printing order confirmations, picking slips, and invoices.)

Select
Specify whether to print labels for a range of order numbers, shipment
numbers, or invoice numbers.

**Use Label**
Select a format for printing the shipping label. Order Entry comes with two label formats that you may be able to use:

- **OELABEL.RPT.** 1½" x 4" sheet labels for a laser printer (14 labels on a page).
- **OELABELD.RPT.** 1½" x 3¾" tractor feed labels.

**Note:** You test these formats before you use them.
Periodic Processing Screens

Use Order Entry Periodic Processing screens to create batches and clear history.

O/E Clear History Screen

To open this screen:
Open Order Entry > O/E Periodic Processing > Clear History.

Related tasks:
• "Performing Day End Processing " (page 243)

Overview

The O/E Clear History screen clears information and statistics from your Order Entry system.

Warning! Information and statistics that match the criteria you specify are deleted permanently.

You can clear the following information:

• Transaction history (all the information from completed orders, and from printed invoices, credit notes, and debit notes).

  Note: Transaction history is not cleared for orders that have not been completed, or for invoices, credit notes, and debit notes that have not been printed.

• Sales history (item and customer sales by period).

• Sales statistics (totals and high and low amounts by period).

• Salesperson commission data (commissions accumulated since the last time history was cleared).

• Printed posting journals (transactions from shipments, invoices, credit notes, and debit notes that will be posted by Accounts Receivable to general ledger accounts, listed by day end number).

You can specify multiple types of information and statistics for which to clear history at the same time.
Fields and Controls

Printed Posting Journals
Select this option to clear printed posting journals.

**Note:** You must print posting journals before you can clear them.

After selecting this option, specify the day-end number through which to clear posting journals, and then select the types of posting journals to clear.

Order Entry clears journal data for the day-end number you specified and for earlier day-end numbers, provided that you have printed. After clearing the journals, you can no longer print them.

Sales History
Select this option to clear sales history from your Order Entry system.

After selecting this option, specify the year and period through which to clear sales history, and then specify the range of customer numbers or item numbers for which to clear sales history.

Order Entry clears history for the previous periods in the specified year, and for all periods in previous years. After clearing, you can no longer print the O/E Sales History report for the cleared data or display it on the O/E Sales History screen.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

Sales Statistics
Select this option to clear sales statistics from your Order Entry system, and then specify the range of years (calendar or fiscal) and periods for which to clear sales statistics.

Order Entry clears statistics for the previous periods in the specified year, and for all periods in previous years. After clearing, you can no longer print the Sales Statistics report for the cleared data or display it in the Sales Statistics screen.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.
Salesperson Commissions
Select this option to clear sales statistics from your Order Entry system, and then specify the range of salesperson commissions to clear.

Salesperson commission figures are accumulated for each salesperson until you use the O/E Clear History screen to reset them.

After performing Day End Processing at the end of each commission period, you should print the O/E Salesperson Commission report and clear salesperson commission statistics so you can begin accumulating new statistics. For more information, see "Performing Day End Processing " (page 243).

Tip: If you use increasing commission rates for increasing sales amounts in each period, make sure you print and clear salesperson commissions promptly at period end to ensure that commission calculations are correct.

Transaction History
Select this option to clear transaction history from your Order Entry system, and then specify the date up to which to clear transaction history.

Order Entry clears the following transaction history:

- Orders that were completed during the specified date range
- Invoices, credit notes, and debit notes that were printed during the specified date range.

Note: Transaction history is not cleared for orders that have not been completed, or for invoices, credit notes, and debit notes that have not been printed.
**O/E Create Batch Screen**

To open this screen:
Open **Order Entry > Periodic Processing > Create Batch**.

**Related tasks:**
- "Creating a Batch of General Ledger Transactions in Order Entry " (page 244)
- "Posting a Batch of Order Entry Invoices in Accounts Receivable" (page 247)

**Overview**

Use the Create Batch screen to:

- Create a batch of General Ledger transactions from posted shipments (or append transactions to an existing General Ledger batch) and optionally post them automatically. You can use this screen to create General Ledger batches only if you selected On Request Using Create G/L Batch Icon for the Create G/L Transactions option on the Integration tab of the O/E G/L Integration screen.

- Post a batch of invoices in Accounts Receivable from invoices or credit/debit notes posted in Order Entry. You can use this screen to post Accounts Receivable invoices created by Order Entry only if you selected On Request Using Create Batch Icon for the Post A/R Batches option on the Processing tab of the O/E Options screen.

**Posting to Locked Fiscal Periods**

If a fiscal period is locked for General Ledger but not for Order Entry, you can create batches for General Ledger as follows:

- During posting.
- During Day End Processing.
- Using the G/L Batch screen (depending on the options you select on the O/E G/L Integration screen).

**Note:**
If you try to post transactions to a locked period in General Ledger, transactions will be added to an error batch. To prevent this from happening, create and post General Ledger batches for outstanding Order Entry transactions before locking the period for General Ledger.
Similarly, you can create transactions for Accounts Receivable from Order Entry transactions, but you cannot post them to a period that is locked for Accounts Receivable.

### Appending General Ledger Transactions to a CSV File

If you do not use Sage 300 ERP General Ledger, or if your Sage 300 ERP General Ledger system is at another location, Order Entry appends its general ledger transactions to a file called oegltran.csv, which can be imported by a Sage 300 ERP General Ledger at another site, or transferred to another general ledger that you use. The file is in Comma Separated Values (CSV) format, and is created in the same directory as your company database.

If you do not use Sage 300 ERP General Ledger in the same database as Order Entry, all general ledger transactions are placed in the same CSV file. Each time Order Entry creates transactions, a message asks whether you want to add transactions to the existing file or replace it.

### Fields and Controls

**Create G/L Batch Through Day End Number**

Select this option and specify the day-end number up to which to create a batch of General Ledger transactions from posted shipments.

**Post A/R Batches**

Select this option to post a batch of invoices in Accounts Receivable from invoices or credit/debit notes posted in Order Entry.

### Reports Screens

Use Order Entry Reports screens to print setup reports and analytical reports.

### Analytical Reports

Print reports on Order Entry transactions, statistics, sales history, salesperson commissions, and more.

### O/E Aged Orders Report Screen

**To open this screen:**

Open Order Entry > O/E Reports > Aged Orders.
Related tasks:
- Printing Order Entry Analytical and Setup Reports

Overview
The O/E Aged Orders report is a list of all incomplete orders and their relative ages in the system. It compares order dates to dates you specify in the Aged As Of field to determine the aging period to which each order belongs.

Print the report periodically to find and act quickly on orders that have been outstanding for a long time.

Information Printed on This Report
The O/E Aged Orders report displays the following information:
- Order subtotals for each aging period.
- The grand total of all aged orders.
- If you use multicurrency accounting, currency totals for each currency.

You can list all or a range of orders by order number, customer number, or currency (if you use multicurrency accounting).

The report lists orders in columns for the current period and the three aging periods you specified for the report. Another column lists orders that have been outstanding for more than the number of days in the last aging category.

Fields and Controls

Buttons

Close
Click Close to close the screen.

Print
Click Print to print the report to your usual print destination.

Tip:
If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:
- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**Aged As Of**
Enter the date as of which you want orders aged.

Orders posted before the date you specify appear in one of the aging periods on the report. Orders posted after the date you specify (and before the date you specify in the Cutoff Date field) appear in the Current column on the report.

**Contact/Phone**
Select this option to include contact and phone information in the report.

**Cutoff Date**
Enter the date of the most recent order you want to include in the report.

**Tip:** If you do not want to list any current orders, enter the same date in the Age As Of and Cutoff Date fields.

**From/To Currency**
Specify the range of currencies to include in the report.

**From/To Customer Number**
Specify the range of customer numbers to include in the report.

**From/To Order Number**
Specify the range of order numbers to include in the report.

**Invoices**
Select this option to include invoice information in the report.

**Print Amounts In**
If you use multicurrency accounting, specify whether to print amounts in the customer's currency or in your company's functional currency.

**Sort By**
Specify whether to sort the report by order number, customer number, or
currency code.

**Space for Comments**
Select this option to leave additional space for comments when you print the report.

**Use Aging Periods**
Specify the number of days in each aging period.

**Note:** Order Entry displays the default aging periods specified on the O/E Options screen.

**O/E G/L Transactions Report Screen**

**To open this screen:**
Open **Order Entry > O/E Reports > G/L Transactions**.

**Related tasks:**
- "Printing Order Entry Analytical and Setup Reports" (page 227)

**Overview**
The O/E G/L Transactions lists the general ledger transactions created from all shipments posted in Order Entry since the last time you created the general ledger batch.

You can print detailed or summary versions of the report. In multicurrency systems, you can print amounts either in your company’s functional currency or in the source (vendor) currencies in which you posted the transactions.

**Note:** You cannot print the G/L Transactions report if Order Entry creates G/L transactions during day end processing.

The option **Create G/L Transactions** (on the Integration tab of the O/E G/L Integration screen) determines whether and when you can print this report in Order Entry:

- **During Day End Processing.** If Order Entry uses this option, the program sends general ledger transactions immediately to General Ledger. You can view the transactions only in General Ledger, and you cannot print the G/L Transactions report in Order Entry.

- **On Request Using Create Batch Icon.** If Order Entry uses this option, you can print the report in Order Entry after you post transactions or run Day End
Appendix A: Order Entry Screen Guides

Processing (depending on when you cost inventory), but before you create G/L batches.

**Tip:** If you want to include the latest information in the report, remember to run Day End Processing before you create the general ledger batch.

**Fields and Controls**

**Buttons**

**Close**

Click **Close** to close the screen.

**Print**

Click **Print** to print the report to your usual print destination.

**Tip:**

If you select **Preview** as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**Report Currency**

If you use multicurrency accounting, specify whether to print amounts in each customer's currency or in your company's functional currency.

**Report Format**

Select **Detail** or **Summary**. The detail report includes additional information about individual transactions, such as date, source code, and description, and allows you to sort the details.

**Sort By**

If you are printing a detail report, specify whether to sort the details by general ledger account number, year/period, or batch/entry number.
Through Posting Sequence

Specify a range of posting sequences. The report lists all transactions for the posting sequences in the range you specify.

**Note:** The first number in the range is set to the earliest unprinted posting sequence, and cannot be changed.

O/E Invoice Action Report Screen

To open this screen:

Open **Order Entry > O/E Reports > Invoice Action**.

Related tasks:

- "Invoicing Shipments" (page 116)
- "Printing Order Entry Analytical and Setup Reports" (page 227)

Overview

Print the O/E Invoice Action report to find out whether orders have been partially or fully invoiced, and to print the current amounts remaining to be invoiced. This report ensures that all products shipped to customers are properly invoiced in a timely manner.

**Note:**

- This report does not include job-related orders that use project invoicing.
  (After you post a shipment for a job-related order that uses project invoicing, that document is marked completed, and cannot be invoiced in Order Entry.)

Information Printed on This Report

Depending on the options you select, the report can list:

- Orders for a range of order or shipment numbers, also sorted for ranges of customer numbers, salespeople, and order or shipment dates.
- Orders fully shipped, partially shipped, fully invoiced, partially invoiced, or never invoiced.
- Order and customer information, including the primary salesperson associated with each order.
- Detailed information about items and miscellaneous charges for each order (if you select **Detail** as the report type).

- Invoiced shipments (if you select **Fully Shipped** and **Fully Invoiced** in the Include Orders area).

- Amounts in customer currency or functional currency.

- The total amount of all orders listed, and the total amount shipped but not invoiced for all orders listed.

- If you use Project and Job Costing, contract, project, and category information (if you are printing a detail report and select **Include Job Details**).

**Fields and Controls**

**Buttons**

**Close**
Click **Close** to close the screen.

**Print**
Click **Print** to print the report to your usual print destination.

**Tip:**
If you select **Preview** as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.

- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**From/To Order Date**
These fields appear when you select **Order Number** in the Select By field. Use them to specify the range of order dates for orders you want to include in the report.
From/To Shipment Date

These fields appear when you select **Shipment Number** in the **Select By** field. Use them to specify the range of shipment dates for shipments you want to include in the report.

Include Job Details

This option is available if you use Project and Job Costing. Select it if you are printing a detail report and you want to print contract, project, and category information for each detail.

Include Orders

This group of status check boxes appears when you select **Order Number** in the **Select By** field.

Select the statuses of orders that you want to include in the report.

**Note:** You must select at least one Shipped status (such as Fully Shipped) and one Invoiced status (such as Partially Invoiced) before printing the report.

Print Amounts In

If you have a multicurrency system, specify whether to print amounts in the customer currency or your functional currency.

Report Type

Specify whether to print a detail report or a summary report. The summary version of the report does not list item details for the order.

Select By

Specify the main selection method and sorting order for the report—by order number or shipment number—and the range of order numbers or shipment numbers to include on the report.

Then By

Optionally, specify a secondary selection method and sorting order—by customer number or primary salesperson—and the range of customer numbers or primary salespeople to include on the report.

**O/E Order Action Report Screen**

**To open this screen:**

Open **Order Entry > O/E Reports > Order Action**.
Related tasks:
- "Printing Order Entry Analytical and Setup Reports" (page 227)

Overview
Print the O/E Order Action report when you want a list of your current orders, sorted in order of primary salesperson, customer number, or order number, as you require.

Order Entry provides several options that allow you to produce a variety of versions of the report.

Information Printed on This Report
Depending on the options you select, the report can list:
- The item status you selected for the report.
- The primary salesperson for each order.
- For multicurrency reports, customer-currency and functional-currency amounts, and the exchange rate used for conversion to the functional currency.
- The total amount for all orders (in functional currency for multicurrency ledgers).
- The total amount outstanding for the order (in functional currency for multicurrency ledgers).
- The contract, project, and category (if you include job details).

The detail version of the report lists the order details for each item on the order.

Fields and Controls

Buttons

Close
Click Close to close the screen.

Print
Click Print to print the report to your usual print destination.

Tip:
If you select Preview as your print destination, you can print or
export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.

- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**From/To**
Optionally, specify a range of order numbers, customer numbers, or primary salesperson numbers to include on the report, depending on your selection for the **Sort By** option.

**From/To Ship Date**
Specify the range of expected ship dates (for orders) to include on the report.

**Item Status**
Specify the item status of orders to include in the report (completed with no shipments, incomplete, some items available for shipment, all items available for shipment, or items out of stock).

**Include Job Details**
If you are printing a detail report and you use Project and Job Costing, select the **Job Details** option if you want to print the contract, project, and category information for each detail.

**Order Source**
Specify the source of orders to include in the report (all sources, entered directly, or entered through the Internet).

**Order Type**
Specify the types of orders to include in the report (all orders, orders never shipped, orders partially shipped, orders never or partially shipped, or orders on hold).

**Print Amounts In**
If you use multicurrency accounting, specify whether to print amounts in the customer currency or your functional currency.
**Print Status**
Specify orders to include in the report, based on print status.

**Note:** If you ship goods from an order and print the picking slip after posting from the O/E Order Entry screen, only the shipment will have a print status of "Picking Slip Printed," not the order.

**Report Type**
Specify whether to print a detail report or a summary report.

**Sort By**
Specify the sorting order for the report. You can sort by order number, customer number, or primary salesperson number.

**O/E Posting Journals Report Screen**

**To open this screen:**
Open **Order Entry > O/E Reports > Posting Journals**.

**Related tasks:**
- "Printing Order Entry Analytical and Setup Reports" (page 227)

**Overview**
Print the O/E Posting Journals report regularly (daily or weekly), as part of your audit trail.

You can print the following journal reports:

- **Shipments Posting Journal.** Lists all shipments for a range of day-end numbers.

- **Invoices Posting Journal.** Lists all invoices issued to customers for a range of day-end numbers.

- **Credit/Debit Notes Posting Journal.** Lists credit notes and debit notes issued to customers (for returned goods and other reasons) for a range of day-end numbers.

For each of these reports, you can include sales splits, tax summaries, and optional fields. You can also choose to reprint posting journals.
Tip: When you print a posting journal for invoices or credit/debit notes, you can include Accounts Receivable audit information. This can help you match postings in Order Entry to Accounts Receivable transactions.

After printing the report to any print destination, you can use the Clear History screen to clear the posting file.

Multicurrency Reports

The multicurrency version of the report lists the customer's currency code for each invoice or credit, along with the exchange rate, exchange rate type, and exchange rate date. The journal prints amounts in both source and functional currencies.

The final pages of the report include totals for each source currency, and a general ledger summary in both source and functional currencies.

Information Printed on This Report

The information you can print on the report and the order in which it appears depends on the type of posting journal you are printing. It can include:

- All shipments for a range of day-end numbers.
- All invoices issued to customers for a range of day-end numbers.
- All credit notes and debit notes issued to customers (for returned goods and other reasons) for a range of day-end numbers.
- Debit and credit amounts distributed to general ledger accounts for each transaction. An asterisk (*) beside an amount in the Invoice Amount column shows that the unit price or extended price was overridden during invoice, order, or credit note entry.
- Transactions can be listed in order by day end number, transaction date, invoice number, or customer number.
- A tax summary.
- Tax reporting information (if you report taxes in a different currency).
- Invoice totals.
- A salesperson summary.
- Optional fields.
- Job details (if you use Project and Job Costing).
• Any allocated serial numbers or lot numbers (if you use Serialized Inventory and Lot Tracking).

• A General Ledger Distribution Summary, including the debit and credit totals for each account listed on the journal.

**Fields and Controls**

**Buttons**

**Close**

Click **Close** to close the screen.

**Print**

Click **Print** to print the report to your usual print destination.

**Tip:**

If you select **Preview** as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.

- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**From/To Day End Number**

Specify the range of day-end numbers for which you are printing the report.

**Include... options**

Select optional information to include on the report.

The options you can select vary, depending on the type of report you are printing and the programs you use with Order Entry. For example, you can include job details only if you use Project and Job Costing, and you can include Accounts Receivable audit information only if you are printing the Invoice Posting Journal or the Credit/Debit Notes Posting Journal.


**Paper Size**
Select the paper size. You can choose 8½ x 11”, A4, or 8 ½ x 14” (except for credit/debit notes).

**Reprint Previously Printed Posting Journals**
Select this option to include previously printed journals in the report.

**Select Posting Journal options**
Select the type of posting journal you want to print (shipments, invoices, or credit/debit notes).

**Sort By options**
Specify the order in which transactions are listed on the report. You can sort by Day End Number, Transaction Date, Customer Number, or Shipment Number.

**Tax Reporting Information**
Select this option if you report taxes in another currency, and you want this information to appear on the report.

**O/E Sales History Report Screen**

**To open this screen:**
Open Order Entry > O/E Reports > Sales History.

**Related tasks:**
- "Looking Up Sales History for Items or Customers " (page 190)
- "Printing Order Entry Analytical and Setup Reports" (page 227)

**Overview**
The O/E Sales History report provides summarized or detailed sales information, including sales totals by customer, inventory item, or primary salesperson.

Use the report as a sales journal, to record sales staff performance by territory or location, and to indicate strengths and weaknesses in company sales.

Print the report after running Day End Processing, at the end of an accounting cycle, or any time you want to check on your sales performance.

After printing this report, you can use the O/E Clear History screen to clear sales history.
Note: To keep sales statistics that you print on this report, you must select the Keep Sales Statistics option on the O/E Options screen before you run Day End Processing.

Information Printed on This Report

The O/E Sales History report can include the following information:

- Details of invoices, credit notes, and debit notes.
- Sales, returns, and cost amounts for each transaction.
- Gross margin percent for each sale and return, as calculated during Day End Processing.
- If you use Serialized Inventory and Lot Tracking, serial numbers and lot numbers on the report.
- If you use multicurrency accounting, transaction details in functional or source (customer) currency.

Fields and Controls

Buttons

Close

Click Close to close the screen.

Print

Click Print to print the report to your usual print destination.

Tip:

If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).
From/To (various)
The Sales History screen provides a variety of From and To fields where you can specify secondary selection criteria, in addition to the ranges of years and period or document dates associated with the Select By field.

The fields that appear depend on the report type and sort order you select.

For a Detail report:
- In a multicurrency system, when sorting by item or customer, you can specify a range of currencies.
- When sorting by customer, you can specify ranges of territories and salespersons.
- When sorting by item, you can specify ranges of account sets and item categories.
- When sorting by primary salesperson, you can specify a range of salesperson codes.

For a Summary report:
- In a multicurrency system, when sorting by item or customer, you can specify a range of currencies.
- When sorting by customer, you can specify ranges of customer numbers and item categories.
- When sorting by item, you can specify ranges of item numbers and categories.

For a Total report:
- If you select Show Comparison, you can specify a second range of years and periods to compare with the first range.
- When sorting by customer, you can specify ranges of customer numbers and item categories.
- When sorting by item, you can specify ranges of item numbers and item categories.
- In a multicurrency system, when sorting by customer, you can specify a range of currencies.

Include Invoice Details
Select this option if you want to show invoice details, serial and lot numbers,
or kit components in the report.

**Note:**
This option appears only for detail reports, and only if you select records by customer number or item number.

When you select this option, the options *Include Serial/Lot Numbers* and *Print Kit Component Items* appear.

**Include Serial/Lot Numbers**
If you want to show serial and lot numbers on the report, select this option, and then specify a range of serial and lot numbers.

**Note:**
This option appears only if you use the Serial Numbers and Lot Tracking program and you selected the *Include Invoice Details* option.

**Print Amounts In**
If you use multicurrency accounting, specify whether to print amounts in the customer's currency or your company's functional currency.

**Note:** This option does not appear if you are printing totals, and you are sorting sales history by item number.

**Print Kit Component Items**
Select this option to show kit component items on the report.

**Note:** This option appears only if you are printing a detail report.

**Report Type**
Select the type of report you want to print:

- **Detail.** Select sales history by year and period, or by document date.

  You can sort sales history by customer number, item number, or primary salesperson.

  If you sort by item or customer, you can also include invoice details, serial and lot numbers (if you use Serialized Inventory and Lot Tracking), and kit components on the report.

  Depending on the sort order you select, you can also specify additional selection criteria.
• In a multicurrency system, when sorting by item or customer, you can specify a range of currencies.

• When sorting by customer, you can specify ranges of territories and salespersons.

• When sorting by item, you can specify ranges of account sets and item categories.

• When sorting by primary salesperson, you can specify a range of salesperson codes.

• **Summary.** Select sales history by year and period.

  You can sort sales history by customer number or item number.

  Depending on the sort order you select, you can also specify secondary selection criteria.

  • In a multicurrency system, when sorting by item or customer, you can specify a range of currencies.

  • When sorting by customer, you can specify ranges of customer numbers and item categories.

  • When sorting by item, you can specify ranges of item numbers and categories.

• **Totals.** Select sales history by year and period or by document date.

  You can sort sales history by customer number, item number, or primary salesperson.

  Depending on the sort order you select, you can also specify secondary selection criteria.

  • If you select **Show Comparison**, you can specify a second range of years and periods to compare with the first range.

  • When sorting by customer, you can specify ranges of customer numbers and item categories.

  • When sorting by item, you can specify ranges of item numbers and item categories.

  • In a multicurrency system, when sorting by customer, you can specify a range of currencies.
Note: You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

Select By
Select sales history to include in the report by specifying a range of years and periods, or a range of document dates.

Note: You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

Depending on the report type and sorting order you choose, you can also specify secondary selection criteria, including ranges of currency codes, customer numbers, item categories, salespersons, and territories.

Note:
- If you select Summary as the report type, you must specify a range of years and periods.
- If you select Totals as the report type, you can select Show Comparison, and then specify a second range of sales history for comparison with the first range.

Show Comparison
Select this option to include a second range of sales history to compare with the range you specify.

Note: This option appears only if you selected the Totals report type.

Sort By
Specify whether to sort information in the report by customer number, item number, or (if you selected Detail as the report type) primary salesperson.

Note: Other report settings become available depending on your selection. For example, if you select Primary Salesperson, you can also include kit components on the report.
**O/E Sales Statistics Report Screen**

**To open this screen:**
Open **Order Entry > O/E Reports > Sales Statistics**.

**Related tasks:**
- "Adding Sales Statistics " (page 187)
- "Looking Up Sales Statistics " (page 187)
- "Printing Order Entry Analytical and Setup Reports" (page 227)

**Overview**

Print the O/E Sales Statistics report when you want to check the volume of orders, invoices, and credit notes you processed during a specified period. The report includes Order Entry statistics accumulated since you last cleared the sales statistics data.

This report can help you understand and analyze the level of processing in your Order Entry system.

**Note:** To keep sales statistics that you print on this report, you must select the **Keep Sales Statistics** option on the O/E Options screen before you run Day End Processing.

**Information Printed on This Report**

The O/E Sales Statistics report lists the following information:

- The net sales amount (not including miscellaneous charges or taxes).
- Total sales lost and average sales lost. (Sales amounts are lost when items are ordered or backordered and then canceled, whether or not quantities were shipped.)
- In multicurrency ledgers, the source currency code and description, and statistics for each source currency.

**Note:** You can print multicurrency versions of the report in functional or source (customer) currency.

**Fields and Controls**

**Buttons**

**Close**

Click **Close** to close the screen.
Print
Click **Print** to print the report to your usual print destination.

**Tip:**
If you select **Preview** as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**Amounts In**
If you use multicurrency accounting, specify whether to print amounts in your company's functional currency or in customer currency.

**Consolidate Currencies**
If you use multicurrency accounting, select this option to consolidate statistics for the range of currencies you specify.

**From/To Currency**
If you use multicurrency accounting, specify the range of currency codes to include in the report.

**From/To Year/Period**
Specify the range of years and periods for which to print the report.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

**O/E Salesperson Commissions Report Screen**

**To open this screen:**
Open **Order Entry > O/E Reports > Salesperson Commissions**.
Related tasks:
- "Printing Order Entry Analytical and Setup Reports" (page 227)

Overview
This report lists commissions earned in the current commission period for each salesperson for whom you track commissions.

You can print a detail or summary version of the report.

**Note:**
Before you print this report:

- The **Track Commissions** option must be selected on the O/E Options screen before you run Day End Processing.
- For each salesperson whose commissions you want to track, the **Paid Commissions** option must be selected in the salesperson record (in Accounts Receivable).

After printing the report, you can clear the salesperson commission data to start a new commission period. For more information, see "About Sales Commissions " (page 52).

**Information Printed on This Report**

- The range of salesperson codes selected for the report.
- The commission earned by each salesperson, including the type of commission (based on the sales amount or on the margin, as specified on the Processing panel of the O/E Options screen).
- Category sales, including those for which the commission is calculated based on the category's commission rate. For category sales where the commission rate is determined by the category, all salespersons receive the commission rate defined for the category (instead of the salesperson's commission rate), unless the category rate is 0 (zero) percent.
- Sales by salesperson, including those for which the commission is calculated based on the salesperson's commission rate. The salesperson can have up to five commission rates, which you define on the A/R Salespersons screen in Accounts Receivable.
- Rates totals for each salesperson (a rate total for the report).
- Report totals (not including miscellaneous charges or taxes).
Note: In multicurrency ledgers, report amounts are printed in the functional (home) currency.

Fields and Controls

Buttons

Close
Click Close to close the screen.

Print
Click Print to print the report to your usual print destination.

Tip:
If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

Display Subtotals
Select this option if you are printing a detail report sorted by customer number, and you want to print subtotals for each customer.

From/To Date
If you selected Date in the Select By field, specify which commissions to include in the report by specifying the range of dates that the commissions were paid.

From/To Fiscal Year/Period
If you selected Fiscal Year/Period in the Select By field, specify which commissions to include in the report by specifying the range of fiscal year/periods that the commissions were paid.

From/To Salesperson
Specify the range of salesperson codes for the salespersons who were paid
the commissions.

**Include Commission Type**
Select this option if you want the report to include the type of commission paid.

**Print**
Select whether to print a Detail or Summary report.

**Select By**
Use this field to filter the commissions to include in the report by date or by fiscal year and period.

**Sort By**
If you are printing a detail report, specify whether to sort the details by document number, document date, or customer number.

**O/E Transaction List Report Screen**

**To open this screen:**
Open **Order Entry > O/E Reports > Transaction List**.

**Related tasks:**
- "Printing Order Entry Analytical and Setup Reports" (page 227)

**Overview**
Print the O/E Transaction List report when you need a list of orders, shipments, invoices, or credit/debit notes. You print a separate report for each type of transaction, and you can print a detail or summary version of the report.

The report includes current transactions and, if you keep transaction history, past transactions.

**Important!**
If you do not keep transaction history, Order Entry deletes transaction information when you run Day End Processing in Inventory Control. Day End Processing deletes order information when orders are completed, and deletes invoice and credit note information after you have printed invoices and credit notes.

For more information about the Keep Transaction History option, see "O/E Options Screen" (page 311).
When printing this report for orders, you can specify which orders to include in the report by selecting the order type, status, and source.

You can sort the report by transaction number or customer number, and you can specify ranges of transaction numbers, customer numbers, and currency codes (if you have a multicurrency system) to include in the report.

**Information Printed on This Report**

Depending on the printing options you select, the O/E Transaction List report can include:

- The information entered on the main screen of the O/E Order Entry screen or the O/E Credit/Debit Note Entry screen, and the total amount. In multicurrency ledgers, the total amount is displayed in both source currency and functional currency.

- The address, phone number, and fax number for billing and shipping.

- Details for each item on the order, invoice, shipment, or credit/debit note, including quantities ordered and shipped or returned, unit prices, and total amounts outstanding.

- The salesperson commission split for the order.

- Any prepayments that were posted to an order or invoice.

- The contract, project, and category to which the items or charges were allocated.

- Any allocated serial numbers or lot numbers (if you use Serialized Inventory and Lot Tracking).

- Grand totals for orders, shipments, invoices, or credit/debit notes.

- Summary totals for each source currency (for the multicurrency version of the report).

**Fields and Controls**

**Buttons**

**Close**

Click **Close** to close the screen.

**Print**

Click **Print** to print the report to your usual print destination.
Tip:
If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

From/To (transaction number or customer number)
Specify a range of credit/debit note numbers, invoice numbers, order numbers, or shipment numbers to include in the report.

Also, specify a range of customer numbers.

(You use the From and To fields associated with the Sort By or the Then By fields, depending on whether you are specifying the customer number or transaction number as the primary or secondary sort order.)

From/To Currency
If you have a multicurrency system, specify a range of currencies to include in the report.

From/To Date
Specify a range of dates to include in the report.

Include options
Select optional information you want to include in the report.

Note: The options are available only for detail reports, and they vary according to the type of transaction you select in the Print field.

Order Type options
Specify order types to include in the report (Active, Standing, Future, or Quote).

Note: These options are available only if you select Order in the Print field.
Print
Specify the type of transaction you want the report to list (orders, shipments, invoices, or credit/debit notes).

Source options
Specify the sources of orders to include in the report. You can include orders entered directly in Order Entry or over the Internet.

Note: These options are available only if you select Order in the Print field.

Report Type
Specify whether to print a detail or summary report.

Sort By / Then By
Specify the primary sort order for the report in the Sort By field, and then, depending on your selection, specify the range of transaction numbers or customer numbers to include on the report.

When you select a primary sort order, Order Entry supplies the secondary sort order in the Then By field. Specify a range of transaction numbers or customer numbers for the secondary range.

Status options
Select order statuses to include in the report.

Note: These options are available only if you select Order in the Print field.

Setup Reports
Print reports that list setup records and options for your Order Entry system.

O/E Optional Fields Report Screen

To open this screen:
Open Order Entry > O/E Reports > Optional Fields.

Related tasks:
- "Printing Order Entry Analytical and Setup Reports" (page 227)
Overview

Print the Optional Fields report to review information about the optional fields you have set up in Order Entry.

For each optional field, the report displays:

- Field code and description
- Default value for the field
- Whether or not the field is automatically inserted in records

Including Optional Field Information on Reports

Optional fields let you analyze your Order Entry data in ways that are relevant to your business. The following reports let you select records by optional fields:

- Posting Journals Report
- Miscellaneous Charges Report
- Transaction List Report

When you use optional fields as selection criteria, Order Entry prints records that have optional fields and values in the ranges you specify.

Fields and Controls

Buttons

Close

Click Close to close the screen.

Print

Click Print to print the report to your usual print destination.

Tip:

If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)
For more information about print destinations, see "About Print Destinations" (page 227).

**Show Settings**
Select this option to print the settings for each optional field on the report. The settings specify the accounts to which optional fields will be passed and whether optional fields will be passed to Project and Job Costing.

**O/E E-mail Messages Report Screen**

**To open this screen:**
Open Order Entry > O/E Reports > E-mail Messages.

**Related tasks:**
- "Printing Order Entry Analytical and Setup Reports" (page 227)

**Overview**
Print the E-mail Messages report to see a list of all the e-mail messages you have set up for your Order Entry system.

The report includes message type, message ID, description, content, and information about when the message was last updated and/or set to inactive.

**Buttons**

**Close**
Click **Close** to close the screen.

**Print**
Click **Print** to print the report to your usual print destination.

**Tip:**
If you select **Preview** as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.

- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)
For more information about print destinations, see "About Print Destinations" (page 227).

O/E G/L Integration Report Screen

To open this screen:
Open Order Entry > O/E Reports > G/L Integration.

Related tasks:
- "Printing Order Entry Analytical and Setup Reports" (page 227)

Overview

The G/L Integration report lists the information entered on the G/L Integration screen that controls how your Order Entry system sends transactions to General Ledger, including G/L transaction and batch creation options.

Print the report before and after changing options.

Information Printed on This Report

The G/L Integration report lists the following information:

- **Integration Information**
  - The last day end number used to generate G/L transactions.
  - G/L source codes that are assigned to the transaction types used in Order Entry.

- **Transaction Information**
  - The information from Order Entry document headers and details that will be kept with G/L transactions and sent to General Ledger.

Buttons

**Close**
Click Close to close the screen.

**Print**
Click Print to print the report to your usual print destination.

**Tip:**
If you select Preview as your print destination, you can print or export the
report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

**O/E Miscellaneous Charges Report Screen**

**To open this screen:**
Open Order Entry > O/E Reports > Miscellaneous Charges.

**Related tasks:**
- "Creating Miscellaneous Charges" (page 49)
- "Managing Miscellaneous Charges" (page 51)
- "Printing Order Entry Analytical and Setup Reports" (page 227)

**Overview**

Print the O/E Miscellaneous Charges report when you need to review information about the miscellaneous charges in your Order Entry system (such as postage, shipping, handling, and restocking charges).

Also print the report after using the Miscellaneous Charges setup screen to create new miscellaneous charges or change existing ones.

**Information Printed on This Report**

For each miscellaneous charge, the report lists the miscellaneous charge code and description, currency code (if you have a multicurrency system), amount of the charge, general ledger account code, tax authority, and tax class.

You can also include optional field information and, if you use Project and Job Costing, the extended cost and job-related expense and clearing accounts for job-related miscellaneous charges.

**Fields and Controls**

**Buttons**

**Close**
Click Close to close the screen.
Print
Click **Print** to print the report to your usual print destination.

**Tip:**
If you select **Preview** as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the
  Crystal Reports report menu bar.

- To export the report to a file, click the export icon on the Crystal
  Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF,
  or CSV as the export format.)

For more information about print destinations, see "About Print
Destinations" (page 227).

**From/To Currency**
If you use multicurrency accounting, specify a range of currency codes to
include in the report.

**From/To Miscellaneous Charge**
Specify a range of miscellaneous charge codes to include in the report.

**Job Related Details**
Select this option to include the extended cost and job-related expense and
clearing accounts for job-related miscellaneous charges in the report.

**Optional Fields**
Select this option to include optional field information in the report.

**Sort By**
If you use multicurrency accounting, specify whether to sort the report by
miscellaneous charge or by currency.

**O/E Options Report Screen**

**To open this screen:**
Open **Order Entry > O/E Reports > Options**.

**Related tasks:**
- "Printing Order Entry Analytical and Setup Reports" (page 227)
Overview

Print the Options report to review the information you entered and the options you selected when you set up your Order Entry system, or when you last used the Options screen to change this information.

Information Printed on This Report

The Options report lists the following information:

- Company Information
  - Your company address.
  - Contact information for the Order Entry contact person.
- Processing Information
  - In multicurrency ledgers, the functional (home) currency and default exchange rate type.
  - Processing options:
    - Whether you calculate backorder quantities.
    - Whether you keep transaction history.
    - Whether you allow non-existent customers.
    - Whether you default the quantity ordered as the quantity committed.
    - Whether you calculate tax reporting amounts automatically.
    - The default unit of measure used for orders.
    - The default weight unit of measure used for orders.
    - The default template used for entering new orders.
    - The default number of days before quotes expire.
    - Whether you create invoices for shipped goods by default.
    - Whether you warn before applying credit notes to previously credited invoices.
- Whether and how you accumulate sales history.
- Whether and how you accumulate sales statistics.
• Whether and how you track and calculate sales commissions.
• What transactions you review for credit checks.

Document Numbering Information
• Document number length, prefix, and next number for quotes, orders, invoices, shipments, and credit and debit notes.

Aging Information
• The number of days in order aging periods.
• The next day end number.

Buttons

Close
Click Close to close the screen.

Print
Click Print to print the report to your usual print destination.

Tip:
If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

• To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
• To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

For more information about print destinations, see "About Print Destinations" (page 227).

O/E Ship-Via Codes Report Screen

To open this screen:
Open Order Entry > O/E Reports > Ship-Via Codes.

Related tasks:
• "Printing Order Entry Analytical and Setup Reports" (page 227)
appendix a: order entry screen guides

overview

print the o/e ship-via codes report to review information about the shipping methods or carriers you use to deliver goods to customers (such as courier, air mail, and parcel post).

print the report when you change ship-via information.

information printed on this report

- ship-via codes and descriptions.
- names, addresses, telephone numbers, and contacts for all listed ship-via codes.

fields and controls

buttons

close

click close to close the screen.

print

click print to print the report to your usual print destination.

**tip:**

if you select preview as your print destination, you can print or export the report from the preview screen in the following ways:

- to print the report on your printer, click the printer icon on the crystal reports report menu bar.
- to export the report to a file, click the export icon on the crystal reports menu bar. (you can select crystal reports, pdf, excel, rtf, or csv as the export format.)

for more information about print destinations, see "about print destinations" (page 227).

from/to ship-via code

specify the range of ship-via codes to include in the report.
O/E Templates Report Screen

To open this screen:
Open Order Entry > O/E Reports > Templates.

Related tasks:
- "Printing Order Entry Analytical and Setup Reports" (page 227)

Overview

Templates help you speed up and simplify order entry by specifying default information and settings to use when you create a new order or invoice.

The Templates report lists the information entered to define the templates that are used in your Order Entry system. Print this report when you add or modify Order Entry templates.

Information Printed on This Report

- Template codes and descriptions.
- Information entered and selections made to define the templates.

Fields and Controls

Buttons

Close
Click Close to close the screen.

Print
Click Print to print the report to your usual print destination.

Tip:
If you select Preview as your print destination, you can print or export the report from the preview screen in the following ways:

- To print the report on your printer, click the printer icon on the Crystal Reports report menu bar.
- To export the report to a file, click the export icon on the Crystal Reports menu bar. (You can select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)
For more information about print destinations, see "About Print Destinations" (page 227).

**From/To Template Code**
Specify the range of template codes to include in the report.

**Setup Screens**
Use Order Entry setup screens to set up accounts, security authorizations, options, setup records, outstanding orders, and other details for your Order Entry system.

**O/E Options Screen**

**To open this screen:**
Open Order Entry > O/E Setup > Options.

**Related tasks:**
- "Allowing Editing of Sales Statistics " (page 40)
- "Selecting Transaction Processing Options in Order Entry" (page 19)
- "Setting Up Customer Credit Check Options " (page 42)
- "Setting Up Order Entry" (page 3)
- "Setting Up Posting and Day End Processing Options " (page 21)
- "Setting Up Salesperson Commissions" (page 54)

**Overview**
Use the O/E Options screen to select options when setting up your Order Entry system, or when you need to change setup options.

- On the Company tab, you enter and edit contact information for your Order Entry system.
- On the Documents tab, you specify how Order Entry assigns document numbers to new transactions.
- On the Processing tab, you select options that determine how and when Order Entry performs various processing tasks.
Note:
- For more information about selecting specific Order Entry options, and about changing options after you have set up your Order Entry system, see "Selecting Transaction Processing Options in Order Entry" (page 19).
- For information about integrating Order Entry with General Ledger, see O/E G/L Integration Screen.

Company Panel
On the Company tab, enter contact information for your Order Entry system.

Note: To change your company name and address, or to change contact information at the company level, use the Company Profile screen in Common Services.

Documents Panel
On the Documents tab, you specify prefixes and next numbers to assign to documents, and specify default aging periods into which Order Entry groups outstanding or overdue transactions for the O/E Aged Orders report.

Document numbers in Order Entry are a combination of the following elements:
- A prefix that identifies the transaction type.
- A number that Order Entry assigns sequentially, starting with the number you specify.

Note: The maximum length for document numbers is 22 characters (including the prefix).

Processing Panel
Use the Processing tab to specify general Order Entry options for transaction processing, currency, default document information, statistics, history, commissions, and credit checks.

You can specify options that determine whether and how Order Entry performs the following tasks:
- Calculates backorder quantities automatically.
- Displays the pricing unit or the stocking unit as the default order unit of measure on Order Entry screens.
- Saves transaction and sales information for reporting.
Appendix A: Order Entry Screen Guides

- Accumulates sales statistics.
- Allows editing of statistics.
- Uses a default template for entering orders, invoices, and credit notes. (You cannot specify the default code until you have added templates on the O/E Templates screen).
- Tracks commissions on sales or margins.
- Allows you to enter a default number of days for the expiration of quotes.
- Allows you the option to clear expired quotes after a delay you specify.
- Allows you the option to post documents for non-existent customers.

**Fields and Controls**

**Company tab**

On the Company tab, enter contact information for your Order Entry system.

**Note:** To change your company name and address, or to change contact information at the company level, use the Company Profile screen in Common Services.

**Contact Name**

Enter the name of a contact person, position, or department for your Order Entry system.

**Fax Number**

Enter a fax number for your Order Entry system.

**Telephone**

Enter a telephone number for your Order Entry system.

**Documents tab**

On the Documents tab, you specify prefixes and next numbers to assign to documents, and specify default aging periods into which Order Entry groups outstanding or overdue transactions for the O/E Aged Orders report.

**Aging Periods**

Specify default aging periods into which Order Entry groups outstanding
or overdue transactions for the Aged Orders report.

You can change the default periods at any time. You can also specify different aging periods for individual reports when you print them.

For more information about viewing outstanding orders, see "O/E Aged Orders Report Screen" (page 275).

**Next Day End Number**

This field displays the day end number that will be assigned the next time you run Day End Processing in Inventory Control.

**Document Numbers table**

On the Document Numbers table, you specify the length, prefix, and next number to use when assigning numbers to each type of document in your Order Entry system.

Document numbers in Order Entry are a combination of the following elements:

- A prefix that identifies the transaction type.
- A number that Order Entry assigns sequentially, starting with the number you specify.

**Note:** The maximum length for document numbers is 22 characters (including the prefix).

**Document Type**

This field displays the type of Order Entry document for which you are specifying the length, prefix, and next number to use when assigning document numbers.

**Length**

Specify the number of characters to use when assigning document numbers to the selected document type. Maximum length is 22 characters.

**Next Number**

If you do not want to use the default starting number for the selected document type, enter a starting number to use.
When you create a new document, if you do not specify a document number, Order Entry automatically assigns the next available number. You can change this number if necessary.

**Prefix**
Enter a prefix of up to 6 characters to use in document numbers for the selected document type. The maximum length for document numbers is 22 characters (including the prefix).

**Processing tab**
Use the Processing tab to specify general Order Entry options for transaction processing, currency, default document information, statistics, history, commissions, and credit checks.

**Default Rate Type**
If you use multicurrency accounting, select the default rate type to use for converting source (customer) currency amounts to your company's functional currency equivalents.

You define rate types using the Currency Rate Types screen in Common Services.

**Note:** You can use different rate types in Order Entry and Accounts Receivable.

**Functional Currency**
This field displays the functional currency for your company.

**Note:**
- You specify the functional currency for your company on the Company Profile screen in Common Services.
- After specifying a functional currency, you cannot change it.
- All Sage 300 ERP programs for the company automatically use the same functional currency.

**Multicurrency**
This option indicates whether your Order Entry system is multicurrency or single-currency. The setting depends on your selection in Accounts Receivable:
- If Accounts Receivable is multicurrency, Order Entry is multicurrency also.

- If Accounts Receivable is single-currency, Order Entry is single-currency also.

You cannot change this option.

**Commissions**

**Commission By**
If you track sales commissions, specify whether to calculate commissions by sales amount or margin amount.

For more information, see "About Sales Commissions " (page 52).

**Track Commissions**
Select this option if you want to track sales commissions.

Order Entry can calculate commissions earned by salespersons using the data from invoices and credit notes. You can print this information on the O/E Salesperson Commissions report.

For more information, see "About Sales Commissions " (page 52).

**Credit Checks**
If a credit limit has been set for a customer in Accounts Receivable, Order Entry checks each transaction posted for the customer to determine whether the customer's current balance in Accounts Receivable exceeds their credit limit.

Select the options in this group if you want to include pending transactions from Accounts Receivable, Order Entry, or other Sage 300 ERP programs in the credit check.

**Note:** Checks that include pending transactions take more time than checks that do not. You can turn these checks off to improve processing speed.

If the customer is part of a national account, Order Entry also checks national account balances. It does not check pending balances for the national account.
Include Other Pending Transactions in Credit Limit Check
Select this option if you want to include unposted transactions from other third-party programs supported by Sage 300 ERP when checking a customer's credit.

Include Pending A/R Transactions in Credit Limit Check
Select this option if you want to include unposted Accounts Receivable transactions when checking a customer's credit.

Include Pending O/E Transactions in Credit Limit Check
Select this option if you want to include unposted Order Entry transactions when checking a customer's credit.

Processing Options

Allow Non-existent Customers
If you select this option, you can post orders for customers for which there is no record in Accounts Receivable.

If you do not select the option, Order Entry prevents you from entering an order, shipment, or invoice for a customer for which no record exists in Accounts Receivable.

Regardless of your choice, you cannot post an invoice in Accounts Receivable until you add the customer to your Accounts Receivable system.

Note:
- We recommend that you do not use this option in a multicurrency system, especially if the reporting currencies for customer tax groups do not match your customers' currencies.

If you select this option, you must specify a tax group when entering a new document for a non-existent customer before you can enter item details. The currency for the tax group you specify will also be the currency for the document, for the tax reporting currency, and for the customer when you add the customer record in Accounts Receivable.

If you want the tax group currency to be different from the tax reporting currency or the document currency, you must add the customer record in Accounts Receivable first.

- If you have activated Sage 300 ERP integration with Sage CRM.
and the order is linked to a Sage CRM opportunity, selecting this option does not enable you to post a shipment for a non-existent customer.

Before you can ship an order that is linked to a Sage CRM opportunity, you must open Sage CRM and promote the customer to Accounts Receivable.

Apply Credit Note to Previously Credited Invoice
Specify how Order Entry responds when you post a credit note for a previously credited invoice.

- **Warning.** Display a warning message (allows the person posting the credit note to cancel or proceed).

- **Error.** Display an error message (prevents the person posting the credit note from proceeding).

- **Ignore.** Ignore previously posted credit notes and continue with posting.

Calculate Backorder Quantities
Select this option if you want Order Entry to calculate and display the quantity backordered when you add items to an order.

If you do not select this option, the **Quantity Backordered** field displays zeros, whether or not the quantity ordered is larger than the quantity shipped.

Whether or not you calculate backorder quantities, you can edit the number in the **Quantity Backordered** field.

Calculate Tax Reporting Amounts Automatically
Select this option if you want the **Calculate Tax** option to be selected by default for new Order Entry transactions.

Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source (customer) currency and the tax reporting currency.

**Note:** The **Calculate Tax** check box appears only if a tax authority for the transaction has a tax reporting currency that is different from the source or functional currency.
Clear Expired Quotes After
If you want to specify a number of days after which expired quotes will be deleted, select this option, and then enter the number of days after which expired quotes will be deleted.

Order Entry deletes expired quotes when you run Day End Processing in Inventory Control.

If you do not select this option, expired quotes are not deleted.

Default Create Invoice Option to
Select Yes if you want the Create Invoice option to be selected by default when you create new documents using the O/E Order Entry and O/E Shipment Entry screens.

When the Create Invoice option is selected on these screens, Order Entry creates an invoice for all items shipped when you post the document.

Tip: Generally, you would select this option if you always invoice shipments, even for partially shipped orders. If you only invoice completed orders, you might choose not to select this option.

Default Order UOM
Specify whether to use the stocking unit or the pricing unit as the default order unit of measure on Order Entry screens.

For more information, see "About Order Unit of Measure" (page 19).

Default Order Weight UOM
Specify whether to use the item weight unit or the pricing weight unit as the default weight unit of measure for items that are priced by weight on Order Entry screens.

You use the I/C Items screen to specify item weight, and you use the I/C Item Pricing screen to specify pricing weight.

Note:
- This setting applies only to items that are priced by weight. If you price an item by quantity, Order Entry uses the weight unit of measure in the item record.

- Pricing by weight is available only in Sage 300 Premium ERP.
**Default Posting Date**
Select the default date that will appear in the **Posting Date** field for new shipments, invoices, credit notes, and debit notes.

- **Document Date.** Select if you usually want the posting date and fiscal period to match the document date.
  
  **Note:** If you select this setting, when you change the document date on a transaction entry screen, Order Entry automatically changes the posting date to match.

- **Session Date.** Select if you usually want the posting date and fiscal period to match the current session date.
  
  **Note:** If you select this setting, when you change the document date on a transaction entry screen, Order Entry keeps the session date as the default posting date.

If you use multicurrency accounting, currency revaluation uses posting dates to select open documents for revaluation purposes so that adjustments are posted to General Ledger in the correct fiscal year and period.

**Default Quantity Committed**
If you select this option, Order Entry automatically copies the number you enter in the **Quantity Ordered** field into the **Quantity Committed** field on transaction entry screens.

Selecting this option ensures that quantities you enter in orders are automatically committed if available in inventory, which ensures that items are available when you ship them (unless you allow negative inventory quantities).

If a quantity is already committed to an order, you can ship another order for the same items only if there is a sufficient quantity in inventory in addition to the committed quantity.

**Default Quote Expiration Days**
Enter the default number of days after which quotes expire. Transaction entry screens display a default expiration date based on the number of days you specify here.

**Default Template Code**
Select a default template for new documents.
For more information, see "O/E Templates Screen " (page 334).

**Tip:** If you use Project and Job Costing and expect to create orders or shipments for "non-existent" customers, select a template that includes a tax group. (If you use project invoicing for a customer who has no record in Accounts Receivable, you cannot edit the tax group. If the **Tax Group** field is blank, you cannot add order details.)

**Keep Transaction History**
Select this option if you want to keep transaction history so that you can:

- Print completed order, invoice, and credit note information on the O/E Transaction List report.
- Drill down from transactions in General Ledger, Accounts Receivable, and Inventory Control to the originating entry in Order Entry.

If you do not select this option, Day End Processing removes information for fully shipped and invoiced orders, and removes information for printed invoices and credit notes, so they will no longer appear on transaction lists.

**Note:** Your selection for this option does not affect posting journals.

**Post A/R Batches**
Specify when to post Accounts Receivable batches generated from Order Entry transactions. You can post these batches either when you create subledger transactions (during posting or Day End Processing, depending on your I/C Costing options) or using the O/E Create Batch screen in Order Entry.

**Important!**
If you create subledger transactions during posting and you choose to post A/R batches at the same time, Order Entry creates and posts an A/R batch for *each invoice* it creates. This choice can significantly slow the processing of transactions, and can also create a large number of A/R batches.
If you process a large volume of orders, you should either create subledger batches during Day End Processing or use the O/E Create Batch screen to post A/R batches.

If you select **On Request Using Create Batch Icon** for this option, you can also use the A/R Post Batch screen in Accounts Receivable to post the batches.

For more information, see "Order Entry Options for Posting Accounts Receivable Batches" (page 23).

**Sales History**

**Accumulate By**
Specify whether to accumulate sales history by calendar year or fiscal year.

- **Calendar Year.** Sets the start date for sales history to January 1.
- **Fiscal Year.** Sets the start date for sales history to the first day of your company's fiscal year, as specified in the fiscal calendar in Common Services.

**Keep Sales History**
Select this option to keep sales history to support inquiry, reporting, and analysis.

If you select this option, you must also specify how sales history data is accumulated.

**Period Type**
Select the length of the periods by which you will accumulate sales history.

**Note:** Weekly periods run from Sunday to Saturday. If you use weekly periods and your year does not start at the beginning of the week, the first and last periods in a year will be short ones.

**Sales Statistics**

**Accumulate By**
Specify whether to accumulate sales statistics by calendar year or fiscal year.
• **Calendar Year.** Sets the start date for sales statistics to January 1.

• **Fiscal Year.** Sets the start date for sales statistics to the first day of your company's fiscal year, as specified in the fiscal calendar in Common Services.

**Allow Edit of Statistics**
Select this option if you want to allow editing of year-to-date or previous-year totals for orders, invoices, or credit notes.

**Tip:**
• You may want to select this option while you are setting up your Order Entry system, particularly if you are creating the system partway through an accounting year. You can then enter prior-period statistics from your previous system.

• Once your system is operating, you should clear this option. Order Entry updates statistics automatically when you post transactions.

**Keep Sales Statistics**
Select this option to keep sales statistics to support inquiry, reporting, and analysis.

If you select this option, you must also specify how sales statistics are accumulated, and whether or not to allow editing of sales statistics.

**Period Type**
Select the length of the periods by which you will accumulate sales statistics.

**Note:** Weekly periods run from Sunday to Saturday. If you use weekly periods and your year does not start at the beginning of the week, the first and last periods in a year will be short ones.
O/E G/L Integration Detail Screen

To open this screen:

1. Open Order Entry > O/E Setup > G/L Integration.
2. On the Transactions tab, select a detail line, and then click Open.

Related tasks:
- "Setting Up Order Entry" (page 3)

Overview

Use the O/E G/L Integration Detail screen to specify the information to appear in the following fields in General Ledger transactions that are created from invoices, shipments, credit notes, and debit notes:

- Description (for the G/L transaction)
- Description (for details)
- Reference (for details)
- Comment (for details)

To specify this information, you add and arrange fields on the Segments currently used list, and select a field separator (such as a hyphen) that will appear between these fields.

Fields and Controls

Buttons

Close

Click Close to close the screen.

Exclude

Click Exclude to remove the selected field from the Segments currently used list. It will appear in the Choose segments from list list.

Include

Click Include to add the selected field from the Choose segments from list list to the Segments currently used list.
**Save**

Click **Save** to save changes you have made to the screen.

**Choose segments from list**

This list displays fields that you can add to the **Segments currently used** list.

Fields that you add will appear in the G/L transaction field for the selected transaction type, separated by the separator (such as a hyphen) that you selected.

**Example**

This field displays a preview of the G/L transaction field for the selected transaction type. It contains the fields that appear on the **Segments currently used** list, separated by the separator (such as a hyphen) that you selected.

**Example:** If customer number and customer name appear on the **Segments currently used** list, "Customer Number-Customer Name" appears in the **Example** field.

To change the information that appears in this field, you can add, remove, and arrange fields on the **Current Fields** list.

**G/L Transaction Field**

For the selected transaction type, select a G/L transaction field for which to specify G/L transaction field information.

**Segment Separator**

Select a separator (such as a hyphen) that will appear between multiple fields used to create the G/L transaction field for the selected transaction type.

**Example:** If customer number and customer name appear on the **Segments currently used** list, "Customer Number-Customer Name" appears in the **Example** field.

**Segments currently used**

This list displays fields that will appear in the G/L transaction field for the selected transaction type, separated by the separator (such as a hyphen) that you selected.
To add a field to this list, select the field on the **Choose segments from list** list, and then click **Include**.

**Transaction Type**
Select a transaction type (shipment, invoice, or credit/debit note) or detail type for which to specify G/L transaction field information.
O/E G/L Integration Screen

To open this screen:
Open Order Entry > O/E Setup > G/L Integration.

Secondary screens:
- "O/E G/L Integration Detail Screen" (page 324)

Related tasks:
- "Setting Up Order Entry" (page 3)

Overview

Use the G/L Integration screen to:

- Specify when to add General Ledger transactions to the G/L batch: during posting, during Day End Processing, or on request.

**Important!** The option you select here can prevent you from printing the O/E G/L Transactions report or consolidating Order Entry transactions, and can also have a significant impact on system performance during transaction processing. For more information, see "General Ledger Integration Options" (page 28).

- Specify whether to create a separate G/L batch each time you create the G/L batch (and optionally automatically post the batch) or add new transactions to an existing batch.

- Specify whether to consolidate the G/L batch when you post, or always enter full transaction details in the batch.

**Note:** Consolidation reduces the amount of information in the general ledger batch and results in a shorter list when you print the G/L Transactions Listing report, but also reduces information and prevents drilldown from General Ledger. For more information, see "General Ledger Integration Options" (page 28).

- Assign source codes to General Ledger transactions created by Order Entry and added to G/L batches. (New source codes are automatically added to G/L, but you will have to update G/L source journal profiles to include transactions on source journals.)
Setup Screens

- Select information to appear in the **Entry Description, Detail Description, Detail Reference**, and **Detail Comment** fields in G/L transactions created from invoices and shipments. (This information appears for transactions in the G/L Transactions report.)

- Look up the last Day End Number for which you have created General Ledger batches.

**Changing G/L Integration Settings**

You can change any of the settings on the **O/E G/L Integration** screen at any time. However, any changes you make will apply only to General Ledger transactions created after the change, and will not affect existing General Ledger batches.

**Important!** Before changing any settings on the **O/E G/L Integration** screen, make sure you understand the impact these settings have on processing within Order Entry. For more information, see "General Ledger Integration Options" (page 28).

**Appending General Ledger Transactions to a CSV File**

If you do not use Sage 300 ERP General Ledger, or if your Sage 300 ERP General Ledger system is at another location, Order Entry appends its general ledger transactions to a file called oegltran.csv, which can be imported by a Sage 300 ERP General Ledger at another site, or transferred to another general ledger that you use. The file is in Comma Separated Values (CSV) format, and is created in the same directory as your company database.

If you do not use Sage 300 ERP General Ledger in the same database as Order Entry, all general ledger transactions are placed in the same CSV file. Each time Order Entry creates transactions, a message asks whether you want to add transactions to the existing file or replace it.

**Fields and Controls**

**Buttons**

**Open**

On the Transactions tab, click **Open** to open the **O/E G/L Integration Detail** screen. You use this screen to specify the information that will appear in fields in General Ledger transactions that are created from invoices, shipments, credit notes, and debit notes.

For more information, see "O/E G/L Integration Detail Screen " (page 324).
Save
Click **Save** to save changes you have made to the screen.

**Integration tab**
On this tab, you select settings that control how and when batches of General Ledger transactions are created from Order Entry transactions.

**Consolidate G/L Batches**
Specify whether Order Entry consolidates transaction details for the same General Ledger account into a single detail, or whether it posts unconsolidated transaction details to General Ledger.

Consolidation reduces the amount of information in the general ledger batch and results in a shorter list when you print the G/L Transactions Listing report, but also reduces information and prevents drilldown from General Ledger.

For more information, see "General Ledger Integration Options" (page 28).

**Create G/L Transactions**
Specify when to create General Ledger transactions.

**Important!** The option you select here can prevent you from printing the O/E G/L Transactions report or consolidating Order Entry transactions, and can also have a significant impact on system performance during transaction processing.

- **During Posting.** Depending on when you create subledger transactions in Inventory Control, you can select this option to create General Ledger transactions during posting.

  **Warning!** This selection can have a significant impact on the speed of processing inventory transactions and transactions in Order Entry. If you want to speed up order processing, switch to creating transactions when you run Day End Processing.

- **During Day End Processing.** Depending on when you create subledger transactions in Inventory Control, you can select this option to create General Ledger transactions when you run Day End
Processing in Inventory Control.

**Note:** If you select this option, you cannot print the O/E G/L Transactions, and you cannot consolidate Order Entry transactions that are posted to General Ledger.

- **On Request Using Create Batch Icon.** Select this option if you want to create General Ledger transactions manually using the O/E Create Batch screen.

  If you prefer to create General Ledger transactions automatically each time you post Order Entry transactions or each time you run Day End processing in Inventory Control, select During Posting or During Day End Processing for the Create G/L Transactions option.

  **Important!** You must select this option if you want to print the O/E G/L Transactions Report, or if you want to consolidate transactions in Order Entry.

For more information, see "General Ledger Integration Options" (page 28).

**Create G/L Transactions By**

Specify whether to add new General Ledger transactions to an existing batch, to a new batch, or to a new batch that Order Entry posts automatically to General Ledger.

To have all transactions appended to a single General Ledger batch, select the **Adding to an Existing Batch** option. Order Entry must use the same database as Sage 300 ERP General Ledger.

**Note:** Remember to create and post all General Ledger batches for outstanding transactions before locking periods for General Ledger.

If you do not use Sage 300 ERP General Ledger, or if your Sage 300 ERP General Ledger system is at another location, Order Entry appends its general ledger transactions to a file called oegltran.csv, which can be imported by a Sage 300 ERP General Ledger at another site, or transferred to another general ledger that you use. The file is in Comma Separated Values (CSV) format, and is created in the same directory as your company database.

If you do not use Sage 300 ERP General Ledger in the same database as Order Entry, all general ledger transactions are placed in the same CSV
Appendix A: Order Entry Screen Guides

file. Each time Order Entry creates transactions, a message asks whether you want to add transactions to the existing file or replace it.

**G/L Transactions Generated Through Day End Number**
This field displays the last day end number for which General Ledger transactions have been created.

**G/L Source Codes Table**
In General Ledger, a source code comprises a source ledger code and a source type code. This table lists source ledger codes and source type codes for each type of transaction generated by Order Entry.

You can change the source type code for each type of transaction created by Order Entry, but you cannot change the source ledger code.

If you change a source type code, the new source code is automatically added to General Ledger, but you must update General Ledger source journal profiles to include transactions on source journals. For more information, see the General Ledger help.

**Source Ledger**
This column displays source ledger codes for all General Ledger transactions created by Order Entry. You cannot change these codes.

**Source Type**
This column displays source type codes for all General Ledger transactions created by Order Entry.

You can change the source type code for a transaction type. If you change it, the new source code is automatically added to General Ledger, but you must update General Ledger source journal profiles to include transactions on source journals. For more information, see General Ledger help.

**Transaction Type**
This column lists transaction types generated by Order Entry, such as invoices, adjustments, and consolidated G/L entries.

**Transactions tab**
On this tab, you can review the information that will appear in transaction description, detail reference, detail description, and detail comment fields in the General Ledger transactions created from Order Entry transactions.
To select and arrange the Order Entry information that will appear in these fields, and to specify a separator (such as a hyphen) that appears between this information, select a detail line and click the Open button to open the O/E G/L Integration Details screen.

For more information, see "O/E G/L Integration Detail Screen " (page 324) and "General Ledger Integration Options" (page 28).

**G/L Detail Comment**

This field displays the type of information that will appear with unconsolidated details in the Comment column on the O/E G/L Transactions report, on the G/L Journal Entry screen, and on other reports in General Ledger.

To select and arrange the Order Entry information that will appear in these fields, and to specify a separator (such as a hyphen) that appears between this information, select a detail line and click the Open button to open the O/E G/L Integration Details screen.

**G/L Detail Description**

This field displays the type of information that will appear with unconsolidated details in the Description column on the G/L Transactions report and in that field in the general ledger batch. (The Detail Description field is the description on each detail line, not the main description for the General Ledger transaction.)

To select and arrange the Order Entry information that will appear in these fields, and to specify a separator (such as a hyphen) that appears between this information, select a detail line and click the Open button to open the O/E G/L Integration Details screen.

**G/L Detail Reference**

This field displays the type of information that will appear with unconsolidated details in the Reference column on the G/L Transactions report and in that field in the general ledger batch.

To select and arrange the Order Entry information that will appear in these fields, and to specify a separator (such as a hyphen) that appears between this information, select a detail line and click the Open button to open the O/E G/L Integration Details screen.

**G/L Entry Description**

This field displays the type of information that will appear in the
Description field for a General Ledger transaction (not in the description for a detail line).

To select and arrange the Order Entry information that will appear in these fields, and to specify a separator (such as a hyphen) that appears between this information, select a detail line and click the Open button to open the O/E G/L Integration Details screen.
**O/E Templates Screen**

*To open this screen:*
Open **Order Entry > O/E Setup > Templates**.

**Related tasks:**
- "Creating Templates" (page 36)
- "Managing Templates" (page 37)
- "Setting Up Order Entry" (page 3)

**Overview**

Use the O/E Templates screen to speed up and simplify order entry by setting up templates that specify default settings for new orders and credit notes.

Order Entry templates are optional. They specify default customer and order information for new orders and new credit notes.

After adding or changing templates, print the O/E Templates report to check the new information and to update your printed records.

**Note:** You must use the **Order Type** field (on the Order tab) and the **Customer Type** list (on the Customer tab) to specify the order type and customer type for each template. All other information is optional.

**Customer Tab**

Use the Customer tab to specify the following information:
- Shipping method (ship-via code) for the template
- Customer type
- Default tax group
- Default price list and terms code
- Optional territory code

**Order Tab**

Use the Order tab to specify the following information:
• Order type for the template (Active, Future, Standing, or Quote). For more information, see "Order Types" (page 84).

• Optional FOB ("Free On Board") point.

• Location code.

• Other optional information, such as description, reference information, and comments.

**Specifying Tax Groups in Templates**

If you use multicurrency accounting, when you use a template to create an order or shipment for a customer that has not yet been added to Accounts Receivable, the tax group sets the currency and the reporting currency for the order or shipment.

**Templates Used for Job-Related Documents**

Project and Job Costing allows tax groups to be specified by project on an invoice. When Project and Job Costing creates an invoice, it uses each project's tax group to calculate tax. Therefore, you can enter details for contracts and projects that use different tax groups on the same document, provided Project and Job Costing handles the invoicing. (This is the case if you select **Project Invoicing** for a document.)

However, if you will produce the invoice in Order Entry, you must use separate orders for contracts and projects that use different tax groups. This is because the tax group specified for an Order Entry invoice applies to all the document details.

**Note:** If you create an order or shipment for a "non-existent" customer (a customer for which no record exists in Accounts Receivable) and select **Project Invoicing**, you will not be able to add order or shipment details unless the default template includes a tax group. (The tax group is not editable if you select **Project Invoicing**, and it will be blank unless it is specified in the template.)

**Fields and Controls**

**Template Code**

A template code is a unique code of up to 6 characters that identifies a template.

Use this field to:
- Create a new template code.
- Select an existing template code to view or edit template details.

In the description field to the right, enter a description of up to 60 characters to identify the template code.

**Customer tab**

**Customer Type**
Select a standard customer type (Base, A, B, C, D, or E).

Customer type specifies the discount level for a customer. "Base" indicates that the customer is not eligible for price discounts.

**Note:** Discount percentages are set up in Inventory Control Item Pricing. Customer types are assigned to customer records in Accounts Receivable.

**Price List**
Select an optional price list code. Price lists allow you to vary your basic item prices. For example, you can set up price lists that calculate sale prices, give volume discounts, or assign different regional prices for items.

**Note:** Price lists are set up in Inventory Control.

**Ship-Via Code**
Select an optional ship-via code.

**Note:** You use the O/E Ship-Via Codes screen to add codes and descriptions for the shipping methods you use in Order Entry.

**Tax Group**
Select an optional tax group.

A tax group defines the tax authorities to which the customer is subject. Tax groups must match the currency of the customer record.

The tax group you select will be used for an order or shipment only if you have not yet added the customer record. (The tax group specified in the
customer record will always override the tax group specified in the template.)

Tax groups and tax classes are defined in Tax Services. Customers are assigned to tax groups (and assigned a tax class for each authority in their tax group) in Accounts Receivable, and inventory items are assigned tax classes in Inventory Control.

For more information, see "About Taxes " (page 176).

**Terms**
Select optional payment terms.

*Note: Payment terms are set up in Accounts Receivable.*

** Territory**
If you use sales territory codes to identify your customers in Accounts Receivable, enter an optional territory code.

**Order tab**

**Comment**
Enter an optional message or announcement, up to 250 characters long, to appear on invoices, picking slips, order confirmations, and credit notes.

*Tip: To insert a line break, press Ctrl+Enter.*

**Description**
Enter an optional description of up to 60 characters for the type of transaction for which you will use the template.

*Note: You can edit the description when you are using the template to add an order, invoice, return, or credit note.*

**FOB Point**
Enter an optional FOB ("Free On Board") point. This is the location at which the customer begins paying freight charges on the order (if any). The order is shipped as far as the FOB point at no cost to the customer.
**Location**
Select an optional warehouse or other location from which items are usually shipped to fill orders.

**Note:** Location codes are set up in Inventory Control.

**On Hold**
Select this option if the template is typically used for orders that are on hold.

**Note:** If an order is on hold, you cannot create or print an invoice for the order, even if you have entered quantities as shipped.

**Order Type**
Select an optional order type for the template.
For more information, see "Order Types " (page 84).

**Reference**
Enter optional reference information of up to 60 characters for an order, invoice, or credit note.
O/E Miscellaneous Charges Screen

To open this screen:
Open Order Entry > O/E Setup > Miscellaneous Charges.

Secondary screens:
- "O/E Optional Fields Screen " (page 344)
- "O/E Optional Fields Settings Screen " (page 353)

Related tasks:
- "Creating Miscellaneous Charges " (page 49)
- "Managing Miscellaneous Charges " (page 51)
- "Setting Up Order Entry" (page 3)

Overview

Use the O/E Miscellaneous Charges screen to:
- Add records to identify the miscellaneous charges (such as service charges) used in your Order Entry system.
- Edit and delete existing miscellaneous charge records.

Multicurrency Ledgers

If you use multicurrency accounting, you must specify a currency code for each miscellaneous charge.

Note: If you want to apply the same charges to customers using different currencies, you must create a separate miscellaneous charge record for each currency. However, you can use the same miscellaneous charge code for each of the currencies.

For more information about creating and managing miscellaneous charges, see "Creating Miscellaneous Charges " (page 49) and "Managing Miscellaneous Charges " (page 51).

Integration with Project and Job Costing

For job-related orders, you can use miscellaneous charges for the following purposes:
To specify additional charges to customer orders for invoicing external charges such as freight (UPS or FedEx).

To record internal non-material transactions such as equipment, subcontractors, and labor.

To create miscellaneous charges for job-related orders, you must select the **Allow For Jobs** option on the O/E Miscellaneous Charges screen, and then specify an extended cost, expense account, and clearing account.

For more information, see "About Miscellaneous Charges" (page 47).

### Fields and Controls

#### Buttons

**Add**
Click **Add** to add a new miscellaneous charge record after you have entered details for the charge.

**Delete**
Click **Delete** to delete an existing miscellaneous charge record.

**Save**
Click **Save** to save changes you have made to the screen.

#### Allow for Jobs
Select this option if you use Project and Job Costing and this charge is used for contracts or projects in PJC.

After you select this option, additional fields appear that you can use to specify an extended cost, a miscellaneous charge expense account, and a miscellaneous charge clearing account.

#### Amount
Enter the amount of the charge. If you want to enter charge amounts manually when entering transactions, leave this field blank.

If this is a job-related miscellaneous charge, you use the **Default Billing Rate** list for the project in Project and Job Costing to specify whether this amount appears by default.

#### Currency
If you use multicurrency accounting, select the currency for the
miscellaneous charge record you are adding.

If you want to apply the same charges to customers using different currencies, you must create a separate miscellaneous charge record for each currency. You can use the same miscellaneous charge code for each of the currencies.

**Extended Cost**

Enter the cost amount for the miscellaneous charge.

This amount can also be used in Project and Job Costing to calculate labor and overhead. You use the **O/E Miscellaneous Charges** list for the project in Project and Job Costing to specify whether the amount you specify here appears by default.

**Misc. Charge Clearing**

Specify the general ledger clearing account to which the expense amounts of miscellaneous charges are posted when you ship goods.

- When you ship goods and run Day End Processing, Order Entry debits the miscellaneous charge clearing account and credits the miscellaneous charge expense account.

- When you post the invoice, Order Entry credits the clearing account and debits cost of goods sold.

**Misc. Charge Expense**

Specify the general ledger expense account to which the expense amounts of miscellaneous charges are posted when you ship goods.

- When you ship goods and run Day End Processing, Order Entry debits the miscellaneous charge clearing account and credits the expense account.

- When you post the invoice, Order Entry credits the clearing account and debits cost of goods sold.

**Misc. Charge Revenue**

Specify the general ledger revenue account to which amounts entered as miscellaneous charges are posted.

**Miscellaneous Charge Code**

A miscellaneous charge code is a unique code of up to 6 characters that identifies a miscellaneous charge, such as a service charge.

Use this field to:
• Enter a name for a new miscellaneous charge code

• Edit the name of a new miscellaneous charge code (if you have not saved the code yet)

In the description field to the right of the **Miscellaneous Charge Code** field, enter a description of up to 60 characters to identify the miscellaneous charge code.

**Note:** If you want to apply the same charges to customers using different currencies, you must create a separate miscellaneous charge record for each currency. However, you can use the same miscellaneous charge code for each of the currencies.

**Miscellaneous Charges**

Use the **Miscellaneous Charges** navigation buttons and Finder to select a miscellaneous charge record, or click New to create a new record.

• If you select an existing record, the miscellaneous charge code, description, and currency appear in the fields on this screen.

• If you create a new record, you must enter or select information in these fields before adding the record.

**Note:** If you want to apply the same charges to customers using different currencies, you must create a separate miscellaneous charge record for each currency. However, you can use the same miscellaneous charge code for each of the currencies.

**Optional Fields**

If the **Optional Fields** option is selected, you can click the Zoom button to review optional field entries for this screen.

For more information, see "O/E Optional Fields Screen " (page 344).

**Tax Authorities table**

**Authority**

Select each tax authority that levies taxes on the miscellaneous charge. To add a new authority, press the Insert key.

**Authority Description**

This field displays the description for the tax authority that levies taxes on
the miscellaneous charge.

**Class Description**
This field displays the description for the sales tax class, which determines the rate that applies to the miscellaneous charge.

**Sales Tax Class**
For each authority, select the sales tax class that determines the rate that applies to the miscellaneous charge.
O/E Optional Fields Screen

To open this screen:
1. Open Order Entry > O/E Setup > Miscellaneous Charges.
2. Beside the Optional Fields option, click the Zoom button.

Related tasks:
- "Creating Miscellaneous Charges " (page 49)
- "Managing Miscellaneous Charges " (page 51)

Overview

Use the O/E Optional Fields screen to set up and review optional field entries for miscellaneous charges.

Before you can add optional fields to miscellaneous charges, you must assign the optional fields to the O/E Miscellaneous Charges screen using the O/E Optional Fields screen.

To add optional item fields that were not set as automatically inserted, press the Insert key to add a new line to the grid, and then use the Finder to add the optional field.

Note: If an optional field is required, you cannot save the transaction unless the field has a default value, or until you fill in the field yourself.

Fields and Controls

Optional Field
Use the Finder to select the optional field codes you want to use.

You can define an unlimited number of optional fields, providing the optional fields are set up in Common Services for use in your system.

Optional Field Description
Displays the description for the selected optional field code.

Value
Enter or select the value that the program will display as the default for the optional field.
If the optional field you selected requires validation, you must select a value that is defined for the optional field in Common Services. However, if the optional field allows blanks, you can leave the default value field blank.

If the optional field does not use validation, you can do one of the following:

- Select a value that is defined for the optional field in Common Services.
- Leave the field blank.
- Enter a combination of alphanumeric or special characters and spaces. The entry must be consistent with the type of field (text, number, date, amount, and so on) and must not exceed the number of characters specified for the optional field. In a Yes/No field, you can enter only Yes or No.

When you specify a value that is defined in Common Services, the program displays the description for the value.

**Value Description**
Displays the description for the selected optional field value.

**Value Set**
Double-click the field in the Value Set column to specify whether or not the optional field has a default value.

This column has two purposes:

- You must set **Value Set** to "Yes" in order to set a default value for the optional field.
- The "Yes" flag provides information to the transaction-entry clerk, letting them know if the field contains default information.
O/E Ship-Via Codes Screen

To open this screen:
Open Order Entry > O/E Setup > Ship-Via Codes.

Related tasks:
- "Creating Ship-Via Codes " (page 56)
- "Managing Ship-Via Codes " (page 57)
- "Setting Up Order Entry" (page 3)

Overview

Use the O/E Ship-Via Codes screen to create and manage ship-via codes, which identify the shipping methods or carriers you use to deliver goods to customers (such as courier, air mail, and parcel post).

Specifying Ship-Via Codes in Order Entry Transactions

When creating an order, if you select a ship-via code you have set up, Order Entry displays the description for that ship-via code with the document information.

On the O/E Order Entry, Shipment Entry, and Invoice Entry screens, if you do not select a ship-via code, you can enter the shipping method in the Ship-Via description field on the Customer tab.

Ship-via records are printed on the O/E Ship-Via Codes report. You can edit ship-via records as needed.

Note:
- If you specify a default ship-via code for a customer (on the Invoicing tab of the A/R Customers screen), Order Entry displays that ship-via code by default when you enter a new document for that customer.
- If you specify a primary ship-to location for a customer (on the A/R Ship-To Locations screen), Order Entry displays that ship-to location by default when you enter a new document for that customer.

Fields and Controls

Ship-Via Code
A ship-via code is a unique code of up to 6 characters that identifies a shipping method or carrier.
Use this field to:

- Create a new ship-via code
- Select an existing ship-via code to view or edit details associated with it

**Contact tab**
On the Contact tab, enter information about the contact person, position, or department for the carrier.

**E-mail**
Enter an e-mail address for the contact person, position, or department.

**Fax**
Enter a fax number for the contact person, position, or department.

**Name**
Enter the name of a contact person, position, or department for the carrier.

**Telephone**
Enter a telephone number for the contact person, position, or department.

**Ship-Via tab**
On the Ship-Via tab, enter information about the carrier.

**Address**
Enter the carrier's street address.

**City**
Enter the name of the city for the carrier's address.

**Comment**
Enter an optional comment (this can be up to 80 characters in length).

**Country**
Enter the name of the country for the carrier's address.

**E-mail**
Enter an e-mail address for the carrier.
**Fax**
Enter a fax number for the carrier.

**Name**
Enter the name of the carrier (this can be up to 60 characters in length).

**Telephone**
Enter a telephone number for the carrier.

**State/Province**
Enter the name of the state or province for the carrier's address.

**Zip/Postal Code**
Enter the zip or postal code for the carrier's address.
**O/E Optional Fields Screen**

**To open this screen:**
Open Order Entry > O/E Setup > Optional Fields.

**Secondary screens:**
- "O/E Optional Fields Settings Screen " (page 353)

**Related tasks:**
- "Adding Optional Fields to Transaction Entry Screens" (page 60)
- "Setting Up Order Entry" (page 3)

**Overview**

If you use Sage Transaction Analysis and Optional Field Creator, you can use the O/E Optional Fields screen to assign optional fields to Order Entry transactions and screens.

Before you can add optional fields for Order Entry transactions, you must create them in Common Services. After you create them in Common Services, you use the O/E Optional Fields screen to assign them to Order Entry transactions and records.

- Optional fields that you add to *transactions* appear in the Optional Fields tab on transaction entry screens.
- Optional fields that you add to *transaction details* appear as columns in the Detail table on transaction entry screens.

**Sending Information to G/L Accounts and Subledgers**

Depending on the transaction type or transaction detail type you select, you may be able to select a detail line, and then click the Settings button to open the O/E Optional Fields Settings screen, which you use to select the G/L accounts and other subledgers to which Sage 300 ERP sends the information entered in an optional field.

**Note:** This button is not available for miscellaneous charges, orders, order details, or shipments.

For more information, see "O/E Optional Fields Settings Screen " (page 353).
Fields and Controls

Buttons

Settings
Click **Settings** to open the O/E Optional Fields Settings screen.

You use this screen to select the General Ledger accounts and other subledgers to which Sage 300 ERP sends the information entered in an optional field. For more information, see "O/E Optional Fields Settings Screen " (page 353).

**Note:** This button is not available for miscellaneous charges, orders, order details, or shipments.

Optional Fields For
Select the transaction type or transaction detail type for which you want to add optional fields.

- If you select a transaction type (such as **Invoices**), optional fields you add will appear in the Optional Fields tab for that transaction type.
- If you select a transaction detail type (such as **Invoice Details**), optional fields you add will appear as columns in the Detail table.

Table
Use the table to add, edit, and delete optional fields for the selected transaction type or transaction detail type.

Depending on the transaction type or transaction detail type you select, you may be able to select a detail line, and then click the **Settings** button to open the O/E Optional Fields Settings screen, which you use to select the G/L accounts and other subledgers to which Sage 300 ERP sends the information entered in an optional field. For more information, see "O/E Optional Fields Settings Screen " (page 353).

Auto Insert
Select "Yes" in this field for a detail line if you want Sage 300 ERP to display the optional field and its default value for the transaction or detail type you selected.
**Example:** If you define Transit Number as a optional field for invoices and then select **Auto Insert**, a new Transit Number field appears on the Optional Fields tab of the O/E Invoice Entry screen.

**Default Value**
Enter a default value for the optional field.

- If the optional field can be blank, you can leave the default value blank.
- If the optional field requires validation, you must select a value that is defined for the optional field in Common Services.

If the optional field does not use validation, you can do one of the following:
- Leave the field blank.
- Select a value that is defined for the optional field in Common Services.
- Enter a combination of alphanumerical or special characters and spaces.

The entry must be consistent with the type of field (text, number, date, amount, and so on) and must not exceed the number of characters specified for the optional field. In a Yes/No field, you can enter only Yes or No.

**Optional Field**
Select a optional field to add to the selected transaction or detail type. You can define an unlimited number of optional fields for each type, as long as the optional fields are set up in Common Services.

**Note:**
If you want to retain optional field information from Order Entry transactions when you create batches for General Ledger, you must use the same optional fields for transaction details in Order Entry as you use for accounts in General Ledger.

Similarly, if you want to pass invoice optional field information to Accounts Receivable, you must use the same fields for O/E invoices and for A/R invoices.
**Optional Field Description**
This field displays the description for the selected optional field.

**Required**
Select this option to make this optional field required on all records or transactions where it is used.

*Note:* When you select **Required**, **Auto Insert** is automatically selected as well. (Required fields must be inserted automatically in new records or transactions.)

**Value Description**
This field displays the description for the default value you selected.

**Value Set**
Select this option if the optional field has a default value. This enables you to set the default value, and also indicates to the transaction entry clerk that the field contains default information.
**O/E Optional Fields Settings Screen**

To open this screen:

1. Open **Order Entry > O/E Setup > Optional Fields**.
2. On the **Optional Fields For** list, select a transaction type.
3. Select a detail line, and then click the **Settings** button.

**Note:** This button is not available for miscellaneous charges, orders, order details, or shipments.

**Related tasks:**
- "Adding Optional Fields to Transaction Entry Screens" (page 60)

**Overview**

Use the O/E Optional Fields Settings screen to select the G/L accounts and other subledgers to which Sage 300 ERP sends the information entered in a optional field.

You can select these settings for the following transaction types and items/charges:

- Credit notes (and credit note details)
- Debit notes (and debit note details)
- Invoices (and invoice details)
- Shipment details

You cannot specify these settings for the following transaction types and items/charges:

- Miscellaneous charges
- Orders (and order details)
- Shipments

**Fields and Controls**

**Accounts Receivable**

**A/R Invoices Optional Fields**

Passes information entered in a optional field to invoices in Accounts
Setup Screens

Accounts Receivable

Available if you selected Invoices or Credit/Debit Notes.

Accounts Receivable Detail G/L Accounts

Damaged Goods
Passes information entered in a optional field to the Damaged Goods account in General Ledger.

Available if you selected Credit/Debit Note Details.

Miscellaneous Charges
Passes information entered in a optional field to the Miscellaneous Charges account in General Ledger.

Available if you selected Invoice Details or Credit/Debit Note Details.

Returns
Passes information entered in a optional field to the Returns account in General Ledger.

Available if you selected Credit/Debit Note Details.

Sales/Shipment Clearing/COGS
Passes information entered in a optional field to the Sales, Shipment Clearing, and Cost of Goods Sold accounts in General Ledger.

Available if you selected Invoice Details or Credit/Debit Note Details.

G/L Accounts

Cost Variance
Passes information entered in a optional field to the Cost Variance account in General Ledger.

Available if you selected Invoice Details, Shipment Details, or Credit/Debit Note Details.

Cr./Db. Note/Misc. Charge Clearing
Passes information entered in a optional field to the Credit/Debit Note and Miscellaneous Charge Clearing accounts in General Ledger.
Available if you selected Invoice Details, Shipment Details, or Credit/Debit Note Details.

**Inventory Control/Misc. Charge Cost**
Passes information entered in a optional field to the Inventory Control and Miscellaneous Cost accounts in General Ledger.

Available if you selected Credit/Debit Note Details.

**Labor**
Passes information entered in a optional field to the Labor account in General Ledger.

Available if you selected Shipment Details.

**Non-stock Clearing**
Passes information entered in a optional field to the Non-stock Clearing account in General Ledger.

Available if you selected Shipment Details, Invoice Details, or Credit/Debit Note Details.

**Overhead**
Passes information entered in a optional field to the Overhead account in General Ledger.

Available if you selected Shipment Details.

**Sales**
Passes information entered in a optional field to the Sales account in General Ledger.

Available if you selected Credit/Debit Note Details.

**Shipment/Misc. Charge Clearing**
Passes information entered in a optional field to the Shipment Clearing and Miscellaneous Charge Clearing accounts in General Ledger.

Available if you selected Shipment Details or Invoice Details.

**Project and Job Costing**

**External Cost Transactions**
Passes information entered in a optional field to Costs in Project and Job
Costing.

Available if you selected Shipment Details.
O/E E-mail Messages Screen

To open this screen:
Open Order Entry > O/E Setup > E-mail Messages.

Related tasks:
- "Creating E-mail Messages " (page 43)
- "Setting Up Order Entry" (page 3)

Overview
You can create e-mail messages to send with order confirmations, quotes, invoices, and credit notes.

Each message is identified with a unique message ID of up to 16 characters. You use this message ID to select the message when you select Customer as the delivery method on an Order Entry customer form (an order confirmation, quote, invoice, credit note, or debit note).

Tip: You can add variables to the subject line and body of your e-mail message, which are then replaced with specific information when you send the e-mail message. For more information, see "E-mail Message Variables " (page 44).

Fields and Controls

Description
Enter a description of up to 60 characters for the e-mail message.

E-mail Subject
Enter a subject line for the e-mail message.

You can use variables to insert specific information in the subject line. For more information, see "E-mail Message Variables " (page 44).

Inactive
Select this field only when you want to make this message unavailable for use.

Last Maintained
This read-only field displays the system date on which the record was last
modified.

**Message ID**

A message ID is a unique code of up to 16 characters that identifies an e-mail message. You select messages using this message ID when you send order confirmations, quotes, invoices, or credit notes by e-mail.

Use this field to create a new message ID, or to select an existing message ID so you can view or edit details.

**Message Type**

Select the type of document for which you are creating the e-mail message.
Statistics and Inquiries Screens

Use Order Entry Statistics and Inquiries screens to look up information about customers and transactions.

O/E Current Orders Inquiry Screen

To open this screen:
Open Order Entry > O/E Statistics and Inquiries > Current Orders Inquiry.

Related tasks:
- "Looking Up Posted Documents" (page 188)

Overview

Use the O/E Current Orders Inquiry screen to view posted sales orders for a customer.

You can view all posted orders for a customer, or you specify criteria to filter orders by order number, order date, and/or expected ship date. You can view all order types and statuses, or select an order type or order status.

Tip: To view an order in the O/E Order Entry screen, double-click a detail line in the table, or select the detail line and click the Details button.

Fields and Controls

Buttons

Clear
Click Clear to restore the default filter criteria for this screen.

Close
Click Close to close the screen.

Details
Click the Details button to view the selected order in the O/E Order Entry screen.
Go

Click the Go button to view documents that match the criteria you specified.

Customer Number
Enter the number of the customer for which you want to view orders.

From/To Expected Ship Date
Specify a range of expected ship dates, or accept the default entries to view all orders regardless of expected ship date.

From/To Order Date
Specify a range of order dates, or accept the default entries to view all orders regardless of order date.

From/To Order Number
Specify a range of order numbers, or accept the default entries to view all orders regardless of order number.

Order Type
Select the type of orders to include. You can view all orders, or select active orders, future orders, standing orders, or quotes.

Status
Select order statuses to include.

Current Orders Inquiry table
The table displays all posted orders that meet the criteria you specify.

Tip: You can click the link that appears in the Order Number column to view the order in the O/E Order Entry screen.

Description
This field displays the shipment description entered on the order.

Exp. Ship Date
This field displays the expected ship date for the order.

FOB Point
The Free On Board (FOB) point is the location at which the customer
begins paying freight charges on the order (if any). The order is shipped as far as the FOB point at no cost to the customer.

**Location**
This field displays the code for the location from which goods will be shipped, which is specified on the order.

**On Hold**
This field indicates whether the order is currently on hold.

**Order Date**
This field displays the order date specified on the order.

**Order Number**
This field displays the number assigned to the order when it was posted, or the order number that was entered for it.

**Price List**
This field displays the price list specified for the order.

**Note:** Individual order detail lines may use different price lists.

**PO Number**
This field displays the purchase order number that was entered for the order.

**Reference**
This field displays information entered in the Reference field for the order.

**Ship Via**
If a ship-via method was specified for the order, this field displays the ship-via code.

**Ship-To Location**
This field displays the ship-to location specified for the order.

**Status**
This field displays the status of the order.
**Tax Group**
This field displays the tax group for the customer.

**Terms**
This field displays the terms code specified for the order.

**Territory**
This field displays the territory code specified for the order.

**Type**
This field displays the order type (active, future, standing, or quote).
**O/E Pending Shipments Inquiry Screen**

**To open this screen:**
Open Order Entry > O/E Statistics and Inquiries > Pending Shipments Inquiry.

**Secondary screens:**
- "O/E Pending Shipments Inquiry Details Screen " (page 366)
- "O/E Pending Shipments Inquiry P/O Details Screen " (page 367)

**Related tasks:**
- "Invoicing Shipments " (page 116)
- "Shipping Orders and Items " (page 120)

**Overview**
Use the O/E Pending Shipments Inquiry screen to review orders that you expect to ship, and to determine whether sufficient stock is available for the shipments.

You can select pending shipments you want to view by expected ship date, customer number, item number, and/or location. You can also specify whether inquiry results include all order types or a specific order type.

---

**Note:** Results for the inquiry do not include orders that are on hold.

---

**Viewing Order Details**
To view details for an order, select the detail line for the order, and then click the Details button to open the O/E Pending Shipments Inquiry Details screen. For more information, see "O/E Pending Shipments Inquiry Details Screen " (page 366).

**Viewing Purchase Order Details**
On the O/E Pending Shipments Inquiry Details screen, "Yes" appears in the On PO field for items on purchase order. If an item is on purchase order, you can double-click the detail line or click the Drilldown button in the On PO column header to open the O/E Pending Shipments Inquiry P/O Details screen and view purchase orders for the item. For more information, see "O/E Pending Shipments Inquiry P/O Details Screen " (page 367).
Fields and Controls

Buttons

Clear
Click **Clear** to restore the default filter criteria for this screen.

Close
Click **Close** to close the screen.

Details
Click **Details** to open the O/E Pending Shipments Inquiry Details screen, which displays details for the selected order. For more information, see "O/E Pending Shipments Inquiry Details Screen" (page 366).

Go
Click the **Go** button to view documents that match the criteria you specified.

From/To Customer Number
Specify a range of customer numbers, or accept the default entries if you wish to view orders for all customers.

From/To Expected Shipment Date
Specify a range of expected shipment dates, or accept the default entries if you wish to view all orders regardless of their expected shipment dates.

From/To Item Number
Specify a range of item numbers, or accept the default entries if you wish to view orders for all items.

From/To Location
Specify a range of inventory locations, or accept the default entries if you wish to view all locations.

Include Order Type
Select the type of orders you want to view. You can select all, active, future, or standing.

Pending Shipments Inquiry table
The table displays information about for orders with pending shipments, such
as order number, description, expected ship date, and location.

To view details for an order, select the detail line for the order, and then click the Details button to open the O/E Pending Shipments Inquiry Details screen. For more information, see "O/E Pending Shipments Inquiry Details Screen" (page 366).
O/E Pending Shipments Inquiry Details Screen

To open this screen:

1. Open **Order Entry > O/E Statistics and Inquiries > Pending Shipments Inquiry**.
2. Specify a range of orders to view, and then click the Go button.
3. Select a detail line, and then click the **Details** button.

Secondary screens:

- "O/E Pending Shipments Inquiry P/O Details Screen" (page 367)

Overview

The O/E Pending Shipments Inquiry Details screen displays information about order details, such as location; expected ship date; and quantities ordered, committed, and available.

If an item is on purchase order, you can double-click the detail line or click the Drilldown button in the **On PO** column header to open the O/E Pending Shipments Inquiry P/O Details screen and view purchase orders for the item. For more information, see "O/E Pending Shipments Inquiry P/O Details Screen" (page 367).

Fields and Controls

**Customer Number**

This field displays the customer number and name associated with the order.

**Order Number**

This field displays the order number associated with the order.

**Details table**

The table displays information about order details, such as location; expected ship date; and quantities ordered, committed, and available.

If an item is on purchase order, you can double-click the detail line or click the Drilldown button in the **On PO** column header to open the O/E Pending Shipments Inquiry P/O Details screen and view purchase orders for the item. For more information, see "O/E Pending Shipments Inquiry P/O Details Screen" (page 367).
**O/E Pending Shipments Inquiry P/O Details Screen**

**To open this screen:**

1. Open **Order Entry > O/E Statistics and Inquiries > Pending Shipments Inquiry**.
2. Specify a range of orders to view, and then click the Go button.
3. Select a detail line, and then click the **Details** button.
4. If an item is on purchase order, you can double-click the detail line or click the Drilldown button in the **On PO** column header to open this screen and view purchase orders for the item.

**Overview**

The O/E P/O Details screen displays information about purchase orders for an item, such as quantity ordered, expected arrival date, and vendor information.

**Fields and Controls**

**Item Number**

This field displays the item number and description for the item with the purchase order.

**P/O Details table**

The table displays information about purchase orders for an item, such as quantity ordered, expected arrival date, and vendor information.
O/E Sales History Screen

To open this screen:
Open Order Entry > O/E Statistics and Inquiries > Sales History.

Secondary screens:
- "O/E Sales History Detail Screen " (page 374)
- "O/E Serial/Lot Numbers Screen " (page 378)
- "O/E Kitting Item Components Screen " (page 372)

Related tasks:
- "Looking Up Sales History for Items or Customers " (page 190)

Overview

If you keep sales history for Order Entry, you can use the O/E Sales History screen to:

- Review all sales and returns of items for the years and periods for which you keep history.

  Note: You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

- Open the O/E Sales History Detail screen, where you can drill down to source documents and view additional information, including serial and lot numbers and kitting item components where applicable.

- Print the O/E Sales History report for a customer or item.

To print sales history for a customer or item from this screen, click File > Print.

Tip: On transaction entry screens, you can click the History button to view sales history for a selected item or customer.

Fields and Controls

Buttons

Clear
Click Clear to restore the default filter criteria for this screen.
Close
Click Close to close the screen.

Details
Click Details to open the O/E Sales History Detail screen, which displays additional information about the selected customer or item. For more information, see "O/E Sales History Detail Screen " (page 374).

Go ➤
Click the Go ➤ button to view sales history for the item or customer in the range of years and periods that you specify.

Currency
If you use multicurrency accounting, specify whether to view sales history in your company's functional currency or in customer currency.

From Year/Period to Year/Period
Specify a range of years and periods for which to view sales history, and select a customer number or item number.

Note: You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

Select By
Specify whether to view sales history by customer number or by item number.

Sales History table
The table displays information about sales history for the item or customer you selected.

To view additional information about the selected customer or item, click the Details to open the O/E Sales History Detail screen. For more information, see "O/E Sales History Detail Screen " (page 374)

Cost of Sales
Displays the original item purchase cost.
**Note:**
- You need Cost Inquiry authorization for Inventory Control to view this field.
- If you use multicurrency accounting, this amount appears in the currency you select on the **Currency** list (functional or customer).

**Currency**
If you use multicurrency accounting and are viewing sales history for an item, this field displays the currency in which sales history amounts are shown.

**Customer Name**
If you are viewing sales history for an item, this field displays the names of customers who have purchased the item.

**Customer Number**
If you are viewing sales history for an item, this field displays the customer numbers of customers who have purchased the item.

**Item Description**
If you are viewing sales history for a customer, this field displays a description of the item purchased by the customer.

**Item Number**
If you are viewing sales history for a customer, this field displays item numbers for items purchased by the customer.

**Margin Percent**
Displays the profit margin on sales of the item for the selected the year and period.

**Period**
Displays the period in which customers purchased items from your company.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.
Appendix A: Order Entry Screen Guides

**Quantity Sold**
Displays the quantity sold in each transaction.

**Return Amount**
Displays the total amount (excluding taxes and miscellaneous charges) of returns posted for the customer or item in the specified range of years and periods.

**Note:** If you use multicurrency accounting, this amount appears in the currency you select on the **Currency** list (functional or customer).

**Returns Count**
Displays the total number of returns posted for the customer or item in the specified range of years and periods.

**Sales Amount**
Displays the total amount (excluding taxes and miscellaneous charges) of invoices posted for the customer or item in the specified range of years and periods.

**Note:** If you use multicurrency accounting, this amount appears in the currency you select on the **Currency** list (functional or customer).

**Sales Count**
Displays the total number of invoices posted for the customer or item in the specified range of years and periods.

**Year**
Displays the year in which customers purchased items from your company.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.
O/E Kitting Item Components Screen

To open this screen:

1. Open Order Entry > O/E Statistics and Inquiries > Sales History.
2. Specify criteria, and then click the Go button to view results.
3. In the table, click a detail line to select it, and then click the Details button to open the O/E Sales History Detail screen.
4. Select a detail line for a kitting item, and then click Serial/Lot Numbers.

Secondary screens:
- "O/E Serial/Lot Numbers Screen " (page 378)

Related tasks:
- "Looking Up Sales History for Items or Customers " (page 190)

Overview

Use the O/E Kitting Item Components screen to view the component items that constitute a kitting item.

For each component item, you can view the following information:
- Item number and description.
- The quantity of the component item included in the kit.
- The unit of measure (such as DOZEN, BOX, or EACH).

If an item is serialized or lotted, you can click the Details button to view serial and lot numbers allocated to the item.

Fields and Controls

Customer Number
- Displays the customer number and name associated with the transaction that includes the selected kitting item.

Document Number
- Displays the document number of the transaction that includes the selected kitting item.
Item Number
Displays the item number and description of the selected kitting item.

Transaction Type
Displays the type of the transaction that includes the selected kitting item.

Kitting Item Components table
This table displays information about component items for the selected kitting item.

If an item is serialized or lotted, you can click the Details button to view serial and lot numbers allocated to the item.

Component Item Number
Displays the item number of the component item.

Description
Displays the description of the component item.

Quantity
Displays the quantity of the component item included in the kit.

UOM
Displays the unit of measure (such as DOZEN, BOX, or EACH) for the component item.
**O/E Sales History Detail Screen**

**To open this screen:**

1. Open **Order Entry > O/E Statistics and Inquiries > Sales History**.
2. Specify criteria, and then click the Go button to view results.
3. In the table, click a detail line to select it, and then click the Details button.

**Secondary screens:**

- "O/E Serial/Lot Numbers Screen " (page 378)
- "O/E Kitting Item Components Screen " (page 372)

**Related tasks:**

- "Looking Up Sales History for Items or Customers " (page 190)
- "Looking Up Sales Statistics " (page 187)

**Overview**

Use the O/E Sales History Detail screen to:

- View a list of documents posted in a range of fiscal years and periods for an item or customer.

- Drill down to view documents in the original transaction entry screen.

- For documents that include serialized or lotted items, view serial numbers or lot numbers allocated in the document.

- For documents that include kitting items, view kitting item components.

After selecting a detail line in the table, you can click the Document button to view the document in the original transaction entry screen.

For serialized and lotted items, you can also click the **Serial/Lot Numbers** button to view information about serial and lot numbers and kitting item components

**Fields and Controls**

**Customer Number**

Displays the number and name of the customer that purchased the selected item.
Appendix A: Order Entry Screen Guides

**Item Number**
Displays the number and description of the item purchased by the selected customer.

**Sales History Detail table**
The table displays information about sales history for the item or customer you selected.

After selecting a detail line in the table, you can click the **Document** button to view the document in the original transaction entry screen.

For serialized and lotted items, you can also click **the Serial/Lot Numbers** button to view information about serial and lot numbers and kitting item components

**Category**
Displays the code for the item category (which defines the General Ledger accounts for sales, returns, cost of goods sold, cost variance, and damaged goods).

**Cost of Sales**
Displays the original item purchase cost.

**Note:**
- You need Cost Inquiry authorization for Inventory Control to view this field.
- If you use multicurrency accounting, this amount appears in the currency you select on the **Currency** list (functional or customer).

**Day End Number**
Displays the sequence number assigned to the transaction during Day End Processing.

**Entry Number**
Displays the transaction entry number assigned during Day End processing.

**Location**
Displays the location from which the item was shipped.
**Order Date**  
Displays the date the order was processed.

**Order Number**  
Displays the number assigned to the order.

**Period**  
When you view sales history for a customer number, this field displays the period in which the customer purchased items from your company.

When you view sales history for an item number, this field displays the period in which customers purchased the item.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

**Quantity Sold**  
Displays the quantity of items sold in the transaction.

**Return Amount**  
Displays the total amount (excluding taxes and miscellaneous charges) of returns posted for the customer or item in the specified range of years and periods.

**Note:** If you use multicurrency accounting, this amount appears in the currency you select on the Currency list (functional or customer).

**Sales Amount**  
Displays the total amount (excluding taxes and miscellaneous charges) of invoices posted for the customer or item in the specified range of years and periods.

**Note:** If you use multicurrency accounting, this amount appears in the currency you select on the Currency list (functional or customer).

**Salesperson**  
Displays the primary salesperson assigned to the document.

**Ship Date**  
Displays the ship date specified during order entry.
**Territory**
Displays the territory code assigned to the customer.

**Note:** You use the A/R Customers screen to assign a territory to a customer, but you can specify a different territory when entering a transaction.

**Transaction Date**
Displays the date the transaction was processed.

**Transaction Number**
Displays the number assigned to the transaction.

You can click the linked transaction number to view the transaction in the associated entry screen (for example, to view an invoice in the O/E Invoice Entry screen).

**Transaction Type**
Displays the type of transaction (invoice, credit note, or debit note).

**Year**
When you view sales history for a customer number, this field displays the calendar year or fiscal year in which the customer purchased items from your company.

When you view sales history for an item number, this field displays the calendar year or fiscal year in which customers purchased the item.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.
O/E Serial/Lot Numbers Screen

To open this screen:
1. Open Order Entry > O/E Statistics and Inquiries > Sales History.
2. Specify criteria, and then click the Go button to view results.
3. In the table, click a detail line to select it, and then click the Details button to open the O/E Sales History Detail screen.
4. Select a detail line for a serialized or lotted item, and then click Serial/Lot Numbers.

Related tasks:
- "Allocating Serial Numbers or Lot Numbers to an Order " (page 157)
- "Allocating Serial Numbers or Lot Numbers to a Shipment " (page 161)
- "Allocating Serial Numbers or Lot Numbers to an Invoice " (page 164)
- "Allocating Serial Numbers or Lot Numbers to a Credit Note " (page 167)
- "Allocating Serial Numbers or Lot Numbers to a Debit Note " (page 171)
- "Looking Up Sales History for Items or Customers " (page 190)

Overview

Use the O/E Serial/Lot Numbers screen to view serial and lot numbers allocated to a serialized or lotted item.

Serial Numbers

Serial numbers are used to track individual items. Each serial number must be unique to one specific item.

Example: An electronics retailer can use serial numbers to record sales of items that have warranties.

Lot Numbers

Lot numbers are used to track groups of items. Unlike serial numbers, a lot number can be allocated to multiple items.
Example: A food distribution company can use lot numbers to record purchases and sales of unique batches of product.

For more information, see "About Serialized Inventory and Lot Tracking " (page 154).

**Fields and Controls**

**Customer Number**
Displays the number and name of the customer associated with the transaction and item for which the serial and lot numbers were allocated.

**Document Number**
Displays the document number of the transaction for which the serial and lot numbers were allocated.

**Item Number**
Displays the number and description of the item for which the serial and lot numbers were allocated.

**Transaction Type**
Displays the type of transaction for which the serial and lot numbers were allocated.

**Lot Numbers tab**
Click this tab to view information about lot numbers allocated for the selected item and document.

**Lot Number**
Displays lot numbers allocated for the selected item and document.

**Quantity**
Displays the quantity of the selected item included in the lot.

**Unit of Measure**
Displays the unit of measure (such as DOZEN, BOX, or EACH) for an item.

The unit of measure determines how many lot numbers are required, allocated, shipped, and remaining.
Example: If the detail line specifies 2 as the order quantity, but the unit of measure is DOZEN and you have lots with available quantities of 6 EACH, when you allocate lot numbers on the O/E Serial/Lot Numbers Allocation screen, 0.5 dozen is allocated for 4 lots.

Serial Numbers tab
Click this tab to view information about serial numbers allocated for the selected item and document.

Serial Number
Displays serial numbers allocated for the selected item and document.
O/E Sales Statistics Screen

To open this screen:
Open Order Entry > O/E Statistics and Inquiries > Sales Statistics.

Related tasks:
- "Adding Sales Statistics " (page 187)
- "Looking Up Sales Statistics " (page 187)
- "Setting Up Order Entry" (page 3)

Overview

Use the O/E Sales Statistics screen to:

- Enter or edit statistics for sales, invoices, credit notes, and debit notes from your previous order entry system while setting up Sage 300 ERP Order Entry (if you selected the Allow Edit of Statistics option on the O/E Options screen).
- Look up sales statistics for invoices, debit notes, and credit notes posted in Order Entry during a year and period you specify (if you selected the Keep Sales Statistics option on the O/E Options screen).
- Print the O/E Sales Statistics report.

If you selected the Keep Sales Statistics option on the O/E Options screen, Order Entry keeps sales statistics for posted orders, invoices, credit notes, and debit notes. You can review statistics for all years and periods for which you keep this information by printing the O/E Sales Statistics report.

Fields and Controls

Buttons

Add
Click Add to add new sales statistics for the selected year, period, and currency.

Note: You can add and edit sales statistics only if you selected the Allow Edit of Statistics option on the O/E Options screen.
Close
Click Close to close the screen.

Delete
Click Delete to delete all sales statistics for the selected year, period, and currency.

Save
Click Save to save changes you have made to sales statistics for the selected year, period, and currency.

**Note:** You can add and edit sales statistics only if you selected the Allow Edit of Statistics option on the O/E Options screen.

Currency
If you use multicurrency accounting, select the currency in which you want to add or view statistics. You can add statistics in the customer’s currency or in your company's functional currency.

Period
Select the period for which you want to add or view statistics.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

Year/Fiscal Year
Select the year for which you want to add or view statistics.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

**Invoices, Credit Notes, and Debit Notes table**
This table displays statistics for invoices, credit notes, and debit notes for the selected year and period.

If you use multicurrency accounting, statistics appear in the customer's currency and your company's functional currency.
Appendix A: Order Entry Screen Guides

**Average**
Displays the average amount of invoices, credit notes, and debit notes posted during the selected year and period.

**Customer**
Displays the customer number of the customer to whose account the document in the preceding row (that is, Largest or Smallest) was posted.

**Largest**
Displays the amount of the largest invoice, credit note, and debit note posted during the selected year and period.

**Note:** The customer number of the customer to whose account the document was posted appears in the Customer row below this field.

**Number**
Displays the number of invoices, credit notes, and debit notes posted during the selected year and period.

**Smallest**
Displays the amount of the smallest invoice, credit note, and debit note posted during the selected year and period.

**Note:** The customer number of the customer to whose account the document was posted appears in the Customer row below this field.

**Sales table**
This table displays sales statistics for the selected year and period.

If you use multicurrency accounting, statistics appear in the customer’s currency and your company’s functional currency.

**Average Sales Lost**
Displays the average amount of lost sales for the year and period.

Sales amounts are lost when you make either of the following changes (whether or not quantities were shipped):
- Reduce amounts in the Quantity Backordered field on an order without reducing the amount ordered.

- Cancel an order that had quantities entered in the Quantity Backordered field.

When you enter or edit statistics, Order Entry calculates average sales lost from the figures you enter.

When an order is complete, information about lost sales is updated during Day End Processing and reported as lost sales on the O/E Sales Statistics report.

**Cost of Sales**
Displays the total cost of goods sold on invoices less the total cost of goods sold on credit notes.

*Note:* To view this field, you need Cost Inquiry authorization in Inventory Control.

**Margin Percent**
Displays the calculated profit (margin) percentage for the year and period. When you enter or edit statistics, Order Entry calculates this percentage from the figures you enter.

**Net Invoice Amount**
Displays the total invoice amounts (including taxes) for the year and period.

**Net Quantity Sold**
Displays the number of units of items shipped on invoices less the number of units returned on credit notes.

**Net Sales Amount**
Displays the total sales amounts on invoices (excluding taxes and miscellaneous charges) less the total sales amounts on credit notes.

**Number of Orders**
Displays the number of sales orders posted during the selected year and period.
**Total Sales Lost**
Displays the total of all quantities ordered that will not be shipped, multiplied by their unit prices.
**O/E Salesperson Inquiry Screen**

**To open this screen:**
Open **Order Entry > O/E Statistics and Inquiries > Salesperson Inquiry**.

**Related tasks:**
- "Looking Up Sales History for Items or Customers " (page 190)
- "Adding Sales Statistics " (page 187)
- "Looking Up Posted Documents" (page 188)

**Overview**

Use the O/E Salesperson Inquiry screen to review and print sales information (invoices and credit notes) according to salesperson and customer.

---

**Tip:** To print a copy of a document that appears in the results on this screen, select the detail line for the document and click the **Details** button.

**Note:** Sales information is available only if you select **Keep Sales History** on the O/E Options screen.

---

**Fields and Controls**

**Buttons**

**Clear**
Click **Clear** to restore the default filter criteria for this screen.

**Close**
Click **Close** to close the screen.

**Details**
To print a copy of a document that appears in the results on this screen, select the detail line for the document and click the **Details** button.

**Go ➤**
Click the Go ➤ button to view documents that match the criteria you specified.
**Customer Number**
Enter the number of the customer for which you want to review sales data. The customer name appears in the description field to the right. If you use multicurrency accounting, the currency in which sales history amounts appear is also displayed.

**Document Type**
Select the type of documents you want to review: invoices, credit notes, or debit notes.

**From Year/Period to Year/Period**
Specify the range of years and periods for which you want to review sales data. Only documents processed within the range you specify will appear in results.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

**Primary Salesperson**
Enter the salesperson code of the primary salesperson for whom you want to review sales data.

**Salesperson Inquiry table**
Documents that match the criteria you specified appear in the table.

**Doc. Date**
Displays the date of the document. By default, this is the date that the person who entered it signed in to Sage 300 ERP and entered the transaction.

**Doc. Number**
Displays the number assigned to track the document.

**Document Type**
Displays the type of document (invoice, credit note, or debit note).

**Functional Doc. Amount**
Displays the total document amount in your company’s functional currency.
**Order Date**
Displays the date the order was entered.

**Order Number**
Displays the number that was assigned to the order when it was posted.

**Period**
Displays the period in which the document was processed.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.

**PO Number**
Displays the purchase order number that was assigned to the original invoice, if applicable.

**Shipment Date**
Displays the actual shipment date specified during order entry.

**Source Doc. Amount**
Displays the total document amount in the vendor’s (source) currency.

**Year**
Displays the calendar year or fiscal year in which the document was processed.

**Note:** You specify on the Processing tab of the O/E Options screen whether to accumulate sales history and statistics by calendar year or fiscal year, and the period type to use.
Transaction Screens

Use Order Entry transaction entry screens to process quotes, orders, shipments, invoices, credit notes, and debit notes.

O/E Order Entry Screen

To open this screen:
Open Order Entry > O/E Transactions > Order Entry.

Secondary screens:
- "O/E Bank Rate Screen " (page 449)
- "O/E Confirmation Screen " (page 453)
- "O/E Create Order from Quotes Screen " (page 455)
- "O/E Customer Bill-To Address Screen " (page 456)
- "O/E Ship-To Address Screen " (page 458)
- "O/E Items/Taxes Screen " (page 460)
- "O/E Kitting Components Screen " (page 481)
- "O/E BOM Components Screen " (page 451)
- "O/E Pre-authorization Screen " (page 485)
- "O/E Prepayments Screen" (page 489)
- "O/E Pre-Transaction Credit Check Screen" (page 496)
- "O/E Price Approval Screen" (page 499)
- "O/E Project and Job Costing Apply Details Screen " (page 445)
- "O/E Sales History Screen " (page 368)
- "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501)
- "O/E Shipments/Invoices Screen" (page 500)

Related tasks:
- "Canceling Backordered Quantities on an Order " (page 103)
Use the O/E Order Entry screen to enter, edit, and post transactions, print documents, enter prepayments, and perform other key Order Entry tasks.

On the O/E Order Entry screen, you can:

- Enter, edit, and post quotes and orders, including active, standing, and future orders.
- Enter prepayments for orders.
- Enter quantities shipped, and create an invoice for shipped quantities.
- Print quotes, order confirmations, receipts (for prepayments), and invoices (if created for shipped quantities) immediately after posting.
- If you use Sage 300 ERP Serialized Inventory and Lot Tracking, assign serial numbers and/or lot numbers. For more information, see "About Serialized Inventory and Lot Tracking" (page 154).
- If you use Payment Processing, pre-authorize credit card payments, and process credit card prepayments.
- Copy an order into the O/E Copy Orders screen (on the File menu, click **Copy Current Order**).

**Note:** You can copy an order only after it is posted.

**Note:** Before entering new orders, see "Setting Up Order Entry" (page 3) for important information about setting up your Order Entry system.
In the header area of the O/E Order Entry screen, you specify the order number and customer number. You can also review information about any shipments and invoices generated from the order.

If you separate order entry, shipping, and invoicing tasks, you can also use the O/E Shipment Entry screen to ship posted orders and the O/E Invoice Entry screen to invoice shipments.

**Customer Tab**

Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

On the Customer tab, you can specify:

- Shipping method
- Tracking number if sending by courier or registered mail
- Optional FOB (free-on-board) location
- Optional territory code
- Customer type (this specifies whether the customer is eligible for discounts or special pricing)
- Price list to use to select prices for item details
- Tax group
- Customer account set
- Payment terms that will be used for invoices from this transaction
- Due date and discount terms

**Optional Fields Tab**

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.
Note: If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

Order Tab

Use the Order tab to perform the following tasks:

- Specify general information about the order
- Select options related to tax, project and job costing, project invoicing, and retainage
- Add and edit detail lines for items and miscellaneous charges on the Details table

You use the fields and options at the top of the Order tab to specify general information about the order, and to select options related to tax, project and job costing, project invoicing, and retainage.

- An optional template code to specify the default entries in order and customer information fields
- The customer's purchase order number
- Order date
- Default location code for the order
- Whether the account is on hold
- Order type (for more information, see "Order Types " (page 84)
- The quote, or quotes, on which the order is based
- Expected ship date
- Whether to calculate taxes automatically
- The ship-to location from the Accounts Receivable customer record, or a shipping address to use for the current order
- An optional shipping method or carrier
- An optional description and reference information

You use the Details table to add and edit detail lines for items and miscellaneous charges.
On the Details table, you can:

- Add detail lines for items and miscellaneous charges
- Edit or delete existing detail lines (unless you have shipped any of the details on the order)
- Specify ordered quantities
- Specify prices
- Specify shipped quantities
- Add optional fields
- Use the LocationFinder on a selected detail line to display quantities for other locations.

Tip:
- To open a separate detail entry screen to view and change information for a selected detail, click Items/Taxes.
- Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed. Inventory quantities are displayed in the unit of measure defined for the item.

Note: Some table columns do not appear as fields on the O/E Items/Taxes screen.

Rates Tab

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

If you are shipping goods, you can also change the rate information for converting the shipped amount from customer’s currency.

The Rates tab can show the following groups of exchange rate information:

- Order Exchange Rate (if you are creating or have created an order)
- Shipment Exchange Rate (if you are shipping or have shipped goods)
- Invoice Exchange Rate (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.

- If you are shipping goods, change rate information for converting the shipped amount from customer's currency.

- If you are invoicing shipped goods, change rate information for the invoice.

- If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

For more information, see "About Exchange Rates" (page 75).

**Retainage Tab**

The Retainage tab appears only for job-related documents that use the **Retainage** option. You use this tab to specify retainage terms for orders, shipments and invoices. If you use multicurrency accounting, you also specify the exchange rate to use for the retainage invoice, retainage debit note, or retainage credit note when outstanding retainage is processed in Accounts Receivable.

The Retainage tab appears only if the following conditions are true:

- You use Sage 300 ERP Project and Job Costing

- The document is job-related

- You select the **Retainage** option for the document. (You cannot select this option if you select **Project Invoicing**.)
The default entries for the retainage percentage and retention period for each detail line come from the **Customer Default** fields on the Contract Maintenance Project Project tab in Project and Job Costing. You can change these entries for each detail line.

**Sales Split Tab**

Use the Sales Split tab to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

For more information, see "Managing Sales Splits " (page 83).

**Taxes Tab**

Use the Taxes tab to select the method you will use to calculate taxes, and to review and change tax information for a document.

On the Taxes tab, you can:

- Specify whether taxes are calculated manually or automatically.
- Select automatic tax calculation for tax reporting (if you report taxes in a different currency), or enter the tax reporting amounts manually.
- Review the tax information that applies to the transaction.
• Change the customer tax class for the document.

  **Tip:** To change the tax status of an item, click the **Items/Taxes** button on the Order tab.

• Enter the tax base and tax amount, if you are entering taxes manually.
• Enter or edit the customer's tax exemption number.
• Automatically prorate tax amounts for individual details on the document.

For information about entering and distributing tax amounts manually, see "Entering and Distributing Tax Amounts " (page 182).

**Totals Tab**

Use the Totals tab to review and edit discounts, totals, and other final document details.

On the Totals tab, you can:

• Verify totals and discounts before posting an order
• Check the total estimated weight of items ordered
• Specify whether any discounts apply to miscellaneous charges
• Specify the number of labels you want to print for an order
• Enter a comment for the order

**Fields and Controls**

**Buttons**

**Calc. Taxes**

The **Calc. Taxes** button appears on the Taxes tab. Click the button to calculate and overwrite any existing tax amounts on the Taxes tab.

**Note:** If you do not select the **Calculate Tax** option on the Taxes tab, you can change tax amounts manually after clicking the **Calc. Taxes** button.

You can also use the **Calc. Taxes** button to recalculate taxes after changing the tax authority – even if you have selected the **Calculate Tax** option.

For more information about entering taxes manually, see "Entering Taxes Manually " (page 183).
Capture
If you use Payment Processing, this button becomes available after you pre-authorize a credit card payment.

Click **Capture** to open the O/E Prepayments screen, and then click **Charge** to begin processing the payment.

For more information, see "About Pre-authorizing, Capturing, and Forcing Credit Card Payments " (page 141).

Components
Click this button to view the components that make up a kit or a BOM. For more information, see "O/E Kitting Components Screen " (page 481) or "O/E BOM Components Screen " (page 451).

Contracts
If you are adding a job-related quote, you can click this button to open the New Contract Wizard, which lets you create a new contract in Project and Job Costing for the quote that you are entering.

The New Contract Wizard copies the settings, projects, categories, and resources from the existing contract to the new contract, and allows you to specify various settings for the new contract.

**Note:** When you post the quote, all details that you entered for the quote will update the contract estimates in Project and Job Costing.

Create PO
Click this button if you want to create a purchase order based on the current order.

When you click the button, the **P/O Create POs from O/E** screen opens in Purchase Orders with information automatically entered in it from the O/E Order Entry screen.

Delete
Click this button to delete an order.

You can delete an order even if it has been posted. When you delete an order, all its details are removed, and it no longer appears in any lists of orders.
**Note:** You can delete an order or an order detail only if none of the items on the order have been shipped.

**Derive Rate**

This button is available on the Rates tab if you calculate the tax amount in the tax reporting currency manually (if you report taxes in a different currency than you collect them).

If you have already changed the tax reporting amount on the Taxes tab, click **Derive Rate** to calculate the actual exchange rate between the tax amount and the tax reporting amount.

**Note:**
- If Order Entry automatically calculates the tax amount in the tax reporting currency, it will use the tax reporting currency exchange rate that you enter on the Rates tab.
- The rate on the Rates tab must match the effective exchange rate before you can post the document.
- If you change the total amount on the Taxes tab, you must redistribute the tax reporting amount to the document details.

**Dist. Taxes**

This button is available if you do not select the **Calculate Tax** option.

When you click the **Dist. Taxes** button, the total tax (from the Taxes tab) is prorated to the document details.

**Note:** You can review tax amounts for document details on the O/E Items/Taxes screen. For more information, see "O/E Items/Taxes Screen" (page 460).

**History**

Click this button to review the sales history for a selected item or a customer. For more information, see "Looking Up Sales History for Items or Customers" (page 190).

**Item/Tax**

Click **Item/Tax** to open the O/E Items/Taxes screen.
You can use this screen to add, edit, and delete items and charges, and to change tax information for items and charges. The screen displays details for each item or charge on a single screen, rather than in a table row, making it easier for you to review and modify information without scrolling.

You can also change a tax class to another tax class that is assigned to the authority, and you can specify whether tax is included (in the Tax Included column).

For more information, see "O/E Items/Taxes Screen " (page 460).

**Post**

Click this button to post a transaction. When you post, you can print documents related to the transaction. Depending on the transaction and the options you selected, you may be able to print a quote, order confirmation, picking slip, prepayment receipt, and/or invoice. For more information, see "O/E Confirmation Screen " (page 453).

**Note:**

- If you have set up Order Entry to check customer credit limits, and the transaction you are posting will put the customer over their credit limit, the O/E Credit Check screen appears when you post. On this screen, you can put the transaction on hold, or you can override the customer’s credit limit and continue with posting.

- For job-related transactions, if you change the status of a contract from Estimate to Open, and then post, you cannot change the contract’s status back to Estimate. For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**Pre-authorize**

If you use Payment Processing, you can click Pre-authorize to open the O/E Pre-authorization screen and begin pre-authorizing a credit card prepayment.

You pre-authorize a credit card payment when you want to verify that sufficient credit exists on a customer’s credit card before processing a sale. When you create a pre-authorization, the cardholder’s credit limit is reduced by the amount of the pre-authorization until the pre-authorization is captured or expires.
The amount of a pre-authorization does not need to match the amount captured in the final sale. The captured amount may be more (for example, when a restaurant customer adds a tip) or less (for example, when a gas station customer swipes a credit card, and then purchases fuel that costs less than the amount pre-authorized for a fill-up).

For more information, see "O/E Pre-authorization Screen " (page 485).

**Note:** After you pre-authorize a credit card payment, the **Pre-authorize** button is replaced with the **Void Pre-auth** button.

### Prepayment

Click **Prepayment** to open the O/E Prepayments screen, which you use to enter complete or partial payments for a transaction. For more information, see "O/E Prepayments Screen" (page 489).

**Note:** If you use Payment Processing, the **Prepayment** button is replaced with the **Capture** button after you pre-authorize a credit card payment.

### Ship All

This button is available on the Order or Shipment tab if a document includes any details. It provides a quick way to ship outstanding items for an order.

When you click **Ship All**, all backordered quantities are shipped. That is, for each detail, the number in the **Quantity Backordered** field is added to the **Quantity Shipped** field.

**Important!** Because this button uses backordered quantities to determine the number to enter in **Quantity Shipped**, it will not work properly if you do not enter backordered quantities, or if you use the option to calculate backordered quantities automatically.

**Tip:** To cancel shipment for a detail, enter 0 (zero) in the **Quantity Backordered** field. The quantity ordered will be added to the **Sales Lost** field on the O/E Sales Statistics report.

**Note:** If the **Allow Negative Inventory Levels** option is not selected in Inventory Control, Order Entry ships only those quantities on hand in Inventory Control.
**Void Pre-auth**

If you use Payment Processing, this button becomes available after you pre-authorize a credit card payment.

Click **Void Pre-auth** to open the O/E Pre-authorization screen and void an existing pre-authorization.

For more information, see "O/E Pre-authorization Screen " (page 485).

**Note:** You cannot void a pre-authorization that has expired or been captured.

**Customer No.**

Enter the customer number of the customer to whose account you will post the transaction.

The customer number determines the customer and billing address, and sets the default tax group and payment terms. In multicurrency systems, the customer number also specifies the currency of the document.

**Note:** After you enter a customer number, the field to the right displays the customer's name.

You can enter an existing customer number in the following ways:

- Enter the number, and then press Tab.
- Use the Finder 📊 to select the number.

Using the buttons to the right of the **Customer No.** field, you can:

- **Create a new customer.** Click the New 📚 button to create a new customer on the A/R Customers screen. When you finish, the new customer number appears in the **Customer No.** field.

- **Check the customer's credit.** Click the Pre Credit Check 🛒 button to check the customer's credit status before entering a transaction.

- **Edit the customer's billing address.** Click the Zoom ➤ button to view and edit the customer's billing address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

- **Look up information about the customer.** Click the Inquiry 📚 button to open the A/R Customer Inquiry screen to look up information about the customer.
If a customer account or its account set is inactive, you cannot enter transactions for the customer. If a customer account becomes inactive after you enter an order, you will not be able to post changes or invoices for the order until the account is made active again.

**Note:**

If the **Allow Non-existent Customers** option is selected on the O/E Options screen, you can enter a new customer number, and then continue entering the document. In a multicurrency system, the currency for the order is set by the reporting currency of the customer tax group that you choose.

You should not use this method to enter transactions in a multicurrency system, especially if the reporting currencies for customer tax groups do not match your customers' currencies.

Also note that you must add the customer record in Accounts Receivable before you post an invoice for the order in Accounts Receivable.

**Last Invoice No.**

This field displays the number assigned to the last invoice issued from the order. Order Entry updates the number each time you issue a new invoice.

**Last Shipment No.**

This field displays the number assigned to the last shipment processed for the order. Order Entry updates the number each time you process a new invoice.

**No. of Shipments**

This field displays the number of shipments that have been processed for the order.

**Order No.**

An order number is a unique number that identifies an order.

You can use this field to:

- Enter a number for a new order if you want to create one manually, or accept ***NEW*** to have Order Entry assign the next available number.

- Select an existing order that you want to view, edit, or delete.

Order Entry assigns order numbers according to settings you specify on the Documents tab of the O/E Options screen. For more information, see "O/E Options Screen " (page 311).
Customer tab
Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

Customer Account Set
This field displays the account set specified in the A/R record as the default.

The account set specifies the General Ledger accounts to which the transaction will be distributed: receivables control, payment discounts, prepayment liability, retainage, and write-offs.

You can change the account set for a transaction. If you use multicurrency, however, you must select an account set that uses the same currency as the customer's account set.

Customer Type
Select a code that identifies the price discount level for the customer. You can select Base, A, B, C, D, or E.

If you select Base, and the discount is based on customer type, the customer is not eligible for price discounts.

Note:
- You specify customer type on the A/R Customers screen, but you can change it for an individual order.
- Item prices in Inventory Control are specified by customer type.

FOB Point
If applicable, enter the free-on-board (FOB) location at which the customer begins paying freight charges on the order.

If a default FOB point or primary ship-to location is specified for the customer on the A/R Customers screen, the FOB point from the customer record or the ship-to location appears in this field when you select a customer.

Price List
Enter the code for the default price list from which prices are displayed on detail lines.

Order Entry displays the price list from the customer record, template, or ship-to location, depending on the order in which you select these
records. For example, if you specified the ship-to location last, the price list for the location appears in the **Price List** field.

**Note:** You can select different price lists for individual detail lines.

### Tax Group

Enter the code for the customer's tax group.

The tax group determines the tax authorities to which the customer is subject, and the tax classes that are used for each authority to calculate sales tax.

You can change the tax group at any time, even after posting. (For example, if you change the ship-to location on a posted order, you can also change the tax group to include the tax authorities for the new location.)

**Note:** If you use Project and Job Costing, see "About Order Entry Integration with Project and Job Costing" (page 7) for information about specifying tax groups for contracts and projects.

### Tax Reporting Currency

If you use multicurrency accounting, this field displays the tax reporting currency for the tax group selected in the **Tax Group** field.

**Note:** The tax group's reporting currency can be different than the functional currency. It can also be different than the customer's reporting currency.

### Terms Code

Enter the terms code for the transaction.

The terms code specifies the default terms that appear when you enter transactions for the customer in Accounts Receivable and Order Entry. In Accounts Receivable, you use the A/R Terms screen to set up terms codes, and you use the A/R Customers screen to assign a terms code to each customer.

You can specify different terms for the customer during transaction entry without changing the default terms code assigned to the customer in Accounts Receivable.
**Territory**

If you use territory codes to identify sales regions or track customer accounts, enter the territory code for the transaction in this field.

**Note:** You can use the A/R Ship-To Locations screen to assign a territory code to each ship-to location you create for customers.

**Optional Fields tab**

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

**Optional Field**

Use the Optional Field Finder to select optional fields that are assigned (in the O/E Optional Fields setup screen) to this type of transaction.

When you select an optional field code, Order Entry displays its description in the next column.

**Value**

Use the Value Finder to select a value created for the optional field in Common Services.

When you select a value code, Order Entry displays its description in the next column.

**Value Set**

The Value Set column shows whether a blank optional field currently has a value. (By looking at the field, you cannot know otherwise whether the
field has a blank default value or no value.

The Value Set field changes from **No** to **Yes** if you make an entry in the Value field.

**Order tab**

The Order tab provides separate sections, where you can enter or view document information, as follows:

- **Header.** You use the top portion of the tab to enter general information that applies to the entire document (for example, the date, description, reference, template code, warehouse location, ship-to information, whether to calculate tax automatically for the document, and whether the document is job related).

- **Details.** You use the Details table to add and edit detail lines for items and miscellaneous charges.

On the Details table, you can:

- Add item and miscellaneous-charge detail lines.
- Edit or delete existing detail lines (provided that no order details have been shipped).
- Specify ordered quantities.
- Specify prices.
- Specify shipped quantities.
- Add optional fields.
- Open a separate screen where you can view or change all the information for a selected detail—including tax information—without having to scroll sideways.

- **Inventory Quantities.** The bottom of the tab displays inventory quantities for the location specified for a selected detail line and for all locations.

Click the Drilldown buttons to view details for items on sales order, on purchase order, and committed to orders, including expected arrival and shipping dates.

**Note:** Inventory quantities are displayed in the unit of measure defined for the item.
Calculate (Calc.) Tax
Select this option if you want Order Entry to calculate tax automatically for this document. For more information, see "Entering Taxes Manually " (page 183)

**Note:** If this document is job-related and you select the **Project Invoicing** option, you cannot enter taxes manually. The **Calculate Tax** option is automatically selected, and you cannot change it.

Create Invoice
This option is available if you have shipped goods for an order. Select it to create an invoice when you post the order.

When you select the **Create Invoice** option, **Invoice No.**, **Invoice Date**, and **Invoice Posting Date** fields appear on the Totals tab.

**Note:** The **Create Invoice** option is not available for job-related orders that use project invoicing. All customer invoicing for these orders is handled by Project and Job Costing.

Deliver By
If your customer has requested delivery of the order by a specific date, enter that date in this field.

Description
Enter an optional description of up to 60 characters for the order.

When you create a shipment for the order, this description appears as the default description for the shipment.

If you do not change the description for the shipment or the invoice, it will appear for the Accounts Receivable invoice and in the General Ledger batch, depending on the options you selected for your Order Entry system. For more information about these options, see "O/E Options Screen " (page 311) and "O/E G/L Integration Screen" (page 327).

Entered By
This field indicates how the transaction was entered:

- **Directly in Order Entry.** If the transaction was entered manually in Order Entry, the field displays the name of the person who entered
the transaction.

- **By an integrated e-commerce solution.** If the transaction was entered using an e-commerce solution, the field displays:
  - **Internet.** If you use eTransact or iConnect.
  - **ePOS.** If you use ePOS.
  - **Electronic Commerce.** If you use another e-commerce solution.

**Exp. Ship Date**
Enter the date on which you expect to ship the order. The default date is the order date.

If necessary, you can enter different expected ship dates for individual details lines included in the order.

**Expiration Date**
This field appears if you select **Quote** as the order type.

Enter the date on which the quote expires. Order Entry displays a default expiration date based on the default number of days specified on the O/E Options screen.

**Note:**
- If you selected the **Clear Expired Quotes** option and specified a number of days on the O/E Options screen, Order Entry deletes the expired quote from the system the next time you run Day End Processing after the specified delay.
- If you do not select the **Clear Expired Quotes** option on the O/E Options screen, expired quotes are not deleted.
- If you do not change the quote to an order before the expiration date, Order Entry automatically removes the quote when you run Day End Processing.

**From Multiple Quotes**
This option allows you to create a new order from multiple quotes, or reuse quotes from which you have already produced an order.

For more information, see "O/E Create Order from Quotes Screen " (page 455).
Appendix A: Order Entry Screen Guides

**Note:**
- You must select quotes before you add any detail lines for the new order. If you have added detail lines to the order, you must delete them before you can select quotes.
- If you are using Sage 300 ERP integrated with Sage CRM, you cannot use this option to select multiple quotes that belong to different opportunities in Sage CRM.

**Job Related**
Select this option if the document applies to a project that you are managing using Project and Job Costing.

When you select the option, additional columns appear in the detail table so you can enter job-related information for each detail line.

When you post the document, Order Entry updates the contracts, projects, categories, and (if required) resources in Project and Job Costing to which the items in this order apply.

For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**Location**
Specify the inventory location from which you expect to ship items to fill the order.

This location is the default location for detail lines included in the transaction, although you can select different locations for individual detail lines.

**Note:** If you select a logical inventory location instead of a physical location, an error message appears. (Logical locations are used mainly for transferring goods between physical locations in Inventory Control.)

**On Hold**
Select this option if you need to place an order on hold.

If you want to specify the reason that an order is on hold, you can enter this information in the field beside the option.

If the customer account is on hold in Accounts Receivable, the order is automatically placed on hold.
You can enter and post an order that is on hold, but you cannot ship items or produce an invoice for the order until you do one of the following:

- Remove the hold for the customer in Accounts Receivable.
- Remove the hold for the order on the O/E Order Entry screen, and then post the order.

To view a list of the orders currently on hold, print the O/E Order Action report.

**Note:**
- Placing an order on hold automatically clears any serial numbers or lot numbers that have been allocated to the order quantity.
- Posting an order that is on hold has the following effects on Inventory Control records: If an item is serialized, the Allocated To OE Order status for the item and serial number is cleared on the I/C Serial Numbers screen. If an item is lotted, the number in the Quantity Reserved for Order field is reduced for the item and lot number on the I/C Lot Numbers screen.

**Order Date**

Enter the date for the order. This date is also used to age the order on the O/E Aged Orders report.

For a future order, enter the date that the order becomes active. The date you enter for a future order determines when the order will be activated by Day End Processing.

By default, this field displays the system date (the date you selected when signing in to Sage 300 ERP).

**Order Subtotal**

This field appears on both the Order tab and the Totals tab.

It displays the subtotal of all items and miscellaneous charges on the order, including tax amounts that are included in item prices.

**Order Type**

Select the type of order you are entering:

- **Active.** An active order is an order that you expect to fill in a normal period of time.
- **Future.** A future order is an order to be filled on a future date you specify. It becomes active and is posted when you run Day End Processing on the specified order date. You can also change the order status to Active before the order date.

- **Standing.** A standing order is an order that is filled regularly for the same customer, or for different customers.

- **Quote.** A quote is an order with an expiration date. When you run Day End Processing on that date, the quote is removed from the system.

For more information, see "Order Types " (page 84).

**Note:**
- If Inventory Control permits the allocation of serial numbers and/or lot numbers using Order Entry’s Qty Ordered field, you can allocate serial numbers or lot numbers to the order quantity for active orders.

- If you use Project and Job Costing, the selection you make here can affect your estimates and contracts. For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**PO No.**

If necessary, enter the customer’s purchase order number in this field.

If you selected **Warning** or **Error** on the **Check for Duplicate POs** list on the Invoicing tab of the A/R Customers screen, Order Entry displays a warning or error message if you enter a purchase order number that has already been used for this customer.

**Note:** Order Entry checks for duplicate purchase order numbers only on active or future orders—not on quotes or standing orders.

**Project Invoicing**

Select this option if Project and Job Costing will handle all invoicing for this document.

If you select this option:

- Order Entry does not create an invoice for the order. (When you ship the order, Order Entry passes shipment information to Project and
Job Costing, where billing is handled using the PJC Create Billing Worksheet screen.)

- Taxes are calculated automatically. (You cannot clear the **Calculate Tax** option.)

- The **Retainage** option is not available. (All invoicing, including retainage amounts, is handled by Project and Job Costing.)

For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**Qty. Available**
Displays the inventory quantity that is available for sale to your customers. This is determined by the quantity on hand less the quantity committed, as maintained in Inventory Control.

**Qty. Committed**
Displays the inventory quantity that is committed to orders.

By committing an inventory quantity to an order, you ensure that the required inventory will be available when it is time to ship the order. (If a quantity is already committed to an order, you cannot ship another order for the same items unless there is a sufficient quantity in inventory in addition to the committed quantity.)

**Tip:** You can click the **Drilldown** button to the right of the displayed quantities to view more information (such as the customer and the expected ship date).

**Qty. on Hand**
Displays the inventory quantity currently on hand, as maintained in Inventory Control.

**Qty. on Purchase Order**
Displays the inventory order quantity that you have ordered.

**Tip:** You can click the **Drilldown** button to the right of the displayed quantities to view more information (such as the order date and the expected arrival date).

**Qty. on Sales Order**
Displays the inventory quantity that customers have ordered from you.
Tip: You can click the Drilldown button to the right of the displayed quantities to view information (such as the customer and the expected ship date).

Reference
Enter reference information for the order. When you ship the order, the order description appears as the default reference for the shipment.

If you do not change the reference for the shipment or the invoice, it will appear for the Accounts Receivable invoice and in the General Ledger batch, depending on the integration and posting options you selected.

Retainage
Select this option to indicate that retainage applies to the document you are entering. (Retainage is where a percentage of the payment is held back for a fixed period of time, and then invoiced separately after the hold-back period.)

When you select this option, the Retainage tab becomes available. You use this tab to specify how to process the retainage amount for the document.

Note:
- The Retainage option is available only if you are entering a job-related transaction and your Accounts Receivable ledger uses the Retainage Accounting option.
- The Retainage option is not available if you select Project Invoicing (where invoicing is handled through Project and Job Costing).

Ship-To Location
Enter a ship-to location that you have defined for the customer on the A/R Ship-To Locations screen in Accounts Receivable. You can do this in the following ways:

- Enter the ship-to location, and then press Tab.
- Use the Finder to select the location.

Using the buttons to the right of the field, you can:
• **Create a new ship-to location.** Click the New button to create a new ship-to location on the A/R Ship-To Locations screen. When you finish, the new ship-to location appears in the **Ship-To Location** field.

• **Edit the customer's ship-to address.** Click the Zoom button to view and edit the customer's ship-to address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

**Note:**

- When you enter a ship-to location, Order Entry updates the price list, territory, tax group, and sales split information for the transaction based on the information stored for the ship-to location.

- If you do not specify a ship-to location, Order Entry uses the address in the customer record.

**Ship Via**

Enter an optional ship-via code to specify the delivery method for the shipment.

If you specified a primary ship-to location for the customer on the A/R Customers screen in Accounts Receivable, the ship-via code for that ship-to location record appears as the default.

If the transaction uses a template, the description field to the right displays the description for the ship-via code used in the template by default.

If you select a ship-to location with an associated ship-via code for the transaction, the description for that location's ship-via code replaces the default description.

You can change the description if necessary.

**Status**

This field displays the status of the batch. Batch status can be **Posted, Confirmation Printed, Picking Slip Printed,** or **Quote Printed.**

**Template Code**

Select an optional template to use for the transaction. The information from the template appears as defaults in fields for the transaction.
Note:
- If the customer record specifies information that is different from the information in the template, the information from the customer record appears by default.
- If you select a new template after selecting a customer, the information from the template replaces the transaction and customer information from the customer record.
- If you want to select a template after you have added details to the transaction, you must select a template that uses the same currency.
- You set up templates on the O/E Templates screen.

Tracking No.
If you use waybill numbers to track shipments, enter the waybill number in this field.

Note: You can also enter a separate tracking number with any detail included in the transaction.

Detail Table
You use the Details table to add and edit detail lines for items and miscellaneous charges.

All detail fields appear as columns in the detail table.

Tip:
- To open a separate detail entry screen to view and change information for a selected detail, click Items/Taxes.
- Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed. Inventory quantities are displayed in the unit of measure defined for the item.

A/R Item No.
If the document is job-related and you are using project invoicing,
this field displays the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.

**A/R Item UOM**

If the document is job-related and you are using project invoicing, this field displays the unit of measure for the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.

**Billing Type**

If the document is job related, this field indicates whether the item or charge is billable or non-billable.

**Category (Inventory)**

This field displays the category assigned to the item record in Inventory Control. You can use the Finder to select a different category.

**Category (Job Related)**

This field appears if you selected the Job Related option for the document.

For job-related orders, specify the category to use for this item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**

- If you use a term other than “Category” in Project and Job Costing, that term appears as the label for this field.
- Use the Item Number field to specify the resource.
- After you add the detail, you cannot edit this field.

**COGS Acct.**

If the document is job-related and you are not using project invoicing, this field displays the default Cost Of Goods Sold account from Project and Job Costing for the item or charge.
Comments/Instr.
This field indicates whether there are comments or instructions entered for the detail, and also allows you to add comments or instructions. For more information, see "Adding Comments and Instructions to Order Entry Transactions " (page 101).

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Comments for a detail line appear in the Description column on printed quotes, order confirmations, invoices, credit notes, and debit notes.</td>
</tr>
<tr>
<td>• Instructions for a detail line appear in the Description column on printed picking slips.</td>
</tr>
</tbody>
</table>

Completed
The status of a detail is automatically set to Completed when you post a shipment for all ordered units for the detail, or when you enter 0 (zero) in the Quantity Backordered field.

You can also set the status for a detail to Completed manually, by selecting Yes in the Completed field. The unshipped quantity will be listed as lost sales on the O/E Sales Statistics report after the order is processed by Day End Processing.

Contract
This field appears if you selected the Job Related option for the transaction.

For job-related orders, specify the contract to use for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• If you use a term other than “Contract” in Project and Job Costing, that term appears as the label for this field.</td>
</tr>
<tr>
<td>• Use the Item Number field to specify the resource.</td>
</tr>
<tr>
<td>• After you add the item or charge, you cannot edit this field.</td>
</tr>
</tbody>
</table>
**Cost Class**
This field displays the cost class for the project category used in each job-related detail.

*Note:* If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

---

**Costing UOM**
This field displays the costing unit of measure specified in the item record.

*Note:* If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

---

**Customer Item No.**
If you set up customer item numbers in Inventory Control (using the I/C Customer Details screen), you can use the customer's item number to enter the item number for the detail.

If you use customer item numbers to enter the item number for details, Order Entry will replace the customer's item number with your inventory item number, and automatically insert the customer's item number in this field. (This works the same way as the manufacturers' item numbers.)

**Deliver By**
If your customer has requested delivery of the item by a specific date, enter that date in this field. By default, this field displays the requested delivery date entered in the Deliver By field for the document, but you can change it.

**Description**
This field displays the description from the item price list or miscellaneous charge record for the item or miscellaneous charge selected in the Item No./ Misc. Charge field.

This description appears on printed order confirmations, picking slips, and invoices. You can use the default description or enter a new description to be used for an individual transaction.
In a multicurrency system, the description from the item record appears here if the price list does not include a price in the customer’s currency.

**Discount %**
You can specify a separate discount percentage or amount for each detail in an Order Entry transaction.

You can also enter a discount percentage or amount for the transaction on the Totals tab.

**Discount Amount**
You can specify a discount percentage or amount for each detail in an Order Entry transaction. If you specify a discount amount, Order Entry calculates the discount percentage and the discounted extended price.

You can also enter a discount percentage or amount for the transaction on the Totals tab.

**Discounted Ext. Amt.**
This field displays the amount for the detail after the discount is applied.

**Exp. Ship Date**
Enter the date you expect to ship the item. By default, this field displays the expected shipment date entered for the document, but you can change it.

**Extended Cost**
This field appears if you selected the **Job Related** option for the document.

Extended cost is the cost amount for the miscellaneous charge. It can also be used in Project and Job Costing to calculate labor and overhead. For more information, see Project and Job Costing help.

**Ext. Price**
Enter the extended price for the detail, or accept the calculated value.

Extended price refers to the extended price of an order (that is, the total cost of the items being ordered, whether or not they have been
shipped). It is calculated automatically when you enter an order quantity. Sage 300 ERP divides the unit price by the pricing unit of measure conversion factor, and then multiplies the result by the order unit of measure conversion factor and the quantity ordered.

If you change the extended price calculated by the program, an asterisk appears beside the **Ext. Price** field on the O/E Items/Taxes screen, and also appears beside the item on the O/E Transaction List report.

**Extended Weight**
This field displays the extended weight, which is calculated by multiplying quantity shipped by the unit weight entered for the item in Inventory Control.

You might use extended weight to determine postage, shipping, or other charges.

You can edit the item weight and the extended weight on the transaction entry screen if necessary.

Order Entry converts the extended weight for each detail to the order weight unit of measure, and displays the estimated weight for the entire order on the Totals tab.

**Item No./ Misc. Charge**
Enter the item number or miscellaneous charge code for the item or charge. Order Entry displays information from the Inventory Control item record, including pricing unit and unit price information based on the customer’s price list.

**Note:** After entering an item number in this field, you can use the Finder to see alternate items for the specified item. For more information about specifying alternate items, see the Inventory Control help.

After you add an item or charge, you can no longer change its item number or miscellaneous charge code.

**Kit/BOM**
If the selected item is part of a kit or a BOM (bill of materials) in Inventory Control, click the Finder to select the kit or BOM number (if you have more than one build for the item).
To review the items in the build, click the **Components** button at the bottom of the screen.

**Note:**
- You can create kits from stock or non-stock items in Inventory Control and then use them in Order Entry. You can also enter or post multiple kitting entries (or mix kitting entries with regular entries) in any Order Entry transaction entry screen.
- Kits can be assigned serial numbers that are maintained in Serialized Inventory.
- You can include kit components and BOM components when printing order confirmations, quotes, picking slips, invoices, credit notes, and debit notes.
- When you print the O/E Transaction List report and select Detail as the report type, the report displays kit components and BOM components.
- When you print the O/E Posting Journals report, it includes actual breakdown amounts for each kit component.

**Line No.**
Line numbers are assigned automatically, and you cannot change them.

You use line numbers to identify details you have entered, or to recall them for editing when you are using the O/E Items/Taxes screen to enter detail information.

You can also list items on picking slips by line number.

**Location**
By default, this field displays the location code specified for the order. You can change the location for individual details.

Optionally, enter the code for the physical location from which you will ship the items ordered on the detail line.

You must specify a physical location, not a logical inventory location. Logical locations are used primarily for transferring goods between physical locations in Inventory Control.
Note: You cannot change the location for a serialized or lotted item after you enter a quantity in the Quantity Ordered field.

Tip: You can click the Location Finder to see the quantity on hand at other locations.

Manuf. Item No.
If you have set up manufacturer's item numbers in Inventory Control, you can enter the manufacturer's item number (usually a bar code) in this field, rather than entering your inventory control item number. The manufacturers' item numbers are translated to your inventory item numbers by Inventory Control.

If you entered the manufacturer's item number in the Item Number field, Order Entry inserts it here automatically when it retrieves item information.

For more information about using manufacturer’s item numbers, see the Inventory Control help.

If you selected a non-stock item, the non-stock clearing account used by the item’s account set appears as the default in this field. You can change the account number if necessary.

Optional Fields
If you use optional fields, you can review and edit optional fields by clicking the Optional Fields column heading. (If you are using the O/E Items/Taxes screen, click the Zoom button beside the Optional Fields option.)

If an optional field is required, you cannot save the transaction unless the field has a default value, or until you fill in the field yourself.

To add optional item fields that were not automatically inserted, press the Insert key to add a new line to the table, and then use the Finder to select an optional field.

Optional fields must be assigned to the transactions screens using the O/E Optional Fields screen before you can add them to individual transactions. For more information, see "O/E Optional Fields Screen" (page 349).
Order UOM
This is the unit of measure in which you are ordering item quantities for the detail. You can select a different unit of measure if necessary.

Tip: Make sure that the amount in the Quantity Ordered field uses this unit of measure.

Depending on your settings on the O/E Options screen, this field displays either the item weight unit (from the item record in Inventory Control) or the pricing weight unit (from the price list in Inventory Control). Stocking units and pricing units are defined for individual items in Inventory Control, and they may be different. For example, you may use "Dozen" as the stocking unit for an item, but "Each" as the pricing unit.

For more information, see "About Order Unit of Measure" (page 19).

Order Weight UOM (unit of measure)
This is the unit of measure for weighing this item on the order. You can select a different unit of measure if necessary.

Depending on your settings in O/E Options, this field displays either the item weight unit (from the item record in Inventory Control) or the pricing weight unit (from the price list in Inventory Control).

The order weight unit of measure for the complete order is determined by the default weight unit of measure specified on the I/C Options screen.

Note:
- If the item is not priced by weight, this field displays the item weight unit from the item record.
- If the item is priced by weight, and it has base prices for multiple units of measure, this field displays the default unit of measure from the price list if your Default Order Weight UOM in O/E Options is the Pricing Weight Unit.

Orig. Order
This field displays the quantity specified when the detail was first entered and posted. This number does not change even if you change the quantity ordered for the detail.
Price Approval
Price checks are set in Inventory Control price lists for particular items, price lists, and user IDs.
If price checks are in effect, and the price you enter is outside the boundaries allowed, this field displays "Yes." To approve the price:
1. In the Price Approval column heading, click the Zoom button.
2. On the O/E Price Approval screen, enter the ID of the person approving the price override. If security is set, you must also enter a password.

Note: The Price Approval field does not appear if you are using the O/E Item/Taxes screen. Instead, an error message may appear when you try to save the item detail, stating that the price requires approval.

For more information, see "About Price Checks" (page 82).

Price By
This field indicates whether the item is priced by weight or by quantity.
- If pricing is by quantity, Sage 300 ERP sets volume discount amounts or percentages according to the quantity of goods that are ordered.
- If pricing is by weight, Sage 300 ERP sets volume discount amounts or percentages by item weight.

Item weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

Note: Pricing by weight is available in Sage 300 Premium ERP only.

Price List
By default, this field displays the price list code you specified on the Customer tab.
If necessary, enter the code for the price list to use for the detail line.

Note: If you enter a non-stock item, the price list can be blank.
**Pricing UOM (unit of measure)**

This field displays the unit of measure in which the item is priced.

Sage 300 Premium ERP supports multiple pricing units of measure, but you must set one as the default on the I/C Item Pricing screen in Inventory Control.

The pricing UOM is determined by the price list as follows: If the price list provides only one pricing UOM, that UOM appears here. If the price list provides several pricing UOMs, the pricing unit that matches the order UOM appears here. If no pricing UOM matches the order UOM, the default pricing UOM appears here. If you price by cost, the default pricing UOM appears here, and the cost-based price appears in the Unit Price field.

**Note:** If the item is not on the specified price list, the program uses the item’s stocking unit as the pricing unit.

**Project**

This field appears if you selected the **Job Related** option for the document.

For job-related orders, specify the project for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than “Project” in Project and Job Costing, that term appears as the label for this field.
- Use the **Item Number** field to specify the resource.
- After you add the item or charge, you cannot edit this field.

**Qty. B/O**

If Order Entry uses the **Calculate Backorder Quantities** option (on the O/E Options screen), and if the customer record in Accounts Receivable allows backordered quantities, Order Entry automatically calculates the quantity backordered by subtracting the quantity shipped from the quantity ordered.
If Order Entry does not automatically calculate quantities and you are not shipping the entire order, enter the quantity backordered.

Each time you enter a shipped amount, the backordered quantity is reduced. When the backordered amount is zero, the item is considered to be fully shipped, and its status is set to Completed.

**Tip:** To cancel unshipped quantities of an order, enter 0 (zero) in this field.

**Qty. Committed**
Specify an inventory quantity to commit to the order. When it is time to ship the order, the quantity is guaranteed to be available (unless you allow negative inventory quantities).

If a quantity is already committed to an order, you can ship another order for the same items only if there is a sufficient quantity in inventory in addition to the committed quantity.

**Qty. Ordered**
Enter the number or quantity of the item or charge to include in the order.

Make sure that the number or quantity you enter uses the unit of measure specified in the **UOM** field. For example, if the UOM is "Case" and the order is for two cases, enter 2 in the **Quantity Ordered** field.

**Note:**
- The **Allow Fractional Quantities** option on the I/C Options screen in Inventory Control determines whether you can use decimals in the **Quantity Ordered** field. For more information, see Inventory Control help.
- If the detail is not completed (indicated in the **Completed** field), you can change the quantity ordered for items that have not been shipped and invoiced.
- If you are unable to ship all the items on an order, and want to cancel unshipped items, you can edit the details to reduce the quantities ordered so they match the quantities shipped.
- If the item is serialized or lotted and Inventory Control allows the allocation of serial numbers or lot numbers to order quantities, the
O/E Serial/Lot Numbers Allocation screen appears after you enter the quantity ordered and leave the field. (The Inventory Control option Use the Qty Ordered Field in OE determines whether you can allocate serial numbers or lot numbers using order quantities.) You use the O/E Serial/Lot Numbers Allocation screen to allocate serial numbers or lot numbers for the quantity of items ordered. For more information, see O/E Serial/Lot Numbers Allocation/Generation Screen.

**Qty. Shipped**

If necessary, enter the quantity shipped or to be shipped on an active order.

Usually, you create invoices when you ship items to a customer. However, you can enter a quantity shipped even if you are not ready to produce an invoice.

**Note:**

If the item is serialized or lotted and you did not allocate serial numbers or lot numbers to the quantity ordered, the O/E Serial/Lot Numbers Allocation screen appears after you enter the quantity shipped and leave the field. You use this screen to allocate serial numbers or lot numbers for the quantity of items ordered. For more information, see"O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

If Inventory Control allows the allocation of serial numbers or lot numbers to order quantities (controlled by the Use the Qty Ordered Field in OE option), you can ship only the serial and lot numbers already allocated from the Quantity Ordered field. (You cannot use the O/E Serial/Lot Numbers Allocation screen to allocate numbers using the Quantity Shipped field.)

**Retainage Percentage (%)**

Enter the retainage percentage to be used when calculating the retainage amount for the item or charge.

When you edit this field, the retainage amount for the item or charge is calculated automatically.

**Retention Period**

The retention period is the number of days for which the customer
can withhold the retainage amount.

You issue the retainage invoice in Accounts Receivable at the end of the retention period.

**Revenue Acct.**

If the document is job-related and you are not using project invoicing, you also specify the revenue/billing account for each item or charge.

The default account number is specified in Project and Job Costing, and is used instead of the sales account specified for the item in the item category record.

**Shipped To Date**

This field displays the number of item units that have been shipped to date for the detail.

You can click the Drilldown button to open the O/E Shipments/Invoices screen and view shipment and invoice information for the detail. For more information, see "O/E Shipments/Invoices Screen" (page 500).

**Ship Via and Description**

In the **Ship Via** field, enter the ship-via method for the detail. When you navigate out of this field, the description from the ship-via record for the selected ship-via code appears in the related **Description** field.

**Note:** You can specify a separate ship-via method for each detail.

**Tracking No.**

If you use tracking (waybill) numbers to track shipments that use different carriers or that are shipped at different times, enter the tracking number to use for the detail.

**Type**

Select the type of detail you are entering: Select Item to add a detail line for an inventory item or non-stock item that is assigned an item number in Inventory Control. Select Miscellaneous to add a detail line for a miscellaneous charge defined in Order Entry.
Tip: You can select a detail type by typing the first letter (for example, type M for Miscellaneous), or you can toggle between available selections by pressing the spacebar or double-clicking in the field.

Unit Cost
You enter the unit cost for an item only if the item uses the user-specified costing method in Inventory Control (that is, if User-Specified appears in the Costing Method field on the I/C Items screen).

For more information, see "Inventory Costing Methods" (page 33).

Note: If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

Unit Price
By default, this field displays the lowest unit price for which the customer is eligible. This may be the base price, a sale price for a specified time period, or the price specified for the customer's price level or the quantity purchased, based on a discount or markup.

If necessary, enter the price for the item, per pricing unit.

Note:
- If price checks are in effect, and the unit price is outside the allowed limit, the price must be approved. For more information, see "About Price Checks " (page 82).
- You can edit the information in this field only if you have Unit Price Override security authorization in Order Entry.
- If the item is not on the price list you specified for the detail, no price appears.
- If the lowest price is a negative amount, it is displayed as zeros.
- If you set up contract pricing for a customer in Inventory Control, Order Entry uses that information to calculate prices for items affected by the customer’s pricing contract, and it displays the contract price by default in this field.
- If you do not set up contract pricing for a customer, Order Entry calculates prices based on the customer type and the price lists you set up in Inventory Control.

- If the price list you select is not currently in effect: The Unit Price Finder does not appear. (That is, the Finder does not appear if the document date is not between the Price List Starts date and the Price List Ends date specified for the item, currency, and price list code on the I/C Item Pricing screen.) The Unit Price field displays 0.000000 by default.

- The number of decimal places that appear in this field is determined by the information specified for the item on the I/C Item Pricing screen.

**Unit Weight**

Unit weight is the weight of a single item for this detail, expressed in the order weight unit of measure. You can edit the weight that appears in this field.

To calculate the extended weight, multiply the unit weight by the quantity ordered.

If you are pricing by weight, the unit weight and extended weight determine the price. Otherwise, the weight is used only to determine the total order weight for estimating shipping costs.

**WIP Acct.**

If the document is job-related and you are using project invoicing, you also specify the WIP (Work in Progress) account for each order detail.

By default, this field displays the account number specified in Project and Job Costing.

**Note:** The level at which the WIP account is specified in Project and Job Costing depends on the project type and accounting method.

**Rates tab**

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

The Rates tab can show the following groups of exchange rate information:
- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.
- If you are shipping goods, change rate information for converting the shipped amount from customer's currency.
- If you are invoicing shipped goods, change rate information for the invoice.
- If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

For more information, see "About Exchange Rates " (page 75).

**Currency**

This field displays the currency code and description for the customer's currency.

The currency is set for the customer in Accounts Receivable, and you cannot change it in Order Entry.
If the tax group specified for this document on the Customer tab uses a different currency from the customer's currency and your functional currency, the code and description for that currency appear in the adjacent **Tax Reporting Currency** field.

**Rate**
This field displays the exchange rate currently in effect for the specified currency and the selected rate type and rate date.

If you want to change the rate, you can click the Finder to see a list of available rates for the selected rate type and rate date.

**Rate Date**
Enter the date to use to select the exchange rate. Order Entry displays the rate date that is nearest the date you entered.

You can enter any date for which an exchange rate has been entered for the currency. (You enter exchange rates for currencies on the Currency screen in Common Services.)

**Rate Type**
Enter the rate type to use when converting multicurrency amounts to functional currency for the document.

Examples of rate types might be "Daily spot rate," "Monthly average rate," and "Contract rate."

**Tax Reporting Currency**
This field displays the exchange rate currently in effect between the tax reporting currency and your functional currency for the displayed rate type and rate date. You can change the rate on this tab, or you can change the tax totals on the Taxes tab and then derive the new rate on the Rates tab.

- If you change the exchange rate for the tax reporting currency on the Rates tab, the program will change the tax reporting amounts on the Taxes tab when you use the Calc. Taxes button to calculate taxes (if you are not calculating taxes automatically).

- If you change the tax reporting amount on the Taxes tab (after clearing the Calculate Tax Reporting option), you will have to redistribute the new tax amount to the detail lines, and then enter the new tax reporting exchange rate on the Rates tab.
To calculate the new exchange rate, click the **Derive Rate** button on the Rates tab.

**Note:**
You cannot post the document unless the tax reporting exchange rate is correct for the tax reporting amount on the Taxes tab, and the tax reporting amounts for the document details match the total tax reporting amount on the Taxes tab.

You will see a warning if you change an exchange rate by an amount that exceeds the Spread setting for the currency table on the Currency Rates screen in Common Services.

**Retainage tab**
The Retainage tab appears only for job-related documents that use the **Retainage** option.

You use this tab to specify retainage terms for orders, shipments and invoices.

If you use multicurrency accounting, you also specify the exchange rate to use for the retainage invoice, retainage debit note, or retainage credit note when outstanding retainage is processed in Accounts Receivable.

**Retainage Rate**
You use this field to specify the method the program will use to determine the exchange rate for the retainage document when outstanding retainage is eventually processed in Accounts Receivable.

You can choose one of the following methods:

- Use Original Document Exchange Rate—to use the same rate as the invoice for this shipment.
- Use Current Exchange Rate—to use the rate in effect when the outstanding retainage is processed in Accounts Receivable.

**Retainage Terms**
You can use different terms for retainage documents (used to invoice for outstanding retainage) than you use for this invoice.

If retainage terms are specified in the A/R customer record, the retainage terms code from the customer record is used as the default retainage terms code for the invoice.
If no retainage terms code is specified in the customer record, the customer’s usual terms code is used as the default.

**Sales Split tab**

Use the Sales Split tab to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

**Percentage**

Enter the percentage of the sale to assign to each salesperson.

You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Salesperson Code**

Enter a salesperson code to add a new salesperson, or to replace a currently assigned salesperson for a transaction.

You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Note:** You set up salesperson codes in Accounts Receivable.
**Salesperson Name**
This field displays the name associated with the salesperson code.

**Note:** You set up salesperson codes in Accounts Receivable.

**Taxes tab**
Use the Taxes tab to select the method you will use to calculate taxes, and to review and change tax information for a document.

**Calculate Tax**
For each Order Entry document, you can specify whether taxes are calculated automatically or entered manually.

If you want Order Entry to calculate tax for this document, select the Calculate Tax option.

**Note:** If the document is job-related and you selected the **Project Invoicing** option, you cannot enter taxes manually. The **Calculate Tax** option is automatically selected, and you cannot change it.

If you want to enter tax amounts manually, do not select the **Calculate Tax** option. If you do not select this option:

- The Dist. Taxes button appears on the screen.
- You can enter tax amounts for the tax authorities listed for the document.

Click Dist. Taxes to prorate tax that you enter manually on the Taxes tab to the document details. For more information, see Entering Taxes Manually.

**Note:** You cannot prorate a tax amount to an authority that uses an exempt tax class.

**Calculate Tax Reporting**
Select this option if you want the program to automatically calculate tax reporting amounts for the document. Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

If you clear this option, you can edit tax reporting amounts.
Note:
- This option appears only if a tax authority has a tax reporting currency that is different from the source or functional currency.
- The default for this check box is determined by the **Calculate Tax Reporting Amounts Automatically** option on the O/E Options screen.

**Tax Reporting Currency**
The fields in this group display the included, excluded, and total tax amounts for the transaction in the tax reporting currency.

**Total Tax**
This field displays the total amount of tax calculated for the transaction (including taxes included in the price), displayed in the customer's currency.

**Note:** The fields in the Tax Reporting Currency group display the total tax in your tax reporting currency.

**Tax Details table**
This table displays information about tax authorities, classes, and amounts for the current document.

If you do not select the **Calculate Taxes** and the **Calculate Tax Reporting** options, you can change the tax base, tax amount, and tax reporting amount for each authority on the document.

**Note:**
You cannot edit information about a tax authority directly on this tab. To change information for a tax authority, you must use the screens in Tax Services.

You can change the tax authorities used by a particular order or invoice by changing the tax group on the Customer tab.

For debit notes and credit notes, however, you **must** use the same tax group as the invoice you are debiting or crediting. (Also, you cannot select a template code or ship-to location that uses a different tax group than the invoice.)
**Authority Description**
This field displays the description for a tax authority.

**Class Description**
This field displays the description for a tax class.

**Customer Tax Class**
This column displays the tax class that is assigned to each tax authority.

If you change the tax class for a tax authority on this screen, click **Calculate Taxes** to see the recalculated tax amount.

**Note:** If the **Calculate Tax** option is selected, the tax amount is recalculated automatically, but is not displayed immediately.

To change the tax class description or make other changes to the information for the specified tax group, use the Tax Services screens in Common Services.

**Registration Number**
If necessary, enter the customer's tax registration or tax exemption number.

**Tax Amount**
If you selected the **Calculate Tax** option, this field displays the amount of tax that is due for each authority.

For each authority, Order Entry calculates a sales tax amount if: The customer is subject to tax. The order contains taxable items or taxable miscellaneous charges. Tax rates are specified for the tax authorities and classes in Tax Services.

If you are entering taxes manually, enter the total tax amount you calculated for each tax authority. Ensure that the amounts you enter agree with the sum of the tax amounts for the details, for each tax authority.

**Tax Authority**
This field displays the tax authorities that are assigned to the tax group specified for the customer in Accounts Receivable.
Tax Base
If you selected the Calculate Tax option, Order Entry displays the transaction total. Any invoice or early-payment discounts are not deducted from this total.

If you are entering taxes manually, enter the total transaction amount in this field.

Tax Reporting Amount
If you selected the Calculate Tax Reporting option, this field displays the tax reporting amount calculated by applying the exchange rate between the source currency and the tax reporting currency.

If you did not select the Calculate Tax Reporting option, you can edit the tax reporting amount in this field.

Note:
- This field appears only if a tax authority for the transaction has a tax reporting currency that is different from the source or functional currency.
- The default for this check box is determined by the Calculate Tax Reporting Amounts Automatically option on the O/E Options screen.

Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

Totals tab
Use the Totals tab to review and edit discounts, totals, and other final document details.

Actual Ship Date
This field appears on the Totals tab when you create an invoice.

Enter the date on which the shipment was sent to the customer. By default, this field displays the current session date, but you can enter another date.

Comment
Enter an optional comment of up to 250 characters for the transaction, and then press Tab to add the comment.
Note: If you do not press Tab, your comment will not be saved.

Comments appear in the Comments section on printed quotes, order confirmations, invoices, picking slips, credit notes, and debit notes.

For more information, see "Adding Comments and Instructions to Order Entry Transactions " (page 101).

Create Invoice

Select this option to create an invoice when you post the transaction.

When you select this option, additional fields appear on the Totals tab, letting you enter an invoice number and an invoice date.

Note:  
- The Create Invoice option appears only if you have shipped goods.
- This option is not available for job-related orders that use project invoicing. If you use project invoicing, all customer invoicing is handled by Project and Job Costing.

Discount Miscellaneous Charges

Select this option if you want to apply the order discount to the miscellaneous charges subtotal. Order Entry prorates the discount specified for the Less Invoice Discount field to miscellaneous charges.

If you do not select this option, the order discount is applied only to the items subtotal.

You can also specify discounts by customer type and early-payment terms. You select the customer type and terms code on the Customer tab.

Estimated Weight

This field displays the estimated weight of the shipment, based on the weight for the units of measure and item quantities specified in the document. (You specify item weights on the I/C Items screen in Inventory Control.)

Tip: Use the estimated weight to calculate shipping costs or postage.
Included Tax
This field displays the total tax amount that is included in item prices and miscellaneous charge amounts.

Invoice Date
If you selected the **Create Invoice** option, enter the invoice date. By default, this field displays the current session date, but you can enter another date.

This date appears as the invoice date on the invoice, and is the date that is used for document aging. The invoice date also appears on invoice transactions in Accounts Receivable.

Invoice No.
If you selected the **Create Invoice** option, this field displays the invoice number assigned when you post an invoice for this shipment. This field is blank until you invoice the shipment.

To view invoice details, click the Drilldown button.

**Note:** After you invoice a shipment, you cannot edit shipment details.

Invoice Posting Date
If you selected the **Create Invoice** option, enter the posting date for the transaction.

Depending on your settings on the O/E Options screen, this field automatically displays either the current session date or the document date. You can enter another date, but you cannot change the fiscal year and period separately.

**Note:**
- The posting date is the date for transactions being posted to General Ledger, so it also determines the contents of the Fiscal Year and Period fields.
- If you use multicurrency accounting, currency revaluation uses posting dates to select open documents for revaluation purposes, ensuring that revaluation adjustments are posted to General Ledger in the correct fiscal year and period.
- If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.
**Items Subtotal**
This field displays the total amount of the item detail lines for the document.

The items subtotal includes tax amounts that are included in item prices, but does not include miscellaneous charge amounts or tax amounts that are charged separately on item prices.

**Less Detail Discount**
This field displays the percentage and total of discount amounts applied to individual detail lines.

**Less Order Discount**
Enter a discount percentage or amount for the order. When you specify a discount in one field, Order Entry calculates the amount or percentage in the other field automatically.

The discount is applied to the items subtotal. If you discount miscellaneous charges as well, it is also applied to the miscellaneous charges subtotal.

**Note:** The order discount is applied after any detail discount has been subtracted from the subtotals.

If you enter a percentage, and then change the fixed amount, an asterisk appears beside the amount field to indicate that the fixed amount calculated from the percentage has been changed. The discount amount will not change unless you re-enter the discount percentage.

**Example:**
Assume that a 33.3333% discount produces a discount amount of 24,999.94.

If you change the amount to 25,000: An asterisk appears beside the amount to show that the calculation was overridden. If you add more item details to the order, the discount percentage will be automatically recalculated for each detail, but the discount amount will not be recalculated unless you re-enter the discount percentage.

**Less Terms Discount Available**
This field displays the amount of any early-payment discount for which the customer might be eligible.

This discount is specified by the terms code assigned to the transaction.
Tip: You edit payment terms for the transaction on the Customer tab.

Note: The number in this field indicates a discount that is currently available, based on the payment terms for the customer. This discount may no longer be available when payment is received.

Less Total Prepayments
This field displays the amount of all prepayments entered for the order.

To apply a prepayment to a specific invoice, enter the prepayment with the invoice. Prepayments made to the order are applied to invoices when they are posted in Accounts Receivable.

Misc. Charges Total
This field displays the total amount of the miscellaneous charge detail lines for the document.

The miscellaneous charges subtotal includes tax amounts that are included in miscellaneous charge amounts, but does not include item prices or tax amounts that are charged separately on miscellaneous charge amounts.

Net Amount
This field displays the total amount of all items and miscellaneous charges for the document, after any discounts have been subtracted. The net amount also includes tax amounts that are not included in item prices or miscellaneous charge amounts.

Net of Detail Discount
This field displays the total amount of all items and miscellaneous charges on the document, minus the total amount of discounts applied on individual detail lines.

Number of Labels
Use this field to specify the number of labels you need to print.

You can print labels for the order (for example, to send an order confirmation), and you can print shipping labels for each invoice.

No. of Lines
This field displays the total number of detail lines (for items and
miscellaneous charges) entered for the document.

If you are not invoicing the entire order, this field still displays the total number of detail lines (including those you are not invoicing).

Tip: Use this number to be sure you have entered all the details you need and deleted any unused details.

Order Subtotal
This field displays the total amount of all items and miscellaneous charges for the document, before any discounts have been subtracted.

The subtotal includes tax amounts that are included in item prices and miscellaneous charge amounts, but does not include tax amounts that are charged separately on item prices or miscellaneous charge amounts.

Outstanding Order Amount
This field displays the total amount owing on the order, assuming that all items on the order are shipped and invoiced. (You could think of this as the projected invoice amount.)

Plus Excluded Tax
This field displays the total amount of taxes calculated on the items and miscellaneous charges for the document.

The amount in this field does not include tax amounts that are included in item prices or miscellaneous charge amounts.

Shipment No.
Order Entry displays the shipment number for each detail, indicating the source of the detail, if you are invoicing more than one shipment.

You can click the Drilldown button to view all the details for the shipment.

Total
This field displays the total amount, including taxes. This amount does not include invoice prepayments or early-payment discounts.

Total Tax
The total amount of tax calculated for the invoice, including taxes
included in the price.
O/E Project and Job Costing Apply Details Screen

To open this screen:
1. Open Order Entry > O/E Transactions.
2. Select Order Entry, Shipment Entry, or Invoice Entry.
3. Click the Prepayment button.
4. Click the Jobs button.

Related tasks:
- "Entering a Prepayment " (page 109)
- "Processing a Credit Card Prepayment " (page 112)
- "Voiding a Credit Card Prepayment " (page 114)

Overview

Use the O/E Project and Job Costing Apply Details screen to apply prepayments to job details.

Note: The prepayment amount on a job-related order can exceed the document total. However, the sum of the prepayment amounts for individual details must match the prepayment total.

You can apply prepayments in the following ways:

- **Apply by Amount.** Click this button to prorate payment amounts to all details.
- **Apply Top Down.** Click this button to do a "top-down" distribution, starting at the first job-related detail.
- **Manually edit payment amounts.** You can directly enter or change payment amounts for individual details.

Note: If you click Apply by Amount or Apply Top Down after manually entering or changing payment amounts, Order Entry overwrites the amounts you entered.

Fields and Controls

Buttons

Apply by Amount
Click **Apply by Amount** to apply the prepayment amount to jobs proportionally, based on net extended price.

**Example:**
Your document includes two jobs: Job #1 (net extended price of $75.00) and Job #2 (net extended price of $25.00). You have a prepayment of $10.00.

If you click **Apply by Amount**, Order Entry applies the prepayment as follows:

- Job #1: $7.50
- Job #2: $2.50

**Note:** If you click **Apply by Amount** or **Apply Top Down** after manually entering or changing payment amounts, Order Entry overwrites the amounts you entered.

---

**Apply Top Down**
Click **Apply Top Down** to use the prepayment to fully pay for as many jobs as possible, beginning with the first job that is listed.

**Example:**
Your document includes four jobs, each with a net extended price of $20.00. You have a prepayment of $50.00.

If you click **Apply Top Down**, Order Entry applies the prepayment as follows:

- Job #1: $20.00
- Job #2: $20.00
- Job #3: $10.00
- Job #4: $0.00

**Note:** If you click **Apply by Amount** or **Apply Top Down** after manually entering or changing payment amounts, Order Entry overwrites the amounts you entered.

---

**Clear**
Click **Clear** to clear all applied amounts.
**Close**
Click **Close** to close the screen.

**Table**
All the jobs for the document are listed in the table on this screen. The only field you can edit in the table is **Applied Amount**.

**Applied Amount**
Enter the prepayment amount to apply to a job.

You can enter amounts automatically (by clicking **Apply by Amount** or **Apply Top Down**). You can also enter amounts manually.

---

**Note:** The sum of the applied amounts must match the prepayment amount.

**Billing Type**
Indicates whether the item or charge is billable or non-billable.

**Category**
Displays the Project and Job Costing category.

**Contract**
Displays the contract number.

**Cost Class**
Displays the cost class used for the detail.

**Description**
Displays the description of the item or miscellaneous charge.

**Item No.**
Displays the item number.

**Kit/BOM**
For items that are part of a kit or BOM, this field displays the number of the kit or BOM.

**Line Number**
Each detail line in the table is automatically assigned a line number,
which cannot be changed.

**Location**
Displays the physical location where an item is located.

**Misc. Charge**
Displays the miscellaneous charge code.

**Net Ext. Price**
Displays the net extended price for the detail.

**Project**
Displays the project number.

**Type**
Displays the type of detail (Item or Miscellaneous).
O/E Bank Rate Screen

To open this screen:

1. Open Order Entry > O/E Transactions.
2. Select Order Entry, Shipment Entry, or Invoice Entry.
3. Click the Prepayment button.
4. Beside the Currency field, click the Zoom button.

Related tasks:
- "Entering a Prepayment " (page 109)

Overview

In a multicurrency system, you use the O/E Bank Rate screen to specify the bank rate (and related details) for a prepayment.

Note: This is only necessary if the currency of the prepayment is different from your functional currency.

Fields and Controls

Bank Code
This field displays the bank code and description for the batch.

Note: Each batch is for a single bank.

Bank Rate
This field displays the exchange rate associated with the currency, rate date, and rate type specified. To change the rate, enter the new rate or select it from the Finder.

The bank rate is the rate at which the prepayment amount will be converted to the functional currency.

Currency
You cannot change the currency for an existing batch. Order Entry uses the receipt currency specified for the existing batch.
If this is a new batch, enter the code for the currency in which you want to add prepayments to the batch, or choose the currency code from the Finder beside the Currency field. You must select a currency that is used by the specified bank.

If you have created a new batch, but if another user adds a receipt in a different currency to this new batch before you post the order (changing the default batch currency), Order Entry will report an error when you post, and you will have to select a different batch.

**Rate Date**

Enter the date for selecting the exchange rate associated with the rate type.

The program displays the session date, but you can change it.

**Rate Type**

Enter the code for the rate type to use when selecting the bank rate for the prepayment.

The program displays the rate type assigned to the currency table in Common Services, but you can change it to another of the rate types defined for your Sage 300 ERP system.
O/E BOM Components Screen

To open this screen:
1. Open Order Entry > O/E Transactions.
2. Select a transaction entry screen, such as Order Entry.
3. On the Details table, select a detail line for a BOM item.
4. Click Components.

Related tasks:
- "Entering an Order " (page 92)
- "Shipping Orders and Items " (page 120)
- "Invoicing Shipments " (page 116)

Overview

Use the O/E BOM Components screen to review the components that make up a BOM (bill of materials).

Fields and Controls

Component's BOM Number
A bill of materials can include a component that is also a BOM. The Component's BOM Number field displays the identifying number of this BOM within a BOM.

Component Item Number
Displays the item number for a component.

Description
Displays the description for a component.

Qty. Invoiced
Displays the quantity of a component included in the invoice (calculated based on the number of BOMs invoiced).

Qty. Ordered
Displays the quantity of a component included in the order (calculated based on the number of BOMs ordered).
**Qty. Shipped**
Displays the quantity of a component included in the shipment (calculated based on the number of BOMs shipped).

**Unit of Measure**
Displays the unit of measure for a component.
O/E Confirmation Screen

To open this screen:

1. Open Order Entry > O/E Transactions.
2. Select a transaction entry screen, such as Order Entry.
3. Enter transaction information, and then click Post.

Related tasks:

- "Entering an Order " (page 92)
- "Entering a Prepayment " (page 109)
- "Shipping Orders and Items " (page 120)
- "Invoicing Shipments " (page 116)

Overview

Use the O/E Confirmation screen to select documents and forms (such as invoices, picking slips, and receipts) that you want to print after posting a transaction.

Note: The documents and forms you can print depend on the type of transaction you are posting.

Fields and Controls

Check/Receipt Number

When you post a shipment for which a prepayment has been made by check, this field displays the number of the check/receipt.

Invoice

Select this option to print an invoice for the posted transaction.

Invoice Number

This field displays the invoice number associated with the posted transaction.

Order Confirmation

Select this option to print an order confirmation for the posted transaction.
**Order Number**
This field displays the order number associated with the posted transaction.

**Prepayment Receipt**
Select this option to print a prepayment receipt for the posted transaction.

**Shipment Number**
This field displays the shipment number associated with the posted transaction.

**Shipment Picking Slip**
Select this option to print a shipment picking slip for the posted transaction.
O/E Create Order from Quotes Screen

To open this screen:

1. Open **Order Entry > O/E Transactions > Order Entry**.

2. Do one of the following:
   - Click the Zoom button to the right of the **From Multiple Quotes** option.
   - Select the **From Multiple Quotes** option, and then press the F9 key.

Related tasks:

- "Entering a Quote " (page 87)
- "Entering an Order " (page 92)

Overview

Use the O/E Create Order from Quotes screen to select multiple quotes from which to create a new order.

If you wish, you can reuse quotes from which you have already produced an order.

When you create the new order, Order Entry assigns the PO Number from the first quote you select to the new order. Other information for the order comes from the order template.

Note:

- You must select quotes before you add any detail lines for the new order. If you have added detail lines to the order, you must delete them before you can select quotes.
- If you are using Sage 300 ERP integrated with Sage CRM, you cannot use this option to select multiple quotes that belong to different opportunities in Sage CRM.
O/E Customer Bill-To Address Screen

To open this screen:

1. Open Order Entry > O/E Transactions.
2. Select a transaction entry screen, such as Order Entry.
3. Beside the Customer No. field, click the Zoom button.

Related tasks:
- "Invoicing Shipments " (page 116)

Overview

Use the Customer Bill-To Address screen to:

- Review or edit billing information for a customer.
- Enter billing information for a new customer number you have specified on an order but have not yet added to Accounts Receivable.

Fields and Controls

Address
Enter the street address for the billing location.

Bill-To Name
Enter a name to include as part of the billing address.

City
Enter the name of the city for the billing address.

Contact
Enter a name for the contact person, position, or department.

Contact E-mail
Enter an e-mail address for the contact person, position, or department.

Contact Fax
Enter a fax number for the contact person, position, or department.

Contact Phone
Enter a telephone number for the contact person, position, or department.
Appendix A: Order Entry Screen Guides

**Country**
Enter the name of the country for the billing address.

**Customer No.**
Displays the customer number you entered in the **Customer No.** field on the transaction entry screen.

**E-mail**
Enter an e-mail address for the billing location.

**Fax**
Enter a fax number for the billing location.

**Phone**
Enter a telephone number for the billing location.

**State/Province**
Enter the name of the state or province for the billing address.

**Zip/Postal Code**
Enter the zip or postal code for the billing location.
O/E Ship-To Address Screen

To open this screen:
1. Open Order Entry > O/E Transactions.
2. Select a transaction entry screen, such as Order Entry.
3. Beside the Ship-To Location field, click the Zoom button.

Related tasks:
- "Shipping Orders and Items" (page 120)

Overview

Use the O/E Ship-To Address screen to:
- Review or edit shipping information for a customer.
- Enter shipping information for a new customer number you have specified on an order but have not yet added to Accounts Receivable.

Fields and Controls

Address
  Enter the street address for the shipping location.

City
  Enter the name of the city for the shipping address.

Contact
  Enter a name for the contact person, position, or department.

Contact E-mail
  Enter an e-mail address for the contact person, position, or department.

Contact Fax
  Enter a fax number for the contact person, position, or department.

Contact Phone
  Enter a telephone number for the contact person, position, or department.

Country
  Enter the name of the country for the shipping address.
**Customer No.**
Displays the customer number you entered in the **Customer No.** field on the transaction entry screen. The name associated with the customer appears in the description field to the right.

**E-mail**
Enter an e-mail address for the shipping location.

**Fax**
Enter a fax number for the shipping location.

**Phone**
Enter a telephone number for the shipping location.

**Ship-To Location**
If you selected a ship-to location code, it appears in this field. You cannot change the ship-to location code on this screen.

**Ship-To Name**
Enter a name to include as part of the shipping address.

**State/Province**
Enter the name of the state or province for the shipping address.

**Zip/Postal Code**
Enter the zip or postal code for the shipping location.
O/E Items/Taxes Screen

To open this screen:

1. Open Order Entry > O/E Transactions.
2. Open Order Entry, Shipment Entry, or Invoice Entry, or Credit/Debit Note Entry.
3. Click the Item/Tax button.

Secondary screens:

- "O/E Kitting Components Screen " (page 481)
- "O/E BOM Components Screen " (page 451)
- "O/E Price Approval Screen" (page 499)
- "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501)
- "O/E Shipments/Invoices Screen" (page 500)

Related tasks:

- "Copying Orders " (page 104)
- "Entering an Order " (page 92)
- "Editing an Order" (page 100)
- "Entering Taxes Manually " (page 183)
- "Invoicing Shipments " (page 116)
- "Shipping Orders and Items " (page 120)

Overview

Use the O/E Items/Taxes screen to add, edit, and delete items and charges, and to change tax information for items and charges.

This screen displays details for a single item or charge on a screen, rather than in a table row, making it easier for you to review and modify information without scrolling.
Optional Fields

If optional fields are assigned to an item or charge, you can use the Optional Fields tab to enter information in those fields. (The Optional Fields tab appears only if there are optional fields assigned to this item or charge.) For more information, see "About Optional Fields" (page 58).

**Note:** If a optional field is required but does not have a default value specified, you must specify a value for the field before saving.

Tax Table

On the tax table on this screen, you can change a tax class to another tax class that is assigned to the authority, and you can double-click the **Tax Included** field to specify Yes or No.

If you are entering taxes manually (that is, if you did not select the **Calculate Tax** option), you can also change the tax base and the tax amount.

**Note:** On the Totals tab of each transaction entry screen, you can review tax amounts for a document and compare the totals on the screen with the totals on the source document.

Inventory Quantities

Below the tax information table, inventory quantities are displayed for the item. Quantities are displayed for the location specified in the detail, and for all locations.

You can click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed.

**Note:** Inventory quantities are displayed in the unit of measure defined for the item.

Customer and Manufacturers' Item Numbers

If a manufacturer's item number or customer item number is associated with an item, you can enter that number in the **Item Number** field. When you click or tab out of the field:

- Order Entry replaces the number you entered with the inventory item number.
- The associated manufacturer's item number and/or customer item numbers appear in the **Manufacturer's Item Number** and/or **Customer Item Number** fields.

- If you entered a manufacturer's item number that is associated with multiple inventory item numbers, the Finder displays those inventory numbers so you can select one.

**Fields and Controls**

**Amount**
Enter or accept the amount of the miscellaneous charge.

**Note:** This field appears only for miscellaneous charges.

**A/R Item No.**
If the document is job-related and you are using project invoicing, this field displays the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.

**A/R Item Unit of Measure**
If the document is job-related and you are using project invoicing, this field displays the unit of measure for the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.

**B/O**
If Order Entry uses the **Calculate Backorder Quantities** option (on the O/E Options screen), and if the customer record in Accounts Receivable allows backordered quantities, Order Entry automatically calculates the quantity backordered by subtracting the quantity shipped from the quantity ordered.

If Order Entry does not automatically calculate quantities and you are not shipping the entire order, enter the quantity backordered.

Each time you enter a shipped amount, the backordered quantity is reduced. When the backordered amount is zero, the item is considered to be fully shipped, and its status is set to Completed.

**Tip:** To cancel unshipped quantities of an order, enter 0 (zero) in this field.
**Billing Type**
If the document is job related, this field indicates whether the item or charge is billable or non-billable.

**Category (Inventory)**
This field displays the category assigned to the item record in Inventory Control. You can use the Finder to select a different category.

**Category (Job Related)**
This field appears if you selected the Job Related option for the document.

For job-related orders, specify the category to use for this item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than “Category” in Project and Job Costing, that term appears as the label for this field.
- Use the Item Number field to specify the resource.
- After you add the detail, you cannot edit this field.

**COGS Acct.**
If the document is job-related and you are not using project invoicing, this field displays the default Cost Of Goods Sold account from Project and Job Costing for the item or charge.

**Comments/Instructions**
This field indicates whether there are comments or instructions entered for the detail, and also allows you to add comments or instructions. For more information, see "Adding Comments and Instructions to Order Entry Transactions " (page 101).

**Note:**
- Comments for a detail line appear in the Description column on printed quotes, order confirmations, invoices, credit notes, and debit notes.
Instructions for a detail line appear in the **Description** column on printed picking slips.

**Completed**

The status of a detail is automatically set to Completed when you post a shipment for all ordered units for the detail, or when you enter 0 (zero) in the **Quantity Backordered** field.

You can also set the status for a detail to Completed manually, by selecting the **Completed** option. The unshipped quantity will be listed as lost sales on the O/E Sales Statistics report after the order is processed by Day End Processing.

**Contract**

This field appears if you selected the **Job Related** option for the transaction.

For job-related orders, specify the contract to use for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**

- If you use a term other than “Contract” in Project and Job Costing, that term appears as the label for this field.
- Use the **Item Number** field to specify the resource.
- After you add the item or charge, you cannot edit this field.

**Costing UOM**

This field displays the costing unit of measure specified in the item record.

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

**Customer Item No.**

If you set up customer item numbers in Inventory Control, this field displays the customer item number associated with the inventory item number in the **Item Number** field.

You can change the number that appears in this field, or you can enter a number if one does not appear by default.
Appendix A: Order Entry Screen Guides

Note: If you enter the customer item number in the Item Number field (instead of entering the inventory item number), Order Entry replaces the number you enter with the associated inventory item number, and displays the customer item number in the Customer Item No. field.

You use the I/C Customer Details screen to add customer item numbers for inventory items. For more information, see the Inventory Control help.

Deliver By
If your customer has requested delivery of the item by a specific date, enter that date in this field. By default, this field displays the requested delivery date entered in the Deliver By field for the document, but you can change it.

Discount %
You can specify a separate discount percentage or amount for each detail in an Order Entry transaction.

If you override the discount percentage in the amount field, Order Entry displays an asterisk beside the field on the O/E Items/Taxes screen to show that the amount was overridden.

You can also enter a discount percentage or amount for the transaction on the Totals tab.

Discount Amount
You can specify a discount percentage or amount for each detail on an order, shipment, invoice, credit note, or debit note.

If you override the discount percentage in the amount field, Order Entry displays an asterisk beside the field in the popup detail entry screen to show that the amount was overridden.

You can still enter a discount for the whole document, if you like. Order Entry displays the discount amount for the transaction details, as well as the discount for the whole document, on the Totals tab summary.

Discounted Ext. Amt.
This field displays the amount for the detail after the discount is applied.

Exp. Ship Date
Enter the date you expect to ship the item. By default, this field displays the expected shipment date entered for the document, but you can change it.
**Ext. Cost**
This field appears if you selected the **Job Related** option for the document.

Extended cost is the cost amount for the miscellaneous charge. It can also be used in Project and Job Costing to calculate labor and overhead. For more information, see Project and Job Costing help.

**Ext. Price**
Enter the extended price for the detail, or accept the calculated value.

Extended price refers to the extended price of an order (that is, the total cost of the items being ordered, whether or not they have been shipped). It is calculated automatically when you enter an order quantity. Sage 300 ERP divides the unit price by the pricing unit of measure conversion factor, and then multiplies the result by the order unit of measure conversion factor and the quantity ordered.

If you change the extended price calculated by the program, an asterisk appears beside the **Ext. Price** field on the O/E Items/Taxes screen, and also appears beside the item on the O/E Transaction List report.

**Ext. Weight**
This field displays the extended weight, which is calculated by multiplying quantity shipped by the unit weight entered for the item in Inventory Control.

You might use extended weight to determine postage, shipping, or other charges.

You can edit the item weight and the extended weight on the transaction entry screen if necessary.

Order Entry converts the extended weight for each detail to the order weight unit of measure, and displays the estimated weight for the entire order on the Totals tab.

**Item Description**
This field displays the description from the item price list for the item selected in the **Item Number** field.

This description appears on printed order confirmations, picking slips, and invoices. You can use the default description or enter a new description to be used for an individual order.

In a multicurrency system, the description from the item record appears here if the price list does not include a price in the customer’s currency.
**Item Number**
Enter the number for the item. Order Entry displays information from the Inventory Control item record, including item description, pricing unit, and unit price information based on the customer's price list.

If a manufacturer's item number or customer item number is associated with an item, you can enter that number in the **Item Number** field. When you click or tab out of the field:

- Order Entry replaces the number you entered with the inventory item number.
- The associated manufacturer's item number and/or customer item numbers appear in the **Manufacturer's Item Number** and/or **Customer Item Number** fields.
- If you entered a manufacturer's item number that is associated with multiple inventory item numbers, the Finder displays those inventory numbers so you can select one.

**Note:** After you add an item, you can no longer change its item number.

**Kit/BOM**
If the selected item is part of a kit or a BOM (bill of materials) in Inventory Control, enter the kit or BOM number.

After you enter the number, you can view the details for the kit or BOM by clicking the **Zoom** button to the right of the field.

**Note:**
- You can create kits from stock or non-stock items in Inventory Control and then use them in Order Entry. You can also enter or post multiple kitting entries (or mix kitting entries with regular entries) on any Order Entry transaction entry screen.
- You can include kit components and BOM components when printing order confirmations, quotes, picking slips, invoices, credit notes, and debit notes.
- When you print the O/E Transaction List report and select Detail as the report type, the report displays kit components and BOM components.
- When you print the O/E Posting Journals report, it includes actual breakdown amounts for each kit component.
**Line Number**
This field displays the line number assigned to the detail (in the Detail table on the main screen). You can select a different line number to edit a different detail.

**Note:** You can list items on picking slips by line number.

**Line Type**
Select the type of detail you are entering:

- **Item.** Adds a detail line for an inventory item or non-stock item that is assigned an item number in Inventory Control.

- **Miscellaneous.** Adds a detail line for a miscellaneous charge defined in Order Entry.

**Location**
By default, this field displays the location code specified for the order. You can change the location for individual details.

Optionally, enter the code for the physical location from which you will ship the items ordered on the detail line.

You must specify a physical location, not a logical inventory location. Logical locations are used primarily for transferring goods between physical locations in Inventory Control.

**Note:** You cannot change the location for a serialized or lotted item after you enter a quantity in the **Quantity Ordered** field.

**Tip:** You can click the **LocationFinder** to see the quantity on hand at other locations.

**Manuf. Item No.**
If you set up manufacturers' item numbers in Inventory Control, this field displays the manufacturer's item number (usually a bar code) associated with the inventory item number in the **Item Number** field.

You can change the number that appears in this field, or you can enter a number if one does not appear by default.

**Note:**
- If you enter the manufacturer's item number in the **Item Number** field
(instead of entering the inventory item number), Order Entry replaces the number you enter with the associated inventory item number, and displays the manufacturer's item number in the **Manuf. Item No.** field.

- If you entered a manufacturer's item number that is associated with multiple inventory item numbers, the Finder displays those inventory numbers so you can select one.

You use the I/C Manufacturers' Items screen to add customer item numbers for inventory items. For more information, see the Inventory Control help.

**Miscellaneous Charge**

Enter the code for the miscellaneous charge.

The description field to the right of the **Miscellaneous Charge** field displays the description from the miscellaneous charge record. This description appears on printed order confirmations, picking slips, and invoices. You can use the default description or enter a new description to be used for an individual order.

**Note:** After you add a charge, you can no longer change its miscellaneous charge code.

**Optional Fields**

If you use optional fields, you can review and edit optional fields by clicking the **Optional Fields** column heading. (If you are using the O/E Items/Taxes screen, click the Zoom ▲ button beside the **Optional Fields** option.)

If an optional field is required, you cannot save the transaction unless the field has a default value, or until you fill in the field yourself.

To add optional item fields that were not automatically inserted, press the Insert key to add a new line to the table, and then use the Finder Q to select an optional field.

Optional fields must be assigned to the transactions screens using the O/E Optional Fields screen before you can add them to individual transactions. For more information, see "O/E Optional Fields Screen" (page 349).

**Original Order**

This field displays the quantity specified when the detail was first entered.
and posted. This number does not change even if you change the quantity ordered for the detail.

**Non-Stk. Clr. Acct.**
If you selected a non-stock item, the non-stock clearing account used by the item's account set appears as the default in this field. You can change the account number if necessary.

**Price By**
This field indicates whether the item is priced by weight or by quantity.

- If pricing is by quantity, Sage 300 ERP sets volume discount amounts or percentages according to the quantity of goods that are ordered.
- If pricing is by weight, Sage 300 ERP sets volume discount amounts or percentages by item weight.

Item weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Note:** Pricing by weight is available in Sage 300 Premium ERP only.

**Price List**
By default, this field displays the price list code you specified on the Customer tab.

If necessary, enter the code for the price list to use for the detail line.

**Note:** If you enter a non-stock item, the price list can be blank.

**Pricing UOM**
This field displays the unit of measure (UOM) in which the item is priced.

Sage 300 Premium ERP supports multiple pricing units of measure, but you must set one as the default on the I/C Item Pricing screen in Inventory Control.

The pricing UOM is determined by the price list as follows: If the price list provides only one pricing UOM, that UOM appears here. If the price list provides several pricing UOMs, the pricing unit that matches the order UOM appears here. If no pricing UOM matches the order UOM, the default pricing UOM appears here. If you price by cost, the default pricing UOM appears here, and the cost-based price appears in the Unit Price field.
Note: If the item is not on the specified price list, the program uses the item's stocking unit as the pricing unit.

**Project**
This field appears if you selected the Job Related option for the document.

For job-related orders, specify the project for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than “Project” in Project and Job Costing, that term appears as the label for this field.
- Use the Item Number field to specify the resource.
- After you add the item or charge, you cannot edit this field.

**Qty. Available**
Displays the inventory quantity that is available for sale to your customers. This is determined by the quantity on hand less the quantity committed, as maintained in Inventory Control.

**Qty. Committed (document)**
Specify an inventory quantity to commit to the order. When it is time to ship the order, the quantity is guaranteed to be available (unless you allow negative inventory quantities).

If a quantity is already committed to an order, you can ship another order for the same items only if there is a sufficient quantity in inventory in addition to the committed quantity.

**Qty. Committed (inventory)**
Displays the inventory quantity that is committed to orders.

By committing an inventory quantity to an order, you ensure that the required inventory will be available when it is time to ship the order. (If a quantity is already committed to an order, you cannot ship another order for the same items unless there is a sufficient quantity in inventory in addition to the committed quantity.)
Transaction Screens

Tip: You can click the Drilldown button to the right of the displayed quantities to view more information (such as the customer and the expected ship date).

Qty. Ordered
Enter the number or quantity of the item or charge to include in the order.

Make sure that the number or quantity you enter uses the unit of measure specified in the UOM field. For example, if the UOM is "Case" and the order is for two cases, enter 2 in the Quantity Ordered field.

Note:
- The Allow Fractional Quantities option on the I/C Options screen in Inventory Control determines whether you can use decimals in the Quantity Ordered field. For more information, see Inventory Control help.
- If the detail is not completed (indicated in the Completed field), you can change the quantity ordered for items that have not been shipped and invoiced.
- If you are unable to ship all the items on an order, and want to cancel unshipped items, you can edit the details to reduce the quantities ordered so they match the quantities shipped.
- If the item is serialized or lotted and Inventory Control allows the allocation of serial numbers or lot numbers to order quantities, the O/E Serial/Lot Numbers Allocation screen appears after you enter the quantity ordered and leave the field. (The Inventory Control option Use the Qty Ordered Field in OE determines whether you can allocate serial numbers or lot numbers using order quantities.) You use the O/E Serial/Lot Numbers Allocation screen to allocate serial numbers or lot numbers for the quantity of items ordered. For more information, see O/E Serial/Lot Numbers Allocation/Generation Screen.

Qty. Shipped
If necessary, enter the quantity shipped or to be shipped on an active order.

Usually, you create invoices when you ship items to a customer. However, you can enter a quantity shipped even if you are not ready to produce an invoice.

Note:
If the item is serialized or lotted and you did not allocate serial numbers or...
lot numbers to the quantity ordered, the O/E Serial/Lot Numbers Allocation screen appears after you enter the quantity shipped and leave the field. You use this screen to allocate serial numbers or lot numbers for the quantity of items ordered. For more information, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

If Inventory Control allows the allocation of serial numbers or lot numbers to order quantities (controlled by the **Use the Qty Ordered Field in OE** option), you can ship only the serial and lot numbers already allocated from the **Quantity Ordered** field. (You cannot use the O/E Serial/Lot Numbers Allocation screen to allocate numbers using the **Quantity Shipped** field.)

**Retainage Percentage (%)**

Enter the retainage percentage to be used when calculating the retainage amount for the item or charge.

When you edit this field, the retainage amount for the item or charge is calculated automatically.

**Retention Period**

The retention period is the number of days for which the customer can withhold the retainage amount.

You issue the retainage invoice in Accounts Receivable at the end of the retention period.

**Revenue Acct.**

If the document is job-related and you are not using project invoicing, you also specify the revenue/billing account for each item or charge.

The default account number is specified in Project and Job Costing, and is used instead of the sales account specified for the item in the item category record.

**Shipped To Date**

This field displays the number of item units that have been shipped to date for the detail.

You can click the Drilldown button to open the O/E Shipments/Invoices screen and view shipment and invoice information for the detail. For more information, see "O/E Shipments/Invoices Screen" (page 500).
Ship Via and Description

In the Ship Via field, enter the ship-via method for the detail. When you navigate out of this field, the description from the ship-via record for the selected ship-via code appears in the related Description field.

**Note:** You can specify a separate ship-via method for each detail.

Tracking No.

If you use tracking (waybill) numbers to track shipments that use different carriers or that are shipped at different times, enter the tracking number to use for the detail.

Unit Cost

You enter the unit cost for an item only if the item uses the user-specified costing method in Inventory Control (that is, if User-Specified appears in the Costing Method field on the I/C Items screen).

For more information, see "Inventory Costing Methods" (page 33).

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

UOM

This is the unit of measure in which you are shipping item quantities for the detail. You can select a different unit of measure if necessary.

Make sure that the amount in the Quantity Ordered field uses this unit of measure.

Depending on your settings on the O/E Options screen, this field displays either the item weight unit (from the item record in Inventory Control) or the pricing weight unit (from the price list in Inventory Control). Stocking units and pricing units are defined for individual items in Inventory Control, and they may be different. For example, you may use "Dozen" as the stocking unit for an item, but "Each" as the pricing unit.

For more information, see "About Order Unit of Measure" (page 19).

Unit Price

By default, this field displays the lowest unit price for which the customer is eligible. This may be the base price, a sale price for a specified time period, or the price specified for the customer's price level or the quantity purchased, based on a discount or markup.

If necessary, enter the price for the item, per pricing unit.
Note:
- If price checks are in effect, and the unit price is outside the allowed limit, the price must be approved. For more information, see "About Price Checks" (page 82).

- You can edit the information in this field only if you have Unit Price Override security authorization in Order Entry.

- If the item is not on the price list you specified for the detail, no price appears.

- If the lowest price is a negative amount, it is displayed as zeros.

- If you set up contract pricing for a customer in Inventory Control, Order Entry uses that information to calculate prices for items affected by the customer’s pricing contract, and it displays the contract price by default in this field.

- If you do not set up contract pricing for a customer, Order Entry calculates prices based on the customer type and the price lists you set up in Inventory Control.

- If the price list you select is not currently in effect: The Unit Price Finder does not appear. (That is, the Finder does not appear if the document date is not between the Price List Starts date and the Price List Ends date specified for the item, currency, and price list code on the I/C Item Pricing screen.) The Unit Price field displays 0.000000 by default.

- The number of decimal places that appear in this field is determined by the information specified for the item on the I/C Item Pricing screen.

Unit Weight
Unit weight is the weight of a single item for this detail, expressed in the order weight unit of measure. You can edit the weight that appears in this field.

To calculate the extended weight, multiply the unit weight by the quantity ordered.

If you are pricing by weight, the unit weight and extended weight determine the price. Otherwise, the weight is used only to determine the total order weight for estimating shipping costs.

Weight UOM (unit of measure)
This is the unit of measure for weighing this item on the order. You can
select a different unit of measure if necessary.

Depending on your settings in O/E Options, this field displays either the item weight unit (from the item record in Inventory Control) or the pricing weight unit (from the price list in Inventory Control).

The order weight unit of measure for the complete order is determined by the default weight unit of measure specified on the I/C Options screen.

**Note:**
- If the item is not priced by weight, this field displays the item weight unit from the item record.
- If the item is priced by weight, and it has base prices for multiple units of measure, this field displays the default unit of measure from the price list if your Default Order Weight UOM in O/E Options is the Pricing Weight Unit.

**WIP Acct.**

If the document is job-related and you are using project invoicing, you also specify the WIP (Work in Progress) account for each order detail.

By default, this field displays the account number specified in Project and Job Costing.

**Note:** The level at which the WIP account is specified in Project and Job Costing depends on the project type and accounting method.

**Tax table**

**Tax Amount**

If you selected the **Calculate Tax** option, this field displays the amount of tax that is due for each authority.

For each authority, Order Entry calculates a sales tax amount if: The customer is subject to tax. The order contains taxable items or taxable miscellaneous charges. Tax rates are specified for the tax authorities and classes in Tax Services.

If you are entering taxes manually, enter the total tax amount you calculated for each tax authority. Ensure that the amounts you enter agree with the sum of the tax amounts for the details, for each tax authority.
**Tax Authority**
This field displays the tax authorities that are assigned to the tax group specified for the customer in Accounts Receivable.

**Tax Base**
If you selected the **Calculate Tax** option, Order Entry displays the transaction total. Any invoice or early-payment discounts are not deducted from this total.

If you are entering taxes manually, enter the total transaction amount in this field.

**Tax Class**
This column lists the tax classes assigned to the tax authority. On this screen, you can change the tax class, but not the description.

To change the tax class description or make other changes to the information for the specified tax group, use the Tax Services screens in Common Services.

Tax classes determine whether customers are subject to or exempt from particular taxes.

**Tax Description**
These columns lists descriptions for tax classes that are assigned to the tax authority. On this screen, you can change the tax class, but not the description.

To change the tax class description or make other changes to the information for the specified tax group, use the Tax Services screens in the Common Services folder.

Tax classes determine whether customers are subject to or exempt from particular taxes.

**Tax Included**
Double-click this field to specify whether tax amounts are included in the item price or miscellaneous charge amount.

**Note:** You can select Yes only if the tax authority (defined in Tax Services) allows the tax to be included in the price.
**O/E Kitting/BOM Components Screen**

**To open this screen:**
1. Open **Order Entry > O/E Transactions**.
2. Select a transaction entry screen, such as **Order Entry**.
3. On the Details table, select a detail line for a kitting item or a BOM item.
4. Click the **Details** button.

**Related tasks:**
- "Entering an Order " (page 92)
- "Shipping Orders and Items " (page 120)
- "Invoicing Shipments " (page 116)
- "Allocating Serial Numbers or Lot Numbers to an Order " (page 157)
- "Allocating Serial Numbers or Lot Numbers to a Shipment " (page 161)
- "Allocating Serial Numbers or Lot Numbers to an Invoice " (page 164)
- "Allocating Serial Numbers or Lot Numbers to a Credit Note " (page 167)
- "Allocating Serial Numbers or Lot Numbers to a Debit Note " (page 171)

**Overview**

Use the O/E Kitting Components screen or O/E BOM Components screen to:
- Review the components that make up a kit or BOM.
- Enter serial/lot numbers for kitting components, if necessary.
- Enter unit prices for kitting components, if you do not want to use the default unit prices.

**Fields and Controls**

**Component BOM Number**
A bill of materials can include a component that is also a BOM. The **Component BOM Number** field displays the identifying number of this BOM within a BOM.
**Component Item Number**
Displays the item number for a component.

**Costing UOM**
Displays the unit of measure used for the unit cost of a component.

**Description**
Displays the description for a component.

**Extended Weight**
The quantity shipped multiplied by the unit weight.

**Invoice UOM**
Displays the unit of measure used for stocking a component.

**Kitting Quantity**
Displays the quantity of a component included in the kit.

**Non-Stock Clearing Account**
For a component that is a non-stock item, this field displays the non-stock clearing account used by the item’s account set.

**Order UOM**
Displays the unit of measure used for stocking a component.

**Quantity Available**
Displays the available quantity of a component at the location specified in the detail for the kit or BOM. You can click the quantity number displayed in this field to see more inventory details for the component.

**Quantity Invoiced**
Displays the quantity of a component included in the invoice (calculated based on the number of kits or BOMs invoiced).

**Quantity Ordered**
Displays the quantity of a component included in the order (calculated based on the number of kits or BOMs ordered).

**Quantity Shipped**
Displays the quantity of a component included in the shipment (calculated based on the number of kits or BOMs shipped).
**Serialized/Lotted**
Indicates if a component is a serialized or lotted item.

**Shipment UOM**
Displays the unit of measure used for stocking a component.

**Unit Cost**
Displays the unit cost of a component.

**Unit of Measure**
Displays the unit of measure for a component.

**Unit Weight**
Displays the weight of a component.

**Weight UOM**
Displays the unit of measure used for weighing a component.

**Weight UOM Description**
Displays a description of the unit of measure used for weighing a component.
**O/E Kitting Components Screen**

**To open this screen:**
1. Open **Order Entry > O/E Transactions**.
2. Select a transaction entry screen, such as **Order Entry**.
3. On the Details table, select a detail line for a kitting item.
4. Click **Components**.

**Related tasks:**
- "Entering an Order " (page 92)
- "Shipping Orders and Items " (page 120)
- "Invoicing Shipments " (page 116)
- "Allocating Serial Numbers or Lot Numbers to an Order " (page 157)
- "Allocating Serial Numbers or Lot Numbers to a Shipment " (page 161)
- "Allocating Serial Numbers or Lot Numbers to an Invoice " (page 164)
- "Allocating Serial Numbers or Lot Numbers to a Credit Note " (page 167)
- "Allocating Serial Numbers or Lot Numbers to a Debit Note " (page 171)

**Overview**

Use the O/E Kitting Components screen to:
- Review the components that make up a kit.
- Enter serial/lot numbers for kitting components, if necessary.
- Enter unit prices for kitting components, if you do not want to use the default unit prices.

**Inventory Quantities**

Below the Kitting Components table, inventory quantities are displayed for the selected kitting component. Quantities are displayed for the location specified in the detail, and for all locations.

You can click the Drilldown button to see more information about quantities on sales orders or purchase orders, and quantities committed.
Note: Inventory quantities are displayed in the unit of measure defined for the selected kitting component.

Fields and Controls

Component Item Number
Displays the item number for a component.

Costing UOM
Displays the unit of measure used for the unit cost of a component.

Description
Displays the description for a component.

Ext. Weight
Displays the extended weight, which is the quantity shipped multiplied by the unit weight.

Invoice UOM
Displays the unit of measure used for stocking a component.

Kitting Quantity
Displays the quantity of a component included in the kit.

For a component that is a non-stock item, this field displays the non-stock clearing account used by the item's account set.

Order UOM
Displays the unit of measure used for stocking a component.

Qty. Available
Displays the inventory quantity that is available for sale to your customers. This is determined by the quantity on hand less the quantity committed, as maintained in Inventory Control.

Qty. Committed
Displays the inventory quantity that is committed to orders.

By committing an inventory quantity to an order, you ensure that the required inventory will be available when it is time to ship the order. (If a quantity is already committed to an order, you cannot ship another order for
the same items unless there is a sufficient quantity in inventory in addition to the committed quantity.)

Tip: You can click the Drilldown button to the right of the displayed quantities to view more information (such as the customer and the expected ship date).

Qty. Invoiced
Displays the quantity of a component included in the invoice (calculated based on the number of kits invoiced).

Qty. on Hand
Displays the inventory quantity currently on hand, as maintained in Inventory Control.

Qty. on Purchase Order
Displays the inventory quantity that you have ordered.

Tip: You can click the Drilldown button to the right of the displayed quantities to view more information (such as the order date and the expected arrival date).

Qty. on Sales Order
Displays the inventory quantity that customers have ordered from you.

Tip: You can click the Drilldown button to the right of the displayed quantities to view information (such as the customer and the expected ship date).

Qty. Ordered
Displays the quantity of a component included in the order (calculated based on the number of kits ordered).

Qty. Shipped
Displays the quantity of a component included in the shipment (calculated based on the number of kits shipped).

Serialized/Lotted
Indicates if a component is a serialized or lotted item.

Shipment UOM
Displays the unit of measure used for stocking a component.
**Unit Cost**
Displays the unit cost of a component.

**Unit Weight**
Displays the weight of a component.

**Weight Unit of Measure**
Displays the unit of measure used for weighing a component.

**Weight UOM Description**
Displays a description of the unit of measure used for weighing a component.
O/E Pre-authorization Screen

To open this screen:

1. Open Order Entry > O/E Transactions > Order Entry.
2. On the O/E Order Entry screen, click the Pre-authorize button.

Related tasks:
- "Capturing a Pre-authorized Credit Card Payment" (page 147)
- "Capturing and Invoicing Pre-authorized Credit Card Payments" (page 150)
- "Pre-authorizing a Credit Card Payment" (page 144)
- "Processing a Credit Card Prepayment " (page 112)
- " Voiding a Credit Card Prepayment " (page 114)
- "Voiding a Credit Card Pre-authorization" (page 153)

Overview

Use the O/E Pre-authorization screen to:

- Pre-authorize a credit card payment for an order.
- Void a previously created credit card pre-authorization for which you will not process a payment.

About Pre-authorizing Credit Card Payments

If you use Payment Processing, you can click Pre-authorize on the O/E Order Entry screen to pre-authorize a credit card payment for an order.

You pre-authorize a credit card payment when you want to verify that sufficient credit exists on a customer’s credit card before processing a sale. When you create a pre-authorization, the cardholder’s credit limit is reduced by the amount of the pre-authorization until the pre-authorization is captured or expires.

The amount of a pre-authorization does not need to match the amount captured in the final sale. The captured amount may be more (as when a restaurant customer adds a tip) or less (as when a service station customer swipes a credit card, and then purchases fuel that costs less than the amount pre-authorized for a fill-up).
If you use multicurrency accounting, you can pre-authorize a credit card payment only if the customer currency matches the currency specified for an existing processing code. For example, if you want to pre-authorize a credit card payment for a USD customer, USD must be specified as the currency for an existing processing code.

Merchant service providers charge a fee for voiding a credit card pre-authorization. However, this fee is lower than the fee that is charged if you do not void or capture a pre-authorization and allow it to expire. For this reason, we recommend that you void any pre-authorization that will not be captured.

If a pre-authorization has expired, you may be able to force a payment for the pre-authorized amount. You can force a payment only if the pre-authorization has expired recently (typically within 30 days), and if you used a saved credit card for the pre-authorization (that is, you did not select the Enter A Card For One-Time Use option when processing the pre-authorization).

**Note:** Forced transactions may be subject to higher fees than regular transactions.

If it is likely that more than seven days will pass before an order is shipped, you should not pre-authorize a credit card payment for the order. If you do, the pre-authorization may expire, in which case your merchant service provider will charge a fee. (Credit card pre-authorization in Sage Payment Solutions expires after approximately seven days.) Rather than pre-authorize a credit card payment, you can process an initial prepayment when the order is created, and then process the balance when the order is shipped.

**Fields and Controls**

**Buttons**

If you have not pre-authorized a credit card payment, the Pre-authorize button appears. After you pre-authorize a payment, this button is replaced by the Void button.

**Close**

Click Close to close the screen.

**Pre-authorize**

After you enter pre-authorization information, click Pre-authorize to open the PMT Process Credit Card screen and pre-authorize a credit card payment.
Before pre-authorizing a payment, you must select a payment code that uses the payment type SPS Credit Card, and a processing code that specifies the merchant ID, bank, and currency that will be used when processing the transaction.

For more information, see "Pre-authorizing a Credit Card Payment" (page 144).

**Void**
If a credit card payment has been pre-authorized but has not yet been processed, you can click **Void** to open the PMT Process Credit Card screen and void the pre-authorization.

For more information, see "Voiding a Credit Card Pre-authorization" (page 153).

**Amount Due**
This field displays the order total minus any prepayments.

**Bank Code**
This field displays the bank code associated with the processing code that will be used to process the transaction.

**Currency**
If you use multicurrency accounting, this field displays the currency associated with the processing code that will be used to process the transaction.

**Customer No.**
This field displays the number of the customer for which you are pre-authorizing a credit card payment.

**Order Total**
This field displays the total order amount.

**Payment Code**
Select or verify the payment code that will be used to process the transaction. To pre-authorize a credit card transaction, you must select a payment code that uses the payment type SPS Credit Card.

**Tip:** Click the **Payment Code** Finder to see a list of payment codes and associated payment types.
Pre-authorization Amount

Enter the amount of the credit card payment to be pre-authorized.

You pre-authorize a credit card payment when you want to verify that sufficient credit exists on a customer’s credit card before processing a sale. When you create a pre-authorization, the cardholder’s credit limit is reduced by the amount of the pre-authorization until the pre-authorization is captured or expires.

The amount of a pre-authorization does not need to match the amount captured in the final sale. The captured amount may be more (for example, when a restaurant customer adds a tip) or less (for example, when a gas station customer swipes a credit card, and then purchases fuel that costs less than the amount pre-authorized for a fill-up).

Processing Code

Select the processing code to be used for the transaction. This code specifies the merchant ID, bank, and currency that will be used when processing the transaction.

Note: The bank and currency specified for a credit card transaction must match the information specified for the processing code.
O/E Prepayments Screen

To open this screen:
1. Open Order Entry > O/E Transactions.
2. Open Order Entry, Shipment Entry, or Invoice Entry.
3. Click the Prepayment button.

Secondary screens:
- "O/E Project and Job Costing Apply Details Screen " (page 445)
- "O/E Bank Rate Screen " (page 449)
- "O/E Pre-authorization Screen " (page 485)

Related tasks:
- "Entering a Prepayment " (page 109)
- "Processing a Credit Card Prepayment " (page 112)
- "Capturing a Pre-authorized Credit Card Payment" (page 147)
- "Voiding a Credit Card Prepayment " (page 114)

Overview

Use the O/E Prepayments screen to enter, modify, and delete prepayments with an order, shipment, or invoice, or to process or void a credit card prepayment if you use Payment Processing.

Before entering a prepayment, you should determine which Accounts Receivable receipt batch to use for the prepayment.

Prepayments are applied to transactions as follows:
- Prepayments entered with orders do not reduce the amount of the next invoice you create. Instead, they are matched to invoices when they are posted in Accounts Receivable (using the order number).
- Prepayments entered with invoices immediately reduce the amount due on the invoices sent to customers, and are matched to invoices posted to Accounts Receivable.

The order prepayment total is displayed on the Totals tab of the O/E Invoices screen, so you can easily determine if there is an outstanding balance.
**Note:** You can enter multiple prepayments for an order, but only one prepayment for an invoice.

### Credit Card Prepayments

If you use Payment Processing, you can use the O/E Prepayments screen to perform the following tasks:

- "Processing a Credit Card Prepayment " (page 112)
- "Capturing a Pre-authorized Credit Card Payment" (page 147)
- "Voiding a Credit Card Prepayment " (page 114) (if it has not been settled in Sage Payment Solutions).

To enable the **Charge** and **Void** buttons on this screen, you must select a payment code that uses the payment type SPS Credit Card before adding the prepayment.

**Tip:** Click the Payment Code Finder to see a list of payment codes and associated payment types.

### Job-Related Prepayments

If the document for which you are adding a prepayment is job related, click the **Jobs** button to open the O/E Project and Job Costing Apply Details screen and distribute payment amounts to job details.

For more information, see "O/E Project and Job Costing Apply Details Screen " (page 445).

**Note:** The prepayment amount on a job-related order can exceed the document total. However, the sum of the prepayment amounts for individual details must match the prepayment total.

### Fields and Controls

#### Buttons

**Add**

Click **Add** to add a new prepayment.

If you use Payment Processing and you selected a payment code that uses the payment type SPS Credit Card, the **Charge** button becomes available after you click **Add**.
**Close**
Click **Close** to close the screen.

**Delete**
Click **Delete** to delete a prepayment.

**Note:** If you use Payment Processing and you have processed a credit card payment, you must void the credit card transaction before you can delete the prepayment.

**Charge**
If you use Payment Processing and you selected a payment code that uses the payment type SPS Credit Card, the **Charge** button becomes available after you click **Add**.

Click **Charge** to open the PMT Process Credit Card screen, which you can use to process a credit card payment for the transaction.

**Note:** After you process a credit card payment, the **Charge** button is replaced with the **Void** button.

**Jobs**
If the document for which you are adding a prepayment is job related, click the **Jobs** button to open the O/E Project and Job Costing Apply Details screen and distribute payment amounts to job details. For more information, see "O/E Project and Job Costing Apply Details Screen " (page 445).

**Note:** The prepayment amount on a job-related order can exceed the document total. However, the sum of the prepayment amounts for individual details must match the prepayment total.

**Void**
If you use Payment Processing, the **Void** button becomes available after you process a credit card payment.

Click **Void** to cancel a prepayment.
Note: You can void a prepayment in Order Entry only if you have not posted the document, and only if the prepayment has not been settled in Sage Payment Solutions. (Payments are typically settled within 48 hours.) If you have posted the document, you must void the prepayment in A/R Receipt Entry.

Amount Due
This field displays the total amount due for the invoice. Discounts that apply to the invoice are deducted from the amount due.

Bank Code
Enter the bank code for the bank for this receipt batch. Each batch must specify a single bank.

If you use multicurrency accounting:
- If you are adding payments to an existing batch, the program displays the default currency of the batch, and you cannot change it.
- If you are creating a new batch, you can select a currency that is accepted by the bank you select.

Bank Rate
The bank rate is the rate at which the prepayment amount will be converted to the functional currency.

This field displays the exchange rate associated with the currency, rate date, and rate type specified. You can change the default rate that appears here.

Batch Date
Select a date to use as the batch date. Sage 300 ERP displays the session date by default.

Batch Number
Select an existing receipt batch for the prepayment you are entering, or click the New button to create a new batch.

In the description field to the right, enter a description of up to 60 characters for the receipt batch that will include the prepayment.

Check/Receipt No.
Enter the check number for each payment made by check. If the payment is not by check, you can enter a reference number.
Note: If you leave the field blank, Sage 300 ERP assigns a number that consists of the batch number and the entry number.

**Currency**
If you are creating a new batch, specify the currency in which you want to add prepayments to the batch. You must select a currency that is used by the specified bank.

If you select an existing batch, Sage 300 ERP defaults the receipt currency to the default currency specified for the existing batch, and you cannot change the currency. (You can change the batch default currency in Accounts Receivable if necessary.)

If you want to view or edit the bank rate for the currency, click the Zoom button beside the Currency field to open the O/E Bank Rate screen. For more information, see "O/E Bank Rate Screen " (page 449).

**Customer No.**
This field displays the customer number of the customer to whose account you will post the document.

**Deposit Number**
If this is a new receipt batch, you can select an existing deposit number or click the New button to create a new deposit.

Tip: Select an existing deposit number if you want to consolidate multiple receipt batches into a single bank deposit.

**Discount Available**
This field displays the sum of all terms discount amounts available for the document.

**Document Total**
This field displays the total value of the document for which you are entering the prepayment.

**Order Total**
This field displays the total value of the order for which you are entering the prepayment.

**Payment Code**
Select the payment code for the prepayment. Payment codes are the
payment methods that you have defined in Accounts Receivable to identify the types of payments you process (such as cash, checks, and credit cards).

If you use Payment Processing and want to process or pre-authorize a credit card transaction for a document, you must select a payment code that uses the payment type SPS Credit Card.

**Tip:** Click the Payment Code Finder to see a list of payment codes and associated payment types.

**Pre-authorization Amount**
If you have pre-authorized a credit card payment, this field displays the amount of the pre-authorization.

**Processing Code**
If you use Payment Processing, select the processing code to be used for the transaction. This code specifies the merchant ID, bank, and currency that will be used when processing the transaction.

**Note:** The bank and currency you specify for a credit card transaction must match the information specified for the processing code.

**Rate Date**
Select a date to specify the exchange rate associated with the rate type. Sage 300 ERP displays the session date by default.

**Rate Type**
Enter the code for the rate type to use when selecting the bank rate for the prepayment.

Sage 300 ERP displays the rate type assigned to the currency table in Common Services, but you can change it to another of the rate types defined for your system.

**Receipt Amount**
Enter the amount of the receipt. This amount will appear in the Prepayments field on the Totals tab for the document.

**Tip:** If you use multicurrency accounting, enter this amount in the receipt currency (see the Currency field).

**Receipt Date**
Select a date for the prepayment. Sage 300 ERP displays the session date by
default.

Sage 300 ERP uses the date you enter to select the default fiscal year and period to display.

**Note:** In Accounts Receivable, the receipt date is used to assign the prepayment to aging periods on statements and reports, and to update statistics in customer records and salesperson records.
O/E Pre-Transaction Credit Check Screen

To open this screen:

1. Open Order Entry > O/E Transactions.
2. Open Order Entry, Shipment Entry, or Invoice Entry.
3. Beside the Customer No. field, click the Pre Credit Check button.

Related tasks:
- "Entering a Quote " (page 87)
- "Entering an Order " (page 92)
- "Shipping Orders and Items " (page 120)
- "Invoicing Shipments " (page 116)

Overview

Use the O/E Pre-Transaction Credit Check screen to check the customer and national account credit limit, outstanding balance, account activity, and aged transactions, and to approve changes to the customer's credit.

There is a variant of the O/E Pre-Transaction Credit Check screen: the O/E Credit Check screen. The main difference between these screens is when you use them:

- **O/E Pre-Transaction Credit Check.** You can manually use this screen any time before posting.
- **O/E Credit Check.** This screen appears if you have set up Order Entry to check a customer's credit limit when you post a transaction, and you post a transaction that will put the customer over their credit limit. For more information, see "About Posting Orders, Posting Invoices, and Posting Shipments " (page 77).

Fields and Controls

Buttons

**Cancel**

Click **Cancel** to clear any information you have entered and close the screen without approving credit.
**Proceed**

After entering an approved amount, click **Proceed** to approve that amount of credit.

**Aged Transactions Exceeds**

This section displays information about overdue payments for the customer, and for the national account if the customer belongs to one.

**Approved Amount**

Enter the amount of credit you want to approve.

**Note:** This field appears only on the O/E Pre-Transaction Credit Check screen (not the O/E Credit Check screen).

**Credit Approved By**

Enter your user ID. When you click Proceed, Sage 300 ERP prompts you to enter your password.

**Customer Credit Limit**

The fields in this group display the following information:

- The customer's credit limit
- Pending balances in other Sage 300 ERP programs
- The customer's current order amount and prepayment amount
- Total outstanding balance
- The amount by which the total outstanding balance exceeds the credit limit

**National Account Credit Limit**

If the customer belongs to a national account, this field displays the credit limit and outstanding balances for that national account.

**On Hold**

Select this option if you need to place an order on hold.

If you want to specify the reason that an order is on hold, you can enter this information in the field beside the option.

If the customer account is on hold in Accounts Receivable, the order is automatically placed on hold.
You can enter and post an order that is on hold, but you cannot ship items or produce an invoice for the order until you do one of the following:

- Remove the hold for the customer in Accounts Receivable.
- Remove the hold for the order on the O/E Order Entry screen, and then post the order.

To view a list of the orders currently on hold, print the O/E Order Action report.

**Note:**

- Placing an order on hold automatically clears any serial numbers or lot numbers that have been allocated to the order quantity.
- Posting an order that is on hold has the following effects on Inventory Control records: If an item is serialized, the Allocated To OE Order status for the item and serial number is cleared on the I/C Serial Numbers screen. If an item is lotted, the number in the Quantity Reserved for Order field is reduced for the item and lot number on the I/C Lot Numbers screen.
O/E Price Approval Screen

To open this screen:
1. Open Order Entry > O/E Transactions.
2. Select a transaction entry screen, such as Order Entry.
3. Select a detail line in the table.
4. In the Price Approval column heading, click the Zoom button.

Related tasks:
- "Entering an Order" (page 92)

Overview

If price checks are in effect and an item's price is outside the allowed limit, you can use the O/E Price Approval screen to approve the price. To do this, you must have Price Check Approval authorization.

Note:
- Price approval is available only in Sage 300 Premium ERP.
- Price checks are set in Inventory Control price lists for particular items, price lists, and Sage 300 ERP user IDs. For more information, see the Inventory Control help.

Fields and Controls

Password
Enter your password.

Price Approved By
Enter your user ID.
O/E Shipments/Invoices Screen

To open this screen:

1. Open Order Entry > O/E Transactions > Order Entry.
2. Select an existing order or create a new order.
3. Select a detail line in the table, and then click the Drilldown button in the Shipped to Date column heading. (On the O/E Items/Taxes screen, the Drilldown button appears beside the Shipped to Date field.)

Related tasks:
- "Entering an Order " (page 92)
- "Editing an Order" (page 100)
- "Invoicing Shipments " (page 116)
- "Shipping Orders and Items " (page 120)

Overview

Use the O/E Shipments/Invoices screen to view shipments and invoices for a detail line in an order.

You can click a shipment or invoice to view it in the O/E Shipment Entry screen or the O/E Invoice Entry screen.
O/E Serial/Lot Numbers Allocation/Generation Screen

To open this screen:
1. Open Order Entry > O/E Transactions.
2. Select the screen for the type of document you want to enter (for example, Order Entry).
3. Enter document information, including details for serialized or lotted items.
4. Select a detail for a serialized or lotted item, and then:
   For a non-kitting item
   a. In the Qty. Ordered field, enter a quantity for the item, and then press Tab or click the Qty. Ordered column header. If your system is set up to use the Qty. Ordered field to allocate serial/lot numbers, the Serial/Lot Numbers Allocation screen appears. Otherwise, proceed to the following step.
   b. In the Qty. Shipped field, enter a quantity for the item, and then press Tab or click the Qty. Shipped column header.

   For a kitting item
   a. Click Components. The O/E Kitting Components screen appears, listing the component items that make up the kit.
   b. Select a serialized or lotted component item. The Serialized/Lotted column displays Yes for items that are serialized or lotted.
   c. In the Qty. Ordered field, enter a quantity for the item, and then press Tab or click the Qty. Ordered column header. If your system is set up to use the Qty. Ordered field to allocate serial/lot numbers, the Serial/Lot Numbers Allocation screen appears. Otherwise, proceed to the following step.
   d. In the Qty. Shipped field, enter a quantity for the item, and then press Tab or click the Qty. Shipped column header.

Related tasks:
- "Allocating Serial Numbers or Lot Numbers to an Order " (page 157)
- "Allocating Serial Numbers or Lot Numbers to a Shipment " (page 161)
• "Allocating Serial Numbers or Lot Numbers to an Invoice " (page 164)
• "Allocating Serial Numbers or Lot Numbers to a Credit Note " (page 167)
• "Allocating Serial Numbers or Lot Numbers to a Debit Note " (page 171)
• "Allowing Serial and Lot Number Allocation for Quantity Ordered" (page 33)

**Overview**

Use the O/E Serial/Lot Numbers Allocation screen or O/E Serial/Lot Numbers Generation screen to allocate or generate serial or lot numbers.

**Serials Tab**

On the Serials tab, you assign serial numbers to serialized items when you enter orders, shipments, debit notes, and credit notes.

Serial numbers are used to track individual items. Each serial number must be unique to one specific item.

**Example:** An electronics retailer can use serial numbers to record sales of items that have warranties.

**Lots Tab**

On the Lots tab, you assign lot numbers to lotted items when you enter orders, shipments, debit notes, and credit notes.

Lot numbers are used to track groups of items. Unlike serial numbers, a lot number can be allocated to multiple items.

**Example:** A food distribution company can use lot numbers to record purchases and sales of unique batches of product.

**Fields and Controls**

**Buttons**

**Add**
Click this button to generate the number displayed in the **Next Serial Number** or **Next Lot Number** field.

**Auto-Alloc.**
Click this button to allocate all the required serial numbers or lot
quantities.

**Note:** If you specify a number in the **Start Allocating At** field, the program allocates serial numbers or lot quantities starting with this number.

Allocated numbers appear in the list of serial numbers or lot numbers.

**Auto-Gen.**

Click this button to generate all the required serial numbers or lot numbers.

**Note:** When generating lot numbers, you must use the **Make [ ] Lots OR Each Lot Has [ ]** field to specify how lot numbers are generated.

These numbers are automatically assigned, starting with the Next Serial Number or Next Lot Number you specified.

If you do not specify the next number to use, Order Entry automatically assigns the next available numbers.

**Clear All**

Click this button to remove all serial or lot numbers.

**Close**

Click this button to save the information you have entered and close the screen.

**Ship All**

Click this button to ship all the detail items using the serial numbers or lot numbers listed on the screen. This changes the Shipped status for each serial number to Yes, and updates the available lot quantities for each lot.

**Note:** This button appears only if you use the **Use the Qty Ordered field in OE for the Allocation of Serial Numbers** option in I/C.

For more information, see the Inventory Control help.

**Item Number**

Displays the item number from the document detail.

**Location**

Displays the location specified for the document detail.
**Stock Date**

The stock date is assigned when you ship items from inventory or return them to inventory.

The stock date is used to calculate expiry dates.

**Example:** If an item is received on August 1st, and the number of days from which it expires is 30, August 31st will be the expiry date.

The stock date is also used to calculate quarantine release dates for lots.

**Lots tab**

**Allocated**

Indicates how many lot quantities you have allocated.

**Auto-Allocate From**

Use this field to specify the lot number from which to start allocating quantities.

If you do not enter a number in this field, or if you clear the check box to the left of this field, quantities will be allocated starting with the first available lot.

**Generated**

Indicates how many lot quantities you have generated and assigned to the items you are returning to inventory.

**Lot Qty Required**

Indicates the quantity you need to allocate to lots.

This field displays either the Quantity Ordered or the Quantity Shipped, depending on which of these fields you use to allocate lot numbers. (An option in Inventory Control determines this. For more information, see the Inventory Control help.)

**Lots Shipped**

Indicates the lot quantities that have been shipped. (The Quantity Shipped column indicates how many quantities are shipped for each lot.)

**Make [ ] Lots OR Each Lot Has [ ]**

Enter a number in one of these fields to specify how lot numbers are
generated when you click the **Auto-Gen.** button:

- **Make [ ] Lots.** Enter a number in this field to generate a specific number of lots. The required quantity is divided equally among the lots. If you return 400 items and you specify that 10 lots should be created, each lot has 40 items.

- **Each Lot Has [ ].** Enter a number in this field to generate lots with a specific quantity in each lot. If you return 400 items and you specify that there should be 100 items in each lot, 4 lots are generated.

### Next Lot Number
Displays the next sequential lot number that is available to be assigned to the items you are returning to inventory.

**Note:** When you assign a lot number, this field is updated automatically (so it always shows the next lot number that is available).

### Qty Shipped
Displays the quantity shipped that you entered for the item detail in order or shipment entry.

### Remaining
Indicates how many lot quantities you need to assign or ship.

When you are allocating or generating lot quantities, this field displays the difference between the lot quantities required and the number allocated or generated.

**Note:** You must allocate all the required lot quantities before you can save the allocation.

When you are identifying shipped quantities, this field displays the difference between the item quantity shipped and the lot quantities shipped.

### Unit of Measure
Displays the unit of measure (such as DOZEN, BOX, or EACH) for an item.

The unit of measure determines how many lot numbers are Required, Allocated, Shipped, and Remaining.
Example: If the detail line specifies 2 as the order quantity, but the unit of measure is DOZEN and you have lots with available quantities of 6 EACH, when you click the **Auto-Alloc.** button, 0.5 dozen is allocated for 4 lots.

**Table**

**Expiry Date**
Indicates the expiry date for a lot.

There are various reasons a lot may have an expiry date. For example:
- If the lot contains perishable items, the expiry date could indicate when the items are no longer suitable for use.
- If the lot contains entry ballots for a contest, the expiry date could indicate the last day that entries will be accepted.

**Lot Number**
Indicates the lot numbers to which the current item quantities are allocated.

**Quantity**
Indicates the quantity of items assigned to a lot.

**Quantity Shipped**
Displays the quantity of items shipped from a lot.

If you click **Ship All**, the program updates the **Quantity Shipped** column with the quantity shipped in the item detail.

You can change the quantity shipped for a lot number.

**Serials tab**

**Allocated**
Indicates how many serial numbers you have allocated.

**Auto-Allocate From**
Use this field to specify the serial number from which to start allocating serials.
If you do not enter a number in this field, or if you clear the check box to the left of this field, serial numbers will be allocated starting with the first available number.

**Generated**
Indicates how many serial numbers you have generated and assigned to the items you are returning to inventory.

**Next Serial Number**
Displays the next sequential serial number that is available to be assigned to the items you are returning to inventory.

**Note:** When you assign a serial number, this field is updated automatically (so it always shows the next serial number that is available).

**Qty Shipped**
Displays the quantity shipped that you entered for the item detail in order or shipment entry.

**Remaining**
Indicates how many serial numbers you need to assign or ship.

When you are allocating or generating serial numbers, this field displays the difference between the serial numbers required and the number allocated or generated.

**Note:** You must allocate all the required serial numbers before you can save the allocation.

When you are identifying shipped quantities, this field displays the difference between the item quantity shipped and the serial numbers shipped.

**Serial Nos. Required**
Indicates how many serial numbers you need to allocate.

This field displays either the Quantity Ordered or the Quantity Shipped, depending on which of these fields you use to allocate serial numbers. (An option in Inventory Control determines this. For more information, see the Inventory Control help.)
**Serials Shipped**
Indicates how many serial numbers have been shipped.

**Unit of Measure**
Displays the unit of measure (such as DOZEN, BOX, or EACH) for an item.

The unit of measure determines how many serial numbers are Required, Allocated, Shipped, and Remaining.

**Example:** If the detail line specifies 10 as the order quantity, but the unit of measure is DOZEN, you must allocate 120 serial numbers.

**Table**

**Serial Number**
Indicates the serial numbers that are allocated to the items in the current detail.

**Shipped**
Indicates whether or not a serial number has been shipped.

To change the status for an individual serial number, double-click in the **Shipped** column for the serial number.

**Note:** To ship serials to match the quantity shipped in the entry detail, click **Ship All**.
O/E Shipment Entry Screen

To open this screen:
Open Order Entry > O/E Transactions > Shipment Entry.

Secondary screens:
- "O/E Project and Job Costing Apply Details Screen" (page 445)
- "O/E Bank Rate Screen" (page 449)
- "O/E Confirmation Screen" (page 453)
- "O/E Create Shipment from Orders Screen" (page 561)
- "O/E Customer Bill-To Address Screen" (page 456)
- "O/E Shipment To Address Screen" (page 458)
- "O/E Items/Taxes Screen" (page 460)
- "O/E Kitting Components Screen" (page 481)
- "O/E BOM Components Screen" (page 451)
- "O/E Prepayments Screen" (page 489)
- "O/E Pre-Transaction Credit Check Screen" (page 496)
- "O/E Price Approval Screen" (page 499)
- "O/E Sales History Screen" (page 368)
- "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501)

Related tasks:
- "Allocating Serial Numbers or Lot Numbers to a Shipment" (page 161)
- "Changing Payment Terms" (page 83)
- "Changing Tax Groups and Tax Classes for Order Entry Documents" (page 180)
- "Entering Taxes Manually" (page 183)
- "Invoicing Shipments" (page 116)
- "Shipping Orders and Items" (page 120)
Overview

Use the Shipment Entry screen to enter and post shipments, add miscellaneous charges, create invoices, print picking slips, and assign serial numbers and/or lot numbers.

On the Shipment Entry screen, you can:

- Enter and post shipments (for existing orders or without entering orders first).
- Add miscellaneous charges to existing orders.
- Create invoices automatically for posted shipments.
- Print picking slips and invoices (if you created an invoice) immediately after posting shipments.
- If you use Serialized Inventory and Lot Tracking, assign serial numbers and/or lot numbers. For more information, see About Serialized Inventory and Lot Tracking.
- If you use Payment Processing, capture or void credit card prepayments for orders. For more information, see "Credit Card Transactions" (page 141).

In the header area of the O/E Shipment Entry screen, you specify the shipment number and customer number. You can also review information about any invoices associated with the shipment.

Tip: If you want to enter, ship, and invoice an order directly on the O/E Shipment Entry screen, enter order information and details without selecting an order in the Order Number field, and then select the Create Invoice option to create an invoice automatically when you ship the order.

Note: You can recall and edit a shipment until you invoice it or until the order is fully shipped.

Customer Tab

Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

On the Customer tab, you can specify:

- Shipping method
- Tracking number if sending by courier or registered mail
Optional FOB (free-on-board) location

Optional territory code

Customer type (this specifies whether the customer is eligible for discounts or special pricing)

Price list to use to select prices for item details

Tax group

Customer account set

Payment terms that will be used for invoices from this transaction

Due date and discount terms

Optional Fields Tab

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the Auto Insert option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

Rates Tab

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

If you are shipping goods, you can also change the rate information for converting the shipped amount from customer’s currency.

The Rates tab can show the following groups of exchange rate information:
• **Order Exchange Rate** (if you are creating or have created an order)
• **Shipment Exchange Rate** (if you are shipping or have shipped goods)
• **Invoice Exchange Rate** (if you are creating or have created an invoice)
• **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

• Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.

• If you are shipping goods, change rate information for converting the shipped amount from customer's currency.

• If you are invoicing shipped goods, change rate information for the invoice.

• If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

  If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

  If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

  For more information, see "About Exchange Rates " (page 75).

**Retainage Tab**

The Retainage tab appears only for job-related documents that use the **Retainage** option. You use this tab to specify retainage terms for orders, shipments and invoices. If you use multicurrency accounting, you also specify the exchange rate to use for the retainage invoice, retainage debit note, or retainage credit note when outstanding retainage is processed in Accounts Receivable.

The Retainage tab appears only if the following conditions are true:
• You use Sage 300 ERP Project and Job Costing
• The document is job-related
• You select the Retainage option for the document. (You cannot select this option if you select Project Invoicing.)

The default entries for the retainage percentage and retention period for each detail line come from the Customer Default fields on the Contract Maintenance Project tab in Project and Job Costing. You can change these entries for each detail line.

Sales Split Tab

Use the Sales Split tab to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

**Important!**
When shipping multiple orders, you should always check the Sales Split panel to ensure that the sales allocation is correct.
When you create a shipment from multiple orders, uses only the sales split for the first order. If the orders use different sales splits, you must change the allocation for the shipment manually.

If the sale is split among more than five salespersons, you should not create one shipment from the multiple orders.

For more information, see "Managing Sales Splits" (page 83).

**Shipment Tab**

Use the Shipment tab to perform the following tasks:

- Specify general information about the shipment
- Select options related to tax, project and job costing, project invoicing, and retainage
- Add and edit detail lines for items and miscellaneous charges on the Details table

You use the fields and options at the top of the Shipment tab to select one or more orders you are shipping, and to specify general information about the shipment.

Information you specify on the Shipment tab includes:

- Order number (or numbers) you are shipping
- Shipment date
- The ship-to location (from the Accounts Receivable customer record) or a shipping address for this shipment
- Optional description and reference information

You use the Details table to add and edit detail lines for items and miscellaneous charges.

On the Details tab, you can:

- Specify shipped quantities, prices, discount information, and serial numbers for a detail
- Add miscellaneous charges to existing orders
- Add detail lines for items if shipping goods without entering orders first
- Enter a comment or special instructions for a detail
• Include the customer's item number
• Enter a ship-via method and tracking number for a detail, if you plan to ship the items separately from the rest of the items

**Tip:**
• To open a separate detail entry screen to view and change information for a selected detail, click **Items/Taxes**.
• Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed. Inventory quantities are displayed in the unit of measure defined for the item.

**Note:** Some table columns do not appear as fields on the O/E Items/Taxes screen.

**Taxes Tab**

Use the Taxes tab to select the method you will use to calculate taxes, and to review and change tax information for a document.

On the Taxes tab, you can:

• Specify whether taxes are calculated manually or automatically.
• Select automatic tax calculation for tax reporting (if you report taxes in a different currency), or enter the tax reporting amounts manually.
• Review the tax information that applies to the transaction.
• Change the customer tax class for the document.

**Tip:** To change the tax status of an item, click the **Items/Taxes** button on the Order tab.

• Enter the tax base and tax amount, if you are entering taxes manually.
• Enter or edit the customer's tax exemption number.
• Automatically prorate tax amounts for individual details on the document.

For information about entering and distributing tax amounts manually, see "Entering and Distributing Tax Amounts " (page 182).
**Totals Tab**

Use the Totals tab to review and edit discounts, totals, and other final document details.

On the Totals tab, you can:

- Verify totals and discounts before posting a shipment.
- Check the total estimated weight of items ordered.
- Specify whether shipment discounts apply to miscellaneous charges.
- Specify the number of labels you want to print for a shipment.
- Automatically create an invoice for the shipped items when you post the shipment.
- Enter a comment for the shipment.

**Fields and Controls**

**Buttons**

**Calc. Taxes**

The **Calc. Taxes** button appears on the Taxes tab. Click the button to calculate and overwrite any existing tax amounts on the Taxes tab.

**Note:** If you do not select the **Calculate Tax** option on the Taxes tab, you can change tax amounts manually after clicking the **Calc. Taxes** button.

You can also use the **Calc. Taxes** button to recalculate taxes after changing the tax authority – even if you have selected the **Calculate Tax** option.

For more information about entering taxes manually, see "Entering Taxes Manually" (page 183).

**Capture**

If you use Payment Processing, this button becomes available after you pre-authorize a credit card payment.

Click **Capture** to open the O/E Prepayments screen, and then click **Charge** to begin processing the payment.
For more information, see "About Pre-authorizing, Capturing, and Forcing Credit Card Payments " (page 141).

Components
Click this button to view the components that make up a kit or a BOM. For more information, see "O/E Kitting Components Screen " (page 481) or "O/E BOM Components Screen " (page 451).

Derive Rate
This button is available on the Rates tab if you calculate the tax amount in the tax reporting currency manually (if you report taxes in a different currency than you collect them).

If you have already changed the tax reporting amount on the Taxes tab, click Derive Rate to calculate the actual exchange rate between the tax amount and the tax reporting amount.

Note:
- If Order Entry automatically calculates the tax amount in the tax reporting currency, it will use the tax reporting currency exchange rate that you enter on the Rates tab.
- The rate on the Rates tab must match the effective exchange rate before you can post the document.
- If you change the total amount on the Taxes tab, you must redistribute the tax reporting amount to the document details.

Dist. Taxes
This button is available if you do not select the Calculate Tax option.

When you click the Dist. Taxes button, the total tax (from the Taxes tab) is prorated to the document details.

Note: You can review tax amounts for document details on the O/E Items/Taxes screen. For more information, see "O/E Items/Taxes Screen " (page 460).

History
Click this button to review the sales history for a selected item or a customer. For more information, see "Looking Up Sales History for Items or Customers " (page 190).
**Item/Tax**

Click **Item/Tax** to open the O/E Items/Taxes screen.

You can use this screen to add, edit, and delete items and charges, and to change tax information for items and charges. The screen displays details for each item or charge on a single screen, rather than in a table row, making it easier for you to review and modify information without scrolling.

You can also change a tax class to another tax class that is assigned to the authority, and you can specify whether tax is included (in the **Tax Included** column).

For more information, see "O/E Items/Taxes Screen" (page 460).

**Post**

Click this button to post a transaction. When you post, you can print documents related to the transaction. Depending on the transaction and the options you selected, you may be able to print a quote, order confirmation, picking slip, prepayment receipt, and/or invoice. For more information, see "O/E Confirmation Screen" (page 453).

**Note:**
- If you have set up Order Entry to check customer credit limits, and the transaction you are posting will put the customer over their credit limit, the O/E Credit Check screen appears when you post. On this screen, you can put the transaction on hold, or you can override the customer's credit limit and continue with posting.
- For job-related transactions, if you change the status of a contract from Estimate to Open, and then post, you cannot change the contract's status back to Estimate. For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**Prepayment**

Click **Prepayment** to open the O/E Prepayments screen, which you use to enter complete or partial payments for a transaction. For more information, see "O/E Prepayments Screen" (page 489).

**Note:** If you use Payment Processing, the **Prepayment** button is replaced with the **Capture** button after you pre-authorize a credit card payment.
Ship All

This button is available on the Order or Shipment tab if a document includes any details. It provides a quick way to ship outstanding items for an order.

When you click Ship All, all backordered quantities are shipped. That is, for each detail, the number in the Quantity Backordered field is added to the Quantity Shipped field.

Important! Because this button uses backordered quantities to determine the number to enter in Quantity Shipped, it will not work properly if you do not enter backordered quantities, or if you use the option to calculate backordered quantities automatically.

Tip: To cancel shipment for a detail, enter 0 (zero) in the Quantity Backordered field. The quantity ordered will be added to the Sales Lost field on the O/E Sales Statistics report.

Note: If the Allow Negative Inventory Levels option is not selected in Inventory Control, Order Entry ships only those quantities on hand in Inventory Control.

Complete Status

This field displays the status of the shipment. A shipment is automatically assigned Completed status when you post an invoice for the shipment.

Customer No.

Enter the customer number of the customer to whose account you will post the transaction.

The customer number determines the customer and billing address, and sets the default tax group and payment terms. In multicurrency systems, the customer number also specifies the currency of the document.

Note: After you enter a customer number, the field to the right displays the customer’s name.

You can enter an existing customer number in the following ways:

- Enter the number, and then press Tab.
- Use the Finder to select the number.

Using the buttons to the right of the Customer No. field, you can:
- **Create a new customer.** Click the New button to create a new customer on the A/R Customers screen. When you finish, the new customer number appears in the **Customer No.** field.

- **Check the customer's credit.** Click the Pre Credit Check button to check the customer's credit status before entering a transaction.

- **Edit the customer's billing address.** Click the Zoom button to view and edit the customer's billing address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

- **Look up information about the customer.** Click the Inquiry button to open the A/R Customer Inquiry screen to look up information about the customer.

If a customer account or its account set is inactive, you cannot enter transactions for the customer. If a customer account becomes inactive after you enter an order, you will not be able to post changes or invoices for the order until the account is made active again.

**Note:**
If the **Allow Non-existent Customers** option is selected on the O/E Options screen, you can enter a new customer number, and then continue entering the document. In a multicurrency system, the currency for the order is set by the reporting currency of the customer tax group that you choose.

You should not use this method to enter transactions in a multicurrency system, especially if the reporting currencies for customer tax groups do not match your customers' currencies.

Also note that you must add the customer record in Accounts Receivable before you post an invoice for the order in Accounts Receivable.

**Entered By**
This field displays the name of the person who entered the transaction.

**Invoice Number**
The program displays the invoice number assigned when you post an invoice for this shipment. This field is blank until you invoice the shipment.

To view the invoice details, click the Drilldown button.

**Note:** You cannot change a shipment after you create an invoice for it.
**Shipment Number**

To add a new shipment, press the Tab key or click the New button. If you do not want Order Entry to assign the shipment number, type the new number yourself.

To select an existing shipment for editing, use the Finder, or type the shipment number, and then press Tab or Enter.

**Customer tab**

Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

**Customer Account Set**

This field displays the account set specified in the A/R record as the default.

The account set specifies the General Ledger accounts to which the transaction will be distributed: receivables control, payment discounts, prepayment liability, retainage, and write-offs.

You can change the account set for a transaction. If you use multicurrency, however, you must select an account set that uses the same currency as the customer's account set.

**Customer Type**

Select a code that identifies the price discount level for the customer. You can select **Base, A, B, C, D, or E**.

If you select **Base**, and the discount is based on customer type, the customer is not eligible for price discounts.

**Note:**

- You specify customer type on the A/R Customers screen, but you can change it for an individual order.
- Item prices in Inventory Control are specified by customer type.

**FOB Point**

If applicable, enter the free-on-board (FOB) location at which the customer begins paying freight charges on the order.

If a default FOB point or primary ship-to location is specified for the customer on the A/R Customers screen, the FOB point from the
customer record or the ship-to location appears in this field when you select a customer.

**Price List**
Enter the code for the default price list from which prices are displayed on detail lines.

Order Entry displays the price list from the customer record, template, or ship-to location, depending on the order in which you select these records. For example, if you specified the ship-to location last, the price list for the location appears in the **Price List** field.

**Note:** You can select different price lists for individual detail lines.

**Ship Via**
Enter an optional ship-via code to specify the delivery method for the shipment.

If you specified a primary ship-to location for the customer on the A/R Customers screen in Accounts Receivable, the ship-via code for that ship-to location record appears as the default.

If the transaction uses a template, the description field to the right displays the description for the ship-via code used in the template by default.

If you select a ship-to location with an associated ship-via code for the transaction, the description for that location's ship-via code replaces the default description.

You can change the description if necessary.

**Tax Group**
Enter the code for the customer's tax group.

The tax group determines the tax authorities to which the customer is subject, and the tax classes that are used for each authority to calculate sales tax.

You can change the tax group at any time, even after posting. (For example, if you change the ship-to location on a posted order, you can also change the tax group to include the tax authorities for the new location.)
Note: If you use Project and Job Costing, see "About Order Entry Integration with Project and Job Costing" (page 7) for information about specifying tax groups for contracts and projects.

Tax Reporting Currency
If you use multicurrency accounting, this field displays the tax reporting currency for the tax group selected in the Tax Group field.

Note: The tax group's reporting currency can be different than the functional currency. It can also be different than the customer's reporting currency.

Terms Code
Enter the terms code for the transaction.

The terms code specifies the default terms that appear when you enter transactions for the customer in Accounts Receivable and Order Entry. In Accounts Receivable, you use the A/R Terms screen to set up terms codes, and you use the A/R Customers screen to assign a terms code to each customer.

You can specify different terms for the customer during transaction entry without changing the default terms code assigned to the customer in Accounts Receivable.

Territory
If you use territory codes to identify sales regions or track customer accounts, enter the territory code for the transaction in this field.

Note: You can use the A/R Ship-To Locations screen to assign a territory code to each ship-to location you create for customers.

Tracking No.
If you use waybill numbers to track shipments, enter the waybill number in this field.

Note: You can also enter a separate tracking number with any detail included in the transaction.

Optional Fields tab
If optional fields are assigned to the screen, use the Optional Fields tab to
enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

**Optional Field**

Use the Optional Field Finder to select optional fields that are assigned (in the O/E Optional Fields setup screen) to this type of transaction.

When you select an optional field code, Order Entry displays its description in the next column.

**Value**

Use the Value Finder to select a value created for the optional field in Common Services.

When you select a value code, Order Entry displays its description in the next column.

**Value Set**

The Value Set column shows whether a blank optional field currently has a value. (By looking at the field, you cannot know otherwise whether the field has a blank default value or no value.)

The Value Set field changes from **No** to **Yes** if you make an entry in the Value field..

**Rates tab**

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

The Rates tab can show the following groups of exchange rate information:
Appendix A: Order Entry Screen Guides

- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.
- If you are shipping goods, change rate information for converting the shipped amount from customer's currency.
- If you are invoicing shipped goods, change rate information for the invoice.
- If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

For more information, see "About Exchange Rates " (page 75).

**Currency**

This field displays the currency code and description for the customer's currency.

The currency is set for the customer in Accounts Receivable, and you cannot change it in Order Entry.
If the tax group specified for this document on the Customer tab uses a different currency from the customer's currency and your functional currency, the code and description for that currency appear in the adjacent **Tax Reporting Currency** field.

**Rate**
This field displays the exchange rate currently in effect for the specified currency and the selected rate type and rate date.

If you want to change the rate, you can click the Finder to see a list of available rates for the selected rate type and rate date.

**Rate Date**
Enter the date to use to select the exchange rate. Order Entry displays the rate date that is nearest the date you entered.

You can enter any date for which an exchange rate has been entered for the currency. (You enter exchange rates for currencies on the Currency screen in Common Services.)

**Rate Type**
Enter the rate type to use when converting multicurrency amounts to functional currency for the document.

Examples of rate types might be "Daily spot rate," "Monthly average rate," and "Contract rate."

**Tax Reporting Currency**
This field displays the exchange rate currently in effect between the tax reporting currency and your functional currency for the displayed rate type and rate date. You can change the rate on this tab, or you can change the tax totals on the Taxes tab and then derive the new rate on the Rates tab.

- If you change the exchange rate for the tax reporting currency on the Rates tab, the program will change the tax reporting amounts on the Taxes tab when you use the **Calc. Taxes** button to calculate taxes (if you are not calculating taxes automatically).

- If you change the tax reporting amount on the Taxes tab (after clearing the **Calculate Tax Reporting** option), you will have to redistribute the new tax amount to the detail lines, and then enter the new tax reporting exchange rate on the Rates tab.
To calculate the new exchange rate, click the **Derive Rate** button on the Rates tab.

**Note:**
You cannot post the document unless the tax reporting exchange rate is correct for the tax reporting amount on the Taxes tab, and the tax reporting amounts for the document details match the total tax reporting amount on the Taxes tab.

You will see a warning if you change an exchange rate by an amount that exceeds the Spread setting for the currency table on the Currency Rates screen in Common Services.

**Retainage tab**
The Retainage tab appears only for job-related documents that use the **Retainage** option.

You use this tab to specify retainage terms for orders, shipments and invoices.

If you use multicurrency accounting, you also specify the exchange rate to use for the retainage invoice, retainage debit note, or retainage credit note when outstanding retainage is processed in Accounts Receivable.

**Retainage %**
This field displays the retainage percentage used to calculate the retainage amount for the shipment, invoice, debit note, or credit note. It is a weighted average percentage, based on the sum of the details.

**Retainage Amount**
This field displays the sum of the retainage amounts for all shipment details in this field. You cannot change the amount.

**Retainage Rate**
You use this field to specify the method the program will use to determine the exchange rate for the retainage document when outstanding retainage is eventually processed in Accounts Receivable.

You can choose one of the following methods:

- Use Original Document Exchange Rate—to use the same rate as the invoice for this shipment.
- Use Current Exchange Rate—to use the rate in effect when the outstanding retainage is processed in Accounts Receivable.

**Retainage Terms**

You can use different terms for retainage documents (used to invoice for outstanding retainage) than you use for this invoice.

If retainage terms are specified in the A/R customer record, the retainage terms code from the customer record is used as the default retainage terms code for the invoice.

If no retainage terms code is specified in the customer record, the customer’s usual terms code is used as the default.

**Sales Split tab**

Use the Sales Split tab to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

**Percentage**

Enter the percentage of the sale to assign to each salesperson.
You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Salesperson Code**
Enter a salesperson code to add a new salesperson, or to replace a currently assigned salesperson for a transaction.

You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Note:** You set up salesperson codes in Accounts Receivable.

**Salesperson Name**
This field displays the name associated with the salesperson code.

**Note:** You set up salesperson codes in Accounts Receivable.

**Shipment tab**
The Shipment tab provides separate sections, where you can enter or view document information, as follows:

- **Header.** You use the top portion of the tab to enter general information that applies to the entire document (for example, the date, description, reference, template code, warehouse location, ship-to information, whether to calculate tax automatically for the document, and whether the document is job related).

- **Details.** You use the Details table to add and edit detail lines for items and miscellaneous charges.

On the Details table, you can:

- Specify shipped quantities, prices, discount information, and serial and/or lot numbers for a detail.

- Add item detail lines if shipping goods without entering orders first.

- Enter a ship-via method and tracking number for a detail, if you plan to ship some items separately from the rest of the items.

- Add miscellaneous charges to existing orders.

- Enter a comment or special instructions for a detail.

- Include the customer’s item number.
- Add shipment detail optional fields.
- Open a separate screen where you can view or change all the information for a selected detail—including tax information—without having to scroll sideways.

**Inventory Quantities.** The bottom of the tab displays inventory quantities for the location specified for a selected detail line and for all locations.

Click the Drilldown \( \text{F} \) buttons to view details for items on sales order, on purchase order, and committed to orders, including expected arrival and shipping dates.

**Note:** Inventory quantities are displayed in the unit of measure defined for the item.

**Create Invoice**
Select this option to create an invoice when you post a shipment.

When you select the option, **Invoice Number** and **Invoice Date** fields appear on the Totals tab.

You can invoice each shipment separately, or you can use the O/E Invoice Entry screen to invoice all shipments that have not been invoiced.

**Currency**
If you use multicurrency accounting, the customer's currency code is displayed after you enter the customer number. All amounts you enter for the document will be in the customer's currency.

The currency is assigned for the customer in Accounts Receivable and you cannot change it in Order Entry.

**Description**
Enter an optional description of up to 60 characters for the shipment, or use the default order description that appears when you selected an order or orders from which to create the shipment.

If you do not change the description for the shipment or the invoice, the description you enter here will appear for the Accounts Receivable invoice and in the General Ledger batch, depending on the options you selected for your Order Entry system. For more information about these options,
see "O/E Options Screen" (page 311) and "O/E G/L Integration Screen" (page 327).

**Exp. Ship Date**
Enter the date on which you expect to ship the order. The default date is the order date.

If necessary, you can enter different expected ship dates for individual details lines included in the order.

**From Multiple Orders**
If you want to create a new shipment from multiple orders, select the From Multiple Orders option, and then click the Zoom button to open the O/E Create Shipment from Orders screen.

For more information, see "O/E Create Shipment from Orders Screen" (page 561).

**Note:**
- You must select orders before you add any detail lines for the new shipment. If you have added detail lines to the shipment, you must delete them before you can select orders.

- When you create a shipment from more than one order, all of the shipment header information (including the fields on the Optional Fields tab) comes from the first order that you select.

- If you use Payment Processing, you cannot select an order with a pre-authorized credit card payment. You must capture the payment and ship the order separately.

- You cannot combine job-related and non-job-related orders in the same shipment.

**Job Related**
Select this option if the document applies to a project that you are managing using Project and Job Costing.

When you select the option, additional columns appear in the detail table so you can enter job-related information for each detail line.

When you post the document, Order Entry updates the contracts, projects, categories, and (if required) resources in Project and Job Costing to which the items in this order apply.
For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**Location**
Specify the inventory location from which you expect to ship items to fill the order.

This location is the default location for detail lines included in the transaction, although you can select different locations for individual detail lines.

**Note:** If you select a logical inventory location instead of a physical location, an error message appears. (Logical locations are used mainly for transferring goods between physical locations in Inventory Control.)

**No. of Shipments**
This field displays the number of shipments that have been processed from the order—*not including the currently displayed shipment*.

**Important!** If you are reviewing the last posted shipment for the order, *the number in this field does not include the currently displayed shipment*. For example, if you have posted 10 shipments and you are viewing the last posted shipment, this field displays 9, not 10.

**Order Number**
Enter the number of the order that you want to ship.

After entering the order number, you can click the Drilldown button to view the order in the O/E Order Entry Screen, or click the Inquiry button to view more information about the order.

**Note:** If you want to ship more than one order, select the From Multiple Orders option, and then click the Zoom button to open the O/E Create Shipment from Orders screen and select the orders.

**PO Number**
If necessary, enter the customer's purchase order number in this field.

If you selected Warning or Error on the Check for Duplicate POS list on the Invoicing tab of the A/R Customers screen, Order Entry displays a
warning or error message if you enter a purchase order number that has already been used for this customer.

**Notes:**
- Order Entry checks for duplicate purchase order numbers only on active or future orders—not on quotes or standing orders.
- By default, you can edit this field only if an order is not specified for the shipment. However, you can make this field editable at any time until the shipment is invoiced by adding the following to the OE.INI file:

  [UnconditionalPONumberEditInShipmentEntry]

  Allowed=Yes

**Posting Date**

The posting date is different from the document date. The posting date determines the year and period to which a transaction is posted in General Ledger. You can change the posting date, but you cannot change the **Fiscal Year/Period** field separately.

In a multicurrency system, posting dates are also used to select open documents for currency revaluation, so that revaluation adjustments are posted to the correct fiscal year and period in General Ledger.

Depending on your settings in the O/E Options screen, Order Entry displays the session date or the document date as the default in this field.

**Note:** If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Project Invoicing**

Select this option if Project and Job Costing will handle all invoicing for this document.

If you select this option:

- Order Entry does not create an invoice for the order. (When you ship the order, Order Entry passes shipment information to Project and Job Costing, where billing is handled using the PJC Create Billing Worksheet screen.)
- Taxes are calculated automatically. (You cannot clear the **Calculate Tax** option.)
- The **Retainage** option is not available. (All invoicing, including retainage amounts, is handled by Project and Job Costing.)

For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**Qty. Available**
Displays the inventory quantity that is available for sale to your customers. This is determined by the quantity on hand less the quantity committed, as maintained in Inventory Control.

**Qty. Committed**
Displays the inventory quantity that is committed to orders.

By committing an inventory quantity to an order, you ensure that the required inventory will be available when it is time to ship the order. (If a quantity is already committed to an order, you cannot ship another order for the same items unless there is a sufficient quantity in inventory in addition to the committed quantity.)

**Tip:** You can click the Drilldown button to the right of the displayed quantities to view more information (such as the customer and the expected ship date).

**Qty. on Hand**
Displays the inventory quantity currently on hand, as maintained in Inventory Control.

**Qty. on Purchase Order**
Displays the inventory quantity that you have ordered.

**Tip:** You can click the Drilldown button to the right of the displayed quantities to view more information (such as the order date and the expected arrival date).

**Qty. on Sales Order**
Displays the inventory quantity that customers have ordered from you.
Tip: You can click the Drilldown button to the right of the displayed quantities to view information (such as the customer and the expected ship date).

Reference
By default, this field displays the reference information from the order you selected (or from the first order if you selected multiple orders). You can edit the information in this field if necessary.

If you do not edit this field for the shipment or the invoice, the reference information that appears here will appear for the Accounts Receivable invoice and in the General Ledger batch, depending on the options you selected for your Order Entry system. For more information about these options, see "O/E Options Screen " (page 311) and "O/E G/L Integration Screen" (page 327).

Retainage
Select this option to indicate that retainage applies to the document you are entering. (Retainage is where a percentage of the payment is held back for a fixed period of time, and then invoiced separately after the hold-back period.)

When you select this option, the Retainage tab becomes available. You use this tab to specify how to process the retainage amount for the document.

Note:
- The Retainage option is available only if you are entering a job-related transaction and your Accounts Receivable ledger uses the Retainage Accounting option.
- The Retainage option is not available if you select Project Invoicing (where invoicing is handled through Project and Job Costing).

Ship-To Location
Enter a ship-to location that you have defined for the customer on the A/R Ship-To Locations screen in Accounts Receivable. You can do this in the following ways:
- Enter the ship-to location, and then press Tab.
- Use the Finder to select the location.
Using the buttons to the right of the field, you can:

- **Create a new ship-to location.** Click the New button to create a new ship-to location on the A/R Ship-To Locations screen. When you finish, the new ship-to location appears in the **Ship-To Location** field.

- **Edit the customer's ship-to address.** Click the Zoom button to view and edit the customer's ship-to address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

**Note:**
- When you enter a ship-to location, Order Entry updates the price list, territory, tax group, and sales split information for the transaction based on the information stored for the ship-to location.
- If you do not specify a ship-to location, Order Entry uses the address in the customer record.

**Shipment Date**

Enter the date on which you are sending the shipment to the customer.

The current session date appears in this field by default, but you can change it.

**Shipment Subtotal**

This field appears on both the Order tab and the Totals tab.

It displays the subtotal of all items and miscellaneous charges on the shipment, including tax amounts that are included in item prices.

**Template Code**

Select an optional template to use for the transaction. The information from the template appears as defaults in fields for the transaction.

**Note:**
- If the customer record specifies information that is different from the information in the template, the information from the customer record appears by default.
- If you select a new template after selecting a customer, the information from the template replaces the transaction and customer information from the customer record.
If you want to select a template after you have added details to the transaction, you must select a template that uses the same currency.

You set up templates on the O/E Templates screen.

**Year/Period**
This field displays the fiscal year and period to which the shipment will be posted in General Ledger.

If you want to post the shipment to a different fiscal year and period, you must change the posting date.

**Note:** You cannot post transactions to closed fiscal periods.

**Detail table**
All detail fields appear as columns in the detail table.

**Tip:**
- To open a separate detail entry screen to view and change information for a selected detail, click **Items/Taxes**.
- Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed. Inventory quantities are displayed in the unit of measure defined for the item.

**A/R Item No.**
If the document is job-related and you are using project invoicing, this field displays the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.

**A/R Item UOM**
If the document is job-related and you are using project invoicing, this field displays the unit of measure for the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.
Billing Type
If the document is job related, this field indicates whether the item or charge is billable or non-billable.

Category (Inventory)
This field displays the category assigned to the item record in Inventory Control. You can use the Finder to select a different category.

Category (Job Related)
This field appears if you selected the Job Related option for the document.

For job-related orders, specify the category to use for this item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than "Category" in Project and Job Costing, that term appears as the label for this field.
- Use the Item Number field to specify the resource.
- After you add the detail, you cannot edit this field.

COGS Acct.
If the document is job-related and you are not using project invoicing, this field displays the default Cost Of Goods Sold account from Project and Job Costing for the item or charge.

Comments/Instr.
This field indicates whether there are comments or instructions entered for the detail, and also allows you to add comments or instructions. For more information, see "Adding Comments and Instructions to Order Entry Transactions " (page 101).

**Note:**
- Comments for a detail line appear in the Description column on
printed quotes, order confirmations, invoices, credit notes, and debit notes.

- Instructions for a detail line appear in the **Description** column on printed picking slips.

### Completes Order

This field automatically changes from "No" to "Yes" when you completely ship the number of items for the detail line, or change the number of backordered items to 0 for the line.

### Contract

This field appears if you selected the **Job Related** option for the transaction.

For job-related orders, specify the contract to use for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**

- If you use a term other than “Contract” in Project and Job Costing, that term appears as the label for this field.

- Use the **Item Number** field to specify the resource.

- After you add the item or charge, you cannot edit this field.

### Cost Class

This field displays the cost class for the project category used in each job-related detail.

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

### Costing UOM

This field displays the costing unit of measure specified in the item record.
Note: If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

Customer Item No.
If you set up customer item numbers in Inventory Control (using the I/C Customer Details screen), you can use the customer's item number to enter the item number for the detail.

If you use customer item numbers to enter the item number for details, Order Entry will replace the customer's item number with your inventory item number, and automatically insert the customer's item number in this field. (This works the same way as the manufacturers' item numbers.)

Description
This field displays the description from the item price list or miscellaneous charge record for the item or miscellaneous charge selected in the Item No./ Misc. Charge field.

This description appears on printed order confirmations, picking slips, and invoices. You can use the default description or enter a new description to be used for an individual transaction.

In a multicurrency system, the description from the item record appears here if the price list does not include a price in the customer’s currency.

Discount %
You can specify a separate discount percentage or amount for each detail in an Order Entry transaction.

You can also enter a discount percentage or amount for the transaction on the Totals tab.

Discount Amount
You can specify a discount percentage or amount for each detail in an Order Entry transaction. If you specify a discount amount, Order Entry calculates the discount percentage and the discounted extended price.

You can also enter a discount percentage or amount for the transaction on the Totals tab.
**Discounted Extended Amount**

This is the amount for the quantity/weight of units for this line on this shipment after subtracting any discount for the line.

**Exp. Ship Date**

Enter the date you expect to ship the item. By default, this field displays the expected shipment date entered for the document, but you can change it.

**Extended Cost**

This field appears if you selected the **Job Related** option for the document.

Extended cost is the cost amount for the miscellaneous charge. It can also be used in Project and Job Costing to calculate labor and overhead. For more information, see Project and Job Costing help.

**Extended Price**

Type the extended price for the detail line, if needed.

Order Entry automatically calculates the extended price when you enter an order quantity. To calculate the extended price, the program divides the unit price by the pricing unit of measure conversion factor, and then multiplies the result by the order unit of measure conversion factor and the quantity ordered.

If you override the extended price calculated by Order Entry, an asterisk appears beside it on the O/E Items/Taxes screen, and also appears beside the item on the Shipment List.

If you change the extended price, Order Entry does not recalculate the unit price.

**Extended Weight**

The quantity shipped multiplied by the unit weight entered for the item in Inventory Control (or in the Unit Weight field). You can override the extended weight, if necessary.

Order Entry calculates a weight for the shipment, using the extended weights from each line, and converting it to the default weight UOM specified in Inventory Control.

You can use the calculated shipping weight for determining the postage, shipping, or other charges.
**Item No./ Misc. Charge**

Enter the item number or miscellaneous charge code for the item or charge. Order Entry displays information from the Inventory Control item record, including pricing unit and unit price information based on the customer's price list.

**Note:** After entering an item number in this field, you can use the Finder to see alternate items for the specified item. For more information about specifying alternate items, see the Inventory Control help.

After you add an item or charge, you can no longer change its item number or miscellaneous charge code.

**Kit/BOM**

If the selected item is part of a kit or a BOM (bill of materials) in Inventory Control, click the Finder to select the kit or BOM number (if you have more than one build for the item).

To review the items in the build, click the **Components** button at the bottom of the screen.

**Note:**
- You can create kits from stock or non-stock items in Inventory Control and then use them in Order Entry. You can also enter or post multiple kitting entries (or mix kitting entries with regular entries) in any Order Entry transaction entry screen.
- Kits can be assigned serial numbers that are maintained in Serialized Inventory.
- You can include kit components and BOM components when printing order confirmations, quotes, picking slips, invoices, credit notes, and debit notes.
- When you print the O/E Transaction List report and select Detail as the report type, the report displays kit components and BOM components.
- When you print the O/E Posting Journals report, it includes actual breakdown amounts for each kit component.

**Line No.**

Line numbers are assigned automatically, and you cannot change
them.

You use line numbers to identify details you have entered, or to recall them for editing when you are using the O/E Items/Taxes screen to enter detail information.

You can also list items on picking slips by line number.

**Location**

Order Entry displays the code for the location from which you shipped the items for the detail line.

**Note:** An error message if you select a logical inventory location instead of a physical location. (Logical locations are used mainly for transferring goods between physical locations in Inventory Control.)

**Manuf. Item No.**

If you have set up manufacturer's item numbers in Inventory Control, you can enter the manufacturer's item number (usually a bar code) in this field, rather than entering your inventory control item number. The manufacturers' item numbers are translated to your inventory item numbers by Inventory Control.

If you entered the manufacturer's item number in the Item Number field, Order Entry inserts it here automatically when it retrieves item information.

For more information about using manufacturer's item numbers, see the Inventory Control help.

**Non-Stk. Clr. Acct.**

If you selected a non-stock item, the non-stock clearing account used by the item's account set appears as the default in this field. You can change the account number if necessary.

**Optional Fields**

If you use optional fields, you can review and edit optional fields by clicking the Optional Fields column heading. (If you are using the O/E Items/Taxes screen, click the Zoom button beside the Optional Fields option.)
If an optional field is required, you cannot save the transaction unless the field has a default value, or until you fill in the field yourself.

To add optional item fields that were not automatically inserted, press the Insert key to add a new line to the table, and then use the Finder to select an optional field.

Optional fields must be assigned to the transactions screens using the O/E Optional Fields screen before you can add them to individual transactions. For more information, see "O/E Optional Fields Screen" (page 349).

**Order No.**

In this field, enter the number for the order that you want to ship, or use the Finder to select the number. After you select an order number, Order Entry fills in the details from the order.

If you want to ship more than one order at this time, select the **From Multiple Orders** option on the Shipment tab, and then click the Zoom button to open the O/E Create Shipment from Orders screen.

**Price Approval**

Price checks are set in Inventory Control price lists for particular items, price lists, and user IDs.

If price checks are in effect, and the price you enter is outside the boundaries allowed, this field displays "Yes." To approve the price:

1. In the Price Approval column heading, click the Zoom button.

2. On the O/E Price Approval screen, enter the ID of the person approving the price override. If security is set, you must also enter a password.

**Note:** The Price Approval field does not appear if you are using the O/E Item/Taxes screen. Instead, an error message may appear when you try to save the item detail, stating that the price requires approval.

For more information, see "About Price Checks" (page 82).

**Price By**

This field indicates whether the item is priced by weight or by quantity.
If pricing is by quantity, Sage 300 ERP sets volume discount amounts or percentages according to the quantity of goods that are ordered.

If pricing is by weight, Sage 300 ERP sets volume discount amounts or percentages by item weight.

Item weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Note:** Pricing by weight is available in Sage 300 Premium ERP only.

### Price List
The program displays the price list code used for the detail on the shipment. You can select a different price list and change item pricing for the shipment and invoice. If necessary, type the code for the price list to use for the detail or choose a price list from the Finder.

By default, the program displays the price list code you specified on the Customer tab.

### Pricing UOM (unit of measure)
This field displays the unit of measure in which the item is priced.

Sage 300 Premium ERP supports multiple pricing units of measure, but you must set one as the default on the I/C Item Pricing screen in Inventory Control.

The pricing UOM is determined by the price list as follows: If the price list provides only one pricing UOM, that UOM appears here. If the price list provides several pricing UOMs, the pricing unit that matches the order UOM appears here. If no pricing UOM matches the order UOM, the default pricing UOM appears here. If you price by cost, the default pricing UOM appears here, and the cost-based price appears in the Unit Price field.

**Note:** If the item is not on the specified price list, the program uses the item's stocking unit as the pricing unit.

### Project
This field appears if you selected the **Job Related** option for the document.
For job-related orders, specify the project for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than “Project” in Project and Job Costing, that term appears as the label for this field.
- Use the **Item Number** field to specify the resource.
- After you add the item or charge, you cannot edit this field.

**Qty. B/O**
If you did not ship the entire order and you use backorder quantities, the program displays the quantity backordered in this field. (If you use backordered quantities, the quantity shipped plus the quantity backordered usually matches the quantity on order.)

**Note:**
- If you set this field to zero, Order Entry marks the line as complete and adds the line amount (the quantity ordered) to the **Sales Lost** fields on the O/E Sales Statistics report.
- If you by increase the quantity backordered for a fully shipped detail, Order Entry marks the order as incomplete.

**Qty. Committed**
If you committed an inventory quantity to the order to ensure that the quantity is available for shipping, the committed quantity appears in this field.

**Qty. On Order (Order UOM)**
The number of item units on the original order document appears in this field.

**Qty. Shipped**
This is the quantity of goods that you are shipping for this detail line.

If you calculate backorders automatically, the program will change the backordered quantity when you enter a quantity shipped.
If you click the **Ship All** button, the program will entered the backordered quantity in this field.

You can change the quantity shipped until you have fully invoiced the shipped quantities for the shipment detail.

**Note:**
If the item is serialized or lotted and you did not allocate serial numbers or lot numbers to the quantity ordered, the O/E Serial/Lot Numbers Allocation screen appears after you enter the quantity shipped and leave the field. You use this screen to allocate serial numbers or lot numbers for the quantity of items ordered. For more information, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

If Inventory Control allows the allocation of serial numbers or lot numbers to order quantities (controlled by the **Use the Qty Ordered Field in OE** option), you can ship only the serial and lot numbers already allocated from the **Quantity Ordered** field. (You cannot use the O/E Serial/Lot Numbers Allocation screen to allocate numbers using the **Quantity Shipped** field.)

**Retainage %**
Order Entry uses the retainage percentage to calculate the retainage amount for each detail line on the shipment. It is a weighted average percentage, based on the sum of the details.

You can enter a different retainage percentage in the Retainage % field. When you enter a new percentage, Order Entry recalculates the retainage amount for the detail.

**Retainage Amount**
The retainage amount is the amount the customer can withhold for an original document detail until the end of the retention period, when retainage is invoiced.

To calculate the retainage amount, Order Entry multiples the extended detail amount (or the extended amount plus tax, if you include taxes in retainage) by the retainage percentage.

Order Entry displays the sum of the retainage amounts for all shipment details in this field. You cannot change the amount.
Retention Period
The retention period is the number of days for which the customer can withhold the retainage amount.

You issue the retainage invoice in Accounts Receivable at the end of the retention period.

Revenue Acct.
If the document is job-related and you are not using project invoicing, you also specify the revenue/billing account for each item or charge.

The default account number is specified in Project and Job Costing, and is used instead of the sales account specified for the item in the item category record.

Ship Via and Description
In the Ship Via field, enter the ship-via method for the detail. When you navigate out of this field, the description from the ship-via record for the selected ship-via code appears in the related Description field.

Note: You can specify a separate ship-via method for each detail.

Shipment UOM
The unit of measure for shipping this item, such as "Each", "Dozen", or "Crate."

Normally, the shipment unit of measure is the same as the order unit of measure for the detail line. However, you can use a shipment unit of measure that is different from the order UOM.

Note: If the shipment UOM is different from the order UOM, the quantity backordered may not be calculated properly and may result in over-shipment or under-shipment. Make sure the number of units you specify for the detail is expressed in the unit of measure you select.

Job-Related Orders and Shipments
If you are entering job-related orders or shipments where: The Default Order UOM = Pricing Unit (set on the O/E Options screen).andThe Default Billing Rate = Billing Rate (set for the project in Project and Job Costing).
Order Entry defaults the unit of measure from the current price list, and then recalculates the unit price based on the billing rate specified in PJC Contract Maintenance.

**Note:** You can use different units of measure in the Inventory Control Price List and in Contract Maintenance.

**Shipment Weight UOM**
This is the unit of measure for weighing this item on the shipment.

Depending on your settings in O/E Options, Order Entry displays either the item weight unit (from the item record) or the pricing weight unit (from the price list).

You can change the weight unit of measure for the detail line, if necessary.

The weight UOM for the complete order is determined by the default weight unit of measure set on the I/C Options screen.

**Shipped to Date (Order UOM)**
The field displays the number of item units that have been shipped for the detail on previous shipments.

**Tracking No.**
If you use tracking (waybill) numbers to track shipments that use different carriers or that are shipped at different times, enter the tracking number to use for the detail.

**Type**
Select the type of detail you are entering: Select Item to add a detail line for an inventory item or non-stock item that is assigned an item number in Inventory Control. Select Miscellaneous to add a detail line for a miscellaneous charge defined in Order Entry.

**Tip:** You can select a detail type by typing the first letter (for example, type M for Miscellaneous), or you can toggle between available selections by pressing the spacebar or double-clicking in the field.

**Unit Cost**
You enter the unit cost for an item only if the item uses the user-
specified costing method in Inventory Control (that is, if User-Specified appears in the Costing Method field on the I/C Items screen).

For more information, see "Inventory Costing Methods" (page 33).

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

### Unit Price

By default, this field displays the lowest unit price for which the customer is eligible. This may be the base price, a sale price for a specified time period, or the price specified for the customer’s price level or the quantity purchased, based on a discount or markup.

If necessary, enter the price for the item, per pricing unit.

**Note:**
- If price checks are in effect, and the unit price is outside the allowed limit, the price must be approved. For more information, see "About Price Checks " (page 82).
- You can edit the information in this field only if you have Unit Price Override security authorization in Order Entry.
- If the item is not on the price list you specified for the detail, no price appears.
- If the lowest price is a negative amount, it is displayed as zeros.
- If you set up contract pricing for a customer in Inventory Control, Order Entry uses that information to calculate prices for items affected by the customer's pricing contract, and it displays the contract price by default in this field.
- If you do not set up contract pricing for a customer, Order Entry calculates prices based on the customer type and the price lists you set up in Inventory Control.
- If the price list you select is not currently in effect: The Unit Price Finder does not appear. (That is, the Finder does not appear if the document date is not between the Price List Starts date and the Price List Ends date specified for the item, currency, and price list.
code on the I/C Item Pricing screen.) The Unit Price field displays 0.000000 by default.

- The number of decimal places that appear in this field is determined by the information specified for the item on the I/C Item Pricing screen.

**Unit Weight**

Unit weight is the weight of a single item for this detail, expressed in the order weight unit of measure. You can edit the weight that appears in this field.

To calculate the extended weight, multiply the unit weight by the quantity ordered.

If you are pricing by weight, the unit weight and extended weight determine the price. Otherwise, the weight is used only to determine the total order weight for estimating shipping costs.

**WIP Acct.**

If the document is job-related and you are using project invoicing, you also specify the WIP (Work in Progress) account for each order detail.

By default, this field displays the account number specified in Project and Job Costing.

**Note:** The level at which the WIP account is specified in Project and Job Costing depends on the project type and accounting method.

**Taxes tab**

Use the Taxes tab to select the method you will use to calculate taxes, and to review and change tax information for a document.

**Calculate Tax**

For each Order Entry document, you can specify whether taxes are calculated automatically or entered manually.

If you want Order Entry to calculate tax for this document, select the Calculate Tax option.
Note: If the document is job-related and you selected the **Project Invoicing** option, you cannot enter taxes manually. The **Calculate Tax** option is automatically selected, and you cannot change it.

If you want to enter tax amounts manually, do not select the **Calculate Tax** option. If you do not select this option:

- The Dist. Taxes button appears on the screen.
- You can enter tax amounts for the tax authorities listed for the document.

Click Dist. Taxes to prorate tax that you enter manually on the Taxes tab to the document details. For more information, see Entering Taxes Manually.

Note: You cannot prorate a tax amount to an authority that uses an exempt tax class.

**Calculate Tax Reporting**

Select this option if you want the program to automatically calculate tax reporting amounts for the document. Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

If you clear this option, you can edit tax reporting amounts.

Note:
- This option appears only if a tax authority has a tax reporting currency that is different from the source or functional currency.
- The default for this check box is determined by the **Calculate Tax Reporting Amounts Automatically** option on the O/E Options screen.

**Tax Reporting Currency**

The fields in this group display the included, excluded, and total tax amounts for the transaction in your tax reporting currency.

**Total Tax**

This field displays the total amount of tax calculated for the transaction (including taxes included in the price), displayed in the customer's currency.
Appendix A: Order Entry Screen Guides

**Note:** The fields in the Tax Reporting Currency group display the total tax in your tax reporting currency.

**Tax Details table**
This table displays information about tax authorities, classes, and amounts for the current document.

If you do not select the **Calculate Taxes** and the **Calculate Tax Reporting** options, you can change the tax base, tax amount, and tax reporting amount for each authority on the document.

**Note:**
You cannot edit information about a tax authority directly on this tab. To change information for a tax authority, you must use the screens in Tax Services.

You can change the tax authorities used by a particular order or invoice by changing the tax group on the Customer tab.

For debit notes and credit notes, however, you *must* use the same tax group as the invoice you are debiting or crediting. (Also, you cannot select a template code or ship-to location that uses a different tax group than the invoice.)

**Authority Description**
This field displays the description for a tax authority.

**Class Description**
This field displays the description for a tax class.

**Customer Tax Class**
This column displays the tax class that is assigned to each tax authority.

If you change the tax class for a tax authority on this screen, click **Calculate Taxes** to see the recalculated tax amount.

**Note:** If the **Calculate Tax** option is selected, the tax amount is recalculated automatically, but is not displayed immediately.
To change the tax class description or make other changes to the information for the specified tax group, use the Tax Services screens in Common Services.

Registration Number
If necessary, enter the customer's tax registration or tax exemption number.

Tax Amount
If you selected the Calculate Tax option, this field displays the amount of tax that is due for each authority.

For each authority, Order Entry calculates a sales tax amount if: The customer is subject to tax. The order contains taxable items or taxable miscellaneous charges. Tax rates are specified for the tax authorities and classes in Tax Services.

If you are entering taxes manually, enter the total tax amount you calculated for each tax authority. Ensure that the amounts you enter agree with the sum of the tax amounts for the details, for each tax authority.

Tax Authority
This field displays the tax authorities that are assigned to the tax group specified for the customer in Accounts Receivable.

Tax Base
If you selected the Calculate Tax option, Order Entry displays the transaction total. Any invoice or early-payment discounts are not deducted from this total.

If you are entering taxes manually, enter the total transaction amount in this field.

Tax Reporting Amount
If you selected the Calculate Tax Reporting option, this field displays the tax reporting amount calculated by applying the exchange rate between the source currency and the tax reporting currency.

If you did not select the Calculate Tax Reporting option, you can edit the tax reporting amount in this field.
Note: This field appears only if a tax authority for the transaction has a tax reporting currency that is different from the source or functional currency.

- The default for this check box is determined by the **Calculate Tax Reporting Amounts Automatically** option on the O/E Options screen.

Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

**Totals tab**

Use the Totals tab to review and edit discounts, totals, and other final document details.

**Comment**

Enter an optional comment of up to 250 characters for the transaction, and then press Tab to add the comment.

**Note:** If you do not press Tab, your comment will not be saved.

Comments appear in the Comments section on printed quotes, order confirmations, invoices, picking slips, credit notes, and debit notes.

For more information, see "Adding Comments and Instructions to Order Entry Transactions " (page 101).

**Create Invoice**

Select this option to create an invoice when you post the transaction.

When you select this option, additional fields appear on the Totals tab, letting you enter an invoice number and an invoice date.

You can invoice each shipment separately, or you can use the O/E Invoice Entry screen to invoice all shipments that have not been invoiced.

**Note:** This option is not available for job-related orders that use project invoicing. If you use project invoicing, all customer invoicing is handled by Project and Job Costing.
Discount Miscellaneous Charges
Select this option if you want to apply discounts allowed on the invoice to miscellaneous charges. The specified discount is prorated for the Less Shipment Discount field to miscellaneous charges.

If you do not select the option, any shipment discount applies only to the item subtotal.

Estimated Weight
This field displays the estimated weight of the shipment, based on the weight for the units of measure and item quantities specified on the order. Use the information to calculate shipping costs or postage.

You assign item weights in the Items screen in Inventory Control. (The estimated weight is in the default weight unit of measure specified in Inventory Control.)

Default item weights are from the item records in Inventory Control, but you can override them on the shipment.

Included Tax
This field displays the total tax amount that is included in item prices and miscellaneous charge amounts.

Invoice Date
Enter the date for the invoice.

The default date is the system date (the date you specify when you open the Sage 300 ERP company database).

Invoice Number
This field appears on the Totals tab if you selected the Create Invoice option in order to create an invoice when you post the shipment.

- To let Order Entry assign the invoice number, press the Tab key, leaving the field showing ***NEW***.

- If you do not want Order Entry to assign the invoice number, enter the new number.

**Note:** The number you enter does not update the Next Number field for invoice document numbers on the Options screen, even if you type the number that would have been assigned automatically.
**Invoice Posting Date**

If you selected the **Create Invoice** option, enter the posting date for the transaction.

Depending on your settings on the O/E Options screen, this field automatically displays either the current session date or the document date. You can enter another date, but you cannot change the fiscal year and period separately.

**Note:**
- The posting date is the date for transactions being posted to General Ledger, so it also determines the contents of the Fiscal Year and Period fields.
- If you use multicurrency accounting, currency revaluation uses posting dates to select open documents for revaluation purposes, ensuring that revaluation adjustments are posted to General Ledger in the correct fiscal year and period.
- If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Items Subtotal**

This field displays the total amount of the item detail lines for the document.

The items subtotal includes tax amounts that are included in item prices, but does not include miscellaneous charge amounts or tax amounts that are charged separately on item prices.

**Less Detail Discount**

This field displays the percentage and total of discount amounts applied to individual detail lines.

**Less Retainage**

This field displays the total of all retainage amounts on this shipment. The customer should be invoiced for the shipment total, less any prepayment and held back amounts. The retained portion is invoiced later in Accounts Receivable.

**Less Ship. Discount**

Use these fields to specify a discount on the shipment total.
This is a discount for a volume purchase, for example, and not an early payment discount. If you enter a discount, it is calculated on the total of all the items on the invoice. If you discount miscellaneous charges as well, the discount is also calculated for the miscellaneous charges.

You can enter a percentage discount or a fixed amount.

**Note:** An asterisk appears beside the amount field if you override the amount calculated from a percentage. The discount amount will not change unless you re-enter the discount percentage.

**Example:** For example, assume that a 33.3333% discount produces a discount amount of 24,999.94.

If you change the amount to 25,000:

- An asterisk appears by the amount to show that the calculation was overridden.
- If you add more details to the shipment, the discount percentage is automatically recalculated for each detail (with charges, you must include charges in the discount), but the discount amount is not recalculated unless you re-enter the discount percentage.

**Less Total Prepayment**
This field displays the total of all prepayments entered for this shipment, and for any orders included with this shipment.

Prepayments made with orders and with shipments are applied to invoices when they are posted in Accounts Receivable (matching by order number).

To apply a prepayment directly to a specific invoice, enter the prepayment with the invoice.

**Misc. Charges Total**
This field displays the total amount of the miscellaneous charge detail lines for the document.

The miscellaneous charges subtotal includes tax amounts that are included in miscellaneous charge amounts, but does not include item prices or tax amounts that are charged separately on miscellaneous charge amounts.
**Net Amount**
This field displays the total amount of all items and miscellaneous charges for the document, after any discounts have been subtracted. The net amount also includes tax amounts that are not included in item prices or miscellaneous charge amounts.

**Net of Detail Discount**
This field displays the total amount of all items and miscellaneous charges on the document, minus the total amount of discounts applied on individual detail lines.

**No. of Labels**
If you want to print more than one label for the shipment, type the number of labels you need.

You can print labels for the order (for example, to send an order confirmation), and you can print shipping labels for each invoice.

**No. of Lines**
This field displays the total number of detail lines (for items and miscellaneous charges) entered for the document.

If you are not invoicing the entire order, this field still displays the total number of detail lines (including those you are not invoicing).

**Tip:** Use this number to be sure you have entered all the details you need and deleted any unused details.

**Plus Excluded Tax**
This field displays the total amount of taxes calculated on the items and miscellaneous charges for the document.

The amount in this field does not include tax amounts that are included in item prices or miscellaneous charge amounts.

**Shipment Subtotal**
This field appears on both the Shipment tab and the Totals tab.

It shows the total amount of all items and miscellaneous charges on the shipment, including tax amounts that are included in item prices.

**Total**
This field displays the shipment total, including taxes.
**Total Order Prepayments**
Displays the total value of all prepayments entered for orders that have order details on this shipment.

**Note:** When you apply order prepayments to a specific invoice in Accounts Receivable, Accounts Receivable calculates any early payment discount that may apply.

**Total Tax**
The total amount of tax calculated for the shipment, including taxes included in the price.
O/E Create Shipment from Orders Screen

To open this screen:

1. Open Order Entry > O/E Transactions > Shipment Entry.

2. Do one of the following:
   - Click the Zoom ▲ button to the right of the From Multiple Orders option.
   - Select the From Multiple Orders option, and then press the F9 key.

Related tasks:
- "Entering an Order " (page 92)
- "Shipping Orders and Items " (page 120)

Overview

Use the O/E Create Shipment from Orders screen when you want to create a new shipment that includes multiple orders. You use this screen to select the orders to include.

Note:
- You must select orders before you add any detail lines for the new shipment. If you have added detail lines to the shipment, you must delete them before you can select orders.
- When you create a shipment from more than one order, all of the shipment header information (including the fields on the Optional Fields tab) comes from the first order that you select.
- If you use Payment Processing, you cannot select an order with a pre-authorized credit card payment. You must capture the payment and ship the order separately.
- You cannot combine job-related and non-job-related orders in the same shipment.
O/E Invoice Entry Screen

To open this screen:
Open Order Entry > O/E Transactions > Invoice Entry.

Secondary screens:
- "O/E Bank Rate Screen " (page 449)
- "O/E Confirmation Screen " (page 453)
- "O/E Create Invoice from Shipments Screen " (page 609)
- "O/E Customer Bill-To Address Screen " (page 456)
- "O/E Items/Taxes Screen " (page 460)
- "O/E Kitting Components Screen " (page 481)
- "O/E BOM Components Screen " (page 451)
- "O/E Prepayments Screen" (page 489)
- "O/E Pre-Transaction Credit Check Screen" (page 496)
- "O/E Price Approval Screen" (page 499)
- "O/E Project and Job Costing Apply Details Screen " (page 445)
- "O/E Sales History Screen " (page 368)
- "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501)
- "O/E Ship-To Address Screen " (page 458)

Related tasks:
- "Allocating Serial Numbers or Lot Numbers to an Invoice " (page 164)
- "Changing Payment Terms " (page 83)
- "Changing Tax Groups and Tax Classes for Order Entry Documents " (page 180)
- "Entering a Prepayment " (page 109)
- "Entering Taxes Manually " (page 183)
- "Invoicing Shipments " (page 116)
"Looking Up Posted Documents" (page 188)
"Processing a Credit Card Prepayment " (page 112)
"Voiding a Credit Card Prepayment " (page 114)

**Overview**

Use the O/E Invoice Entry screen to enter prepayments, and to enter, post, print, and export invoices.

On the O/E Invoice Entry screen, you can:

- Enter and post invoices
- Enter prepayments for invoices
- Export invoices
- Print receipts (for prepayments) and invoices immediately after posting
- If you use Payment Processing, process or void a credit card prepayment for an invoice

In the header area of the O/E Invoice Entry screen, you specify the invoice number and customer number for the invoice.

**Customer Tab**

Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

On the Customer tab, you can specify:

- Shipping method
- Tracking number if sending by courier or registered mail
- Optional FOB (free-on-board) location
- Optional territory code
- Customer type (this specifies whether the customer is eligible for discounts or special pricing)
- Price list to use to select prices for item details
- Tax group
- Customer account set
• Payment terms that will be used for invoices from this transaction
• Due date and discount terms

You can also specify payment schedules for customers who are making multiple payments. For more information, see About Customer Payment Schedules.

**Invoice Tab**

Use the Invoice tab to perform the following tasks:

• Specify general information about the invoice
• Select options related to tax, project and job costing, project invoicing, and retainage
• Add and edit detail lines for items and miscellaneous charges on the Details table

You use the fields and options at the top of the Invoice tab to specify general information about the invoice, and to select options related to tax, project and job costing, project invoicing, and retainage.

Information you specify on the Invoice tab includes:

• Shipment number (or numbers) you are billing on the current invoice
• Invoice date
• Whether to calculate taxes automatically
• Ship-to location (from the Accounts Receivable customer record) or a shipping address just for the invoice
• Optional description, reference, and comment
• Invoice details

You use the Details table to add and edit detail lines for items and miscellaneous charges.

On the Details table, you can:

• Specify shipped quantities, prices, discount information, and serial numbers for a detail
• Enter a comment or special instructions about the detail.
• Enter a ship-via method and tracking number for a detail, if you shipped the items using a different method than for the rest of the invoice
• Open a separate detail entry screen to view and change information for a selected detail

**Tip:**
• To open a separate detail entry screen to view and change information for a selected detail, click **Items/Taxes**.

• Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed. Inventory quantities are displayed in the unit of measure defined for the item.

**Optional Fields Tab**

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

**Rates Tab**

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

If you are shipping goods, you can also change the rate information for converting the shipped amount from customer’s currency.

The Rates tab can show the following groups of exchange rate information:
- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.
- If you are shipping goods, change rate information for converting the shipped amount from customer's currency.
- If you are invoicing shipped goods, change rate information for the invoice.
- If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

For more information, see "About Exchange Rates " (page 75).

**Retainage Tab**

The Retainage tab appears only for job-related documents that use the **Retainage** option. You use this tab to specify retainage terms for orders, shipments and invoices. If you use multicurrency accounting, you also specify the exchange rate to use for the retainage invoice, retainage debit note, or retainage credit note when outstanding retainage is processed in Accounts Receivable.

The Retainage tab appears only if the following conditions are true:
- You use Sage 300 ERP Project and Job Costing
- The document is job-related
- You select the **Retainage** option for the document. (You cannot select this option if you select **Project Invoicing**.)

The default entries for the retainage percentage and retention period for each detail line come from the **Customer Default** fields on the Contract Maintenance Project tab in Project and Job Costing. You can change these entries for each detail line.

**Sales Split Tab**

Use the Sales Split tab to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

**Important!**
Sales commissions are calculated when you post Order Entry invoices. When invoicing multiple shipments, you should always check the Sales Split panel to ensure that the sales allocation is correct.
When you create an invoice from multiple shipments, uses only the sales split for the first shipment. If the shipments use different sales splits, you must change the allocation for the invoice manually.

If the sale is split among more than five salespersons, you should not create one invoice for the multiple shipments.

For more information, see "Managing Sales Splits " (page 83).

**Taxes Tab**

Use the Taxes tab to select the method you will use to calculate taxes, and to review and change tax information for a document.

On the Taxes tab, you can:

- Specify whether taxes are calculated manually or automatically.
- Select automatic tax calculation for tax reporting (if you report taxes in a different currency), or enter the tax reporting amounts manually.
- Review the tax information that applies to the transaction.
- Change the customer tax class for the document.

**Tip:** To change the tax status of an item, click the **Items/Taxes** button on the Order tab.

- Enter the tax base and tax amount, if you are entering taxes manually.
- Enter or edit the customer's tax exemption number.
- Automatically prorate tax amounts for individual details on the document.

For information about entering and distributing tax amounts manually, see "Entering and Distributing Tax Amounts " (page 182).

**Totals Tab**

Use the Totals tab to review and edit discounts, totals, and other final document details.

On the Totals tab, you can:

- Enter a comment about the invoice
- Specify the number of labels you want to print for an invoice
- Verify totals before posting an invoice
- Verify or change the invoice date

You can also review the prepayment total on this tab to determine if there is an outstanding balance.

**Fields and Controls**

**Buttons**

**Calc. Taxes**

The **Calc. Taxes** button appears on the Taxes tab. Click the button to calculate and overwrite any existing tax amounts on the Taxes tab.

- **Note:** If you do not select the **Calculate Tax** option on the Taxes tab, you can change tax amounts manually after clicking the **Calc. Taxes** button.

You can also use the **Calc. Taxes** button to recalculate taxes after changing the tax authority – even if you have selected the **Calculate Tax** option.

For more information about entering taxes manually, see "Entering Taxes Manually " (page 183).

**Components**

Click this button to view the components that make up a kit or a BOM. For more information, see "O/E Kitting Components Screen " (page 481) or "O/E BOM Components Screen " (page 451).

**Derive Rate**

This button is available on the Rates tab if you calculate the tax amount in the tax reporting currency manually (if you report taxes in a different currency than you collect them).

If you have already changed the tax reporting amount on the Taxes tab, click **Derive Rate** to calculate the actual exchange rate between the tax amount and the tax reporting amount.

- **Note:**
  - If Order Entry automatically calculates the tax amount in the tax
reporting currency, it will use the tax reporting currency exchange rate that you enter on the Rates tab.

- The rate on the Rates tab must match the effective exchange rate before you can post the document.
- If you change the total amount on the Taxes tab, you must redistribute the tax reporting amount to the document details.

**Dist. Taxes**

This button is available if you do not select the **Calculate Tax** option.

When you click the **Dist. Taxes** button, the total tax (from the Taxes tab) is prorated to the document details.

**Note:** You can review tax amounts for document details on the O/E Items/Taxes screen. For more information, see "O/E Items/Taxes Screen " (page 460).

**History**

Click this button to review the sales history for a selected item or a customer. For more information, see "Looking Up Sales History for Items or Customers " (page 190).

**Item/Tax**

Click **Item/Tax** to open the O/E Items/Taxes screen.

You can use this screen to add, edit, and delete items and charges, and to change tax information for items and charges. The screen displays details for each item or charge on a single screen, rather than in a table row, making it easier for you to review and modify information without scrolling.

You can also change a tax class to another tax class that is assigned to the authority, and you can specify whether tax is included (in the **Tax Included** column).

For more information, see "O/E Items/Taxes Screen " (page 460).

**Post**

Click this button to post a transaction. When you post, you can print documents related to the transaction. Depending on the transaction and the options you selected, you may be able to print a quote, order
confirmation, picking slip, prepayment receipt, and/or invoice. For more information, see "O/E Confirmation Screen" (page 453).

**Note:**
- If you have set up Order Entry to check customer credit limits, and the transaction you are posting will put the customer over their credit limit, the O/E Credit Check screen appears when you post. On this screen, you can put the transaction on hold, or you can override the customer's credit limit and continue with posting.
- For job-related transactions, if you change the status of a contract from Estimate to Open, and then post, you cannot change the contract's status back to Estimate. For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

**Prepayment**
Click **Prepayment** to open the O/E Prepayments screen, which you use to enter complete or partial payments for a transaction. For more information, see "O/E Prepayments Screen" (page 489).

**Note:** If you use Payment Processing, the **Prepayment** button is replaced with the **Capture** button after you pre-authorize a credit card payment.

**Customer No.**
Enter the customer number of the customer to whose account you will post the transaction.

The customer number determines the customer and billing address, and sets the default tax group and payment terms. In multicurrency systems, the customer number also specifies the currency of the document.

**Note:** After you enter a customer number, the field to the right displays the customer's name.

You can enter an existing customer number in the following ways:
- Enter the number, and then press Tab.
- Use the Finder Q to select the number.

Using the buttons to the right of the **Customer No.** field, you can:
• **Create a new customer.** Click the New button to create a new customer on the A/R Customers screen. When you finish, the new customer number appears in the **Customer No.** field.

• **Check the customer's credit.** Click the Pre Credit Check button to check the customer's credit status before entering a transaction.

• **Edit the customer's billing address.** Click the Zoom button to view and edit the customer's billing address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

• **Look up information about the customer.** Click the Inquiry button to open the A/R Customer Inquiry screen to look up information about the customer.

If a customer account or its account set is inactive, you cannot enter transactions for the customer. If a customer account becomes inactive after you enter an order, you will not be able to post changes or invoices for the order until the account is made active again.

**Note:**
If the **Allow Non-existent Customers** option is selected on the O/E Options screen, you can enter a new customer number, and then continue entering the document. In a multicurrency system, the currency for the order is set by the reporting currency of the customer tax group that you choose.

You should not use this method to enter transactions in a multicurrency system, especially if the reporting currencies for customer tax groups do not match your customers' currencies.

Also note that you must add the customer record in Accounts Receivable before you post an invoice for the order in Accounts Receivable.

**Entered By**
This field displays the name of the person who entered the transaction.

**Invoice No.**
An invoice number is a unique number that identifies an invoice.

You can use this field to:

• Enter a number for a new invoice if you want to create one manually, or accept ***NEW*** to have Order Entry assign the next available number.

• Select an existing invoice that you want to view, edit, or delete.
Order Entry assigns invoice numbers according to settings you specify on the Documents tab of the O/E Options screen. For more information, see "O/E Options Screen" (page 311).

**Customer tab**

Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

**Amount Due**

For each of the payments in a schedule, enter the amount due.

**Amount Remaining**

This field displays the amount remaining to be invoiced according to the multiple payment schedule used in the order.

**As Of Date**

Specify the date from which you want to calculate due dates and discount dates for the document.

By default, this field displays today's date (the session date you entered when you signed in to).

**Cust. Acct. Set**

By default, this field displays the account set specified for the customer on the A/R Customers screen.

The account set specifies the General Ledger accounts to which the transaction will be distributed: receivables control, payment discounts, prepayment liability, retainage, and write-offs.

You can change the account set for a transaction. If you use multicurrency, however, you must select an account set that uses the same currency as the customer's account set.

**Customer Type**

Select a code that identifies the price discount level for the customer. You can select Base, A, B, C, D, or E.

If you select Base, and the discount is based on customer type, the customer is not eligible for price discounts.
**Note:**
- You specify customer type on the A/R Customers screen, but you can change it for an individual order.
- Item prices in Inventory Control are specified by customer type.

**Discount %**
This field displays the discount percentage specified for the shipment, if any.

You can change the displayed rate. If the terms code does not use discounts, you can enter a discount percentage if necessary.

**Discount Amount**
This field displays the discount amount specified for the terms code, if any.

You can change the displayed amount. If the terms code does not use discounts, you can enter a discount amount for the document, if necessary.

**Due Date**
This field displays the due date calculated from the order or invoice date and the specifications for the terms code. If necessary, you can change the date.

**FOB Point**
If applicable, enter the free-on-board (FOB) location at which the customer begins paying freight charges on the order.

If a default FOB point or primary ship-to location is specified for the customer on the A/R Customers screen, the FOB point from the customer record or the ship-to location appears in this field when you select a customer.

**Number of Payments**
When you specify a terms code that uses a payment schedule, this field displays the number of payments permitted in the schedule.

You can enter payment amounts for all the payments in the schedule, or for only some of them. You cannot enter more payments than are permitted by the schedule.
**Note:** You must edit the terms code in Accounts Receivable to change the number of payments in a payment schedule.

**Payment Number**
When you are entering a payment schedule, this field displays the number of each payment line. You cannot change the number.

**Price List**
This field displays the code for the default price list for the order. The description for the price list you enter appears in the description field beside the **Price List** field.

**Ship Via**
Enter an optional ship-via code to specify the delivery method for the shipment.

If you specified a primary ship-to location for the customer on the A/R Customers screen in Accounts Receivable, the ship-via code for that ship-to location record appears as the default.

If the transaction uses a template, the description field to the right displays the description for the ship-via code used in the template by default.

If you select a ship-to location with an associated ship-via code for the transaction, the description for that location's ship-via code replaces the default description.

You can change the description if necessary.

**Tax Group**
Enter the code for the customer's tax group.

The tax group determines the tax authorities to which the customer is subject, and the tax classes that are used for each authority to calculate sales tax.

You can change the tax group at any time, even after posting. (For example, if you change the ship-to location on a posted order, you can also change the tax group to include the tax authorities for the new location.)
Note: If you use Project and Job Costing, see "About Order Entry Integration with Project and Job Costing" (page 7) for information about specifying tax groups for contracts and projects.

**Terms Code**

This field displays the terms code you specified on the Customer tab, and its description.

**Territory**

If you use territory codes to identify sales regions or track customer accounts, enter the territory code for the transaction in this field.

Note: You can use the A/R Ship-To Locations screen to assign a territory code to each ship-to location you create for customers.

**Tracking No.**

If you use waybill numbers to track shipments, enter the waybill number in this field.

Note: You can also enter a separate tracking number with any detail included in the transaction.

**Invoice tab**

Use the Invoice tab to perform the following tasks:

- Specify general information about the invoice
- Select options related to tax, project and job costing, project invoicing, and retainage
- Add and edit detail lines for items and miscellaneous charges on the Details table

You use the fields and options at the top of the Invoice tab to specify general information about the invoice, and to select options related to tax, project and job costing, project invoicing, and retainage.

Information you specify on the Invoice tab includes:

- Shipment number (or numbers) you are billing on the current invoice
- Invoice date
- Whether to calculate taxes automatically
• Ship-to location (from the Accounts Receivable customer record) or a shipping address just for the invoice

• Optional description, reference, and comment

• Invoice details

**Calculate (Calc.) Tax**

Select this option if you want Order Entry to calculate tax automatically for this document. For more information, see "Entering Taxes Manually " (page 183)

**Note:** If this document is job-related and you select the Project Invoicing option, you cannot enter taxes manually. The Calculate Tax option is automatically selected, and you cannot change it.

**Description**

If necessary, enter an optional description for the invoice, using up to 60 characters. The description from the shipment document appears as the default, but you can enter a different description for the invoice if you wish.

If you do not change the description for the shipment or the invoice, it will appear for the Accounts Receivable invoice and in the General Ledger batch, depending on the options you selected for your Order Entry system. For more information about these options, see "O/E Options Screen " (page 311) and "O/E G/L Integration Screen" (page 327).

**From Multiple Shipments**

If you want to create a new invoice from multiple shipments, select the From Multiple Shipments option, and then click the Zoom button to open the O/E Create Invoice from Shipments screen.

For more information, see "O/E Create Invoice from Shipments Screen " (page 609).

**Note:** You cannot combine job-related and non-job-related shipments in the same invoice.

**Invoice Date**

Enter the date for the invoice. By default, this field displays the system date (the date you selected when signing in to Sage 300 ERP).
Invoice Subtotal
This field appears on both the Invoice tab and the Totals tab.

It shows the total amount of all items and miscellaneous charges on the invoice, including tax amounts that are included in item prices.

Job Related
This option is selected if you are invoicing a shipment for a project that you are managing using Sage 300 ERP Project and Job Costing.

You cannot change this setting.

When you post the invoice, Order Entry updates the contracts, projects, categories, and (if required) resources in Project and Job Costing to which the items in this document apply.

Location
This field displays the code that identifies the inventory location from which you shipped the items for the selected detail.

PO No.
This field displays the customer's purchase order number for reference.
You cannot change the PO number on the invoice.

Qty. Available
Displays the inventory quantity that is available for sale to your customers. This is determined by the quantity on hand less the quantity committed, as maintained in Inventory Control.

Qty. Committed
Displays the inventory quantity that is committed to orders.

By committing an inventory quantity to an order, you ensure that the required inventory will be available when it is time to ship the order. (If a quantity is already committed to an order, you cannot ship another order for the same items unless there is a sufficient quantity in inventory in addition to the committed quantity.)

Tip: You can click the Drilldown button to the right of the displayed quantities to view more information (such as the customer and the expected ship date).
Appendix A: Order Entry Screen Guides

**Qty. on Hand**
Displays the inventory quantity currently on hand, as maintained in Inventory Control.

**Qty. on Purchase Order**
Displays the inventory quantity that you have ordered.

**Tip:** You can click the Drilldown button to the right of the displayed quantities to view more information (such as the order date and the expected arrival date).

**Qty. on Sales Order**
Displays the inventory quantity that customers have ordered from you.

**Tip:** You can click the Drilldown button to the right of the displayed quantities to view information (such as the customer and the expected ship date).

**Reference**
The reference from the shipment document appears as the default, but you can enter a different reference for the invoice if you wish.

The reference appears in Accounts Receivable as the reference for the invoice, and in the general ledger batch (if you select Detail Desc./Ref. for the G/L Reference Field or G/L Description field option in the A/R Options screen, and do not consolidate the general ledger transactions created by Accounts Receivable).

**Retainage**
Select this option to indicate that retainage applies to the document you are entering. (Retainage is where a percentage of the payment is held back for a fixed period of time, and then invoiced separately after the hold-back period.)

When you select this option, the **Retainage** tab becomes available. You use this tab to specify how to process the retainage amount for the document.

**Note:**
- The **Retainage** option is available only if you are entering a job-
related transaction and your Accounts Receivable ledger uses the **Retainage Accounting** option.

- The **Retainage** option is not available if you select **Project Invoicing** (where invoicing is handled through Project and Job Costing).

### Ship-To Location

Enter a ship-to location that you have defined for the customer on the A/R Ship-To Locations screen in Accounts Receivable. You can do this in the following ways:

- Enter the ship-to location, and then press Tab.
- Use the Finder to select the location.

Using the buttons to the right of the field, you can:

- **Create a new ship-to location.** Click the New button to create a new ship-to location on the A/R Ship-To Locations screen. When you finish, the new ship-to location appears in the **Ship-To Location** field.

- **Edit the customer's ship-to address.** Click the Zoom button to view and edit the customer’s ship-to address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

**Note:**

- When you enter a ship-to location, Order Entry updates the price list, territory, tax group, and sales split information for the transaction based on the information stored for the ship-to location.

- If you do not specify a ship-to location, Order Entry uses the address in the customer record.

### Shipment Number

In this field, enter the document number for the shipment that you are invoicing at this time, or use the Finder to select the shipment number. Details from the shipment document you select appear in other fields on the screen.

You can also click the Drilldown and Inquiry buttons to the right of this field to view more information about the selected shipment.
Note: If you are invoicing multiple shipments, do not select a shipment number in this field. Instead, select the From Multiple Shipments option, and then click the Zoom button to open the O/E Create Invoice from Shipments screen. For more information, see "O/E Create Invoice from Shipments Screen" (page 609).

Year/Period

This is the fiscal year and period to which the invoice transactions will be posted in the general ledger. You cannot change it except by changing the Posting Date.

You can enter a different invoice date, and you can enter a different posting date for the document.

Note: You cannot post transactions to closed fiscal periods.

Details table

You use the Details table to add and edit detail lines for items and miscellaneous charges.

On the Details table, you can:

- Specify shipped quantities, prices, discount information, and serial numbers for a detail
- Enter a comment or special instructions about the detail.
- Enter a ship-via method and tracking number for a detail, if you shipped the items using a different method than for the rest of the invoice
- Open a separate detail entry screen to view and change information for a selected detail

Tip:

- To open a separate detail entry screen to view and change information for a selected detail, click Items/Taxes.
- Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities.
Inventory quantities are displayed in the unit of measure defined for the item.

**A/R Item No.**
If the document is job-related and you are using project invoicing, this field displays the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.

**A/R Item UOM**
If the document is job-related and you are using project invoicing, this field displays the unit of measure for the Accounts Receivable item number that is assigned to the item or miscellaneous charge for billing in Project and Job Costing.

**Billing Type**
If the document is job related, this field indicates whether the item or charge is billable or non-billable.

**Category (Inventory)**
This field displays the category assigned to the item record in Inventory Control. You can use the Finder to select a different category.

**Category (Job Related)**
This field appears if you selected the Job Related option for the document.

For job-related orders, specify the category to use for this item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than "Category" in Project and Job Costing, that term appears as the label for this field.
- Use the Item Number field to specify the resource.
- After you add the detail, you cannot edit this field.
**COGS Acct.**

If the document is job-related and you are not using project invoicing, this field displays the default Cost Of Goods Sold account from Project and Job Costing for the item or charge.

**Comments/Instr.**

This field indicates whether there are comments or instructions entered for the detail, and also allows you to add comments or instructions. For more information, see "Adding Comments and Instructions to Order Entry Transactions " (page 101).

**Note:**
- Comments for a detail line appear in the Description column on printed quotes, order confirmations, invoices, credit notes, and debit notes.
- Instructions for a detail line appear in the Description column on printed picking slips.

**Contract**

If the sales invoice is job-related, each invoice detail shows where the items or resources are going to be used.

You can add this information only for new miscellaneous charges that you are adding to the invoice. You cannot change this information for existing detail lines from the shipments that you are invoicing.

If you use different terms than “Contract,” “Project,” and “Category” in Project and Job Costing, the program displays them instead.

Invoices update the costs for jobs in the Project and Job Costing program.

**Note:**
- You use the Item Number field to specify the resource.
- After you add the detail line, you cannot change this field.

**Cost Class**

This field displays the cost class for the project category used in each job-related detail.
**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

**Costing UOM**
This field displays the costing unit of measure specified in the item record.

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

**Customer Item No.**
If you set up customer item numbers in Inventory Control (using the I/C Customer Details screen), you can use the customer's item number to enter the item number for the detail.

If you use customer item numbers to enter the item number for details, Order Entry will replace the customer’s item number with your inventory item number, and automatically insert the customer's item number in this field. (This works the same way as the manufacturers' item numbers.)

**Description**
This field displays the description from the item price list or miscellaneous charge record for the item or miscellaneous charge selected in the **Item No./ Misc. Charge** field.

This description appears on printed order confirmations, picking slips, and invoices. You can use the default description or enter a new description to be used for an individual transaction.

In a multicurrency system, the description from the item record appears here if the price list does not include a price in the customer’s currency.

**Discount %**
You can specify a separate discount percentage or amount for each detail in an Order Entry transaction.

You can also enter a discount percentage or amount for the transaction on the Totals tab.

**Discount Amount**
The program displays the discount amount specified for the terms
code, if any.

You can change the displayed amount. If the terms code does not use discounts, you can enter a discount amount for the individual order or invoice, if necessary.

Discountable
Select Yes if the customer is eligible to receive a payment discount when paying early.

Discounted Extended Amount
To calculate the total value of a detail line, Order Entry divides the unit price by the pricing unit of measure conversion factor, then multiplies the result by the order unit of measure conversion factor and the quantity ordered.

The total value of a detail line is not the value of the quantity shipped. The cost of the shipment (which will appear on the invoice) is calculated in the Extended Price column.

Extended Cost
This field appears if you selected the Job Related option for the document.

Extended cost is the cost amount for the miscellaneous charge. It can also be used in Project and Job Costing to calculate labor and overhead. For more information, see Project and Job Costing help.

Ext. Price
Enter the extended price for the detail, or accept the calculated value.

Extended price refers to the extended price of an order (that is, the total cost of the items being ordered, whether or not they have been shipped). It is calculated automatically when you enter an order quantity. Sage 300 ERP divides the unit price by the pricing unit of measure conversion factor, and then multiplies the result by the order unit of measure conversion factor and the quantity ordered.

If you change the extended price calculated by the program, an asterisk appears beside the Ext. Price field on the O/E Items/Taxes screen, and also appears beside the item on the O/E Transaction List report.
**Extended Weight**

This field displays the extended weight, which is calculated by multiplying quantity shipped by the unit weight entered for the item in Inventory Control.

You might use extended weight to determine postage, shipping, or other charges.

You can edit the item weight and the extended weight on the transaction entry screen if necessary.

Order Entry converts the extended weight for each detail to the order weight unit of measure, and displays the estimated weight for the entire order on the Totals tab.

**Invoice UOM**

This is the unit of measure for the invoice, such as "Each."

The invoice unit of measure is determined by the shipment and matches the shipment unit of measure. It may not match the order unit of measure, which also appears in the detail line.

**Invoice Weight UOM**

This is the unit of measure for weighing this item on the invoice.

The default unit should be the weight unit of measure specified for the shipment. You can change the weight unit of measure for the detail line, if necessary.

The weight unit of measure for the complete invoice is determined by the default weight unit of measure specified on the I/C Options screen.

**Item No./ Misc. Charge**

Enter the item number or miscellaneous charge code for the item or charge. Order Entry displays information from the Inventory Control item record, including pricing unit and unit price information based on the customer's price list.

**Note:** After entering an item number in this field, you can use the Finder to see alternate items for the specified item. For more information about specifying alternate items, see the Inventory Control help.
After you add an item or charge, you can no longer change its item number or miscellaneous charge code.

**Kit/BOM**
If the selected item is part of a kit or a BOM (bill of materials) in Inventory Control, click the Finder to select the kit or BOM number (if you have more than one build for the item).

To review the items in the build, click the **Components** button at the bottom of the screen.

**Note:**
- You can create kits from stock or non-stock items in Inventory Control and then use them in Order Entry. You can also enter or post multiple kitting entries (or mix kitting entries with regular entries) in any Order Entry transaction entry screen.
- Kits can be assigned serial numbers that are maintained in Serialized Inventory.
- You can include kit components and BOM components when printing order confirmations, quotes, picking slips, invoices, credit notes, and debit notes.
- When you print the O/E Transaction List report and select Detail as the report type, the report displays kit components and BOM components.
- When you print the O/E Posting Journals report, it includes actual breakdown amounts for each kit component.

**Line Number**
Line numbers are assigned automatically, and you cannot change them.

You use line numbers to identify details you have entered, or to recall them for editing when you are using the O/E Items/Taxes screen to enter detail information.

You can also list items on picking slips by line number.

**Location**
By default, this field displays the location code specified for the order. You can change the location for individual details.
Optionally, enter the code for the physical location from which you will ship the items ordered on the detail line.

You must specify a physical location, not a logical inventory location. Logical locations are used primarily for transferring goods between physical locations in Inventory Control.

**Note:** You cannot change the location for a serialized or lotted item after you enter a quantity in the **Quantity Ordered** field.

**Tip:** You can click the **Location** Finder to see the quantity on hand at other locations.

**Manuf. Item No.**
If you have set up manufacturer's item numbers in Inventory Control, you can enter the manufacturer's item number (usually a bar code) in this field, rather than entering your inventory control item number. The manufacturers' item numbers are translated to your inventory item numbers by Inventory Control.

If you entered the manufacturer's item number in the Item Number field, Order Entry inserts it here automatically when it retrieves item information.

For more information about using manufacturer's item numbers, see the Inventory Control help.

**Non-Stk. Clr. Acct.**
If you selected a non-stock item, the non-stock clearing account used by the item's account set appears as the default in this field. You can change the account number if necessary.

**Optional Fields**
If you use optional fields, you can review and edit optional fields by clicking the **Optional Fields** column heading. (If you are using the O/E Items/Taxes screen, click the Zoom button beside the **Optional Fields** option.)

If an optional field is required, you cannot save the transaction unless the field has a default value, or until you fill in the field yourself.
To add optional item fields that were not automatically inserted, press the Insert key to add a new line to the table, and then use the Finder button to select an optional field.

Optional fields must be assigned to the transactions screens using the O/E Optional Fields screen before you can add them to individual transactions. For more information, see "O/E Optional Fields Screen " (page 349).

**Order Number**

This field displays the order number for each detail, indicating the source of the detail.

You can click the Drilldown button in the column header to view the order on the O/E Order Entry screen.

**Price Approval**

Price checks are set in Inventory Control price lists for particular items, price lists, and user IDs.

If price checks are in effect, and the price you enter is outside the boundaries allowed, this field displays "Yes." To approve the price:

1. In the Price Approval column heading, click the Zoom button.
2. On the O/E Price Approval screen, enter the ID of the person approving the price override. If security is set, you must also enter a password.

**Note:** The Price Approval field does not appear if you are using the O/E Item/Taxes screen. Instead, an error message may appear when you try to save the item detail, stating that the price requires approval.

For more information, see "About Price Checks " (page 82).

**Price By**

This field indicates whether the item is priced by weight or by quantity.

- If pricing is by quantity, Sage 300 ERP sets volume discount amounts or percentages according to the quantity of goods that are ordered.
• If pricing is by weight, Sage 300 ERP sets volume discount amounts or percentages by item weight.

Item weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Note:** Pricing by weight is available in Sage 300 Premium ERP only.

**Price List**
This field displays the code for the price list used for the detail on the shipment.

You can change the unit price and the extended price, but you cannot change the price list.

**Pricing UOM (unit of measure)**
This field displays the unit of measure in which the item is priced.

Sage 300 Premium ERP supports multiple pricing units of measure, but you must set one as the default on the I/C Item Pricing screen in Inventory Control.

The pricing UOM is determined by the price list as follows: If the price list provides only one pricing UOM, that UOM appears here. If the price list provides several pricing UOMs, the pricing unit that matches the order UOM appears here. If no pricing UOM matches the order UOM, the default pricing UOM appears here. If you price by cost, the default pricing UOM appears here, and the cost-based price appears in the Unit Price field.

**Note:** If the item is not on the specified price list, the program uses the item's stocking unit as the pricing unit.

**Project**
This field appears if you selected the **Job Related** option for the document.

For job-related orders, specify the project for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.
Note:
- If you use a term other than “Project” in Project and Job Costing, that term appears as the label for this field.
- Use the Item Number field to specify the resource.
- After you add the item or charge, you cannot edit this field.

Qty. B/O
If you did not ship the entire order and you use backorder quantities, the quantity backordered appears in this field.

The quantity on backorder is the quantity on order less the quantity shipped.

Qty. Committed
You cannot change the quantity committed on an invoice.

Order Entry lets you specify an inventory quantity that is committed to a particular order. When it is time to ship the order, the quantity is guaranteed to be available.

If a quantity is already committed to an order, you cannot ship another order for the same items unless there is a sufficient quantity in inventory in addition to the committed quantity.

Qty. Invoiced
This field displays the quantity of items from the order you are invoicing.

The quantity from the shipment appears as the default for this field, but you can change the quantity.

If you use Serialized Inventory and Lot Tracking, when you enter a quantity invoiced for a serialized or lotted item, and then leave the Qty. Invoiced field, the O/E Serial/Lot Numbers Allocation screen appears. You use the screen to allocate or edit serial numbers and/or lot numbers for the item detail. You must fully allocate serial and lot numbers before you can save the detail.

Qty. On Order
This is the quantity that is still on order (after the shipment).
The quantity on order and the quantity shipped are used to calculate the quantity on backorder.

**Retainage Amount**

The retainage amount is the amount the customer can withhold for an original document detail until the end of the retention period, when retainage is invoiced.

To calculate the retainage amount, the program multiples the extended detail amount (or the extended amount plus tax, if you include taxes in retainage) by the retainage percentage.

You can enter a new retainage amount, if necessary. If you enter an amount to replace a calculated amount, the program recalculates the retainage percentage.

**Note:** You cannot change the amount on the Retainage tab.

**Retainage Percentage (%)**

Enter the retainage percentage to be used when calculating the retainage amount for the item or charge.

When you edit this field, the retainage amount for the item or charge is calculated automatically.

**Retention Period**

The retention period is the number of days for which the customer can withhold the retainage amount.

You issue the retainage invoice in Accounts Receivable at the end of the retention period.

**Revenue Acct.**

If the document is job-related and you are not using project invoicing, you also specify the revenue/billing account for each item or charge.

The default account number is specified in Project and Job Costing, and is used instead of the sales account specified for the item in the item category record.

**Ship Date**

This field displays the shipment date from the shipment document.
**Ship Via and Description**

In the **Ship Via** field, enter the ship-via method for the detail. When you navigate out of this field, the description from the ship-via record for the selected ship-via code appears in the related **Description** field.

**Note:** You can specify a separate ship-via method for each detail.

**Shipment No.**

Order Entry displays the shipment number for each detail, indicating the source of the detail, if you are invoicing more than one shipment.

You can click the Drilldown button in the column header to view the shipment in the O/E Shipment Entry screen.

**Shipped To Date**

This field displays the number of item units that have been shipped to date for the detail.

You can click the Drilldown button to open the O/E Shipments/Invoices screen and view shipment and invoice information for the detail. For more information, see "O/E Shipments/Invoices Screen" (page 500).

**Tracking No.**

If you use tracking (waybill) numbers to track shipments that use different carriers or that are shipped at different times, enter the tracking number to use for the detail.

**Type**

Select the type of detail you are entering: Select Item to add a detail line for an inventory item or non-stock item that is assigned an item number in Inventory Control. Select Miscellaneous to add a detail line for a miscellaneous charge defined in Order Entry.

**Tip:** You can select a detail type by typing the first letter (for example, type M for Miscellaneous), or you can toggle between available selections by pressing the spacebar or double-clicking in the field.

**Unit Cost**

You enter the unit cost for an item only if the item uses the user-
specified costing method in Inventory Control (that is, if User-Specified appears in the Costing Method field on the I/C Items screen).

For more information, see "Inventory Costing Methods" (page 33).

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

### Unit Price

By default, this field displays the lowest unit price for which the customer is eligible. This may be the base price, a sale price for a specified time period, or the price specified for the customer's price level or the quantity purchased, based on a discount or markup.

If necessary, enter the price for the item, per pricing unit.

**Note:**

- If price checks are in effect, and the unit price is outside the allowed limit, the price must be approved. For more information, see "About Price Checks " (page 82).

- You can edit the information in this field only if you have Unit Price Override security authorization in Order Entry.

- If the item is not on the price list you specified for the detail, no price appears.

- If the lowest price is a negative amount, it is displayed as zeros.

- If you set up contract pricing for a customer in Inventory Control, Order Entry uses that information to calculate prices for items affected by the customer's pricing contract, and it displays the contract price by default in this field.

- If you do not set up contract pricing for a customer, Order Entry calculates prices based on the customer type and the price lists you set up in Inventory Control.

- If the price list you select is not currently in effect: The Unit Price Finder does not appear. (That is, the Finder does not appear if the document date is not between the Price List Starts date and the Price List Ends date specified for the item, currency, and price list.
The Unit Price field displays 0.000000 by default.

- The number of decimal places that appear in this field is determined by the information specified for the item on the I/C Item Pricing screen.

**Unit Weight**

This is the weight of a single item for this detail line expressed in the invoice weight unit of measure. You can multiply this weight by the quantity ordered to get the extended weight.

You can edit the unit weight and the extended weight on the invoice.

The estimated weight on the Totals tab is in the default weight unit of measure specified on the I/C Options screen.

**WIP Acct.**

If the document is job-related and you are using project invoicing, you also specify the WIP (Work in Progress) account for each order detail.

By default, this field displays the account number specified in Project and Job Costing.

**Note:** The level at which the WIP account is specified in Project and Job Costing depends on the project type and accounting method.

**Optional Fields tab**

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.
For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

**Optional Field**

Use the Optional Field Finder to select optional fields that are assigned (in the O/E Optional Fields setup screen) to this type of transaction.

When you select an optional field code, Order Entry displays its description in the next column.

**Value**

Use the Value Finder to select a value created for the optional field in Common Services.

When you select a value code, Order Entry displays its description in the next column.

**Value Set**

The Value Set column shows whether a blank optional field currently has a value. (By looking at the field, you cannot know otherwise whether the field has a blank default value or no value.)

The Value Set field changes from No to Yes if you make an entry in the Value field.

**Rates tab**

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

The Rates tab can show the following groups of exchange rate information:

- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:
• Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.

• If you are shipping goods, change rate information for converting the shipped amount from customer's currency.

• If you are invoicing shipped goods, change rate information for the invoice.

• If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

For more information, see "About Exchange Rates " (page 75).

**Currency**
This field displays the currency code and description for the customer's currency.

The currency is set for the customer in Accounts Receivable, and you cannot change it in Order Entry.

If the tax group specified for this document on the Customer tab uses a different currency from the customer's currency and your functional currency, the code and description for that currency appear in the adjacent **Tax Reporting Currency** field.

**Rate**
This field displays the exchange rate currently in effect for the specified currency and the selected rate type and rate date.

If you want to change the rate, you can click the Finder to see a list of available rates for the selected rate type and rate date.

**Rate Date**
Enter the date to use to select the exchange rate. Order Entry displays
the rate date that is nearest the date you entered.

You can enter any date for which an exchange rate has been entered for the currency. (You enter exchange rates for currencies on the Currency screen in Common Services.)

**Rate Type**

Enter the rate type to use when converting multicurrency amounts to functional currency for the document.

Examples of rate types might be "Daily spot rate," "Monthly average rate," and "Contract rate."

**Tax Reporting Currency**

This field displays the exchange rate currently in effect between the tax reporting currency and your functional currency for the displayed rate type and rate date. You can change the rate on this tab, or you can change the tax totals on the Taxes tab and then derive the new rate on the Rates tab.

- If you change the exchange rate for the tax reporting currency on the Rates tab, the program will change the tax reporting amounts on the Taxes tab when you use the **Calc. Taxes** button to calculate taxes (if you are not calculating taxes automatically).

- If you change the tax reporting amount on the Taxes tab (after clearing the **Calculate Tax Reporting** option), you will have to redistribute the new tax amount to the detail lines, and then enter the new tax reporting exchange rate on the Rates tab.

To calculate the new exchange rate, click the **Derive Rate** button on the Rates tab.

---

**Note:**

You cannot post the document unless the tax reporting exchange rate is correct for the tax reporting amount on the Taxes tab, and the tax reporting amounts for the document details match the total tax reporting amount on the Taxes tab.

You will see a warning if you change an exchange rate by an amount that exceeds the Spread setting for the currency table on the Currency Rates screen in Common Services.

---

**Retainage tab**
The Retainage tab appears only for job-related documents that use the Retainage option.

You use this tab to specify retainage terms for orders, shipments and invoices.

If you use multicurrency accounting, you also specify the exchange rate to use for the retainage invoice, retainage debit note, or retainage credit note when outstanding retainage is processed in Accounts Receivable.

**Retainage %**
This field displays the retainage percentage used to calculate the retainage amount for the shipment, invoice, debit note, or credit note. It is a weighted average percentage, based on the sum of the details.

**Retainage Amount**
This field displays the sum of the retainage amounts for all shipment details in this field. You cannot change the amount.

**Retainage Rate**
You use this field to specify the method the program will use to determine the exchange rate for the retainage document when outstanding retainage is eventually processed in Accounts Receivable.

You can choose one of the following methods:

- Use Original Document Exchange Rate—to use the same rate as the invoice for this shipment.
- Use Current Exchange Rate—to use the rate in effect when the outstanding retainage is processed in Accounts Receivable.

**Retainage Terms**
You can use different terms for retainage documents (used to invoice for outstanding retainage) than you use for this invoice.

If retainage terms are specified in the A/R customer record, the retainage terms code from the customer record is used as the default retainage terms code for the invoice.

If no retainage terms code is specified in the customer record, the customer’s usual terms code is used as the default.

**Sales Split tab**
Use the Sales Split tab to calculate sales commissions by allocating
transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

**Percentage**

Enter the percentage of the sale to assign to each salesperson.

You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Salesperson Code**

Enter a salesperson code to add a new salesperson, or to replace a currently assigned salesperson for a transaction.

You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Note:** You set up salesperson codes in Accounts Receivable.

**Salesperson Name**

This field displays the name associated with the salesperson code.

**Note:** You set up salesperson codes in Accounts Receivable.
Taxes tab
Use the Taxes tab to select the method you will use to calculate taxes, and to review and change tax information for a document.

Calculate Tax
For each Order Entry document, you can specify whether taxes are calculated automatically or entered manually.

If you want Order Entry to calculate tax for this document, select the Calculate Tax option.

Note: If the document is job-related and you selected the Project Invoicing option, you cannot enter taxes manually. The Calculate Tax option is automatically selected, and you cannot change it.

If you want to enter tax amounts manually, do not select the Calculate Tax option. If you do not select this option:

- The Dist. Taxes button appears on the screen.
- You can enter tax amounts for the tax authorities listed for the document.

Click Dist. Taxes to prorate tax that you enter manually on the Taxes tab to the document details. For more information, see Entering Taxes Manually.

Note: You cannot prorate a tax amount to an authority that uses an exempt tax class.

Calculate Tax Reporting
Select this option if you want the program to automatically calculate tax reporting amounts for the document. Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

If you clear this option, you can edit tax reporting amounts.

Note:
- This option appears only if a tax authority has a tax reporting currency that is different from the source or functional currency.
• The default for this check box is determined by the **Calculate Tax Reporting Amounts Automatically** option on the O/E Options screen.

**Tax Reporting Currency**
This group of fields provides a breakdown of taxes calculated for the invoice, displayed in your tax reporting currency.

**Total Tax**
This field displays the total amount of tax calculated for the transaction (including taxes included in the price), displayed in the customer's currency.

**Note:** The fields in the Tax Reporting Currency group display the total tax in your tax reporting currency.

**Tax Details table**
This table displays information about tax authorities, classes, and amounts for the current document.

If you do not select the **Calculate Taxes** and the **Calculate Tax Reporting** options, you can change the tax base, tax amount, and tax reporting amount for each authority on the document.

**Note:**
You cannot edit information about a tax authority directly on this tab. To change information for a tax authority, you must use the screens in Tax Services.

You can change the tax authorities used by a particular order or invoice by changing the tax group on the Customer tab.

For debit notes and credit notes, however, you **must** use the same tax group as the invoice you are debiting or crediting. (Also, you cannot select a template code or ship-to location that uses a different tax group than the invoice.)

**Authority Description**
This field displays the description for a tax authority.
Class Description
This field displays the description for a tax class.

Customer Tax Class
This column displays the tax class that is assigned to each tax authority.

If you change the tax class for a tax authority on this screen, click **Calculate Taxes** to see the recalculated tax amount.

**Note:** If the **Calculate Tax** option is selected, the tax amount is recalculated automatically, but is not displayed immediately.

To change the tax class description or make other changes to the information for the specified tax group, use the Tax Services screens in Common Services.

Registration Number
If necessary, enter the customer’s tax registration or tax exemption number.

Tax Amount
If you selected the **Calculate Tax** option, this field displays the amount of tax that is due for each authority.

For each authority, Order Entry calculates a sales tax amount if: The customer is subject to tax. The order contains taxable items or taxable miscellaneous charges. Tax rates are specified for the tax authorities and classes in Tax Services.

If you are entering taxes manually, enter the total tax amount you calculated for each tax authority. Ensure that the amounts you enter agree with the sum of the tax amounts for the details, for each tax authority.

Tax Authority
This field displays the tax authorities that are assigned to the tax group specified for the customer in Accounts Receivable.

Tax Base
If you selected the **Calculate Tax** option, Order Entry displays the transaction total. Any invoice or early-payment discounts are not
deducted from this total.

If you are entering taxes manually, enter the total transaction amount in this field.

**Tax Reporting Amount**

If you selected the **Calculate Tax Reporting** option, this field displays the tax reporting amount calculated by applying the exchange rate between the source currency and the tax reporting currency.

If you did not select the **Calculate Tax Reporting** option, you can edit the tax reporting amount in this field.

**Note:**

- This field appears only if a tax authority for the transaction has a tax reporting currency that is different from the source or functional currency.

- The default for this check box is determined by the **Calculate Tax Reporting Amounts Automatically** option on the O/E Options screen.

Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

**Totals tab**

Use the Totals tab to review and edit discounts, totals, and other final document details.

**Actual Ship Date**

This is the actual ship date from the shipment. You cannot change it on the invoice.

**Amount Due**

Displays the total amount due for the invoice. Discounts that apply to the invoice are deducted from the amount due.

**Comment**

Enter an optional comment of up to 250 characters for the transaction, and then press Tab to add the comment.

**Note:** If you do not press Tab, your comment will not be saved.
Comments appear in the Comments section on printed quotes, order confirmations, invoices, picking slips, credit notes, and debit notes.

For more information, see "Adding Comments and Instructions to Order Entry Transactions" (page 101).

**Discount Miscellaneous Charges**

Select this option if you want to apply the order discount to the miscellaneous charges subtotal. Order Entry prorates the discount specified for **the Less Invoice Discount** field to miscellaneous charges.

If you do not select this option, the order discount is applied only to the items subtotal.

You can also specify discounts by customer type and early-payment terms. You select the customer type and terms code on the Customer tab.

**Estimated Weight**

This field displays the estimated weight of the shipment, based on the weight for the units of measure and item quantities specified in the document. (You specify item weights on the I/C Items screen in Inventory Control.)

**Tip:** Use the estimated weight to calculate shipping costs or postage.

**Included Tax**

This field displays the total tax amount that is included in item prices and miscellaneous charge amounts.

**Invoice Subtotal**

This field appears on both the Invoice tab and the Totals tab.

It displays the total amount of all items and miscellaneous charges on the invoice, including tax amounts that are included in item prices.

**Items Subtotal**

This field displays the total amount of the item detail lines for the document.
The items subtotal includes tax amounts that are included in item prices, but does not include miscellaneous charge amounts or tax amounts that are charged separately on item prices.

**Less Detail Discount**
This field displays the percentage and total of discount amounts applied to individual detail lines.

**Less Inv. Discount**
Use these fields to specify a discount on the invoice total.

This is a discount for a volume purchase, for example, and not an early payment discount. If you enter a discount, it is calculated for all the items on the invoice. If you discount miscellaneous charges as well, the discount is also calculated for the miscellaneous charges.

You can enter a percentage discount or a fixed amount.

**Note:** An asterisk will appear beside the amount field if you override the amount calculated from a percentage. The discount amount will not change unless you re-enter the discount percentage.

**Example:**
Assume that a 33.3333% discount produces a discount amount of 24,999,94.

If you change the amount to 25,000:
- An asterisk will appear by the amount to show that the calculation was overridden.
- If you add more item details to the order, the discount percentage will be automatically recalculated for each detail, but the discount amount will not be recalculated unless you re-enter the discount percentage.

**Less Inv. Prepayment**
This field displays the amount of all prepayments that have been entered for this invoice.

To apply a prepayment to a specific invoice, enter the prepayment with the invoice. Prepayments made to the order are applied to invoices when they are posted in Accounts Receivable (matching by order number).
**Less Retainage**
This field displays the total of all retainage amounts (held back amounts) on this invoice. The retained portion is invoiced later in Accounts Receivable.

**Less Terms Discount Available**
This field displays the amount of any early-payment discount for which the customer might be eligible.

This discount is specified by the terms code assigned to the transaction.

**Tip:** You edit payment terms for the transaction on the Customer tab.

**Note:** The number in this field indicates a discount that is currently available, based on the payment terms for the customer. This discount may no longer be available when payment is received.

**Misc. Charges Total**
This field displays the total amount of the miscellaneous charge detail lines for the document.

The miscellaneous charges subtotal includes tax amounts that are included in miscellaneous charge amounts, but does not include item prices or tax amounts that are charged separately on miscellaneous charge amounts.

**Net Amount**
This field displays the total amount of all items and miscellaneous charges for the document, after any discounts have been subtracted. The net amount also includes tax amounts that are not included in item prices or miscellaneous charge amounts.

**Net of Detail Discount**
This field displays the total amount of all items and miscellaneous charges on the document, minus the total amount of discounts applied on individual detail lines.

**Number of Labels**
Use this field to specify the number of labels you need to print.

You can print labels for the order (for example, to send an order confirmation), and you can print shipping labels for each invoice.
No. of Lines
This field displays the total number of detail lines (for items and miscellaneous charges) entered for the document.

If you are not invoicing the entire order, this field still displays the total number of detail lines (including those you are not invoicing).

**Tip:** Use this number to be sure you have entered all the details you need and deleted any unused details.

Plus Excluded Tax
This field displays the total amount of taxes calculated on the items and miscellaneous charges for the document.

The amount in this field does not include tax amounts that are included in item prices or miscellaneous charge amounts.

Total
This field displays the total amount, including taxes. This amount does not include invoice prepayments or early-payment discounts.

Total Order/Shipments Prepayments
Prepayments entered with all orders and shipments associated with this invoice appear on the Totals tab for your information. If the invoice includes details from several different orders or shipments, you will see the total prepayments for all of the orders and shipments.

The Totals tab also displays shipment prepayments, and also displays an invoice prepayment total if a prepayment is also being posted with this invoice.

When you apply order prepayments to a specific invoice in Accounts Receivable, Accounts Receivable calculates any early payment discounts that may apply.

Total Tax
The total amount of tax calculated for the invoice, including taxes included in the price.
O/E Create Invoice from Shipments Screen

To open this screen:
1. Open Order Entry > O/E Transactions > Invoice Entry.
2. Do one of the following:
   - Click the Zoom button to the right of the From Multiple Shipments option.
   - Select the From Multiple Shipments option, and then press the F9 key.

Related tasks:
- "Shipping Orders and Items " (page 120)
- "Invoicing Shipments " (page 116)

Overview
Use the O/E Create Invoice from Shipments screen when you want to create a new invoice that includes multiple shipments. You use this screen to select the shipments to include.

Note:
- If you use Payment Processing, you cannot select a shipment with a pre-authorized credit card payment. You must capture the payment and invoice the shipment separately.
- You cannot combine job-related and non-job-related shipments in the same invoice.
**O/E Credit/Debit Note Entry Screen**

**To open this screen:**
Open Order Entry > O/E Transactions > Credit/Debit Note Entry.

**Secondary screens:**
- "O/E Confirmation Screen " (page 453)
- "O/E Customer Bill-To Address Screen " (page 456)
- "O/E Ship-To Address Screen " (page 458)
- "O/E Items/Taxes Screen " (page 460)
- "O/E Kitting Components Screen " (page 481)
- "O/E BOM Components Screen " (page 451)
- "O/E Pre-Transaction Credit Check Screen" (page 496)
- "O/E Price Approval Screen" (page 499)
- "O/E Sales History Screen " (page 368)
- "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501)

**Related tasks:**
- "Crediting a Cleared or Missing Invoice " (page 134)
- "Changing Tax Amounts for Order Entry Documents " (page 178)

**Overview**

Use the O/E Credit/Debit Note Entry screen to credit or debit customer accounts for returned merchandise, items not included on an invoice, and other price adjustments.

On the O/E Credit/Debit Note Entry screen, you can:

- Credit customer accounts for returned merchandise, damaged items, and price adjustments.
- Debit customer accounts for price adjustments and for additional merchandise sent to the customer, if it was not included on an invoice.
- Post a debit or credit for a miscellaneous charge.
• Import and export debit notes and credit notes you created in another Order Entry database or in a non-Sage 300 ERP program.

• If you use Serialized Inventory and Lot Tracking, assign serial numbers and/or lot numbers. For more information, see About Serialized Inventory and Lot Tracking.

Note:
• You can process credit note transactions for items that have been set as Inactive in Inventory Control only if you are referencing an existing invoice.

• You cannot post a credit note for job-related documents that use project invoicing. Therefore, Order Entry lets you enter negative shipments to provide credit note functionality for projects that are invoiced in Project and Job Costing.

In the header area of the Credit/Debit Note Entry screen, you specify information about the credit note (or debit note) and the customer number.

On this screen, you can:
• Select the invoice that the credit note or debit note adjusts.
• Select an optional template code to specify the default entries for this screen and the Customer panel.
• Enter an optional description and reference for the transaction.

Customer Tab

Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

On the Customer tab, you can specify:
• The ship-via method for additional shipments.
• The tracking number for shipments.
• An optional territory code.
• Whether the customer is eligible for discounts or special pricing (the customer type).
• The price list to use to select prices for item details.
• The tax group for the return, credit note, or debit note.
• The customer account set.
**Credit Note or Debit Note Tab**

The name of this tab is Credit Note or Debit Note, depending on the document type you selected. It provides separate sections, where you can enter or view document information, as follows:

- **Header.** You use the top portion of the tab to enter general information that applies to the entire document (for example, the date, description, reference, template code, warehouse location, ship-to information, whether to calculate tax automatically for the document, and whether the document is job related).

- **Details.** You use the Details table to add and edit detail lines for items and miscellaneous charges.

  On the Details table, you can:

  - Specify price changes, returned quantities, or damaged goods for particular detail lines from an invoice.
  - Enter new charges.
  - Change quantities or amounts for invoice detail lines.
  - Add new credit or debit lines for an invoice.
  - Add credit or debit details for invoices that no longer exist in your Order Entry system.
  - Open a separate detail entry screen to view and change information for a selected detail.

- **Inventory Quantities.** The bottom of the tab displays inventory quantities for the location specified for a selected detail line and for all locations.

  Click the Drilldown buttons to view details for items on sales order, on purchase order, and committed to orders, including expected arrival and shipping dates.

  **Note:** Inventory quantities are displayed in the unit of measure defined for the item.

  **Tip:** To open a separate detail entry screen to view and change information for a selected detail, click **Items/Taxes.**
Optional Fields Tab

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

Rates Tab

The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for currency conversion.

If you are shipping goods, you can also change the rate information for converting the shipped amount from customer’s currency.

The Rates tab can show the following groups of exchange rate information:

- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer’s currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer’s currency to your company’s functional currency.
If you are shipping goods, change rate information for converting the shipped amount from customer's currency.

If you are invoicing shipped goods, change rate information for the invoice.

If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click Derive Rate to calculate the exchange rate for the tax reporting currency.

For more information, see "About Exchange Rates " (page 75).

**Sales Split Tab**

Use the Sales Split tab to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

For more information, see "Managing Sales Splits " (page 83).
Taxes Tab

Use the Taxes tab to review and change tax information and customer tax class for the credit or debit note.

On the Taxes tab, you can:

- Enter or edit the customer's tax exemption number.
- Specify whether taxes are calculated manually or automatically.
- Select automatic tax calculation for tax reporting (if you report taxes in a different currency), or enter the tax reporting amounts manually.
- Automatically distribute manually entered tax amounts.

For information about manually entering and distributing tax amounts, see Entering and Distributing Tax Amounts.

Totals Tab

Use the Totals tab to review and edit discounts, totals, and other final document details.

On the Totals tab, you can:

- Enter a comment about the items returned.
- Enter a percentage or specific amount (positive or negative) to reduce or increase the total amount credited (or debited) to the customer.
- Verify the credit note or debit note amount and tax amounts.

Fields and Controls

Buttons

Calc. Taxes

The Calc. Taxes button appears on the Taxes tab. Click the button to calculate and overwrite any existing tax amounts on the Taxes tab.

Note: If you do not select the Calculate Tax option on the Taxes tab, you can change tax amounts manually after clicking the Calc. Taxes button.

You can also use the Calc. Taxes button to recalculate taxes after changing the tax authority – even if you have selected the Calculate Tax option.
For more information about entering taxes manually, see "Entering Taxes Manually " (page 183).

**Components**
Click this button to view the components that make up a kit or a BOM. For more information, see "O/E Kitting Components Screen " (page 481) or "O/E BOM Components Screen " (page 451).

**Derive Rate**
This button is available on the Rates tab if you calculate the tax amount in the tax reporting currency manually (if you report taxes in a different currency than you collect them).

If you have already changed the tax reporting amount on the Taxes tab, click **Derive Rate** to calculate the actual exchange rate between the tax amount and the tax reporting amount.

**Note:**
- If Order Entry automatically calculates the tax amount in the tax reporting currency, it will use the tax reporting currency exchange rate that you enter on the Rates tab.
- The rate on the Rates tab must match the effective exchange rate before you can post the document.
- If you change the total amount on the Taxes tab, you must redistribute the tax reporting amount to the document details.

**Dist. Taxes**
This button is available if you do not select the **Calculate Tax** option.

When you click the **Dist. Taxes** button, the total tax (from the Taxes tab) is prorated to the document details.

**Note:** You can review tax amounts for document details on the O/E Items/Taxes screen. For more information, see "O/E Items/Taxes Screen " (page 460).

**History**
Click this button to review the sales history for a selected item or a customer. For more information, see "Looking Up Sales History for Items or Customers " (page 190).
Item/Tax

Click **Item/Tax** to open the O/E Items/Taxes screen.

You can use this screen to add, edit, and delete items and charges, and to change tax information for items and charges. The screen displays details for each item or charge on a single screen, rather than in a table row, making it easier for you to review and modify information without scrolling.

You can also change a tax class to another tax class that is assigned to the authority, and you can specify whether tax is included (in the **Tax Included** column).

For more information, see "O/E Items/Taxes Screen " (page 460).

Post

Click this button to post a transaction. When you post, you can print documents related to the transaction. Depending on the transaction and the options you selected, you may be able to print a quote, order confirmation, picking slip, prepayment receipt, and/or invoice. For more information, see "O/E Confirmation Screen " (page 453).

Note:

- If you have set up Order Entry to check customer credit limits, and the transaction you are posting will put the customer over their credit limit, the O/E Credit Check screen appears when you post. On this screen, you can put the transaction on hold, or you can override the customer's credit limit and continue with posting.

- For job-related transactions, if you change the status of a contract from Estimate to Open, and then post, you cannot change the contract's status back to Estimate. For more information, see "About Order Entry Integration with Project and Job Costing" (page 7).

Customer No.

Enter the customer number of the customer to whose account you will post the transaction.

The customer number determines the customer and billing address, and sets the default tax group and payment terms. In multicurrency systems, the customer number also specifies the currency of the document.
**Note:** After you enter a customer number, the field to the right displays the customer's name.

You can enter an existing customer number in the following ways:

- Enter the number, and then press Tab.
- Use the Finder to select the number.

Using the buttons to the right of the **Customer No.** field, you can:

- **Create a new customer.** Click the New button to create a new customer on the A/R Customers screen. When you finish, the new customer number appears in the **Customer No.** field.

- **Check the customer's credit.** Click the Pre Credit Check button to check the customer's credit status before entering a transaction.

- **Edit the customer's billing address.** Click the Zoom button to view and edit the customer's billing address for the current transaction. (Any changes you make apply to the current transaction only, and are not saved to the customer record.)

- **Look up information about the customer.** Click the Inquiry button to open the A/R Customer Inquiry screen to look up information about the customer.

If a customer account or its account set is inactive, you cannot enter transactions for the customer. If a customer account becomes inactive after you enter an order, you will not be able to post changes or invoices for the order until the account is made active again.

**Note:** If the **Allow Non-existent Customers** option is selected on the O/E Options screen, you can enter a new customer number, and then continue entering the document. In a multicurrency system, the currency for the order is set by the reporting currency of the customer tax group that you choose.

You should not use this method to enter transactions in a multicurrency system, especially if the reporting currencies for customer tax groups do not match your customers' currencies.

Also note that you must add the customer record in Accounts Receivable before you post an invoice for the order in Accounts Receivable.
Document Number
To let Order Entry assign the credit/debit note number, press the Tab key, leaving the field showing ***NEW***. The program then uses the prefix and next number assigned on the O/E Options screen to create the credit or debit note number.

If you do not want Order Entry to assign the credit/debit note number, type the new number yourself.

Note: The number you type does not update the Next Number field for credit/debit note document numbers on the O/E Options screen, even if you type the number that would have been assigned automatically.

- Credit note document numbers. You must assign a different number to each credit note you add. If you use the same number for more than one credit note, you will not be able to post the additional credit notes in Accounts Receivable.

- Debit note document numbers. If you use different sets of numbers for credit notes than you do for debit notes, you may want to type the debit note numbers yourself, rather than let the program assign the numbers automatically.

Document Type
Select Credit Note or Debit Note to indicate the type of transaction you are entering.

Entered By
This field displays the name of the person who entered the transaction.

Credit Note/Debit Note tab
The name of this tab is Credit Note or Debit Note, depending on the document type you selected. It provides separate sections, where you can enter or view document information, as follows:

- Header. You use the top portion of the tab to enter general information that applies to the entire document (for example, the date, description, reference, template code, warehouse location, ship-to information, whether to calculate tax automatically for the document, and whether the document is job related).

- Details. You use the Details table to add and edit detail lines for items and miscellaneous charges.
On the Details table, you can:

- Specify price changes, returned quantities, or damaged goods for particular detail lines from an invoice.
- Enter new charges.
- Change quantities or amounts for invoice detail lines.
- Add new credit or debit lines for an invoice.
- Add credit or debit details for invoices that no longer exist in your Order Entry system.
- Open a separate detail entry screen to view and change information for a selected detail.

- **Inventory Quantities.** The bottom of the tab displays inventory quantities for the location specified for a selected detail line and for all locations.

  Click the Drilldown buttons to view details for items on sales order, on purchase order, and committed to orders, including expected arrival and shipping dates.

  **Note:** Inventory quantities are displayed in the unit of measure defined for the item.

**Actual Return Date**

This field appears for credit notes.

Type the date on which the items were returned to inventory (if the credit note is the result of a return).

**Actual Ship Date**

This field appears for debit notes.

Type the date on which the items were shipped from inventory if the debit note is the result of a shipment.

**Calculate (Calc.) Tax**

Select this option if you want Order Entry to calculate tax automatically for this document. For more information, see "Entering Taxes Manually " (page 183)
Note: If this document is job-related and you select the Project Invoicing option, you cannot enter taxes manually. The Calculate Tax option is automatically selected, and you cannot change it.

Credit Note/Debit Note Date
Type the date you want to use as the transaction date when the transaction is posted in Accounts Receivable.

Credit Note/Debit Note Subtotal
This field displays the subtotal of all detail lines entered on the credit or debit note. The amount does not include discounts and taxes.

Description
Displays the description, if any, that was entered with the selected invoice.

You can type another description for the credit note or debit note, if you wish. You can also retain the original description or leave the field blank.

Invoice Date
Displays the date on which the selected invoice was posted.

Invoice Number
To add a credit or debit note for an existing invoice, select the invoice number. The information entered for the invoice appears on the screen.

To add a credit or debit note for a non-existent invoice or for an invoice that is no longer in your Order Entry system, type the invoice number or leave the field blank.

Job Related
Select Job Related if the document applies to a project that you are managing using Sage 300 ERP Project and Job Costing.

The Job Related option is selected automatically if you are applying a credit note or debit note to a job-related invoice (one that applied to a project you are managing using Sage 300 ERP Project and Job Costing).

If the invoice no longer exists, you must select this option to apply a credit note or debit note to a job. When you select the option, additional
columns appear in the table so you can enter job-related information for each item.

When you post the document, Order Entry updates the contracts, projects, categories, and (if required) resources in Project and Job Costing to which the items apply.

**Location**
Displays the location code for the selected invoice as the default. If goods are being returned elsewhere, you can select another location.

**Note:** The program displays an error message if you select a logical inventory location instead of a physical location. (Logical locations are used mainly for transferring goods between physical locations in the Inventory Control program.)

**Order Number**
This field displays the order number for the posted invoice.

**PO Number**
This field displays the customer's purchase order number for the original order.

**Posting Date**
The posting date is different from the document date. The posting date determines the year and period to which a transaction is posted in General Ledger. You can change the posting date, but you cannot change the Fiscal Year/Period field separately.

In a multicurrency system, posting dates are also used to select open documents for currency revaluation, so that revaluation adjustments are posted to the correct fiscal year and period in General Ledger.

Depending on your settings in the O/E Options screen, Order Entry displays the session date or the document date as the default in this field.

**Note:** If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Qty. Available**
Displays the inventory quantity that is available for sale to your customers. This is determined by the quantity on hand less the quantity
committed, as maintained in Inventory Control.

**Qty. Committed**
Displays the inventory quantity that is committed to orders.

By committing an inventory quantity to an order, you ensure that the required inventory will be available when it is time to ship the order. (If a quantity is already committed to an order, you cannot ship another order for the same items unless there is a sufficient quantity in inventory in addition to the committed quantity.)

**Tip:** You can click the Drilldown button to the right of the displayed quantities to view more information (such as the customer and the expected ship date).

**Qty. on Hand**
Displays the inventory quantity currently on hand, as maintained in Inventory Control.

**Qty. on Purchase Order**
Displays the inventory quantity that you have ordered.

**Tip:** You can click the Drilldown button to the right of the displayed quantities to view more information (such as the order date and the expected arrival date).

**Qty. on Sales Order**
Displays the inventory quantity that customers have ordered from you.

**Tip:** You can click the Drilldown button to the right of the displayed quantities to view information (such as the customer and the expected ship date).

**Reference**
This field displays the reference, if any, that was entered with the selected invoice.

You can type another reference for the credit note or debit note, if you wish. You can also retain the original reference or leave the field blank.

**Retainage**
Select this option to indicate that retainage applies to the document you
are entering. (Retainage is where a percentage of the payment is held back for a fixed period of time, and then invoiced separately after the hold-back period.)

When you select this option, the **Retainage** tab becomes available. You use this tab to specify how to process the retainage amount for the document.

**Note:**
- The **Retainage** option is available only if you are entering a job-related transaction and your Accounts Receivable ledger uses the **Retainage Accounting** option.
- The **Retainage** option is not available if you select **Project Invoicing** (where invoicing is handled through Project and Job Costing).

**Ship-To Location**
This field displays the customer's ship-to location for the invoice.
If necessary, use the Finder to select a different ship-to location.

**Template Code**
This field displays the template code, if any, selected for the invoice. You can select another template code or leave the field blank.
If you select a new template after choosing the customer, Order Entry will replace some document and customer information with the information from the new template.

**Year/Period**
This field displays the fiscal year and period to which the transaction will be posted in the general ledger.
You cannot change the information that appears in this field except by selecting a different posting date in the Posting Date field.

**Note:** You cannot post transactions to closed fiscal periods.

**Details Table**
You use the Details table to add and edit detail lines for items and miscellaneous charges.
All detail fields appear as columns in the detail table.
Appendix A: Order Entry Screen Guides

Tip:
- To open a separate detail entry screen to view and change information for a selected detail, click Items/Taxes.
- Below the table, inventory quantities are displayed for the item in the selected detail line. Quantities are displayed for the location specified in the detail line, and for all locations. You can also click the Drilldown buttons to see more information about quantities on sales orders or purchase orders, and quantities committed. Inventory quantities are displayed in the unit of measure defined for the item.

Amount
Type the amount of the miscellaneous charge. (You see this field when you enter a miscellaneous charge detail on the O/E Items/Taxes screen.)

Billing Type
If the document is job related, this field indicates whether the item or charge is billable or non-billable.

Category (Inventory)
This field displays the category assigned to the item record in Inventory Control. You can use the Finder to select a different category.

Category (Job Related)
This field appears if you selected the Job Related option for the document.

For job-related orders, specify the category to use for this item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

Note:
- If you use a term other than "Category" in Project and Job Costing, that term appears as the label for this field.
Use the **Item Number** field to specify the resource.

After you add the detail, you cannot edit this field.

**COGS Acct.**

If the document is job-related and you are not using project invoicing, this field displays the default Cost Of Goods Sold account from Project and Job Costing for the item or charge.

**Comments/Instructions**

This field indicates whether there are comments or instructions entered for the detail, and also allows you to add comments or instructions. For more information, see "Adding Comments and Instructions to Order Entry Transactions " (page 101).

**Note:**

- Comments for a detail line appear in the **Description** column on printed quotes, order confirmations, invoices, credit notes, and debit notes.
- Instructions for a detail line appear in the **Description** column on printed picking slips.

**Contract**

This field appears if you selected the **Job Related** option for the transaction.

For job-related orders, specify the contract to use for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**

- If you use a term other than “Contract” in Project and Job Costing, that term appears as the label for this field.
- Use the **Item Number** field to specify the resource.
- After you add the item or charge, you cannot edit this field.
Cost Class
This field displays the cost class for the project category used in each job-related detail.

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

Costing UOM
This field displays the costing unit of measure specified in the item record.

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

Credit/Debit Type
Use the Credit Type or Debit Type field to specify the type of credit or debit you are entering. You can select:

- **Items Returned to Inventory.** Enter the number of units returned to inventory in the Quantity field. You can edit other fields if they are not set to read-only. When you enter the number of units, the program displays the extended price for this quantity.

- **Damaged Items.** Enter the number of units damaged in the Quantity field. Damaged items credit the customer and affect item sales, but do not affect inventory levels. You can edit other fields if they are not dimmed. When you enter the number of units, the program displays the extended price for this quantity.

- **Price Adjustment.** If you select this type, enter the price adjustment in the Price/Adjustment field.
  - Price adjustments affect the item sales amount but not inventory levels.
  - Enter a price decrease as a credit note, and a price increase as a debit note. Enter just the differences in price.
  - When you enter the adjustment, the program displays the extended price adjustment in the Extended Amount field. (You can also just enter the extended amount directly.)
• If you do not want to affect any Order Entry or Inventory Control statistics, you should enter the credit note in Accounts Receivable.

• Items Removed from Inventory. Enter the number of units removed from inventory in the Quantity field. This debit note is exactly like a shipment transaction. You can edit other fields if they are not dimmed. When you enter the number of units, the program displays the extended price for this quantity.

**Customer Item No.**

If you set up customer item numbers in Inventory Control (using the I/C Customer Details screen), you can use the customer's item number to enter the item number for the detail.

If you use customer item numbers to enter the item number for details, Order Entry will replace the customer’s item number with your inventory item number, and automatically insert the customer's item number in this field. (This works the same way as the manufacturers' item numbers.)

**Description**

This field displays the description from the item price list or miscellaneous charge record for the item or miscellaneous charge selected in the Item No./ Misc. Charge field.

This description appears on printed order confirmations, picking slips, and invoices. You can use the default description or enter a new description to be used for an individual transaction.

In a multicurrency system, the description from the item record appears here if the price list does not include a price in the customer’s currency.

**Discount %**

You can specify a separate discount percentage or amount for each detail in an Order Entry transaction.

You can also enter a discount percentage or amount for the transaction on the Totals tab.

**Discount Amount**

You can specify a discount percentage or amount for each detail in an Order Entry transaction. If you specify a discount amount, Order Entry
calculates the discount percentage and the discounted extended price.

You can also enter a discount percentage or amount for the transaction on the Totals tab.

**Discounted Ext. Amt.**
This field displays the amount for the detail after the discount is applied.

**Exp. Ship Date**
Enter the date you expect to ship the item. By default, this field displays the expected shipment date entered for the document, but you can change it.

**Extended Cost**
This field appears if you selected the **Job Related** option for the document.

Extended cost is the cost amount for the miscellaneous charge. It can also be used in Project and Job Costing to calculate labor and overhead. For more information, see Project and Job Costing help.

**Ext. Amount/Price**
When you add an item, the program calculates the extended amount (or price) from the quantity and price you enter for the item.

If you change an extended price, entering a positive or a negative number, the program does not recalculate the unit price. An asterisk appears beside the amount on the O/E Items/Taxes screen and with the amount on the Credit Note List.

If you are adding a miscellaneous charge detail, enter the amount of the charge in the Extended Amount column on the Detail Information screen, or in the Amount field in the zoomed detail-entry screen.

**Extended Weight**
This field displays the product of the quantity of returned item units multiplied by the unit weight entered for the item in Inventory Control.

**Item No./Misc. Charge**
When crediting or debiting an existing detail, the item number is
displayed only and you cannot change it.

If you are adding detail lines to an existing invoice or entering a credit to a non-existent invoice, you type the item number to use or choose it from the Finder.

**Kit/BOM**

If the selected item is part of a kit or a BOM (bill of materials) in Inventory Control, click the Finder to select the kit or BOM number (if you have more than one build for the item).

To review the items in the build, click the **Components** button at the bottom of the screen.

**Note:**

- You can create kits from stock or non-stock items in Inventory Control and then use them in Order Entry. You can also enter or post multiple kitting entries (or mix kitting entries with regular entries) in any Order Entry transaction entry screen.
- Kits can be assigned serial numbers that are maintained in Serialized Inventory.
- You can include kit components and BOM components when printing order confirmations, quotes, picking slips, invoices, credit notes, and debit notes.
- When you print the O/E Transaction List report and select Detail as the report type, the report displays kit components and BOM components.
- When you print the O/E Posting Journals report, it includes actual breakdown amounts for each kit component.

**Line No.**

Line numbers are assigned automatically, and you cannot change them.

You use line numbers to identify details you have entered, or to recall them for editing when you are using the O/E Items/Taxes screen to enter detail information.

You can also list items on picking slips by line number.
Location
If you are crediting an existing detail line, this field displays the location assigned to the item detail on the invoice, but you can change it if returning goods to a different location.

To specify the location, select the location code.

**Note:** You must select a physical location, not a logical inventory location. (Logical locations are used mainly for transferring goods between physical locations in Inventory Control.)

Manuf. Item No.
If you have set up manufacturer's item numbers in Inventory Control, you can enter the manufacturer's item number (usually a bar code) in this field, rather than entering your inventory control item number. The manufacturers' item numbers are translated to your inventory item numbers by Inventory Control.

If you entered the manufacturer's item number in the Item Number field, Order Entry inserts it here automatically when it retrieves item information.

For more information about using manufacturer's item numbers, see the Inventory Control help.

If you selected a non-stock item, the non-stock clearing account used by the item's account set appears as the default in this field. You can change the account number if necessary.

Optional Fields
If you use optional fields, you can review and edit optional fields by clicking the Optional Fields column heading. (If you are using the O/E Items/Taxes screen, click the Zoom button beside the Optional Fields option.)

If an optional field is required, you cannot save the transaction unless the field has a default value, or until you fill in the field yourself.

To add optional item fields that were not automatically inserted, press the Insert key to add a new line to the table, and then use the Finder to select an optional field.
Optional fields must be assigned to the transactions screens using the O/E Optional Fields screen before you can add them to individual transactions. For more information, see "O/E Optional Fields Screen" (page 349).

**Order UOM (unit of measure)**
If you are adjusting an existing detail line, the unit of measure used on the invoice is displayed, but you can change it.

Type the code for the unit of measure, or use the Finder to select it. You must specify a unit of measure that is assigned to the item record in Inventory Control.

Make sure the number of units you specify for the detail is expressed in the unit of measure you choose.

For more information, see "About Order Unit of Measure" (page 19).

**Order Weight UOM (unit of measure)**
This is the unit of measure for weighing this item on the order. You can select a different unit of measure if necessary.

Depending on your settings in O/E Options, this field displays either the item weight unit (from the item record in Inventory Control) or the pricing weight unit (from the price list in Inventory Control).

The order weight unit of measure for the complete order is determined by the default weight unit of measure specified on the I/C Options screen.

**Note:**
- If the item is not priced by weight, this field displays the item weight unit from the item record.
- If the item is priced by weight, and it has base prices for multiple units of measure, this field displays the default unit of measure from the price list if your Default Order Weight UOM in O/E Options is the Pricing Weight Unit.

**Price/Adjustment**
Type the price adjustment in the Price/Adjustment field. Price adjustments affect the item sales amount.
Appendix A: Order Entry Screen Guides

Enter a decrease as a positive number and an increase (for a debit note) as a negative number. When you enter the adjustment, the program displays the extended price adjustment in the Extended Amount field. Note that you can enter a negative amount only if you select Price Adjustment as the credit type.

If you do not want to affect any Order Entry or Inventory Control statistics, you should enter the credit note in Accounts Receivable.

The Finder for the Price/Adjustment field is not available if the price list that you selected is not currently in effect. (In other words, the Finder does not appear if the document date is not between the Price List Starts date and the Price List Ends date specified in the I/C Item Pricing screen for the item, currency, and price list code.)

If the price list is not in effect, the Price/Adjustment field displays 0.000000 by default.

**Price Approval**

Price checks are set in Inventory Control price lists for particular items, price lists, and user IDs.

If price checks are in effect, and the price you enter is outside the boundaries allowed, this field displays "Yes." To approve the price:

1. In the Price Approval column heading, click the Zoom button.
2. On the O/E Price Approval screen, enter the ID of the person approving the price override. If security is set, you must also enter a password.

**Note:** The Price Approval field does not appear if you are using the O/E Item/Taxes screen. Instead, an error message may appear when you try to save the item detail, stating that the price requires approval.

For more information, see "About Price Checks" (page 82).

**Price By**

This field indicates whether the item is priced by weight or by quantity.

- If pricing is by quantity, Sage 300 ERP sets volume discount amounts or percentages according to the quantity of goods that
are ordered.

- If pricing is by weight, Sage 300 ERP sets volume discount amounts or percentages by item weight.

Item weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Note:** Pricing by weight is available in Sage 300 Premium ERP only.

**Price List**

This field displays the price list assigned to the item detail on the invoice you are adjusting, or specified on the Customer tab for new details. You can type another price list code over the displayed code, or choose one from the Finder.

In multicurrency ledgers, you can change only to a price list that uses the customer's currency.

**Pricing UOM (unit of measure)**

This field displays the pricing unit of measure used on an existing invoice for the detail line. If you are crediting a non-existent invoice, the field displays the default pricing unit of measure from the item price list.

If necessary, you can select another pricing unit for the item.

**Project**

This field appears if you selected the *Job Related* option for the document.

For job-related orders, specify the project for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**

- If you use a term other than “Project” in Project and Job Costing, that term appears as the label for this field.

- Use the Item Number field to specify the resource.
- After you add the item or charge, you cannot edit this field.

**Quantity B/O (Backordered)**
On existing invoices, this field displays the quantity that is on backorder and has not been shipped from the original order.

**Quantity**
Use this field to enter the number of units being returned to inventory or shipped from inventory.

If you are entering a credit note that references an existing invoice, the program displays the quantity from the invoice as the default quantity.

If you use Serialized Inventory and Lot Tracking, when you enter a quantity for a serialized or lotted item, and then leave the field, the Serial/Lot Numbers Allocation (or Generation) screen appears. You use the screen to allocate or edit serial numbers and/or lot numbers for the item detail. You must fully allocate serial and lot numbers before you can save the detail.

**Quantity on Order**
This is the original order quantity—the quantity specified when the detail line was first entered and posted.

This number does not change even if you change the ordered quantity for the detail.

**Quantity Shipped**
When you are working with an existing invoice, this field displays the quantity shipped for the detail line on the original invoice. On non-existent invoices, the field displays zero.

**Retainage Percentage (%)**
Enter the retainage percentage to be used when calculating the retainage amount for the item or charge.

When you edit this field, the retainage amount for the item or charge is calculated automatically.

**Retainage Amount**
On a debit note, the retainage amount is the amount the customer
can withhold from the document detail until the end of the retention period, when retainage is invoiced.

On a credit note, this is the amount by which the retainage amount is reduced on the invoice.

To calculate the retainage amount, the program multiples the extended detail amount (or the extended amount plus tax, if you include taxes in retainage) by the retainage percentage.

You can enter a new retainage amount, if necessary. If you enter an amount to replace a calculated amount, the program recalculates the retainage percentage.

**Retention Period**

The retention period is the number of days for which the customer can withhold the retainage amount.

You issue the retainage invoice in Accounts Receivable at the end of the retention period.

**Revenue Acct.**

If the document is job-related and you are not using project invoicing, you also specify the revenue/billing account for each item or charge.

The default account number is specified in Project and Job Costing, and is used instead of the sales account specified for the item in the item category record.

**Shipment Date (Ship Date)**

Enter the date on which you are sending the shipment to the customer.

The program displays the current session date. You can type another date.

**Ship Via and Description**

In the **Ship Via** field, enter the ship-via method for the detail. When you navigate out of this field, the description from the ship-via record for the selected ship-via code appears in the related **Description** field.

**Note:** You can specify a separate ship-via method for each detail.
Tracking No.
If you use tracking (waybill) numbers to track shipments that use different carriers or that are shipped at different times, enter the tracking number to use for the detail.

Type
Select the type of detail you are entering: Select Item to add a detail line for an inventory item or non-stock item that is assigned an item number in Inventory Control. Select Miscellaneous to add a detail line for a miscellaneous charge defined in Order Entry.

Tip: You can select a detail type by typing the first letter (for example, type M for Miscellaneous), or you can toggle between available selections by pressing the spacebar or double-clicking in the field.

Unit Cost
If you are adjusting an existing invoice, this field displays the unit cost assigned on the invoice.

If you are entering a credit note or debit note against a non-existing invoice, or if the credit note or debit note is not applied to an invoice, the unit cost that appears depends on the item's costing method.

Note: A "non-existing invoice" is one that does not exist in your system—for example, because it has been cleared or because it was entered in your previous accounting system.

You can change the unit cost before posting the credit or debit note, unless the item is serialized or lotted.

For items that are serialized or lotted, you can change the unit cost only if:

- The credit note does not refer to an invoice number, regardless of the item's costing method. (If the credit note refers to an invoice number, you cannot change the unit cost.)

- The debit note does not refer to an invoice number, and the item does not use the serial or lot costing method.

For more information, see "Inventory Costing Methods" (page 33).
**Unit Weight**

This is the weight of a single item for this detail line expressed in the Invoice Weight Unit of Measure. You can multiply this weight by the quantity ordered to get the extended weight.

You can edit the unit weight and the extended weight on the credit or debit note.

The estimated weight on the Totals tab is in the default weight unit of measure specified in the I/C Options screen.

**WIP Acct.**

If the document is job-related and you are using project invoicing, you also specify the WIP (Work in Progress) account for each order detail.

By default, this field displays the account number specified in Project and Job Costing.

**Note:** The level at which the WIP account is specified in Project and Job Costing depends on the project type and accounting method.

**Customer tab**

Use the Customer tab to specify information about the customer, including shipping method, price list, and eligibility for discounts.

**Customer Account Set**

This field displays the account set specified in the A/R record as the default.

The account set specifies the General Ledger accounts to which the transaction will be distributed: receivables control, payment discounts, prepayment liability, retainage, and write-offs.

You can change the account set for a transaction. If you use multicurrency, however, you must select an account set that uses the same currency as the customer's account set.

**Customer Type**

If you are crediting an existing invoice, this field displays the customer type that was used on the invoice to assign the discount level for the invoice.
Appendix A: Order Entry Screen Guides

You can use a displayed customer type for the return or credit note, or select another type from the drop-down list beside the field. You can select Base, A, B, C, D, or E. “Base” indicates the customer is not eligible for price discounts if the discount is based on customer type.

Customer types are assigned in the customer record in Accounts Receivable, but you can change the type for an individual return, credit note, or debit note. (Item prices can be specified by customer type in Inventory Control.)

**Price List**

This field displays the default price list from the existing invoice, if any, or from the customer record or template code you selected to enter a credit to a non-existent invoice.

You can use the price list code that appears or select another to be the default code that appears on new detail lines you enter in the table.

**Ship-Via**

Type or select an optional ship-via code from the list of codes added on the O/E Ship-Via Codes screen.

If this is a return, you can enter a code for the carrier that your customer is using to return the goods.

If you designated a primary ship-to location for the customer in Accounts Receivable, the shipping information from the primary ship-to location record appears as the default, but you can change it.

**Tax Group**

If you are crediting an existing invoice, this field displays the tax group assigned to the invoice and customer. You can change to another tax group, if needed.

If you are crediting or debiting a non-existent or cleared invoice, type the code for the tax group to use or choose it from the Finder.

The tax group determines the tax authorities to which the customer is subject, and the tax classes that are used for each authority to calculate sales tax. You can change the tax classes for the customer and for individual detail lines.

You can change the tax group at any time, even after posting. (For example, if you change the ship-to location on a posted order, you can change the tax group to match the tax authorities for the new location.)
You can choose a different tax group on the Customer tab, although the tax group should match the group for the original invoice.

You can change the Tax Class for an authority on the O/E Items/Taxes screen.

In multicurrency ledgers, the tax group can have a different reporting currency than the functional currency or than the customer.

**Note:** If you are entering a job-related credit note or debit note and you need to use different tax groups for different contracts and projects, you must enter the details on separate documents. Although Project and Job Costing allows tax groups to be specified for each project, the tax group specified for a credit note or debit note applies to all the contracts and projects listed in the O/E document details.

**Tax Reporting Currency**

If you use multicurrency accounting, this field displays the tax reporting currency for the tax group selected in the **Tax Group** field.

**Note:** The tax group's reporting currency can be different than the functional currency. It can also be different than the customer's reporting currency.

**Territory**

This field displays the territory code, if any, from the existing invoice, or from the customer record or template code you selected if entering a credit to a non-existent invoice.

You can use a territory code that appears, type another code, or leave the field blank.

Territory codes are used mainly in Accounts Receivable to identify a sales region and for sorting reports. does not maintain territory codes, so you can use this field in any way you want.

**Tracking No.**

If you use waybill numbers to track shipments, enter the waybill number in this field.

**Note:** You can also enter a separate tracking number with any detail included in the transaction.
Optional Fields tab
If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the Auto Insert option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

Optional Field
Use the Optional Field Finder to select optional fields that are assigned (in the O/E Optional Fields setup screen) to this type of transaction.

When you select an optional field code, Order Entry displays its description in the next column.

Value Set
The Value Set column shows whether a blank optional field currently has a value. (By looking at the field, you cannot know otherwise whether the field has a blank default value or no value.)

The Value Set field changes from No to Yes if you make an entry in the Value field..

Value
Use the Value Finder to select a value created for the optional field in Common Services.

When you select a value code, Order Entry displays its description in the next column.

Rates tab
The Rates tab appears only if you use multicurrency accounting and you are entering a document for a customer who does not use your company’s functional currency. You use this tab to view and edit rate information for
currency conversion.

The Rates tab can show the following groups of exchange rate information:

- **Order Exchange Rate** (if you are creating or have created an order)
- **Shipment Exchange Rate** (if you are shipping or have shipped goods)
- **Invoice Exchange Rate** (if you are creating or have created an invoice)
- **Credit Note Exchange Rate** or **Debit Note Exchange Rate** (if you are creating a credit note or a debit note)

If the tax group for this document uses a different currency than the customer's currency or your functional currency, the tab also shows the rates for converting document amounts to the tax reporting currency.

You use the Rates tab to:

- Change the rate type, rate date, and exchange rate for converting the order, credit note, or debit note amounts from the customer's currency to your company's functional currency.
- If you are shipping goods, change rate information for converting the shipped amount from customer's currency.
- If you are invoicing shipped goods, change rate information for the invoice.
- If you are reporting taxes in a different currency than you collect them, enter or derive the rate for converting amounts to the tax reporting currency.

If Order Entry automatically calculates amounts in the tax reporting currency, it uses the tax reporting currency exchange rate that appears on this tab.

If you manually entered a tax amount in the tax reporting currency, click **Derive Rate** to calculate the exchange rate for the tax reporting currency.

For more information, see "About Exchange Rates " (page 75).

**Currency**

This field displays the currency code and description for the customer's currency.
The currency is set for the customer in Accounts Receivable, and you cannot change it in Order Entry.

If the tax group specified for this document on the Customer tab uses a different currency from the customer's currency and your functional currency, the code and description for that currency appear in the adjacent Tax Reporting Currency field.

Debit Note/Credit Note Exchange Rate
The program displays the exchange rate currently in effect for the specified currency and the displayed rate type and rate date, and it displays the exchange rate for the original invoice (if it exists in the Order Entry system).

If you post the credit/debit note with a different exchange rate than was used for the invoice, you will realize an exchange gain or loss on the transaction.

You can change the credit/debit note exchange rate directly, or you can specify a different rate date or rate type to change the rate for the transaction.

You see a warning if you change an exchange rate by an amount that exceeds the Spread setting for the currency table in the Currency Rates screen in Common Services.

The program also displays exchange rate information for a tax reporting currency if you report taxes in a currency that is different from the customer's currency and your functional currency.

Invoice Exchange Rate
If you are working with an existing invoice, the program displays the exchange rate used on the invoice. You cannot change it.

You do not see this field if you are working with an invoice that does not exist in Order Entry.

Rate Date
For the credit note or debit note, enter the date to use for selecting the exchange rate. The program displays the document date from the Credit Note (or Debit Note) tab as the default.

The program displays the rate for the date that you type, using the rules for selecting rates for the currency and rate type in the Currency screens in Common Services.
If you are working with an existing invoice, the program displays the exchange rate used on the invoice. You cannot change it.

**Note:** You do not see this field if you are working with an invoice that does not exist in Order Entry.

**Rate Type**

If the rate type you want to use for the credit note or debit note is not displayed, type the code or use the Finder to select it.

The program uses the rate type to select the rate for converting multicurrency amounts on the credit note or debit note to functional currency. Examples of rate types might be “spot rate,” “average rate,” or “contract rate.”

You define rate types using the Currency Rate Types screen in Common Services.

If you are working with an existing invoice, the program displays the rate type used on the invoice. You cannot change it.

**Note:** You do not see this field if you are working with an invoice that does not exist in Order Entry.

**Credit Note/Debit Note/Invoice - Tax Reporting Currency**

This field displays the exchange rate currently in effect between the tax reporting currency and your functional currency for the displayed rate type and rate date. You can change the rate on this tab, or you can change the tax totals on the Taxes tab and then derive the new rate on the Rates tab.

- If you change the exchange rate for the tax reporting currency on the Rates tab, the tax reporting amounts on the Taxes tab are updated when you recalculate taxes using the **Calculate Taxes** button (if you are not calculating taxes automatically).

- If you change the tax reporting amount on the Taxes tab (after clearing the Calculate Tax Reporting option), you will have to redistribute the new tax amount to the detail lines, and then enter the new tax reporting exchange rate on the Rates tab. You can use the Derive Rate button on the Rates tab to calculate the new exchange rate. You cannot post the document unless the tax reporting exchange rate is correct for the tax reporting amount on the Taxes tab, and the tax reporting
amounts for the document details match the total tax reporting amount on the Taxes tab.

A warning appears if you change an exchange rate by an amount that exceeds the Spread specified for the currency in Common Services.

**Note:** Tax reporting currency rates appear only if the tax group specified for the document uses a currency that is different from your currency and from your customer's currency.

**Retainage tab**

The Retainage tab appears only for job-related documents that use the Retainage option.

You use this tab to specify retainage terms for orders, shipments and invoices.

If you use multicurrency accounting, you also specify the exchange rate to use for the retainage invoice, retainage debit note, or retainage credit note when outstanding retainage is processed in Accounts Receivable.

**Retainage %**

This field displays the retainage percentage used to calculate the retainage amount for the shipment, invoice, debit note, or credit note. It is a weighted average percentage, based on the sum of the details.

**Retainage Rate**

You use this field to specify the method the program will use to determine the exchange rate for the retainage document when outstanding retainage is eventually processed in Accounts Receivable.

You can choose one of the following methods:

- Use Original Document Exchange Rate—to use the same rate as the invoice for this shipment.
- Use Current Exchange Rate—to use the rate in effect when the outstanding retainage is processed in Accounts Receivable.

**Retainage Amount**

This field displays the sum of the retainage amounts for all shipment details in this field. You cannot change the amount.

**Sales Split tab**

Use the Sales Split tab to calculate sales commissions by allocating
transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction in Order Entry, the salespersons assigned to the customer account in Accounts Receivable appear on the Sales Split tab by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

**Note:** You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. Some Order Entry reports list only the primary salesperson, while others allow you to sort information by primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the **Percentage** column must total 100 (or 0 if you do not assign salespeople to the transaction).

**Percentage**

Enter the percentage of the sale to assign to each salesperson.

You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Salesperson Code**

Enter a salesperson code to add a new salesperson, or to replace a currently assigned salesperson for a transaction.

You do not have to assign salespersons to a transaction, but if you do, the amounts in the **Percentage** column must total 100.

**Note:** You set up salesperson codes in Accounts Receivable.

**Salesperson Name**

This field displays the name associated with the salesperson code.

**Note:** You set up salesperson codes in Accounts Receivable.
**Taxes tab**

Use the Taxes tab to select the method you will use to calculate taxes, and to review and change tax information for a document.

**Calculate Tax**

For each Order Entry document, you can specify whether taxes are calculated automatically or entered manually.

If you want Order Entry to calculate tax for this document, select the Calculate Tax option.

**Note:** If the document is job-related and you selected the Project Invoicing option, you cannot enter taxes manually. The Calculate Tax option is automatically selected, and you cannot change it.

If you want to enter tax amounts manually, do not select the Calculate Tax option. If you do not select this option:

- The Dist. Taxes button appears on the screen.
- You can enter tax amounts for the tax authorities listed for the document.

Click Dist. Taxes to prorate tax that you enter manually on the Taxes tab to the document details. For more information, see Entering Taxes Manually.

**Note:** You cannot prorate a tax amount to an authority that uses an exempt tax class.

**Calculate Tax Reporting**

Select this option if you want the program to automatically calculate tax reporting amounts for the document. Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

If you clear this option, you can edit tax reporting amounts.

**Note:**

- This option appears only if a tax authority has a tax reporting currency that is different from the source or functional currency.
The default for this check box is determined by the Calculate Tax Reporting Amounts Automatically option on the O/E Options screen.

**Tax Reporting Currency**
The fields in this group display the included, excluded, and total tax amounts for the transaction in the tax reporting currency.

**Total Tax**
This field displays the total amount of tax calculated for the transaction (including taxes included in the price), displayed in the customer's currency.

**Note:** The fields in the Tax Reporting Currency group display the total tax in your tax reporting currency.

**Tax Details table**
This table displays information about tax authorities, classes, and amounts for the current document.

If you do not select the Calculate Taxes and the Calculate Tax Reporting options, you can change the tax base, tax amount, and tax reporting amount for each authority on the document.

**Note:**
You cannot edit information about a tax authority directly on this tab. To change information for a tax authority, you must use the screens in Tax Services.

You can change the tax authorities used by a particular order or invoice by changing the tax group on the Customer tab.

For debit notes and credit notes, however, you must use the same tax group as the invoice you are debiting or crediting. (Also, you cannot select a template code or ship-to location that uses a different tax group than the invoice.)

**Authority Description**
This field displays the description for a tax authority.
**Class Description**
This field displays the description for a tax class.

**Customer Tax Class**
This column displays the tax class that is assigned to each tax authority.

If you change the tax class for a tax authority on this screen, click **Calculate Taxes** to see the recalculated tax amount.

**Note:** If the **Calculate Tax** option is selected, the tax amount is recalculated automatically, but is not displayed immediately.

To change the tax class description or make other changes to the information for the specified tax group, use the Tax Services screens in Common Services.

**Registration Number**
If necessary, enter the customer's tax registration or tax exemption number.

**Tax Amount**
If you selected the **Calculate Tax** option, this field displays the amount of tax that is due for each authority.

For each authority, Order Entry calculates a sales tax amount if:
- The customer is subject to tax.
- The order contains taxable items or taxable miscellaneous charges.
- Tax rates are specified for the tax authorities and classes in Tax Services.

If you are entering taxes manually, enter the total tax amount you calculated for each tax authority. Ensure that the amounts you enter agree with the sum of the tax amounts for the details, for each tax authority.

**Tax Authority**
This field displays the tax authorities that are assigned to the tax group specified for the customer in Accounts Receivable.

**Tax Base**
If you selected the **Calculate Tax** option, Order Entry displays the transaction total. Any invoice or early-payment discounts are not
deducted from this total.

If you are entering taxes manually, enter the total transaction amount in this field.

**Tax Reporting Amount**

If you selected the **Calculate Tax Reporting** option, this field displays the tax reporting amount calculated by applying the exchange rate between the source currency and the tax reporting currency.

If you did not select the **Calculate Tax Reporting** option, you can edit the tax reporting amount in this field.

**Note:**
- This field appears only if a tax authority for the transaction has a tax reporting currency that is different from the source or functional currency.
- The default for this check box is determined by the **Calculate Tax Reporting Amounts Automatically** option on the O/E Options screen.

Sage 300 ERP calculates the amount in the tax reporting currency by applying the exchange rate between the source currency and the tax reporting currency.

**Totals tab**

Use the Totals tab to review and edit discounts, totals, and other final document details.

**Comment**

This field displays the comment, if any, that was entered with the selected invoice. You can type another comment for the credit note or return, if you wish. You can also retain the original comment or leave the field blank.

**Credit/Debit Note Amount**

This field displays the total for the credit note or debit note.

**Credit Note/Debit Note Subtotal**

This field displays the total amount of all items and miscellaneous charges for the credit note or debit note before any discounts have been
subtracted.

The subtotal includes tax amounts that are included in item prices and miscellaneous charge amounts, but does not include tax amounts that are charged separately on item prices or miscellaneous charge amounts.

**Discount Miscellaneous Charges**

Select this option if you applied discounts to miscellaneous charges on the invoice you are crediting or debiting. The option ensures that you will take a similar discount on the total amount of all miscellaneous charges in the document.

Any miscellaneous-charge discount amount is included in the credit note or debit note subtotal. If you do not select the option, any order discount applies only to the item subtotal.

**Estimated Weight**

This field displays the estimated weight of the shipment, based on the weight for the units of measure and item quantities specified in the document. (You specify item weights on the I/C Items screen in Inventory Control.)

**Tip:** Use the estimated weight to calculate shipping costs or postage.

**Included Tax**

This field displays the total tax amount that is included in item prices and miscellaneous charge amounts.

**Items Subtotal**

This field displays the total amount of the item detail lines for the document.

The items subtotal includes tax amounts that are included in item prices, but does not include miscellaneous charge amounts or tax amounts that are charged separately on item prices.

**Less Detail Discount**

This field displays the percentage and total of discount amounts applied to individual detail lines.

**Less Discount**

If a discount was applied on the original invoice to the items and
miscellaneous charges that you are now crediting or debiting, check the
discount that appears on the Totals tab, and edit the discount percentage
or amount, if necessary.

This discount is in addition to any discounts that were applied to items. It
is prorated to all the items and miscellaneous charges (if you are
discounting them) on the current document. It is subtracted from the
credit note or debit note amount.

If the document discount applied to miscellaneous charges on the original
invoice, select the **Discount Miscellaneous Charges** option. You
should take a corresponding discount on the miscellaneous charges you
are crediting or debiting. Any miscellaneous-charge discount amount is
included in the credit/debit note subtotal.

If you are crediting or debiting an invoice that does not exist in your
Order Entry system, or if you need to apply a different discount, enter the
discount as a percentage or a fixed amount.

**Note:**
If you override the amount calculated from a percentage, an asterisk
appears beside the amount. The discount amount will not change unless
you re-enter the discount percentage.

However, if you add details to the credit note or debit note, the discount
percentage is recalculated for each detail (except miscellaneous
charges, if you are not discounting them).

**Example:**
Assume that a 33.3333% discount produces a discount amount of 24,999.94.

If you change the amount to 25,000: An asterisk appears by the amount
to show that the calculation was overridden. If you add more item
details to the document, the discount percentage is automatically
recalculated for each detail, but the discount amount is not recalculated
unless you re-enter the discount percentage.

**Less Retainage**
This field displays the total retainage (amount held back) for this credit
note or debit note. Retainage is processed, later, through the Accounts
Receivable program.
**Misc. Charge Total**
This field displays the total amount of the miscellaneous charge detail lines for the document.

The miscellaneous charges subtotal includes tax amounts that are included in miscellaneous charge amounts, but does not include tax amounts that are charged separately on miscellaneous charges.

**Net Amount**
This field displays the total amount of all items and miscellaneous charges for the document, after any discounts have been subtracted. The net amount also includes tax amounts that are not included in item prices or miscellaneous charge amounts.

**Number of Lines**
This field displays the total number of detail lines (for items and miscellaneous charges) entered for the document.

Tip: Use this number to be sure you have entered all the details you need and deleted any details you did not intend to credit or debit.

**Plus Excluded Tax**
This field displays the total amount of taxes calculated on the items and miscellaneous charges for the document.

The amount in this field does not include tax amounts that are included in item prices or miscellaneous charge amounts.

**Total Tax**
The total amount of tax calculated for the invoice, including taxes included in the price.
O/E Copy Orders Screen

To open this screen:
Open Order Entry > O/E Transactions > Copy Orders.

Secondary screens:
- "O/E Kitting/BOM Components Screen" (page 478)
- "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501)

Related tasks:
- "Allocating Serial Numbers or Lot Numbers to Items in Copied Orders" (page 174)
- "Copying Orders" (page 104)
- "Entering an Order" (page 92)
- "Entering a Quote" (page 87)

Overview

Use the O/E Copy Orders screen to select an existing order, or a range of orders, from which to copy information and details to create a new order.

Details from the source orders appear as defaults for the new order, including item numbers, quantities ordered, pricing, and other information.

You can select the details you want to use in the new order, and you can change the price list, location, ship date, quantity ordered, unit of measure, and unit price for any detail line.

Note:
- You can copy a posted order directly from the O/E Order Entry screen. If you do this, information for the order being copied is automatically entered in the O/E Copy Orders screen.
- You cannot copy an order if any item on the source order requires price approval. If an item on a source order requires price approval, an error message appears when you click the Go button.
- If the From and To customers use different currencies, you must use the Price List field to specify the price list to use for the copied order details.
Appendix A: Order Entry Screen Guides

- You can copy details from an active job-related order to a new order, but not to a new quote.
- You can copy details from a job-related quote to a new quote.

**Copy Orders Tab**

Enter information that will be used to create the new order, and select options to indicate whether the order is on hold or uses retainage.

**Note:**
- If you are creating a quote, enter the date when the quote expires, or verify the default date.
- If the customer account is on hold in Accounts Receivable, the order is automatically placed on hold. You can enter the order and post it, but you cannot ship items or produce an invoice for the order until you clear the customer's on-hold status.
- The Retainage option is not available if you are copying orders that use project invoicing (where invoicing is handled through Project and Job Costing).

**Copy Orders Detail Table**

After you click the Go button, details from the order or orders you specified appear in the Copy Orders Detail table.

In the Copy Detail column, select **Yes** for each detail line you want to include in the new order, and edit each detail line as necessary to set up the new order.

**Note:**
- You cannot edit the item code or miscellaneous charge code for a detail line.
- You cannot add new detail lines to an order (that is, you cannot add detail lines that were not included in the source order or orders).
- If you are copying job-related orders: You cannot change the contract, project, or category. You cannot create a job-related order from a job-related quote. You cannot copy details from other order types to a quote if there are open job details. Normally, to create new job-related quotes, you set up a template quote and copy it each time you create a quote.
Optional Fields Tab

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the Auto Insert option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note**: If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

Fields and Controls

Buttons

**Close**

Click Close to close the screen.

**Create**

After specifying information and details to copy from an existing document, click Create to create a new quote or order.

You can use the O/E Order Entry form to edit and post the new quote or order.

**Note**: The Create button becomes available after you click the Go button.

**Go >>**

After you enter order selection criteria, click Go to view details from the orders you selected in the Copy Orders Detail table.

If you wish, you can change your order selection criteria and click Go again to view details from a different set of orders.

**Kit Component**

Click the Kit Component button to open the O/E Kitting Components
screen, which you can use to review the items in a kit. For more information, see "O/E Kitting Components Screen" (page 481).

**Note:** If you use Serialized Inventory and Lot Tracking, you can open the O/E Serial/Lot Numbers Allocation screen from the O/E Kitting/BOM Components screen. You use this screen to allocate serial or lot numbers to a quantity shipped for a component item, or, if Inventory Control allows it, to allocate serial or lot numbers to the order quantity. For more information, see "O/E Serial/Lot Numbers Allocation/Generation Screen" (page 501).

**From/To Customer Number**
You can copy details from previously entered orders for the same customer or from orders for a different customer.

- In the **From Customer Number** field, enter the number of the customer whose order details you are copying.
- In the **To Customer Number** field, enter the number of the customer for whom you are creating a new order.

**Note:** If the From and To customers use different currencies, you must use the Price List field to specify the price list to use for the copied order details.

**From/To Order Number**
Specify a range of existing orders that contain the information and details you want to use in the new order.

**Job Related**
Select this option if you use Project and Job Costing and you want to copy details from job-related orders.

Quotes in Order Entry refer to estimates in Project and Job Costing. When you activate a job-related order and post it, updates the status of the associated contracts in PJC to Open.

After you select this option, the **Project Invoicing** option becomes available.

**Note:**
- You can copy details from an active job-related order to a new order,
but not to a new quote.

- You can copy details from a job-related quote to a new quote.

**Order Type**
Select the type of order(s) from which you want to copy information and details: Active, Future, Standing, or Quote. For more information about order types, see "Order Types" (page 84).

**Note:**
- You can copy details from an active job-related order to a new order, but not to a new quote.
- You can copy details from a job-related quote to a new quote.

**Price List**
If the From and To customers use different currencies, specify the price list to use for the copied order details.

You can change prices for the new details after creating the new order.

**Project Invoicing**
Select this option if you use Project and Job Costing and you want to copy details from job-related orders that use project invoicing.

Order Entry does not create invoices for orders that use project invoicing. Instead, it completes orders when they are shipped, and posts all information to Project and Job Costing, where it is processed using the PJC Create Billing Worksheet screen.

You can invoice orders that do not use project invoicing in Order Entry, which then posts the invoices to Accounts Receivable.

**Tax Group**
Select the tax group for the new order, or verify the default selection. (By default, this field displays the tax group for the customer you select in the Copy To area.)

**Tax Reporting Currency**
This field displays the tax reporting currency for the customer for which you are creating the order.

**Copy Orders tab**

**Description**
Enter a description for the new order you are creating.

**Expiration Date**
This field appears when you select Quote in the **Order Type** field.

If you are creating a quote, enter the date when the quote expires, or verify the default date, which is calculated using the order date plus the number in the Default Quote Expiration Days field on the O/E Options screen.

**On Hold**
Select this option if you want to place the new order on hold.

If the customer account is on hold in Accounts Receivable, the order is automatically placed on hold. You can enter the order and post it, but you cannot ship items or produce an invoice for the order until you clear the customer's on-hold status.

**Note:** You can clear the On Hold option for orders in Order Entry to ship and invoice the orders. You do not have to clear the On Hold option for the customer in Accounts Receivable.

For more information about on-hold orders, see "Order Types " (page 84).

**Order Date**
Enter the date for the order. For a future order, enter the date that the order becomes active.

This date is also used to age the order on the Aged Orders report.

By default, the system date appears in this field.

**Order Number**
Enter a number for the new order you will create, or leave the default value ***NEW*** in the field if you want Sage 300 ERP to assign a new order number.

**Order Type**
Select the type of order you want to create: Active, Future, Standing, or Quote. For more information about order types, see "Order Types " (page 84).
Note:
- You can copy details from an active job-related order to a new order, but not to a new quote.
- You can copy details from a job-related quote to a new quote.

Reference
Enter optional reference information for the order.

The reference information you enter here appears in Accounts Receivable as the reference for the invoice. It may also appear in the General Ledger batch, depending on your system settings. For more information, see the Accounts Receivable and General Ledger help.

Retainage
If you use retainage accounting and are copying job-related orders, you can select this option to indicate that retainage applies to the order you are creating.

The retainage amount is the amount the customer can withhold for an original document detail until the end of the retention period, when retainage is invoiced.

Note: The Retainage option is not available if you are copying orders that use project invoicing (where invoicing is handled through Project and Job Costing).

Detail table
Click the check box at the left of each detail line you wish to include in the new order, and edit each detail line as necessary to set up the new order.

All item detail fields (and any detail optional fields that are set up for the screen) appear as columns in this table.

Category (Job Related)
This field appears if you selected the Job Related option for the document.

For job-related orders, specify the category to use for this item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.
Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than "Category" in Project and Job Costing, that term appears as the label for this field.
- Use the **Item Number** field to specify the resource.
- After you add the detail, you cannot edit this field.

**Contract**
This field appears if you selected the **Job Related** option for the transaction.

For job-related orders, specify the contract to use for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than "Contract" in Project and Job Costing, that term appears as the label for this field.
- Use the **Item Number** field to specify the resource.
- After you add the item or charge, you cannot edit this field.

**Copy Detail**
Double-click this field to specify whether to copy this detail line to the new order.

**Cost Class**
This field displays the cost class for the project category used in each job-related detail.

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

**Costing UOM**
This field displays the costing unit of measure specified in the item.
record.

For user-specified costing items, the unit cost and costing unit are copied from the original order detail, and you can edit them.

The cost and costing unit for other items (FIFO, LIFO, moving average) are picked up when the orders are copied, and so are current. They will appear on the O/E Copy Orders screen if you are authorized to view them.

**Description**

This field displays the description from the item price list or miscellaneous charge record for the item or miscellaneous charge selected in the **Item No./ Misc. Charge** field.

This description appears on printed order confirmations, picking slips, and invoices. You can use the default description or enter a new description to be used for an individual transaction.

In a multicurrency system, the description from the item record appears here if the price list does not include a price in the customer’s currency.

**Exp. Ship Date**

By default, the expected shipment date is the same as the order date, but you can change it.

**Ext. Cost**

Items that have user-specified costing show the costs entered on the orders that you are copying. You can edit user-specified costs later using the O/E Order Entry screen.

Job-related miscellaneous charges display the extended costs entered with the original orders. These can be defaulted from the miscellaneous charge record or from Project and Job Costing.

**Ext. Price**

Enter the extended price for the detail, or accept the calculated value.

Extended price refers to the extended price of an order (that is, the total cost of the items being ordered, whether or not they have been shipped). It is calculated automatically when you enter an order quantity. Sage 300 ERP divides the unit price by the pricing unit of
measure conversion factor, and then multiplies the result by the order unit of measure conversion factor and the quantity ordered.

If you change the extended price calculated by the program, an asterisk appears beside the Ext. Price field on the O/E Items/Taxes screen, and also appears beside the item on the O/E Transaction List report.

**Item No./Misc. Charge**

This field displays the code for the item or miscellaneous charge used in the source order.

You cannot modify items or miscellaneous charges copied from the source order; you can only specify whether or not to copy the detail line.

**Kit/BOM**

If this item is part of a kit or BOM (bill of material), this field displays the kit number or BOM number. (In Inventory Control, you can have more than one list of items in a kit or BOM.)

You cannot change the kit or BOM number when copying orders.

**Line No.**

Line numbers are assigned automatically, and you cannot change them.

You use line numbers to identify details you have entered, or to recall them for editing when you are using the O/E Items/Taxes screen to enter detail information.

You can also list items on picking slips by line number.

**Location**

By default, this field displays the location code specified for the order. You can change the location for individual details.

Optionally, enter the code for the physical location from which you will ship the items ordered on the detail line.

You must specify a physical location, not a logical inventory location. Logical locations are used primarily for transferring goods between physical locations in Inventory Control.
Note: You cannot change the location for a serialized or lotted item after you enter a quantity in the Quantity Ordered field.

Tip: You can click the Location Finder to see the quantity on hand at other locations.

Optional Fields
Double-click the this field on the detail line or click the Zoom button column heading to enter information for an optional field that was assigned to this transaction type in the O/E Optional Fields setup form.

The entry in the detail line will change from No to Yes.

You can also enter optional field information for the order as a whole on the Optional Fields tab.

Order UOM
This is the unit of measure in which you are ordering item quantities for the detail. You can select a different unit of measure if necessary.

Tip: Make sure that the amount in the Quantity Ordered field uses this unit of measure.

Depending on your settings on the O/E Options screen, this field displays either the item weight unit (from the item record in Inventory Control) or the pricing weight unit (from the price list in Inventory Control). Stocking units and pricing units are defined for individual items in Inventory Control, and they may be different. For example, you may use "Dozen" as the stocking unit for an item, but "Each" as the pricing unit.

For more information, see "About Order Unit of Measure" (page 19).

Order Weight UOM (unit of measure)
This is the unit of measure for weighing this item on the order. You can select a different unit of measure if necessary.

Depending on your settings in O/E Options, this field displays either the item weight unit (from the item record in Inventory Control) or the pricing weight unit (from the price list in Inventory Control).
The order weight unit of measure for the complete order is determined by the default weight unit of measure specified on the I/C Options screen.

**Note:**
- If the item is not priced by weight, this field displays the item weight unit from the item record.
- If the item is priced by weight, and it has base prices for multiple units of measure, this field displays the default unit of measure from the price list if your Default Order Weight UOM in O/E Options is the Pricing Weight Unit.

**Price Approval**
You cannot copy an order if any item on the source order requires price approval.

Price checks are set in Inventory Control price lists for particular items, price lists, and user IDs.

If price checks are in effect, and the price you enter is outside the boundaries allowed, this field displays "Yes."

For more information, see "About Price Checks " (page 82).

**Price By**
This field indicates whether the item is priced by weight or by quantity.

- If pricing is by quantity, Sage 300 ERP sets volume discount amounts or percentages according to the quantity of goods that are ordered.
- If pricing is by weight, Sage 300 ERP sets volume discount amounts or percentages by item weight.

Item weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Note:** Pricing by weight is available in Sage 300 Premium ERP only.

**Price List**
If the From and To customers use different currencies, you must
specify the price list to use for the copied order details.

If the From and To customers use the same currency, details for the new order will use the prices from the previous orders.

You can change prices for the new details after creating the new order.

**Pricing UOM (unit of measure)**

This field displays the unit of measure in which the item is priced.

Sage 300 Premium ERP supports multiple pricing units of measure, but you must set one as the default on the I/C Item Pricing screen in Inventory Control.

The pricing UOM is determined by the price list as follows: If the price list provides only one pricing UOM, that UOM appears here. If the price list provides several pricing UOMs, the pricing unit that matches the order UOM appears here. If no pricing UOM matches the order UOM, the default pricing UOM appears here. If you price by cost, the default pricing UOM appears here, and the cost-based price appears in the Unit Price field.

**Note:** If the item is not on the specified price list, the program uses the item's stocking unit as the pricing unit.

**Project**

This field appears if you selected the **Job Related** option for the document.

For job-related orders, specify the project for the item or charge. You also specify the WIP Account (for Project Invoicing) or the Revenue and COGS accounts and the Billing Type for the customer invoice.

Posting the document updates the committed quantities and costs for jobs in Project and Job Costing.

**Note:**
- If you use a term other than "Project" in Project and Job Costing, that term appears as the label for this field.
- Use the **Item Number** field to specify the resource.
- After you add the item or charge, you cannot edit this field.
**Qty. B/O**

If Order Entry uses the **Calculate Backorder Quantities** option (on the O/E Options screen), and if the customer record in Accounts Receivable allows backordered quantities, Order Entry automatically calculates the quantity backordered by subtracting the quantity shipped from the quantity ordered.

If Order Entry does not automatically calculate quantities and you are not shipping the entire order, enter the quantity backordered.

Each time you enter a shipped amount, the backordered quantity is reduced. When the backordered amount is zero, the item is considered to be fully shipped, and its status is set to Completed.

**Tip:** To cancel unshipped quantities of an order, enter 0 (zero) in this field.

**Qty. Committed**

Specify an inventory quantity to commit to the order. When it is time to ship the order, the quantity is guaranteed to be available (unless you allow negative inventory quantities).

If a quantity is already committed to an order, you can ship another order for the same items only if there is a sufficient quantity in inventory in addition to the committed quantity.

**Qty. Ordered**

Enter the number or quantity of the item or charge to include in the order.

Make sure that the number or quantity you enter uses the unit of measure specified in the **UOM** field. For example, if the UOM is "Case" and the order is for two cases, enter 2 in the **Quantity Ordered** field.

**Note:**
- The **Allow Fractional Quantities** option on the I/C Options screen in Inventory Control determines whether you can use decimals in the **Quantity Ordered** field. For more information, see Inventory Control help.
If the detail is not completed (indicated in the **Completed** field), you can change the quantity ordered for items that have not been shipped and invoiced.

If you are unable to ship all the items on an order, and want to cancel unshipped items, you can edit the details to reduce the quantities ordered so they match the quantities shipped.

If the item is serialized or lotted and Inventory Control allows the allocation of serial numbers or lot numbers to order quantities, the O/E Serial/Lot Numbers Allocation screen appears after you enter the quantity ordered and leave the field. (The Inventory Control option Use the Qty Ordered Field in OE determines whether you can allocate serial numbers or lot numbers using order quantities.) You use the O/E Serial/Lot Numbers Allocation screen to allocate serial numbers or lot numbers for the quantity of items ordered. For more information, see O/E Serial/Lot Numbers Allocation/Generation Screen.

**Retainage Percentage (%)**

Enter the retainage percentage to be used when calculating the retainage amount for the item or charge.

When you edit this field, the retainage amount for the item or charge is calculated automatically.

**Retention Period**

The retention period is the number of days for which the customer can withhold the retainage amount.

You issue the retainage invoice in Accounts Receivable at the end of the retention period.

**Type**

This field indicates the type of detail: item or miscellaneous charge:

- **Item** indicates that the detail is for an inventory item or non-stock item that has an item record in Inventory Control.

- **Miscellaneous** indicates that the detail is for a miscellaneous charge defined in Order Entry.

**Unit Cost**

You enter the unit cost for an item only if the item uses the user-
specified costing method in Inventory Control (that is, if **User-Specified** appears in the **Costing Method** field on the I/C Items screen).

For more information, see "Inventory Costing Methods" (page 33).

**Note:** If security is turned on for your system, you must have Item Cost Inquiry authorization to view and edit information in this field.

**Unit Price**

By default, this field displays the lowest unit price for which the customer is eligible. This may be the base price, a sale price for a specified time period, or the price specified for the customer’s price level or the quantity purchased, based on a discount or markup.

If necessary, enter the price for the item, per pricing unit.

**Note:**

- If price checks are in effect, and the unit price is outside the allowed limit, the price must be approved. For more information, see "About Price Checks " (page 82).

- You can edit the information in this field only if you have Unit Price Override security authorization in Order Entry.

- If the item is not on the price list you specified for the detail, no price appears.

- If the lowest price is a negative amount, it is displayed as zeros.

- If you set up contract pricing for a customer in Inventory Control, Order Entry uses that information to calculate prices for items affected by the customer’s pricing contract, and it displays the contract price by default in this field.

- If you do not set up contract pricing for a customer, Order Entry calculates prices based on the customer type and the price lists you set up in Inventory Control.

- If the price list you select is not currently in effect: The Unit Price Finder does not appear. (That is, the Finder does not appear if the document date is not between the Price List Starts date and the Price List Ends date specified for the item, currency, and
The Unit Price field displays 0.000000 by default.

- The number of decimal places that appear in this field is determined by the information specified for the item on the I/C Item Pricing screen.

**Optional Fields tab**

If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field information that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the **Auto Insert** option for those fields on the O/E Optional Fields setup screen.

If you use identical optional fields in Order Entry transactions and Accounts Receivable invoices, the information in the Order Entry fields is sent to Accounts Receivable.

**Note:** If an optional field is required but does not have a default value, you must specify a value for the field.

For more information, see "About Optional Fields" (page 58) and "Adding Optional Fields to Transaction Entry Screens" (page 60).

**Optional Field**

Use the Optional Field Finder to select optional fields that are assigned (in the O/E Optional Fields setup screen) to this type of transaction.

When you select an optional field code, Order Entry displays its description in the next column.

**Value**

Use the Value Finder to select a value created for the optional field in Common Services.

When you select a value code, Order Entry displays its description in the next column.

**Value Set**

The Value Set column shows whether a blank optional field currently has a value. (By looking at the field, you cannot know otherwise whether the field has a blank default value or no value.)
The Value Set field changes from **No** to **Yes** if you make an entry in the Value field.
O/E Capture Payments with Invoices Screen

To open this screen:
Open Order Entry > O/E Transactions > Capture Payments with Invoices.

Related tasks:
- "Capturing a Pre-authorized Credit Card Payment" (page 147)
- "Capturing and Invoicing Pre-authorized Credit Card Payments" (page 150)
- "Pre-authorizing a Credit Card Payment" (page 144)
- "Voiding a Credit Card Pre-authorization" (page 153)

Overview

Use the O/E Capture Payments With Invoices screen to capture and invoice pre-authorized credit card payments for multiple orders or shipments.

When you capture payments, they are added to an Accounts Receivable receipt batch that is created automatically. If you process payments that use multiple processing codes, a separate Accounts Receivable receipt batch is created for each processing code.

Selecting Documents

By default, this screen displays all documents with outstanding pre-authorized payments.

If you want to process payments for a range of processing codes, shipment numbers, and/or order numbers, you can use the filters on the O/E Capture Payments With Invoices screen to specify criteria, and then click the Go button to see documents that match the criteria you specified.

In the Apply column, "Yes" appears by default for each document. If you do not want to process payment for a document, double-click the row or press the spacebar to select "No."

Tip: If you want to capture payments for a small number of the documents that appear in the table, modify your filter criteria to produce a smaller set of results, or click the Apply None button, and then manually select the documents for which you want to capture payments.
If you want to print invoices and/or receipts after processing payments, select the **Print Invoices After Capture** and/or **Print Receipts After Capture** options.

**Processing Payments and Creating Invoices**

After selecting documents and specifying print options, click the **Capture and Invoice** button to capture pre-authorized payments and create invoices for the documents you selected.

- Sage Payment Solutions processes pre-authorized payments for all documents that display "Yes" in the **Apply** column.
- Order Entry creates an invoice for each pre-authorized payment that was successfully processed.
- Accounts Receivable creates a receipt batch with the batch date you specified. If you use multiple processing codes, a separate receipt batch is created for each processing code.
- When processing is complete, a message displays summary information about payments that were successfully processed. If any errors occur while processing payments and creating invoices, a message displays detailed information about each error.

**Tip:** If any payments were not processed, or if any invoices were not created, print this message to create a record of errors that you need to resolve.

- If you select **Print Invoices After Capture**, the O/E Invoices report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last invoice in the new batch are specified in the **From Invoice** and **To Invoice** fields, and the **Include Invoices Already Printed** option is cleared.

- If you select **Print Receipts After Capture**, the A/R Receipts report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last Accounts Receivable batches created while capturing payments are specified in the **From** and **To** batch number fields.

**Issues when Capturing Payments**

When you pre-authorize a credit card payment, credit card information is validated in Sage Payment Solutions, and the cardholder’s credit limit is reduced by the amount of the pre-authorization until the pre-authorization is
captured or expires. For these reasons, it is rare for errors to occur while capturing a payment. However, the following issues may cause a capture to fail:

- **The pre-authorization has expired and cannot be forced.** Pre-authorizations usually expire after seven days, and you may be able to "force" payment for an expired pre-authorization up to 30 days after expiry. If more than 30 days have passed since the pre-authorization expired, you may be unable to process payment.

- **The pre-authorization has expired and credit card information was not saved.** If credit card information was not saved when the pre-authorization was created, you cannot force payment after the pre-authorization expires.

- **The pre-authorization has been voided.** If you or another user voided the transaction in Sage 300 ERP or in Sage Virtual Terminal, you cannot capture payment.

- **The receipt amount is zero.** You cannot capture a pre-authorized payment if the receipt amount is zero.

- **Another user modified the order or shipment during payment processing.** If another user changes the order or shipment information during processing, the transaction may fail.

- **The Internet connection was lost or interrupted.** If a capture fails due to issues with your Internet connection, you should be able to process the transaction again successfully when the connection is restored.

- **Merchant information has been changed.** If you or another user changed the merchant information or processing codes for your Payment Processing system, capture may fail for pre-authorizations created using the original merchant information or processing codes.

**Fields and Controls**

**Buttons**

**Apply All**

This button becomes available after you click **Apply None**, or after you manually set the value in the **Apply** column to "No" for all documents.

Click **Apply All** to set the value in the **Apply** column to "Yes" for all documents in the table.
Apply None

Click **Apply None** to set the value in the **Apply** column to "No" for all documents in the table.

Capture and Invoice

Click **Capture and Invoice** to capture pre-authorized payments and create invoices.

- Sage Payment Solutions processes pre-authorized payments for all documents that display "Yes" in the **Apply** column.
- Order Entry creates an invoice for each pre-authorized payment that was successfully processed.
- Accounts Receivable creates a receipt batch with the batch date you specified. If you use multiple processing codes, a separate receipt batch is created for each processing code.
- When processing is complete, a message displays summary information about payments that were successfully processed. If any errors occur while processing payments and creating invoices, a message displays detailed information about each error.

**Tip:** If any payments were not processed, or if any invoices were not created, print this message to create a record of errors that you need to resolve.

- If you select **Print Invoices After Capture**, the O/E Invoices report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last invoice in the new batch are specified in the **From Invoice** and **To Invoice** fields, and the **Include Invoices Already Printed** option is cleared.
- If you select **Print Receipts After Capture**, the A/R Receipts report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last Accounts Receivable batches created while capturing payments are specified in the **From** and **To** batch number fields.

Close

Click **Close** to close the screen.

Go >>

Click the Go >> button to view documents that match the criteria you
specified.

**Restore Defaults**
Click **Restore Defaults** to restore default values in the **From/To** fields (that is, to reset filters so that pre-authorized payments for all processing codes, shipment numbers, and document numbers appear in the table).

**A/R Receipt Batch Date**
Specify the date for the Accounts Receivable receipt batch that is created when you capture and invoice pre-authorized payments, or accept the default value to use the current session date.

Batch number and description are generated automatically for each batch.

If you process payments that use multiple processing codes, a separate Accounts Receivable receipt batch is created for each processing code.

**From/To Order Number**
Specify a range of order numbers for which to view pre-authorized payments, or accept the default entries in these fields to view pre-authorized payments for all orders.

If you specify ranges of both shipment numbers and order numbers, only pre-authorized payments that match all criteria you specify will appear in the table.

**From/To Processing Code**
A processing code specifies the bank, currency, and merchant account that will be used to process a credit card transaction.

If you use multiple processing codes, you can specify a single processing code or range of processing codes for which to view pre-authorized payments, or accept the default entries in these fields to view pre-authorized payments for all processing codes.

If you process payments that use multiple processing codes, a separate Accounts Receivable receipt batch is created for each processing code.

**From/To Shipment Number**
Specify a range of shipment numbers for which to view pre-authorized payments, or accept the default entries in these fields to view pre-authorized payments for all shipments.
If you specify ranges of both shipment numbers and order numbers, only pre-authorized payments that match all criteria you specify will appear in the table.

**Print Invoices After Capture**
Select this option if you want to print invoices for the selected documents after you capture payments and create invoices.

If you select **Print Invoices After Capture**, the O/E Invoices report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last invoice in the new batch are specified in the From Invoice and To Invoice fields, and the Include Invoices Already Printed option is cleared.

**Print Receipts After Capture**
Select this option if you want to print receipts for the selected documents after you capture payments and create invoices.

If you select **Print Receipts After Capture**, the A/R Receipts report screen opens after Sage 300 ERP processes payments and creates invoices. By default, the numbers of the first and last Accounts Receivable batches created while capturing payments are specified in the From and To batch number fields.

**Pre-authorized Payments table**
If you want to process payments for a range of processing codes, shipment numbers, and/or order numbers, you can use the filters on the O/E Capture Payments With Invoices screen to specify criteria, and then click the Go button to see documents that match the criteria you specified.

In the Apply column, "Yes" appears by default for each document. If you do not want to process payment for a document, double-click the row or press the spacebar to select "No."

**Tip:** If you want to capture payments for a small number of the documents that appear in the table, modify your filter criteria to produce a smaller set of results, or click the Apply None button, and then manually select the documents for which you want to capture payments.
Appendix B: Order Entry Security Authorizations

If security is turned on for your Sage 300 ERP system, the system administrator must assign these security authorizations to users for Order Entry screens.

For information on activating security and setting up security groups, refer to the System Manager help.

**Note:** To change the print destination for forms and reports, you must have Change Print Destination security authorization for Administrative Services.

The following security authorizations are available on the Security Groups screen in Administrative Services:

<table>
<thead>
<tr>
<th>Security Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sage 300 ERP Inquiry</td>
<td>Query Order Entry data in the portal. If you also have Export Processing authorization for Order Entry, print or export the results of these queries.</td>
</tr>
<tr>
<td>Common Inquiry</td>
<td>Print setup reports; view and print setup screens.</td>
</tr>
<tr>
<td>Credit Approval</td>
<td>Manually increase a customer’s credit limit when entering orders, shipments, and invoices.</td>
</tr>
<tr>
<td>Credit/Debit Note Costing</td>
<td>View the costing unit cost and extended cost in the O/E Credit/Debit Note Entry screen.</td>
</tr>
<tr>
<td>Credit/Debit Note Entry</td>
<td>Enter credit notes and debit notes; view credit note and debit note statistics.</td>
</tr>
<tr>
<td>Credit/Debit Note Printing</td>
<td>Print credit notes, debit notes, and the O/E Salesperson Commissions report.</td>
</tr>
<tr>
<td>Customer Hold Removal</td>
<td>Remove the On Hold status of orders that are on hold.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>View the Order Entry dashboard.</td>
</tr>
<tr>
<td>Export Processing and Invoice Entry</td>
<td>Export orders; view posted invoices.</td>
</tr>
<tr>
<td>Export Processing and</td>
<td>Print setup reports; export setup options.</td>
</tr>
<tr>
<td>Export Processing and</td>
<td></td>
</tr>
</tbody>
</table>
### Appendix B: Order Entry Security Authorizations

<table>
<thead>
<tr>
<th>Security Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Maintenance</td>
<td></td>
</tr>
<tr>
<td>Export Processing, Setup Maintenance, and Transaction Inquiry</td>
<td>Export orders; print setup reports; view, export and print setup options; view posted invoices; view posted credit notes and debit notes; view sales history and statistics.</td>
</tr>
<tr>
<td>History Clearing</td>
<td>Clear history.</td>
</tr>
<tr>
<td>History Clearing and Day End Processing (I/C)</td>
<td>Clear history; print reports; view, print, and edit sales statistics. Note: You can edit statistics only if the Allow Edit of Statistics option is selected on the O/E Options screen.</td>
</tr>
<tr>
<td>Import Processing and Credit/Debit Note Entry</td>
<td>Import and add credit notes and debit notes; view posted credit notes and debit notes.</td>
</tr>
<tr>
<td>Import Processing and Invoice Entry</td>
<td>Import and add orders; view posted invoices.</td>
</tr>
<tr>
<td>Import Processing and Setup Maintenance</td>
<td>Print setup reports; import setup options.</td>
</tr>
<tr>
<td>Invoice Entry</td>
<td>View and modify orders; view invoice statistics. Note: If you use Payment Processing, you must have Invoice Entry authorization to pre-authorize and process credit card transactions in Order Entry.</td>
</tr>
<tr>
<td>Invoice Entry and Receipt Entry (A/R)</td>
<td>View statistics; modify orders, invoices, and prepayments.</td>
</tr>
<tr>
<td>Invoice Printing</td>
<td>Print invoices and the O/E Salesperson Commissions report.</td>
</tr>
<tr>
<td>Item Cost Inquiry</td>
<td>View costing information, such as the costing unit cost and the extended cost, when entering orders, shipments, and invoices.</td>
</tr>
<tr>
<td>Order Confirmation Printing</td>
<td>Print order confirmations and the O/E Salesperson Commissions report.</td>
</tr>
<tr>
<td>Order Entry</td>
<td>Add, modify, delete, and post orders.</td>
</tr>
<tr>
<td>Order/Shipment/Invoice Entry</td>
<td>View, add, modify, delete, and post orders, shipments, and invoices.</td>
</tr>
<tr>
<td>Picking Slip Printing</td>
<td>Print picking slips.</td>
</tr>
<tr>
<td>Security Authorization</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Price Check Approval</td>
<td>Approve price overrides.</td>
</tr>
<tr>
<td>Quote Printing</td>
<td>Print quotes.</td>
</tr>
<tr>
<td>Setup Maintenance</td>
<td>Print setup reports; modify setup options.</td>
</tr>
<tr>
<td>Setup Maintenance and Day End Processing (I/C)</td>
<td>Print reports; modify setup options; view sales history and salesperson statistics.</td>
</tr>
<tr>
<td>Setup Maintenance and Transaction Inquiry</td>
<td>View statistics; print setup reports; modify setup options.</td>
</tr>
<tr>
<td>Shipment Entry</td>
<td>Add, modify, delete, and post shipments.</td>
</tr>
<tr>
<td>Shipment Entry and Transaction Inquiry</td>
<td>Add, modify, delete, and post shipments; view sales history; print posting journals; inquire on shipments.</td>
</tr>
<tr>
<td>Shipment Entry and Day End Processing</td>
<td>Add, modify, delete, and post shipments; perform Day End Processing in Inventory Control.</td>
</tr>
<tr>
<td>Shipping Label Printing</td>
<td>Print shipping labels.</td>
</tr>
<tr>
<td>Transaction Inquiry</td>
<td>View orders; print reports; view statistics.</td>
</tr>
<tr>
<td>Transaction Optional Fields</td>
<td>Add, edit, and delete optional fields on the Order Entry, Shipment Entry, Invoice Entry, and Credit/Debit Note Entry screens, and in Order Entry functions that create transactions automatically.</td>
</tr>
</tbody>
</table>
| Unit Price Override                                        | Change the unit price on orders, shipments, and invoices.}
Appendix C: Data Entry Tools, Tips, and Shortcuts

Use these tools and tips to speed up data entry in Sage 300 ERP.

Data Entry Tools and Shortcuts

Use these tools and shortcuts to speed up data entry in Sage 300 ERP.

Data Entry Tools and Shortcuts

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
</table>
| Drilldown| ![Drilldown](image) | n/a          | The Drilldown button appears beside some data entry fields and in some column headings in transaction detail entry tables. Click it to view details of the record or transaction in the corresponding field. You can "drill down" both within Sage 300 ERP programs and between separate programs. For example, you can drill down:  
  - From General Ledger transactions to original transaction entries.  
  - From Accounts Receivable to Order Entry.  
  - From Accounts Payable to Purchase Orders.  
  - From one transaction to an originating transaction (such as from a credit note to the invoice) within a program. |
<p>| Finder   | <img src="image" alt="Finder" /> | F5           | The Finder appears in some data entry fields, and in some table headings in transaction entry screens. Click it when you want to look up records you can select for a field. Use the Finder to search lists of codes |</p>
<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>maintained in or used by Sage 300 ERP programs (such as document numbers, terms codes, and account set codes). You can use menu commands in the Finder to help you search, as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• On the Settings menu, select <strong>Color</strong> options to highlight a field using color for the text or for the background.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• On the Settings menu, select <strong>Field Name as Column Heading</strong> to use field descriptions or internal field names as column headings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• On the Settings menu, use <strong>Columns</strong> options to specify columns that appear in the table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• On the Global Settings menu, select the <strong>Go to Filter First</strong> option if you want the Finder to display the same filter settings you specified on the <strong>Find By</strong> list the next time you search this type of record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>You can also use the <strong>Auto Search</strong> option to locate a record quickly in a long list. To do this, select <strong>Auto Search</strong> and the criteria by which you want to search, and then begin typing the characters that start or are contained in the field you are searching on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> Records that appear in the Finder are restricted by any selection criteria you apply to this field. If you cannot find the record you are looking for with the Finder or the navigation buttons, check the Finder to see whether any criteria are being used to limit the selection. If necessary, remove the selection criteria. (For more information, see “Setting Finder Criteria” (page 690))</td>
</tr>
</tbody>
</table>
### Data Entry Tools and Shortcuts

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Tip:</strong> For additional instructions on using the Finder to select records, press F1 when the Finder screen appears.</td>
</tr>
<tr>
<td>Go</td>
<td>![Arrow]</td>
<td>F7</td>
<td>The Go button appears on screens where you must enter information (such as filter criteria) before viewing records that match the information you enter. For example, on some Statistics and Inquiries screens, you must select a range of years and periods and specify an item number or vendor number before you can view statistics. (If you use multicurrency accounting, you must also specify a currency.) After specifying this information, you click the Go button or press F7 to view statistics.</td>
</tr>
<tr>
<td>Inquiry</td>
<td>![Question Mark]</td>
<td>n/a</td>
<td>The Inquiry button appears beside some data entry fields. Click it to view comprehensive information for the record selected in the field. <strong>Example:</strong> In Accounts Receivable transaction screens, an Inquiry button appears beside the Customer Number field. You can click it to view all available information about the selected customer in the A/R Customer Inquiry screen.</td>
</tr>
<tr>
<td>Navigation</td>
<td>![Left Arrow, Right Arrow, Up Arrow, Down Arrow]</td>
<td>n/a</td>
<td>Click the Previous and Next buttons to navigate through a list of existing records, or click the First and Last buttons to navigate to the first and last records.</td>
</tr>
</tbody>
</table>
### Appendix C: Data Entry Tools, Tips, and Shortcuts

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> If you clicked the <strong>Set Criteria</strong> button on the Finder screen and specified criteria, only records that match the criteria you specified will appear when you use the navigation buttons. If a record does not appear, click the Finder and check to see whether you have specified criteria that prevent the record from appearing.</td>
</tr>
<tr>
<td>New</td>
<td>![New Icon]</td>
<td>n/a</td>
<td>Click the New button or select <strong>New</strong> from a menu to begin creating a new record.</td>
</tr>
</tbody>
</table>
| Zoom | ![Zoom Icon] | F9           | Click the Zoom button or press the F9 key to view or enter supplementary information for a transaction detail or for a field.  

In any detail entry table, you can select a detail line and press F9 to open a screen that displays all the fields for a single detail, including additional tax-related fields that do not appear on the detail table. You can edit existing details, and even add new details for the document.  

Beside any field that displays a Zoom button, you can click the button (or select the field and then press F9) to open a separate screen where you can view and enter supplementary information specific to that field.  

**Note:** If another Zoom button appears on the detail screen, you can click it or press Shift+F9 to open the new detail screen. (If you simply press F9 again, the first detail screen closes.) This function is referred to as "Detail Zoom." To close the second detail screen, press Shift+F9 again.  

After viewing or editing the information in the detail screen, you can press F9 to close the screen. |
Order Entry Menu Commands

The following commands appear on the File, Settings (when available), and Help menus on Sage 300 ERP screens.

**File Menu**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the current screen.</td>
<td>You can also press Alt+F4 to close a screen.</td>
</tr>
<tr>
<td>Customize</td>
<td>Lets you hide or display fields for users by UI Profile ID.</td>
<td>Click <strong>File &gt; Customize</strong> to hide fields on an open screen for users assigned to a UI Profile ID for that screen. When these fields are hidden, data that would normally appear in these fields cannot be printed. For more information, see the help for the UI Profile Maintenance screen in the System Manager help.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports data records to other Sage 300 ERP databases and non-Sage 300 ERP programs.</td>
<td>Click <strong>File &gt; Export</strong> to export data. For example, you could export purchase statistics for use in spreadsheet or database software. <strong>Note:</strong> You cannot export serial or lot numbers for kit components.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports data records from other databases and from non-Sage 300 ERP programs.</td>
<td>Click <strong>File &gt; Import</strong> to import data. For example, you could use a spreadsheet to enter current requisitions or purchase orders when setting up your system, and then import the transactions later. <strong>Note:</strong> You cannot import serial or lot numbers for kit components.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the current report, list, or screen.</td>
<td>On screens with a corresponding report, click <strong>File &gt; Print</strong> to open the report screen, which you use to select report options (if applicable) before printing the report.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Selects a printer and sets printing options.</td>
<td>Click <strong>File &gt; Print Setup</strong> to set up your printer. You can select the default printer or select...</td>
</tr>
</tbody>
</table>
### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Another from the list of installed printers. For more information about print options, refer to your operating system documentation.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the entries or changes you have made to the current screen.</td>
<td>If you have just entered a new record, <strong>Add</strong> appears instead of <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

### Settings Menu

#### Settings Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Clear</td>
<td>Creates a new entry automatically when you post a transaction.</td>
<td>Use the <strong>Auto Clear</strong> option to streamline data entry in transaction entry screens.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If Auto Clear is turned on, all fields are cleared each time you post a transaction, allowing you to immediately begin entering another transaction.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If Auto Clear is turned off, transaction information remains on the screen after you post it. Click the <strong>New</strong> button to begin entering another transaction.</td>
</tr>
<tr>
<td>Clear Saved Settings</td>
<td>Restores default settings for a report.</td>
<td>This command is available for screens and for some reports.</td>
</tr>
<tr>
<td>Save Settings as Defaults</td>
<td>Saves the current report settings as personal defaults.</td>
<td>This command is available for screens and for some reports.</td>
</tr>
</tbody>
</table>

### Help Menu

#### Help Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Displays version and copyright information for the current screen and program.</td>
</tr>
<tr>
<td>Contents</td>
<td>Opens Help.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Opens Help to an introductory topic on how to use Help.</td>
</tr>
</tbody>
</table>
Working with Detail Entry Tables

The first tab of each transaction entry screen in Sage 300 ERP contains a detail entry table that shows the document details in tabular format.

In most cases, you can enter all the necessary details for a document right on the table.

**Tip:** If there are more columns than can be displayed at one time, you can use the horizontal scroll bar at the bottom of a list to view the additional columns. You can also rearrange the order of columns, or change column widths, consistent with how you enter data.

You can also view and edit all the fields for a single detail on a separate Detail Items/Taxes screen. To view this screen, select a detail line and click the Item/Tax button below the table, or press F9.

**Note:** You use the Detail Items/Taxes screen to view or change tax information for a detail. Detail tax fields do not appear in the detail table.

**To add details using the detail table,** do one of the following:

- If a blank line is highlighted, tab to the **Item Number** field, then either type the item number or select it from the Finder. Enter the remaining information for the detail.

- To start a new line, press Insert or tab through the end of the last line on the table.

  If you want to insert a new line in a specific location, highlight the line above the location, and then press Insert.

  **Note:** A detail line is saved as you enter it on the detail entry table.

**To edit details using the detail table:**

- Select the line you want to edit, and then enter your changes on that line.

  **Note:** For information about using your keyboard to move within a detail table, see "Keyboard Shortcuts for Detail Tables" (page 690)

**To delete details using the detail table:**

1. Select the line you want to delete.

2. Press the Delete key on your keyboard.
3. If you see a message asking you to confirm the deletion, click Yes.

**To edit item information or detail tax information using the Detail Items/Taxes screen:**

1. Select the detail on the table, and then either click the Item/Tax button, or press F9.
2. Edit the item information and/or change the Tax Class or Tax Included options for the detail.

---

**Keyboard Shortcuts for Detail Tables**

Use the following keyboard shortcuts to navigate in detail tables.

<table>
<thead>
<tr>
<th>Key</th>
<th>Menu Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ins/Insert</td>
<td>New</td>
<td>Insert a blank row to add a new record.</td>
</tr>
<tr>
<td>Del/Delete</td>
<td>Delete</td>
<td>Remove the selected row.</td>
</tr>
<tr>
<td>Up or Down Arrow</td>
<td></td>
<td>Go up or down one row.</td>
</tr>
<tr>
<td>Left or Right Arrow</td>
<td></td>
<td>Go left or right one column.</td>
</tr>
<tr>
<td>Pg Up</td>
<td></td>
<td>Go to the top row in view.</td>
</tr>
<tr>
<td>Pg Dn</td>
<td></td>
<td>Go to the bottom row in view.</td>
</tr>
<tr>
<td>Home</td>
<td>First</td>
<td>Go to the first row in a list.</td>
</tr>
<tr>
<td>End</td>
<td>Last</td>
<td>Go to the last row in a list.</td>
</tr>
<tr>
<td>Tab or Enter; Shift+Tab or Shift+Enter</td>
<td></td>
<td>Go to the next or previous column in a list.</td>
</tr>
</tbody>
</table>

---

**Setting Finder Criteria**

To help you search quickly through a long list of records, you can use criteria to restrict the records that are displayed in the Finder and when you use the navigation buttons.

However, at other times, if the Finder uses criteria, it might not display all the records you expect to see.
To check or remove the criteria:

1. Click the Finder  
2. Click the Set Criteria button.
3. On the screen that appears, click the Clear button.

For instructions on setting criteria, click the Help button when the Set Criteria screen appears.
Appendix D: Support and Resources

Find support and resources to help get Sage 300 ERP up and running quickly.

Finding Help and Documentation

You can find information about setting up and using Sage 300 ERP in the Sage 300 ERP Learning Center and in the product documentation included with this release.

Note: For technical support, visit our customer support website at http://na.sage.com/sage-300-erp/product-support or contact your Sage business partner.

The Sage 300 ERP Learning Center

The Learning Center is where you'll find documentation for new product features and modules in the Sage 300 ERP Portal. It features articles and information about the portal, shortcuts, snapshots, and Inquiry.

You view the Learning Center in one of the following ways:

- Open the Sage 300 ERP Portal, and on the welcome bar at the top of the screen, click Help > Learning Center.
- On the tab menu for any portal tab, click Help.

Context-Sensitive Help

Sage 300 ERP features context-sensitive help that you can use to quickly open and view articles and information directly from Sage 300 ERP screens.

- In the Sage 300 ERP Portal, click Help on the tab menu to view help for the current screen.
- On the Sage 300 ERP Desktop, press F1 to view help for the current screen.

Product Documentation

Sage 300 ERP includes guides in printable PDF format, including the Installation and Administration Guide, Upgrade Guide, and other
Appendix D: Support and Resources

documentation related to installation and setup.
These guides are available in the Docs folder on the Sage 300 ERP server, and online in the Sage Customer Portal at:

- [https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm](https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm).

**To view the guides in the Docs folder:**
- On the Windows taskbar, click **Start > Programs > Sage 300 ERP > Documentation**.

**Support and Resources**
Use the links below to find instructions, software training, one-on-one support, technical specifications, or other resources to get Sage 300 ERP working smoothly for your business.

Your Sage Business Partner is also an excellent resource to consult when you have questions about Sage 300 ERP.

**How can we help you?**

**I'm setting up Sage 300 ERP and need information or assistance**

- **Sage 300 ERP Resources online** —
  [https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm](https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm)
  Find and download user guides, technical specifications, and more.

- **Sage 300 ERP Web Portal** — [http://www.sage300erp.com](http://www.sage300erp.com)
  Find a business partner, get priority support, and more.

**I'm looking for instructions to complete a task in Sage 300 ERP**
While using Sage 300 ERP, you can get instructions directly from the software in the following ways:

- **Contextual Help** — To see topics related to your current task:
  - In the Sage 300 ERP Desktop, press **F1**
  - In the Sage 300 ERP Portal, press **Alt+F1**
• **Help Topics** — To explore topics and information:
  - In the Sage 300 ERP Desktop, click Help > Help Topics
  - In the Sage 300 ERP Portal, click Help > Learning Center

**I think something is broken, or I’m getting error messages**
Search our knowledge base for solutions to common issues, or contact us for one-on-one assistance.

- **Knowledge Base** — [https://customers.sagenorthamerica.com](https://customers.sagenorthamerica.com)
  Find answers and solutions to FAQs and known software issues.

  Find links to support services or contact our support team.

- **Customer Center** — [https://customers.sagenorthamerica.com/irj/portal/anonymous/login](https://customers.sagenorthamerica.com/irj/portal/anonymous/login)
  Exclusive support for Sage customers.

- **Partner Center** — [https://partners.sagenorthamerica.com](https://partners.sagenorthamerica.com)
  Exclusive support for Sage partners.

  Learn how to get unlimited support by phone, e-mail, and live chat.

**I’m looking for downloads, updates, or technical specifications**
Find product updates, download resources, or review technical specifications for Sage 300 ERP.

- **Sage 300 ERP Resources online** —
  [https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm](https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm)
  Find and download user guides, technical specifications, and more.

  Find links to support services, contact our support team, and learn how to guarantee your Sage software is always up to date.
Appendix D: Support and Resources

I want to become a more skilled user of Sage 300 ERP
Find links to Sage software training, online communities, and more.

- **Sage University** — [www.sageu.com/sage300erp](http://www.sageu.com/sage300erp)
  Convenient, professional training options to help you achieve your business goals.

- **Sage Summit** — [http://na.sage.com/sage-summit](http://na.sage.com/sage-summit)
  Connect with peers and experts at our annual conference.

  Learn how to get unlimited support by phone, e-mail, and live chat.

I want to share knowledge with other Sage 300 ERP users
Find and share tips, tricks, and solutions online in the Sage 300 ERP Community.

- **Sage 300 ERP Community** — [http://community.sageaccpac.com](http://community.sageaccpac.com)
  Explore Sage 300 ERP blogs, discussions, FAQs, resources, and more.

- **Sage Summit** — [http://na.sage.com/sage-summit](http://na.sage.com/sage-summit)
  Connect with peers and experts at our annual conference.

I want to contact a Sage 300 ERP representative

  Find links to support services, contact our support team, and learn how to guarantee your Sage software is always up to date.

- **Live Chat** — [http://community.sageaccpac.com](http://community.sageaccpac.com)
  Chat with a Sage representative at the Sage 300 ERP Community Web site
Index

A

accounts
  Cost Of Goods Sold 4
  Cost Variance 4
  Damaged Goods 4
  Inventory Control 4
  Prepayment Liability 4
  Receivables Control 4
  Returns 4
  Sales 4
  Shipment Clearing 4
  Tax Liability 4
Accounts Receivable
  including prepayment in receipt batch 107
  posting batches in O/E 23
adding sales statistics 187
Aged Orders report 275
  fields and controls 276
allocating serial or lot numbers 157, 161, 164, 167, 171
Allow Negative Inventory Levels
  effect of I/C option on O/E shipments 69
audit trail
  maintaining 65

B

backorder quantities
  calculating 18, 78
  canceling 81
Bank Rate screen
  fields and controls 449
batches
  creating 28
BOM Components screen
  fields and controls 451, 478
business forms  See customer forms
buttons
  Drilldown 683
  Finder 683
  Go 685
  Inquiry 685
  Navigation 685
  New 686
  Zoom 686

C

Calculate Backorder Quantities 18
Calculate Tax button 183
calculating taxes 96, 180, 183, 392, 395, 515, 568
capturing credit card payments 142
  resolving issues 673
carriers 346
Clear History screen
   fields and controls 272
clearing history 66, 82
commands 683
comments 101
commissions 54
   allowing for item categories 55
   setting up 54
   tracking 53-54
Confirmation screen 453
Copy Orders screen 654
   fields and controls 656
copying orders 104
Cost Of Goods Sold account 4
Cost Variance account 4
costing
   most recent 4
   standard 4
costing methods
   estimates used for Order Entry documents 33
Create Batch screen
   fields and controls 275
Create Invoice from Shipments screen 609
Create Order from Quotes screen 455
Create Shipment from Orders screen 561
creating batches
   credit card transactions 150
creating invoices
   from multiple shipments 117
   when shipping 117
credit card payments 69
   capturing 142
   pre-authorizing 142, 144
   processing batches 150
   settling 114
credit card transactions
   capturing pre-authorized prepayments 147
   forcing 143, 147
   pre-authorizing 153
   prepayments 147, 153
   settling 114
   voiding pre-authorizations 143, 153
credit checks
   when posting invoices 70, 120
credit notes 127
   allocating serial or lot numbers 167
   for job-related invoices 72
   importing 129
   journal entries for 238
Credit/Debit Note Entry screen
   fields and controls 251, 615
credit/debit notes
   looking up 190
   posting journal 285
   printing a range 202
crediting an existing invoice 130
Current Orders Inquiry screen 189
   fields and controls 359
custom fields See optional fields
Customer Bill-To Address screen
   fields and controls 453, 456
customer forms
   about 193
   customizing 197
Order Confirmations 256
Index

Picking Slips 260
customer tax classes 177
editing 96, 396, 515, 568
customizing printed forms 197

D
Damaged Goods account 4
damaged items
  journal entries to account for 238
data entry screens 690
datapiped forms 198
  parameters 198
Day End Processing
  performing 243
  transactions 38, 65, 77, 82
debit notes
  allocating serial or lot numbers 171
  importing 129
  printing a range 202
default order UOM 19
detail entry tables 689
details
  adding 689
  deleting 689
  editing 689
Distribute Tax button 183
document numbers
  entering manually 17
  length 17
documentation and help 693
documents See also transactions
  looking up 188
Drilldown button 683

E
e-mail
  printing reports as attachments to 226
e-mail messages
  variables 44
E-mail Messages report 303
E-mail Messages screen 357
  fields and controls 357
entering taxes 183
entering transactions
  credit notes 610
  debit notes 610
  invoices 116, 562
  orders 92, 389
  shipments 120
  tax information 180
estimates
  job-related 9
exchange rates
  changing 76
  defining 76
exporting
  orders 6, 74
  serial or lot numbers 74

F
FIFO 134, 138
File menu commands 687
  Close 687
  Customize 687
  Export 687
  Import 687
| Index |
|---|---|
| **Print** | 687 |
| **Print Setup** | 687 |
| **Save** | 688 |
| **Finder button** | 683 |
| setting criteria | 690 |
| **forcing payment** | 143 |
| **forms** |  |
| customizing | 198 |
| **function keys** | 683 |
| **G** |  |
| **G/L Integration Details screen** | 324 |
| fields and controls | 324 |
| **G/L Integration report** | 304 |
| **G/L Integration screen** | 327 |
| fields and controls | 328 |
| **G/L Transactions report** |  |
| fields and controls | 279 |
| **General Ledger** |  |
| creating batches | 28 |
| integration with O/E | 28 |
| **Go button** | 685 |
| **guides and documentation** | 693 |
| **H** |  |
| **Help menu** | 688 |
| **hold** | 392 |
| **I** |  |
| **I/C item returns** |  |
| journal entries for | 238 |
| **icons** | 683 |
| importing |  |
| debit notes and credit notes | 129 |
| invoices | 74 |
| multicurrency issues | 130 |
| orders | 6, 74 |
| **forcing payment** | 143 |
| serial or lot numbers | 74 |
| **Inquiry button** | 685 |
| **inquiry screens** |  |
| Order Details | 366 |
| **Installation and Administration Guide** | 693 |
| **Installation and System Administrator's Guide** | 693 |
| installing Sage 300 ERP, documentation on | 693 |
| **instructions** | 101 |
| **inventory** |  |
| costing methods | 33 |
| tracking returned items | 171 |
| **inventory control** |  |
| transaction records | 157 |
| **Inventory Control account** | 4 |
| **inventory item returns** |  |
| journal entries for | 238 |
| **Invoice Action report** |  |
| fields and controls | 281 |
| **Invoice Entry screen** | 562 |
| fields and controls | 569 |
| **invoice forms** |  |
| editing | 199 |
| non-datapipep | 199 |
| **Invoice List** | 115 |
| **invoices** |  |
| allocating serial or lot numbers | 164 |
| creating from shipments | 116, 609 |

700 Sage 300 ERP Order Entry
entering order information 389
G/L journal entries for 236
job-related 7
labels 568
looking up 190
overview 67
partial 70
posting 79, 247
posting journal 285
prepayments 489
Item/Taxes button 180
items
  editing 100
  journal entries to account for damage to 238
Items/Taxes screen
  fields and controls 462

Kitting Components screen
  fields and controls 478, 482
Kitting Item Components screen
  fields and controls 372
kitting items
  allocating serial or lot numbers 159, 163, 166, 169, 172
  and job-related orders 16
  importing on credit notes 130
  journal entries for shipping and invoicing 239

L
  LIFO 134, 138
locked fiscal periods
  posting to 234
lost sales 81
lot cost
  average in a transaction 33
lot numbers 502
  allocating 156-157, 161, 164, 167, 171, 174
  allocating for quantity ordered 33
  cannot import for kit components 130
  transaction records 157

M
  menus and commands 683
miscellaneous charge invoices 47
miscellaneous charges
  and partial invoices 70
details 47
distributing taxes 48
editing 100
integration with PJC 48
job related 10
multicurrency 339
Miscellaneous Charges report
  fields and controls 305
Miscellaneous Charges screen
  fields and controls 340
most recent costing 4
multicurrency accounting 3, 6
multiple payment schedule
  confirming details of 67

N
Navigation buttons 685
negative inventory levels 69
negative shipments
  as credit notes for project-invoiced
  documents 72
New button 686
non-existent customers 78

O
optional fields
  adding for transactions 60
  settings 353
Optional Fields report
  fields and controls 302
Optional Fields screen 344
  fields and controls 344, 350
Optional Fields Settings screen 353
  fields and controls 353
Options report 306
Options screen 311
  Default Template 35
  fields and controls 313
Order Action report
  fields and controls 283
order confirmations
  printing options 257
  printing range 218
  templates 256
Order Confirmations screen 256
  fields and controls 257
Order Details screen 366
  fields and controls 366
Order Entry
  customer forms 197
  invoices 247
  menu commands 687
  posted transactions 188
  posting batches 247
  setting up 3, 19
Order Entry menus
  File 687
  Help 688
  Settings 688
Order Entry screen 389, 610
  fields and controls 396
order unit of measure 19
orders
  allocating serial or lot numbers 33, 157
  completing 389
  copying 104
  editing 100, 390
  entering 92, 389-390
  estimated weight 396
job-related 9
labels 396
looking up current 189
on hold 392
overview 67
posting 77, 390
prepayments 489
processing (overview) 68

P

partial invoices
    and miscellaneous charges 70
partial shipments
    taxes for 81
Payment Processing
    and shipments 69
payment schedules 83
pending shipments
    looking up 189
Pending Shipments Inquiry screen
    fields and controls 364
    using 189
period end procedures 231
periodic processing 231
periodic processing screens
    Process Preauthorized Payments 672
picking slips
    printing 215
Picking Slips screen 260
    fields and controls 261
posted documents
    looking up 188
Posting Journals report
    fields and controls 287
posting transactions 247
Pre-authorization screen
    fields and controls 486
pre-authorizations
    capturing 147
    capturing batches 150
    creating 144
    voiding 153
pre-authorizing credit card payments 142
Pre-Transaction Credit Check screen 496
    fields and controls 496
Prepayment Liability account 4
prepayments 489
    including in receipt batch 107
    job-related 11
    journal entries for 237
Prepayments screen 489
    fields and controls 490
price adjustments
    journal entries to account for 239
Price Approval screen 499
    fields and controls 499
prices
    determining for job-related invoices 13
print destination
    printing to a file 225
    setting 225
    setting e-mail as 226
    setting printer as 225
    setting your screen as 225
print destinations 227
    Printed status 223
printed posting journals
    clearing 271
Index

printer
  setting as print destination 225
printing
  order confirmations 218
  picking slips 215
  reports 227
  setting a print destination 227
Process Preauthorized Payments
  screen 672
  fields and controls 674
processing tasks
  daily 231
  weekly 231
processing transactions 67
Project and Job Costing
  integration with 7
  miscellaneous charges 339
Project and Job Costing Apply Details
  screen
  fields and controls 445
project invoicing 7
prorating taxes 183
Purchase Order Details screen
  fields and controls 367
purchase orders
  creating from job-related sales orders 12

Q
quantity backordered 18
quotes
  editing 390
  entering 390
  job-related 9
posting 390
printing options 266
processing (overview) 68
templates 265
quotes and orders
  adding comments or instructions 101
Quotes screen
  fields and controls 266

R
Receivables Control account 4
reports
  Aged Orders 275
  E-mail Messages 303
  G/L Integration 304
  Options 306
  print destinations 225
  Printed status 223
  printing 227
  printing to a destination 227
  Sales History 288
  Sales Statistics 294
  Salesperson Commissions 228
  Ship-Via Codes 308
  Templates 310
returns
  creating 130
  journal entries for I/C items 238
Returns account 4
reversing  See voiding

S
Sales account 4
sales commissions 83
sales history
  clearing 271
Sales History Detail screen
  fields and controls 374
Sales History report 288
  fields and controls 289
Sales History screen
  fields and controls 368
sales splits 83
sales statistics
  adding 187
  clearing 271
  keeping 39
  lost sales 81
Sales Statistics report 294
  fields and controls 294
Sales Statistics screen
  fields and controls 381
salesperson commissions
  setting up 54
Salesperson Commissions report
  fields and controls 297
Salesperson Inquiry screen 190
  fields and controls 386
screen guides 249
serial cost
  average in a transaction 33
serial numbers 502
  allocating 156-157, 161, 164, 167, 171
  allocating for quantity ordered 33
  allocating in copied orders 174
  cannot import for kit components 130
  transaction records 157
Serial/Lot Numbers Allocation screen 502
  fields and controls 502
Serial/Lot Numbers Generation screen
  fields and controls 502
Serial/Lot Numbers screen
  setting up Order Entry 3
Settings menu 688
Settings menu commands
  Auto Clear 688
  Clear Saved Settings 688
  Save Settings as Defaults 688
setup screens
  E-mail Messages 357
  G/L Integration 327
  G/L Integration Details 324
  Optional Fields 344
  Optional Fields Settings 353
  Options 311
Ship-To Address screen
  fields and controls 458
ship-via codes 36
Ship-Via Codes report 308
  fields and controls 309
Ship-Via Codes screen
  fields and controls 346
Shipment Clearing account 4
Shipment Entry screen
  fields and controls 516
shipments
  allocating serial or lot numbers 161
  and negative inventory levels 69
  creating from orders 561
  estimated weight 516
G/L journal entries for invoicing 235
labels 516
overview 67
posting 80
posting journal 285
prepayments 489
processing (overview) 68
Shipments/Invoices screen 500
Shipping Labels screen
fields and controls 269
shipping methods 346
shipping orders 120
shortcuts 683
source codes
  AR-PI (prepayments) 237
  OE-CN (credit notes) 238
  OE-IN 236
  OE-IN (invoices) 236, 240
  OE-SH (shipments) 235, 240
source currency 139
standard costing 4
tax amounts
  automatically prorating 97, 396, 515, 568
tax base 96, 180, 184, 396, 515, 568
tax classes 177
  changing on documents 180
  customer 180
  item 180
tax exemption number 97, 396, 515, 568
tax groups
  and customer tax classes 177
  and Order Entry templates 178
  and PJC 178
  changing on documents 180
  on job-related orders 11
Tax Liability account 4
taxes
  calculating 183, 392
  calculating automatically 96, 395, 515, 568
  calculating for partial shipments 81
  calculating manually 96, 395, 515, 568
  entering manually 183
  prorating 183
technical support 693-694
template codes 392
creating 36
templates 334
  customer information 37
  customizing 198
  order information 37
  specifying as default 37
Templates report 310
  fields and controls 310
Templates screen
  fields and controls 335
tools 683
transaction history
  clearing 271
Transaction List report
  fields and controls 299
transaction screens
  Apply Prepayment to Jobs 353
Confirmation 453
Copy Orders 654
Create Invoice from Shipments 609
Create Order from Quotes 455
Create Shipment from Orders 561
Invoice Entry 562
Order Entry 389, 610
Pre-Transaction Credit Check 496
Prepayments 489
Price Approval 499
Serial/Lot Number Allocation 501
Serial/Lot Number Generation 501
Shipments/Invoices 500
transactions overview 67

U
Upgrade Guide 693

V
variables 44
voiding pre-authorizations 143

Z
Zoom button 686